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WordPerfect Software

WordPerfect word processing software is also available for the following
computers and operating systems:

Versions of WordPerfect are also available in selected languages. Contact your

Amiga computers

Apple lle/llc and 1IGS computers

Atari ST computers

Data General AOS/VS systems

IBM PC (and most compatibles)

IBM Personal System/2 (running DOS or OS/2)
IBM 370 MVS or VM operating systems
Macintosh computers

NeXT workstations

UNIX-based systems and workstations
VMS Systems

dealer or local WordPerfect Corporation International Affiliate Office, or the
International Division of WordPerfect Corporation, for more information.
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International WordPerfect Offices

If you purchased this product within the U.S. or Canada and want to register
your license outside the U.S. and Canada with the WordPerfect Corporation
International Affiliate Office in your area, entitling you to local customer support
and update notices, you will be charged a maximum of 25% of the local retail

price.

Australia (Also covers New Guinea)
WordPerfect Pacific, Regional Office
Building 2

25 Sirius Road

Lane Cove NSW 2066

Australia

Tel: (61 2) 415 5222
Fax: (61 2) 418 7505

Belgium (Also covers Luxembourg)
WordPerfect Belgium
Manhattan Office Tower
Bolwerklaan 21 b 9

Avenue du Boulevard 21 bte 9
1210 Brussels

Belgium

Tel: (32 2) 217 48 54
Fax: (32 2) 218 83 53

Brazil

WordPerfect Brasil

R. Dr. Luiz Migliano
1110, Conj. 601/602
05711 - Sao Paulo - SP
Brazil

Tel: (55 11) 844 4938
Fax: (55 11) 844 4257

Chile

WordPerfect Chile

Avda. Pedro de Valdivia 176
Providencia

Santiago

Chile

Tel: (56 2) 233 6898
Fax: (56 2) 233 2611

Denmark

WordPerfect Danmark
Helsingprsgade 52
3400 Hillerpd
Denmark

Tel: (45) 42 251199
Fax: (45) 42 250058

Europe

WordPerfect Europe, Regional Office
Barbizonlaan 25

2908 MB Cappelle a/d 1Jssel

The Netherlands

Tel: (31) 10 40 70 100
Fax: (31) 10 45 66 255

Finland

WordPerfect Finland
Sinikalliontie 5
02630 Espoo
Finland

Tel: (358 0) 502 721
Fax: (358 0) 502 7299

France

WordPerfect France

Les Fjords, Immeuble le Nobel
19, avenue de la Norvege

Z.A. de Courtaboeuf

B.P. 353

91959 Les ULIS cedex

France

Tel: (33 1) 69 29 10 10
Fax: (33 1) 69 29 01 10
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Germany (Also covers Austria)
WordPerfect Software GmbH
Frankfurter StraBe 21-25
6236 Eschborn

Germany

Tel: (49 6196) 9 04 01
Fax: (49 6196) 4 60 03

Italy

WordPerfect Italia
Corso Sempione, 2
20154 Milano
Italy

Tel: (39 2) 3310 6200
Fax: (39 2) 3310 6190

Japan

WordPerfect Japan
Kawakami Biru 4F
2-6-11 Ebisu Nishi
Shibuya-ku, Tokyo 150
Japan

Tel: (81 3) 3780 0515
Fax: (81 3) 5489 7349

Latin America

WordPerfect America Latina,
Regional Office

1555 North Technology Way
Orem, Utah 84057

U.S.A.

Tel: (801) 228-4217
Fax: (801) 222-4277

Mlexico

WordPerfect Mexico
Rio de la Plata #32
Colonia Cuauhtemoc
Mexico D.F. 06500
Mexico

Tel: (52 5) 286 5680
Fax: (52 5) 286 5630

INTERNATIONAL WORDPERFECT OFFICES

Netherlands

WordPerfect Nederland
Barbizonlaan 25

2908 MB Capelle a/d 1Jssel
The Netherlands

Tel: (31) 1040 70 100
Fax: (31) 10 45 66 255

Norway

WordPerfect Scandinavia-Norway
Postboks 6779 Rodelpkka

0503 Oslo 5

Norway

Tel: (47 2) 37 70 52
Fax: (47 2) 37 14 61

Spain (Also covers Portugal)
WordPerfect Iberica Sucursal Espana
Dr. Joaquin Albarran, 13-15

08034 Barcelona

Spain

Tel: (34 3) 280 00 20
Fax: (34 3) 280 60 75

Sweden

WordPerfect Scandinavia-Sweden
Box 2063

172 02 Sundbyberg

Sweden

Tel: (46 8) 733 03 20
Fax: (46 8) 733 42 96

Switzerland

WordPerfect Switzerland
Gewerbestrasse 16
3065 Bolligen

Tel: (41 31) 38 07 70
Fax: (41 31) 38 04 82



United Kingdom
WordPerfect U.K., Regional Office
Unit 9

Weybridge Business Park
Addlestone Road
Weybridge

KT15 2UU

United Kingdom

Tel: (44 932) 850500
Fax: (44 932) 843497

INTERNATIONAL WORDPERFECT OFFICES

vii






International Distributor Offices

Argentina

SoftMart

Florida 686

3 Piso, Dept. B
1005 Buenos Aires
Argentina

Tel: (54 1) 322 3828
Fax: (54 1) 322 4617

Caribbean
MERISEL/IMS

8216 N.W. 14 Street
Miami, Florida 33126
US.A.

Tel: (305) 477-0777
Fax: (305) 477-0770

Central America
MERISEL/IMS

8216 N.W. 14 Street
Miami, Florida 33126
U.S.A.

Tel: (305) 477-0777
Fax: (305) 477-0770

Colombia

L.A.S.C.

Carrera 18 No. 79-37
A.A. 8692 Bogota
Colombia

Tel: (57 1) 218 4511
Fax: (57 1) 611 0151

Czechoslovakia

DCC (CSFR) spol s.r.o.
Anglicka 19

120 00 Prague 2
Czechoslovakia

Tel: (42 2) 250 778
Fax: (42 2) 256 723

Egypt

Phoenix

P.O. Box 92
11341 Heliopolis
Cairo

Egypt

Tel: (20 2) 341 4739
Fax: (20 2) 341 4738

Greece (Also covers Cyprus)
M-Data

Sygrou Ave 314
Kallithea

176 73 Athens

Greece

Tel: (30 1) 9590631
Fax: (30 1) 9515356

Hong Kong (Also covers Taiwan)
SIS International Ltd.

1903-4, 19/F Westlands Centre
20 Westlands Road

Quarry Bay

Hong Kong

Tel: (852 5) 65 1682
Fax: (852 5) 62 7428

Hungary
Miiszertechnika
1108 Budapest
Venyige u. 3
Hungary

Tel: (36 1) 1476 590
Fax: (36 1) 1570 418

Iceland

Einar J. Skulason hf.
P.O. Box 8324

128 Reykjavik
Iceland

Tel: (354 1) 68 69 33
Fax: (354 1) 68 84 87
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India

Fertech Computers Limited
E-46/10

Okhla Industrial Area Phase Il
New Delhi 110020

India

Tel: (91 11) 683 7379
Fax: (91 11) 684 1860

Indonesia

PT. SiStech Kharisma

JI. Ir.H. Juanda IV No. 3 B-C
Jakarta 10120

Indonesia

Tel: (62 21) 380 7641
Fax: (62 21) 380 7640

Israel

Aztek Systems Ltd.

7 Derech Hashalom
PO.B. 36528

61364 Tel Aviv, Israel

Tel: (972 3) 695 2406
Fax: (972 3) 691 8771

Kenya

SYSCOM (Kenya Ltd.)
P.O. Box 18523

Rank Xerox House
Westlands, Nairobi
Kenya

Tel: (254 2) 741 735
Fax: (254 2) 545 815

Korea

AIT Korea (Applied Innovative
Technology)

Seocho-Ku Seocho 3 Dong 1579-4
Jinsol Building 2 FI.

Seoul, 137-073
Korea

Tel: (82 2) 522-1491
Fax: (82 2) 522-1495

INTERNATIONAL DISTRIBUTOR OFFICES

Malaysia

PDX Computers Sdn. Bhd.

20th Floor, Block A, Faber Tower
Jalan Desa Bahagia

Taman Desa, Off Jalan Klang Lama
581000 Kuala Lumpur

Malaysia

Tel: (60 3) 782 9888
Fax: (60 3) 781 5957

New Caledonia

Pacific Technology Group
65 Avenue Foch

P.O. Box 65

Noumea

New Caledonia

Tel: (687) 275665
Fax: (687) 278932

New Zealand

The Number One Software Company
P.O. Box 28-349

Remuera

Auckland 5

New Zealand

Tel: (64 9) 522 0 522
Fax: (64 9) 520 1523

Nigeria

Computer Solutions Ltd.
8, Alii Street (3rd Floor)
Tinubu Square

GPO Box 9706

Lagos

Nigeria

Tel: (234 1) 631 618
Fax: (234 1) 635 409



Philippines

SIS Technologies, Inc.

G/F Tucor Building

2288 Pasong Tamo Ext.
Makati, Metro Manila 1200
Philippines

Tel: (63 2) 863 996
Fax: (63 2) 810 8022

Poland

Pro-Test Spolka z o.0.
ul. Mlynarska 16
01-194 Warsaw
Poland

Tel: (48 22) 32 35 32
Fax: (48 22) 32 08 32

Saudi Arabia
Saudisoft

P.O. Box 87871
11652 Riyadh
Saudi Arabia

Tel: (966 1) 465-6581
Fax: (966 1)462-5204

Singapore

Primefield Co. Pte. Ltd.

180 Clemenceau Avenue
#07-01 Haw Par Glass Tower
Singapore 0923

Singapore

Tel: (65) 3388522
Fax: (65) 3398697

South America (Also covers Bolivia and
Peru)

MERISEL/IMS

8216 N.W. 14 Street

Miami, Florida 33126

US.A.

Tel: (305) 477 0777
Fax: (305) 477 0770

United Arab Emirates
Micro Computercentre
P.O. Box 4221

Dubai

United Arab Emirates

Tel: (971 4) 526 619
Fax: (971 4) 524 256

Uruguay

SoftMart (ATEL, S.A)
Canelones 1370 Piso 5
Montevideo 11.200
Uruguay

Tel: (5982) 92 21 18
Fax: (5982) 92 21 19

Venezuela

ENIAC, C.A.

Edificio Polar, piso 5

Plaza Venezuela

Apartado 66685, Las Americas
Caracas 1061-A

Venezuela

Tel: (582) 574 6711
Fax: (582) 574 1605

Yugoslavia

Perpetuum d.o.o.

Integralni Informacijski Sistemi
Kucerina 5

41000 Zagreb

Yugoslavia

Tel: (38 41) 317 020
Fax: (38 41) 328 999

INTERNATIONAL DISTRIBUTOR OFFICES
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Developer’s Toolkit

WordPerfect Corporation offers a Developer’s Toolkit for third-party developers
who are creating products that will interact with WordPerfect. The Developer’s
Toolkit contains documentation and diskettes that help create interactive
applications.

The toolkit is intended for experienced programmers. Novice programmers will
probably not understand much of the toolkit’s documentation or how to use the
files on diskette.

To order the Developer's Toolkit, or to find out more about it, call WordPerfect
Corporation's Information/Orders number: (801) 225-5000.

DEVELOPER'S TOOLKIT  Xiii












The Basics

Registration

Installation

This section will introduce you to WordPerfect and some of its basic functions
and features. If you are new to WordPerfect, it will be to your advantage to take
a few minutes to read through this section before you move on. If you are
already familiar with WordPerfect, you may want to glance through this section
as an introduction to some of the newer features that WordPerfect 5.1 has to
offer.

Before you move on, take a moment to fill out and send in the Customer
Registration card that came in your WordPerfect media box. Registering will
make sure that you stay informed of the latest releases, and entitles you to
receive WordPerfect Corporation’s quarterly newsletter, WordPerfect Report.
Keep the upper portion of the form with your manual for quick reference to your
license number. If you are an upgrade customer, you will want to use the
license number from your previous version of WordPerfect. You need your
license number to receive interim releases and updated program diskettes.

Included in your package is the WordPerfect Installation Program, which guides
you step-by-step through the WordPerfect installation process.

To install all of the WordPerfectfiles, your computer must have at least 4.5 megabytes of
hard disk space.

Below are two sections to help you during installation. In Program Installation,
we walk you through installing the WordPerfect 5.1 programs. You can also
install your printer files at this time. The Printer Installation section is provided
if you need to install printer files after your original program installation.

Program Installation
This section describes how to install your original WordPerfect 5.1 program files
or how to install updated files.

Before you can install program files, you must find the diskette labeled
Install/Learn/Utilities 1 (printed in large letters) that you most recently received.
If the only Install/Learn/Utilities | diskette you have is the one that came in
your original WordPerfect 5.1 package, find that diskette before moving on to
the steps below.

To install program files,
Exit or quit all programs and go to a DOS prompt (for example, C».
Insert the Install/Learn/Utilities 1 diskette into drive A.

From the DOS prompt, type a:install and press Enter.

AW ON Rk

Answer the on-screen prompts until the Installation menu appears.

THE BASICS 3
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5 Select Basic (1) for first-time installation. Follow the on-screen prompts for
the remainder of installation.

or
Select Update (5), then continue the steps listed below.

Perform Step 6 for the source drive (the drive from which you are copying the
new program files) and the destination drive (the drive to which you are copying
the new program files).

6 If the name of the drive is correct, press Enter.

or

Change the name of the source drive (or the destination drive).
The Install: Update screen appears.

7 Select the type of files you want to install. For example, select Program (1)
to install the WordPerfect Program.

8 Answer the prompts on the screen while providing directory or drive names
and pressing Enter.

When WordPerfect asks you to insert a master diskette, "master” refers to the
diskettes that came with your WordPerfect 5.1 package.

9 Repeat steps 7 and 8 until you have installed all the files you want.
10 When you are finished, select Exit (7) to exit the Installation program.

Your program files are now installed and ready to use.

Printer Installation

Before you can install printer files, you must find the diskette labeled
Install/Learn/Utilities 1 (printed in large letters) that you most recently received.
If the only Install/Learn/Utilities 1 diskette you have is the one that came in
your original WordPerfect 5.1 package, find that diskette before moving on to
the steps below.

If you are adding a printer not currently displayed on the Print: Select Printer
(Shift-F7,s) list or under the Select Additional Printers (Shift-F7,s,2) option, you
will need to find the diskettes labeled Printer 1-4 and follow the instructions
below (see Printer, Select in Reference).

Important: Ifyou installed your printer files during program installation, you do not
need to install the printer files now, unless you are updating them.

To install printer files,

1 Exit or quit all programs and go to a DOS prompt (for example, C>).
2 Insert the Install/Learn/Utilities 1 diskette into drive A.

3 From the DOS prompt, type a:install and press Enter.



The Template

4 Answer the on-screen prompts until the Installation menu appears.
5 Select Printer (4).

6 If the Printer 1diskette came with your package, insert it into drive A and
press Enter.

or

If you received a Printer diskette numbered 5 or greater, insert it into drive A
and press Enter.

A list of printers appears along with several instructions.

7 If you don't see your printer listed, press Page Down (PgDn) until the name
of your printer appears on the list. The numbers next to the printer names
do not change when you press Page Down.

8 Type the number that is next to the name of the printer you want to install,
press Enter, then follow the on-screen prompts until the words “Helps and
Hints” appear at the top of the screen.

The Helps and Hints screen contains information pertaining to your printer. Also
read your printer manual for information regarding printer setup, dip switch or
menu settings, cartridge installation, etc.

9 Press any key to exit and complete the printer installation.
10 Start WordPerfect the way you normally do.

11 Press Print (Shift-F7) to display the Print menu. Choose Select Printer (s)
to display the Print: Select Printer screen.

12 Highlight the printer that you just installed and press Enter to select the new
printer.

Your printer files are now installed, selected, and ready to use.

If all journeys begin with a simple first step, your experience with WordPerfect
should begin with the template, a WordPerfect menu of feature options.

In your WordPerfect package, you received a color-coded template designed to
fit over the function keys on your keyboard. This template corresponds to the

THE BASICS 5



enhanced IBM keyboard. Place the template on your keyboard as shown in the
photograph below.

A FUNCTION KEYS

The different colors are your guide to using the WordPerfect function keys.

The color key means you should press the following key(s):

Black Press the function key

Green Hold down Shift and press the function key
Blue Hold down Alt and press the function key
Red Hold down Ctrl and press the function key

Example: To Center, which is printed in green on the template, you would
hold down the Shift key and press F6.

If the template does not Jit your keyboard, an address is provided for requesting a new
template in the Getting Help section immediately following this section.

To remind you which key corresponds with each color, colored stickers called
keycals have been provided in your package. You can, if you wish, peel the
keycals from their backing and place them on the corresponding keys
(Shift=Green, Alt=Blue, Ctrl=Red) on your keyboard.

Start WordPerfect Once WordPerfect has been installed on your computer, you're ready to start the
program. If you're a new user, some things will take some getting used to, but
once you’re familiar with the WordPerfect basics, the rest will fall into place.

Any time you are asked to Enter something throughout the documentation, simply type the
required information and press Enter.

Hard Disk
To start WordPerfect on a computer with a hard disk,

1 Turn on your computer and start DOS.

6  THE BASICS



In most cases, the Disk Operating System (DOS) starts automatically when you turn on
your computer. DOS is software that helps your computer communicate with
WordPerfect. DOS must he started before any other program can he used, including
WordPerfect. 1fyou needfurther information, please see DOS and WordPerfect in

Reference and refer to your DOS manual.

2 At the DOS prompt, enter cd\wp51 (or, if your WP.EXE file is located in a
directory other than WP51, enter the name of that directory after the
backslash).

WP.EXE is afile that helps you to start WordPerfect. You start WordPerfectfrom the
directory that contains WP.EXE. In most cases, the Installation Program will have
copied WP.EXE to a directory called WP5I, so you would t\pe cd\wp51 and then press
Enter. WP.EXE will he used every time you start WordPerfect and should not he deleted.

3 Enter wp

Remember, when you see Enter, type the required information fin this case wp) and then
press Enter.

Two Disk Drives

To run WordPerfect 5.1 on a two disk drive system, it is necessary that each of vour
drives be at least 720K or larger. Ifyou are not sure whether your drives are at least
720K, please refer to your computer manual or contact your dealer.

To start WordPerfect on a computer with a two disk drive system,

Start DOS. (See the paragraph on DOS in the Hard Disk section above.)
Insert the WordPerfect 1 diskette into drive A.

Insert the diskette on which you want to store your files into drive B.
Enter b: to change the default drive to B.

Enter a:wp to start WordPerfect.

(o2 T & 2 B S

When prompted, replace the WordPerfect 1 diskette with the WordPerfect 2
diskette.

THE BASICS 7



Clean Screen

CURSOR
STATUS LINE

DOCUMENT
(L OF2)

PAGE
LINE
POSITION

>>»>» >»>>

Keys to Know

8 THE BASICS

Starting WordPerfect is like rolling a clean sheet of paper into a typewriter.
When you begin a new document, WordPerfect gives you a clean screen to work
from, which will be referred to throughout the documentation as the editing
screen or the normal editing screen.

Doc 1 Pg 1 Lit 1" Poa 1"

A A A A

The dash near the top of your screen is the cursor. It points to your current
position on the screen. The status line at the bottom of the screen displays the
position of the cursor as well as messages and warnings. When you save a
document, the status line can also display the filename of that document for as
long as you continue to work on it. (See Display Setup in Reference.)

Initial (default) formats, such as margins, tabs, and line spacing, have already-
been set for you. You can, however, change them at any time and as many
times as you like throughout a document (see Appendix G: Initial Settings for a
complete list of initial format settings).

Before you begin experimenting, you’ll need to know where to look for help in
case you get lost or make a mistake. WordPerfect is a remarkably forgiving
program; here are a few keys to remember in case you need them.

Backspace
The Backspace key is used to erase mistakes as you type. It erases characters to
the immediate left of the cursor.

Cancel

This key (FI) backs you out of features that display a message on the status line,
such as Block, Exit, and Retrieve, as well as backs you out of any menu.

Cancel can also be used to restore text that has been erased by any of the delete
keys.



Function Keys

Delete
The Delete key (Del) deletes text at the cursor position.

Help

Pressing Help (F3) displays on-screen information about any WordPerfect feature
you are currently using. You can also use this feature to display the
WordPerfect template and/or a list of features that begin with a particular letter.
Pressing Enter or the Space Bar will exit you out of help. (See Help in
Reference for more information.)

Num Lock
When Num Lock is on, you can use the keypad to type numbers. When Num
Lock is off, the keypad gives you cursor control.

To prevent confusion between the number and cursor movement functions of the
keypad, WordPerfect warns you if Num Lock is on. When you begin a new
WordPerfect document, the “Pos” message at the bottom of the screen flashes if
Num Lock is on. As soon as you display a menu or press Enter, the blinking
stops, even though Num Lock is still on. The blinking will also stop if you turn
Num Lock off by pressing that key.

Function keys provide one gateway to WordPerfect features. Throughout this
manual and the WordPerfect Workbook, you will often see key names. The
guide to using these keys is simple:

o If a key name appears by itself (F8), press the key.

* When the key names are separated by a hyphen (Shift-F8), hold down the
first key while you press the second key.

 If the key names are separated by a comma (Shift-F8,1), complete the first
sequence (Shift-F8), release the keys, then press the second key (1).

Function keys work in different ways, and present you with different responses.
Below are a few examples:

Feature Function Key How it Works

Bold F6 Turns the feature either on or off

Print Shift-F7 Presents a menu of options

Center Shift-Fé Begins a feature that is ended when Enter
is pressed

Save F10 Requires entry of a filename

The examples above refer to the original keyboard assignments. You can, if you
want to, change these assignments to suit your needs. For example, the Help
feature is currently assigned to the F3 function key. You could change the
assignment so that Help would be assigned to the FI function key. For further
information on keyboard assignments, see Keyboard Layout in Reference.

THE BASICS 9



Pull-Down Menus

10
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For more information about simply assigning Help to FI, Cancel to Escape, and Repeat
Value to F3, see Alternate Keyboard under Environment Setup in Reference.

In addition to the function keys, there is another way you can select WordPerfect
features: Pull-Down Menus.

3*13 Edit Search Layout Mark Tools Font Graphics Help

Dac 1 Pg 1 Ln 1" Pos 1"

You can turn on the pull-down menus by holding down the Alt key and pressing
the equal sign key (=) (Alt-=). The pull-down menu titles will appear in a bar at
the top of the screen. (You can turn off pull-down menus by holding down the
Alt key and pressing the equal sign key (=) again.) You can also set up the Alt

key so it will display the pull-down menu bar by pressing it alone (see Menu
Options in Reference).

In WordPerfect, you can select features in the pull-down menus by using the
arrow keys (T,i,-><-) and pressing Enter, or by using a mouse, if you have one
connected to your computer. You can also select these features by typing the
mnemonic letter that is highlighted in the feature name (e.g., S for Save). The
pull-down menus can also be turned on and off by clicking the right-most button
on the mouse.

Ifyou don't have a mouse connected to your computer and set up to run with
WordPerfect, the mouse pointer (|) will not appear. See Mouse Setup and Mouse
Support in Reference for further information.

If you prefer to use the pull-down menus, look for this symbol in the steps: 13.
Throughout the documentation, this symbol will be followed by the name of the
pull-down menu where you can find the feature.

Example:
3 Select Setup from the File menu.



Menu Options Earlier in this section, when you were introduced to function keys, you learned
that some features, such as Print (Shift-F7), present you with a menu of options.

Print
1 - Full Document
2 - Page
3 - Document on Disk
4 - Control Printer
5 - Multiple Pages
6 - View Document
7 - Initialize Printer

Options

S - Select Printer standard Printer
B - Binding Offset o

N - Number of Copies 1

U - Multiple Copies Generated by WordPerfect

G - Graphics Quality Medium

T - Text Quality High

Selection: 0

Whenever you are presented with one of these menus, there are three ways that
you can select an option:

- Type the option number, such as (1) for Full Document. (Use the numbers
at the top of the keyboard as opposed to those on the number pad.)

- Type the mnemonic letter that is highlighted in the option name (e.g., F for
Full Document).

- Position your mouse pointer on the option and click the left mouse button.

Codes Codes are commands that tell WordPerfect and your printer what to do.
Whenever you use a feature such as Block or Underline, WordPerfect inserts
these hidden commands into your document. You can examine these codes in
the Reveal Codes (Alt-F3) screen. For information, see Appendix C: Codes for a
list of all codes, in addition to Reveal Codes and Delete Codes in Reference.

Exit WordPerfect When you finish using WordPerfect, you must exit before turning off the
computer.

1 Press Exit (F7) to begin exiting WordPerfect.
CB Select Exitfrom the File menu.
2 Press y to save the document, then enter a filename.
or
Press n to continue exiting without saving the document.
3 Press y to exit WordPerfect.

There are several saving options. For further information, see Save in Reference.
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If you have problems as you work with WordPerfect, help is available from
several sources.

The Help feature (F3) displays on-screen information about any feature you are
currently using. For more information, see Keys to Know in The Basics section
of Getting Started and Help in Reference.

This manual contains an alphabetical list of WordPerfect features, describing
how each feature works. Each section contains steps and information pertaining
to individual features, as well as more detailed information under the Notes
heading at the end of each section. See Also will direct you to related
information. A comprehensive index is provided to direct you to the information
you need, as well as an Appendix devoted exclusively to troubleshooting (see
Appendix O: Troubleshooting for further help).

The WordPerfect Workbook contains several lessons which show you how
WordPerfect features may be used and combined for specific applications.
Lessons include advanced applications as well as basic fundamentals.

WordPerfect includes a tutorial that takes you step-by-step through a number of
basic skills. The tutorial is intended for use with IBM personal computers and
100% compatibles only.

Important: The On-Line Tutorial is installed with the WordPerfect Learning files. 1fyou
did not install the Learning files when you installed WordPerfect or have not subsequently
done so, you must install them before running the tutorial (see the Installation Instructions
card). Ifyou are running the tutorial on a network and the Learning files have not been
installed, check with your system administrator or see Appendix R: Networking
WordPerfect for installation instructions.

Hard Disk
To start the tutorial on a computer with a hard disk,

1 Start DOS on your computer. (See the paragraph on DOS in the Hard Disk
section of Start WordPerfect in The Basics.)

2 Type path, then press Enter.

The path is a listing of the directories that are searched when you want to
execute a program from the DOS prompt. The directories are searched in the
order listed (see DOS and WordPerfect in Reference for further information).

3 Check the path to see if it contains the directories where WP.EXE, WP.FIL,
and the Learning files are located.

The WordPerfect Auto-Install Program automatically asks you if you want the C:\WP5I
directory entered into your path. Ifyou inserted the C:\WP5I and C:\WP51\LEARN



directories upon installation, they should now appear in the path. If your path contains
these directories, move on to step 6.

4 If your path doesn’t contain the proper directories, type path= then type the
same directories that were listed in the original path plus the directories
where WP.EXE, WP.FIL, and the Learning files are contained.

In the PATH command, the directories must be separated by a semicolon (;) (e.g.,
PATH=C:\WP51; C:\WP51\LEARN).

This PATH command remains in effect until you turn off your computer. If you
want to use the PATH command permanently, you should include it in an
AUTOEXEC.BAT file (see DOS and WordPerfect in Reference).

5 After you have finished typing the PATH command, press Enter.
6 Enter tutor to start the tutorial.

Read the messages on the screen and follow the instructions as directed. When
you exit out of the tutorial, you are returned to the same DOS prompt.

If you have problems starting the tutorial after following these steps, try exiting
out of any program that may still be running, then try step 6 again. If you’re
still having problems, go to the DOS prompt before you enter tutor and enter
the following command:

set wp-/nk/nc

These startup options disable the Cursor Speed feature and enhanced keyboard
calls and remain in effect until you turn off your computer or use a new SET
command. See your DOS manual and Appendix N: Startup Options for more
information.

Two Disk Drives
To start the tutorial on a two disk drive system,

1 Start DOS on your computer. (See the paragraph on DOS in the Hard Disk
section of Start WordPerfect in The Basics.)

2 Insert the WordPerfect 1 diskette into drive A.
3 Insert the Learning diskette into drive B.
4 Enter path=a:\;b:\ at the prompt.

The path lists the directories that are searched when you want to execute a program
file from the DOS prompt. The directories are searched in the order listed.

This PATH command remains in effect until you turn off your computer. If you
want to use the PATH command permanently, you should include it in an
AUTOEXEC.BAT file (see DOS and WordPerfect in Reference).

5 Enter tutor to start the tutorial.
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6 When prompted, replace the WordPerfect 1 diskette with the WordPerfect 2
diskette.

Read the messages on the screen and follow the instructions as directed. When
you exit the tutorial, you are returned to the original DOS prompt.

Network
To start the tutorial on a network,

1 Make sure you are logged onto the network.

2 At the DOS prompt, change to the directory that contains the WordPerfect
5.1 program (e.g., Y:\WP51).

3 Enter tutor to start the tutorial.

Read the messages on the screen and follow the instructions as directed. When
you exit the tutorial, you are returned to the network prompt.

Ifyou are unable to run the tutorial from a network, you may have a problem with
WordPerfect temporary files. These files are created by WordPerfect each time you run
the tutorial. WordPerfect saves them in the network default directory, provided that you
have access rights to store files in that directory. 1fyou do not have these access rights,
you must specify another location (directory) where temporary files can be stored. For
more information, see /d=drive/directory and Startup Option Placement under Placing
Startup Options in Appendix R: Network Administration.¥

WordPerfect Customer Support has earned a reputation as the best support in the

software industry. We welcome your calls. We encourage you, however, to
refer to your WordPerfect documentation before calling.

Before you call Customer Support, follow these steps:

e Try to duplicate the problem, keystroke by keystroke, to see exactly what
was done.

¢ Be at your computer when you call Customer Support. Have your manual
and license number handy. Also know the model of printer you are using.

* Run the WPINFO.EXE program to gather information about your setup that
Customer Support may need (see Appendix O: Troubleshooting).

If you are an English version user within the United States, Canada, or any U.S.
Territory, toll-free support is available by dialing the numbers listed below. For
WordPerfect on IBM PC-compatible computers, Customer Support takes toll-free
calls Monday through Friday from 7 a.m. to 6 p.m. Mountain time. For all other
computers, support hours are from 8 a.m. to 5 p.m. Mountain time.

To provide you with the most efficient service possible, we have created
specialized support groups. If you call the number from the following list that
most closely corresponds to your problem, we can assist you in a more effective
and timely manner.



Installation of WordPerfect Software

For assistance when installing WordPerfect 5.1 for the first time, when installing

an upgrade of WordPerfect 5.1, or for answers to general installation questions.

Installation

General Features

(800) 533-9605

For assistance when using any WordPerfect feature.

Equations
Columns
Graphics
Labels
Macros*
Merge*
Sort

Tabs
Tables

All Other Features

800
800
800

(800) 321-3383
(800) 541-5096
(800) 321-3383
(800) 541-5129
(800) 541-5129
(800) 541-5129
(800) 541-5096
(800) 541-5096
(800) 321-3383
(800) 541-5096

*Please note that, although Macros/Merge support operators can assist you in
troubleshooting existing macros/merges, they cannot design and write

customized macros/merges for you.

Printing and Fonts

For assistance when selecting a printer, setting up print options, or when

experiencing other problems when printing from within WordPerfect 5.1. For
assistance with printer hardware problems or when ordering printer accessories

(e.g., toner or font packages), contact your local dealer.

Laser or PostScript Printing
Dot-Matrix/Inkjet/Thermal/
Daisywheel Printing

Networks

For assistance when installing and troubleshooting WordPerfect 5.1 on a Local
Area Network (LAN).

Networks

Information

For answers to non-technical questions about WordPerfect products.

Information Services
Information Services—Canada

(800) 541-5170
(800) 541-5160

(800) 321-3389

(800) 451-5151
(800) 321-2318

GETTING HELP
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Orders (All Products)

For placing or inquiring about orders for program upgrades or product
components (e.g., templates, manuals, workbooks). To order retail packages of
WordPerfect 5.1 or other products, contact your local dealer.

Customer Orders (800) 321-4566
You can fax your problem to fax number (801) 222-4377.

If you purchased this product within the U.S. or Canada and want to register your license
outside the US. and Canada with the WordPerfect Corporation International Affiliate
Office in your area, entitling you to local customer support and update notices, you will
be charged a maximum of 25% of the local retail price.

If you are in an area where the phone system does not handle toll-free numbers,
you can reach the same Support groups described above by dialing the following
numbers, but you will be charged for the call. Note that there is only one printer
number and only one feature number.

Installation (801) 226-5444
Features (801) 226-7900
Printers (801) 226-7977
Networks (801) 226-4777

You can fax your problem to fax number (801) 222-4377.

WordPerfect Corporation offers electronic support through a Bulletin Board
Service (BBS). The number to access the BBS is (801) 225-4414 (this is not a
toll-free number). If you have a modem and a working knowledge of a

Communications software package, you may access our Bulletin Board System.

Your Communications software must be set to 8 data bits, no parity, and 1 stop
bit in order to connect properly. The recommended terminal emulation to use is
ANSI. This number will support 1200 and 2400 baud modem callers. See
Appendix O: Troubleshooting for common problems using the BBS.

Some examples of files found on the BBS are current printer drivers, support
memos, utilities, current graphics drivers, and troubleshooting information.
WordPerfect Program files are not posted for downloading. You may leave
technical questions for Customer Support and enter enhancement requests for
Development. The BBS also facilitates the transfer of problem files to be
reviewed by Customer Support operators.

WordPerfect Corporation is using PCBoard BBS software and is accessible 24
hours a day. All files on the BBS are compressed with PKWare utilities
(PKZIP) in order to protect the integrity of the files. You need to uncompress
the files using PKUNZIP.



Electronic Support for
the Hearing Impaired

After-Hours Support

Ordering Templates

WordPerfect Corporation also offers Electronic Support for the hearing impaired.
Customers may call with a Telecommunications Device for the Deaf (TDD) or
Teletype (TTY). Customer Support takes toll-free calls Monday through Friday
from 8 am. to 4 p.m. Mountain time. The phone number is (800) 321-3256.

Call (801) 222-9010 to receive support on WordPerfect products for IBM PC-
compatible computers Monday through Thursday from 6 p.m. to 7 a.m., Friday
from 6 p.m. to 10 p.m., and Saturday from 8 a.m. to 4 p.m. Mountain time.
This number is not toll free.

If the template included in your package does not fit your keyboard, return it
along with the name (and a photocopy or rough sketch) of the keyboard you are
using to:

WordPerfect Corporation
Attn: Information Services
1555 N. Technology Way
Orem, Utah 84057

WordPerfect Corporation will provide you with the closest match for your
keyboard.
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Now that you've gone through the basics, here is a brief lesson designed to help
you get to know WordPerfect. It will introduce you to some WordPerfect basics
and features that you might typically use. To begin, start WordPerfect as
previously described.

Equipped with the basics, you’re now ready to start typing. The document you
create will be a simple note. If you make any mistakes, use the Backspace key
to erase them.

You'll notice that when a line fills with text, the cursor returns to the left margin
in a new line. This automatic return is known as word wrapping.

1 Type the following note without pressing Enter at the end of a line.

Remember the discussion we had about starting a study abroad
program? I’ve just returned from a study abroad conference in lllinois,
and | have an outline 1'd like you to take a look at. Why don't you stop
by my office the next time you're at this end of campus, and we can talk
about it.

You’ve just created your first document. Looking it over, you see a few things
that you’d like to change. WordPerfect has several features that make editing
quick and efficient.

Moving the Cursor

You can move the cursor on your screen by using either the Up and Down
Arrows (T/4) or the Left and Right Arrows (<-/->) on your keyboard. To move
the cursor with a mouse, simply position the pointer where you want the cursor
to be, and click the left mouse button.

Some keyboards have a separate number pad that is also usedfor cursor control in
WordPerfect. The Num Lock key (or its equivalent) operates as a toggle to turn Num
ljock on and off. When Num Lock is turned off, the number pad can be usedfor cursor
control.

1 Using the arrow keys, move the cursor to the uppercase R in Remember.
Insert vs. Typeover
WordPerfect uses Insert as the main form of editing. While in Insert, any text

you type is inserted at the cursor, moving the existing text to the right. The
alternative is to type over existing text by using Typeover.

2 Type Do you and press the Space Bar.

3 Press Insert (Ins). Notice that the word Typeover appears at the bottom left
of the screen.

4 Type a lowercase r to replace the existing R.



5 Press Insert to end Typeover.
6 Move the cursor to the h in have in the second sentence.

7 Press Delete (Del) until the remainder of the sentence (including the period)
is erased.

Many functions on the WordPerfect keyboard will repeat if you simply hold down the key.
Use caution in doing this until you get used to the keyboard; holding down a key too long
can insert unwanted codes into your document and delete other necessary codes.

8 Type think I've come up with an outline that will make us all very
happy.

9 Move the cursor to the v in very.

Block and Underline
The Block feature is used to define portions of text for use with other features.

1 Press Block (Alt-F4—in other words, hold down the Alt key and press F4),
then press Right Arrow (-2) until the word very has been highlighted.

CB Select Block from the Edit menu, then press Right Arrow (->) until the word very has
been highlighted. Or you can hold down the left button on the mouse and drag until
the word is blocked.

2 Press Underline (F8) to underline the word.
CB Select Appearance from the Font menu, then select Underline.

You can block characters, words, sentences, and entire pages if you wish. If you
had blocked the rest of the note from the word very forward, the entire block
would have been underlined.

3 Move the cursor to the D in Do at the beginning of the note.

4 Press Enter two times to add blank lines at the beginning of the note.
Using the Home Key

The Home key can be used for quick movement throughout your document.

1 Press the Home key twice, followed by Up Arrow (t). This returns you to
the top of your document.

2  Type Mitch,
3 Return to the D in Do at the beginning of the note.
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4 Press Tab.

Mitch,

Do you remember the discussion we had about starting a study
abroad program? 1"ve Just returned from a study abroad conference
In Illinois, and I think I1"ve corae up with an outline that will make
us all verv haoov. Why don®"t you stop by my office the next tint)
you're at this end of campus, and we can talk about it.

Doe 1 Pg 1 Ln 2" Pos 6.5"

Your edited document is complete.

You’ve typed the note and now you want to save it for future reference. When
you save a document in WordPerfect, all document initial settings are saved as
well, including printer selection.

There is more than one way to save a document in WordPerfect, but for now
we’ll use the Save feature.

1 Press Save (F10).

US Select Save from the File menu.

A message appears on the status line at the bottom of the screen: “Document to
be Saved:”

2 Type study as the filename, and then press Enter.

The name of your document and the directory in which it is located appear on
the status line at the bottom of the screen. This original document is now saved.
Any changes you make throughout the rest of the lesson are only temporary, and
will not affect the original document unless you save them under the same
filename at some future time.

Now that you’ve edited and saved your document, you can send it to the printer.
You can print from the screen or from disk. From the screen, you can print a
document, page, or any block of text.

For this section of the lesson, you will print directly from the screen. To find
out how to print from a disk, refer to Print, Document on Disk in the Reference
section of this manual.



Saving the Document
and Exiting

1 Press Print (Shift-F7) to display the Print menu.

CD Select Printfrom the File menu.
2 Select Full Document (1) from the Print menu to send the note to the printer.

If your printer does not print, check to make sure it is turned on, on-line, and
that the printer cable is attached securely to your computer and printer. If you
did not select a printer when installing WordPerfect, you may receive an error
message.

For details on selecting a printer see Printer, Select in Reference.

You’ve saved your original document once. To show you another way to save
your document, and also exit WordPerfect, you’ll save the document under the
same filename, using Exit.

For information on other saving and filing options, see Save and List Files in the
Reference section of this manual.

To save the document and exit WordPerfect,
1 Press Exit (F7).
d Select Exitfrom the File menu.

A message appears on the status line at the bottom of the screen asking you if
you want to “Save Document? Yes (No).”

2 Typey, and press Enter to save it under the STUDY filename.

Simply pressing Enter will automatically select the default option (the option not in
parentheses).

Since there is already a document with the filename STUDY, the message on the
status line asks if you want to replace the previously-saved document. Though
the text has not been modified since you last saved the document, for the
purpose of this lesson, you’ll want to replace it. If you had changed any text,
the new version of the text would replace the old version.

3 Typey.
The message on the status line asks if you want to “Exit WP? No (Yes).”
4 Type y to exit WordPerfect.

Now that you’ve finished this lesson, you may want to look through the
Reference section for more information on individual features, or turn to the
WordPerfect Workbook for a more in-depth introduction to WordPerfect.
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A Advance

You can use Advance to position text at an exact location on a page.

Advance is especially useful for placing text in graphics images. In the image
below, Advance has been used to position "Help!” inside the cartoon bubble.

HELP!

Advance is also often used to fill in spaces in existing forms. For instance, you
might use Advance to position text so that it will fit correctly in a pre-printed job
application (see Filling in Forms below).

When you are using different fonts and type sizes, Advance lets you move to a
specific position on a page without having to calculate the line height required to
reach that position. It can also be used to manually kern characters (see Kerning
in Reference).

To use advance,

1 Move the cursor to where you want the advance to begin.

2 Press Format (Shift-F8), then select Other (4) to display the Other menu.
CO Select Otherfrom the Layout menu.

3 Select Advance (1), then select the advance option of your choice (see
Advance Options below).

4  Enter a distance.
5 Press Exit (F7) to return to the document.

6 Type the text.
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Advance and Graphics Images

If you are using Advance to position text over a graphics image, make sure that
the Wrap Text Around Box option for the graphics box that contains the image
is set to No. Otherwise, WordPerfect will not let you position text over the
graphics box.

Advance and Page Breaks

You can only use Advance to move the cursor on the current page. You cannot
enter an Advance measurement which advances the cursor past a page break (see
Page, Soft and Hard in Reference).

Advance Options

If you select Advance Up (1), Down (2), Left (4), or Right (5), the distance you
enter is measured relative to the cursor position. For example, if you enter an
Advance Left measurement of \" and the cursor is at position 3.5", you will be
advanced to position 2.5" on the same line.

You cannot advance the cursor into the top margin.

If you select Advance to Line (3) or Position (6), the distance you enter is an
absolute position on the page, regardless of where the cursor is located at that
time.

Advance to Line is a vertical measurement, measured from the top edge of the
page. For example, if you enter an Advance to Line measurement of 3", you
will be advanced 3" down from the top edge of the page.

Advance to Position is a horizontal measurement, measured from the left edge of
the page. For example, if you enter an Advance to Position measurement of 3",
you will be advanced 3" in from the left edge of the page.

You cannot advance both vertically and horizontally by using one Advance code.
To change the cursor position to a new vertical and horizontal position, you must
enter two Advance codes.

Cursor Position

The Advance feature inserts an Advance code into your document indicating the
type of advance being made and the distance (e.g., [AdvRgt:3"]). This does not
change the on-screen position of the cursor. However, any change in location is
reflected in the “Ln” and “Pos” numbers on the status line.

Whenever you are unsure of the position of text on a page, move the cursor to
that text, using Reveal Codes (Alt-F3) to be certain that the cursor is placed after
the Advance code, then check the position displayed on the status line. You can
also use View Document (Shift-F7,6) to preview where the text will actually be
printed on the page.



Filling in Forms

When you select Advance to Line (3) from the Advance options and enter a
distance, text is printed immediately below the distance you enter. For example,
if you enter an Advance to Line measurement of 3", the bottom baseline of your
text is not printed 3" down from the top of the page. Instead, the full line of
text is printed immediately below 3" from the top of the page.

A ADVANCE MEASUREMENT
A LINE OF TEXT
A BASELINE

When you place text in pre-printed forms, we suggest that you set the Baseline
Placement for Typesetters option on the Format: Printer Functions menu
(Shift-F8,4,6,5) to Yes. You may also want to enter a fixed line height and enter
a fixed line measurement (see Line Height in Reference). The text you type will
then be printed on top of the line instead of below. With these settings, if you
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enter an Advance to Line measurement of 3", the bottom or baseline of your text
will be printed 3" down from the top of the page.

Th'tt baseline of your text will be 3 inches

Returning to the Original Position

After using Advance, the easiest way to return the cursor to its original position
is to enter both an Advance to Line and an Advance to Position measurement.
For example, if you were originally at the Position 1" Line 1" position, you
could return the cursor to that position by entering an Advance to Line
measurement of 1" and an Advance to Position measurement of 1"

Text Boxes
Advance code measurements inside text boxes are measured from the top left
corner of the box.

See Also: Cursor Movement

Append is used to add on-screen text to an existing file on disk. Text is always
added to the end of the file.

1 Move the cursor to the text you want to append.
2 Press Move (Ctrl-F4) to display the Move menu.
(‘B Choose Selectfrom the Edit menu.

3 Select Sentence (I), Paragraph (2), or Page (3) to highlight the sentence,
paragraph, or page on which the cursor is resting.



Notes

You can also append a block of text (see Blocks of Text below).

4 Select Append (4).

5 Enter the name of the file to which you want to append the text (see
Entering Filenames below). If the file does not exist, WordPerfect will
create it.

Append and Macros

If the filename you enter does not exist, WordPerfect creates the file. This is
handy when using Append in macros, because you do not have to check whether
or not the file already exists.

Blocks of Text

You can append a block of text to a file on disk by using Block (Alt-F4) to
block the text, pressing Move (Ctrl-F4), selecting Block (1), and following steps
4 and 5 above.

Entering Filenames

If the file is found in your default directory, you need only enter the filename.
However, if the file is found in some other directory, you also need to include
the full pathname for the file.

For example, if your default directory is C:\WORK, and you want to append to a
file called STUDY found in that directory, then you need only enter study as the
filename. However, if you are in some other directory, you need to enter the full
pathname, including the WORK directory (e.g., c:\work\study).

Locked Files
You can append to a locked file by using the above steps, then entering the
correct password for the locked file.

Sentence, Paragraph, and Page Delimiters

WordPerfect distinguishes sentences, paragraphs, and pages by delimiters. In
other words, it looks for such things as periods, Hard Return codes [HRt], Soft
Page codes [SPg], and Hard Page codes [HPg] to determine where sentences,
paragraphs, and pages begin and end. If you are having trouble blocking a
sentence, paragraph, or page, it could be that one or more of the necessary
delimiters are missing.

For a more complete description of sentence, paragraph, and page delimiters, see
Move in Reference.

Tabular Columns and Rectangles

You can use Block (AU-F4) to block a tabular column or a rectangle (see
Tabular Column or Rectangle under Move. Block in Reference). While you
cannot enter a filename to append a blocked tabular column or rectangle directly
to a file, you can move these items by appending them to a temporary buffer.
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First, use Block (Alt-F4) to block a tabular column or a rectangle as explained
under Move, Block in Reference. With the block on-screen, press Move
(Ctrl-F4), select Tabular Column (2) or Rectangle (3), then select Append (4) to
save the block to a temporary buffer. The text will remain in that temporary
buffer until you move new text to that buffer or exit WordPerfect.

Consequently, if you want to move the buffer to another file, you can switch to
the new file and retrieve the buffer.

To retrieve the block, press Move (Ctrl-F4), select Retrieve (4), then select
Tabular Column (2) or Rectangle (3). You cannot use the Tabular Column or
Rectangle option to block and append graphics boxes unless the graphics box is
empty or contains only text. If you attempt to use the Tabular Column or
Rectangle option to block and append a graphics box which contains a graphics
image, you will get an error message.

See Also: Block; Move; Move, Block

Attributes change the size or appearance of printed text. They can be used to
provide emphasis to a word or to set text apart on a page.

Size attributes (Small, Large, Very Large, etc.) change the size of printed text.

Appearance attributes (Bold, Underline, Italics, etc.) let you add various
enhancements to printed text.

In the following example, size attributes were used to create headlines of
different sizes.

W ordPerfect 51
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To add an attribute as you type text,
1 Press Font (Ctrl-F8) to display the Font menu on the status line.

2 Select Size (1) or Appearance (2) to display the desired attributes menu at
the status line.

LB Select specific size attributes directly from the Font menu. For appearance
attributes, select Appearance from the Font menu.

3 Select the attribute of your choice.
4 Type the text.

5 Turn off the attribute. You can do this by re-selecting the attribute (steps 1
through 3 above), or by moving the cursor past the attribute off code (see
Codes below). You can also turn off all current active attributes at one time
(see Normal Text below).

Appearance Attributes

Appearance attributes deal with the style of the text. Select Bold (1), Underline
(2), Double Underline (3), Italic (4), Outline (5), Shadow (6), Small Caps (7),
Redline (8), or Strikeout (9).

Base Font

The attributes you select are variations of the current base font in your
document. If you have several different sizes of type, you can use the size
attributes to vary from size to size without having to worry about actually
changing your base font. Flow your attributes will actually appear in print
depends upon the base font you have selected and the fonts your printer has
available. If your attributes do not look the way you think they should in print,
it could be that your printer does not have the necessary fonts to print them (see
Colors/Fonts/Attributes and Font in Reference).

After you have selected attributes, you can preview how they will appear in print
by using View Document (Shift-F7,6).

Bold and Underline

Bold and Underline are the two most commonly-used appearance attributes. For
your convenience, they are also found on separate keys so that you can bold or
underline text as you type by using one keystroke. Press Bold (F6) or
Underline (F8) to turn on the feature you want, then press that keystroke once
again to turn off the feature, or press Right Arrow (->) to move beyond the
attribute off code (see Codes below).

Codes

When you select an attribute, both an on and off code are inserted, with the
cursor resting just before the off code. For example, the on code inserted for the
Bold attribute is [BOLD] and the off code is [bold]. You can display these
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codes by pressing Reveal Codes (Alt-F3). Any text between the codes takes on
the attribute.

When the cursor is placed on an Attribute On code for which an Automatic Font
Change (AFC) is assigned (see Printer Program, Modijy Automatic Font
Changes in Reference for information), the Attribute On code will expand to
display the name of the font used for that attribute. For example, if you are
using the Courier 10cpi font, and the Bold AFC for Courier 10cpi is Courier
I0cpi Bold, the [BOLD] code expands to display [BOLD: Courier 10cpi Bold]
when it is highlighted.

To turn off the attribute, you can simply press Right Arrow (->) to move past
the off code, rather than having to select the attribute again.

Existing Text

To add attributes to existing text, simply block the text using Block (AU-F4),
then select the attribute using steps 1through 3 above. When you use this
method, the cursor is placed after the attribute off code.

Normal Text

When you have more than one attribute active at a time, you can turn off all
current attributes by pressing Font (Ctrl-F8), then selecting Normal (3) to return
the text to the base font. This either inserts the necessary off codes or moves the
cursor beyond existing off codes. Subsequent text is then printed in the current
base font (see Base Font above).

On-Screen Appearance

The attribute currently selected appears both in the text you are typing and in the
numbers next to the "Pos” indicator at the status line. When attributes are
displayed on-screen, they can be represented in several ways depending on the
screen display card you have installed in your computer (e.g., color,
monochrome, etc.).

To learn more about the on-screen appearance of attributes, see
Colors/Fonts/Attributes in Reference.

Printing

Since the appearance of text on the printed page depends upon the capabilities of
your printer, you may not be able to print certain attributes. For example, some
printers print underlining as a solid line while others can only produce a broken
line. To learn more about how attributes are printed, see Font in Reference.

You can discover which attributes are available on your printer by retrieving and
printing the PRINTER.TST file (select your printer before printing). It includes
several attributes as well as some of the most common attribute combinations.

Important: PRINTER.TST is installed with the WordPerfect Program files. It is originally
copied to the directory containing WREXE.



Removing Attributes

You can remove attributes by deleting either one of the pair of attribute codes
which surround the text. WordPerfect then deletes the matching code for you. It
is easiest to delete these codes with Reveal Codes (Alt-F3) on. If you attempt to
delete an attribute code in the normal editing screen, you will be prompted to
confirm the deletion. You can then type y to confirm the deletion, or type any
other key to skip over the code without deleting it.

Size Attribute Ratios
A new feature, Size Attribute Ratios (Shift-FI.4,8,6) helps you determine the
size of these attributes (see Initial Settings in Reference).

Size Attributes
The size attributes deal with the height and width of a character and/or character
position in a line.

Select either Superscript (1), Subscript (2), Fine (3), Small (4), Large (5), Very
Large (6), or Extra Large (7).

If you want to alternate type sizes, you can use these size attributes rather than
having to continually use Base Font (Ctrl-F8,4) to change point sizes in a
document.

Remember, however, that using the size attributes may not actually change the
size of the text you print. It all depends on what fonts your printer has available.
For example, if your printer has only one font with one type size (e.g., Courier
10 point), it will print only in that font regardless of the size attributes you
select.

The actual sizes used for Fine. Small. Large, Very Large, and Extra Large are
determined by your current base font and the printer fonts which you have

selected (see Base Font above, and Font in Reference).

Although WordPerfect chooses which fonts to use for the attributes, you can also
change the fonts being used by editing the .PRS file (see Printer Program,
Modify Automatic Font Changes in Reference for details).

See Also: Colors/Fonts/Attributes; Font; Printer, Select; Redline/Strikeout
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B Backup, Original

A FIRST DRAFT (LETTER BK)
A SECOND DRAFT (LETTER)

Normally, when you replace a document with one of the same name, the original
is deleted. The Original Backup option lets you save both the original and the
replacement versions of the document.

Original Backup is useful in several instances, but probably is most helpful as a
safeguard against mistakenly replacing previous versions of a document.
Sometimes you get used to replacing documents and before you know it, you’ve
replaced a document that you really didn't want to replace.

When you replace a file with Original Backup on, the original version of a file is
renamed to filename.BK! (where filename is the name of the original file). As
you continue replacing the same hie, the .BK! hie is replaced with the “new”
original hie. The .BK! hies are stored in the same directory as the replacement
hie and remain on disk even when you exit WordPerfect.

For example, let’s say you’ve saved the hrst draft of a document named LETTER.
When you replace the hrst draft of LETTER with the second draft of LETTER,
the hrst draft is renamed LETTER.BK! while the second draft is named
LETTER.

Taking the example one step further, when you replace the second draft of
LETTER with the third draft of LETTER, the hrst draft of LETTER is deleted,
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ihe second draft of LETTER is renamed LETTER.BK!, and the third draft is
named LETTER.

A FIRST DRAFT (DELETED)

A SECOND DRAFT
(LETTER.BK!)

A THRD DRAFT (LETTER)

To set Original Backup,
1 Press Setup (Shift-F 1) to display the Setup menu.
Select Setup from the File menu.

2 Select Environment (3), then select Backup Options (1) to display the Setup:
Backup menu.

Select Original Document Backup (2).
4 Type y to tell WordPerfect you want to use the Original Backup option.
5 Press Exit (F7) to exit the Setup: Backup menu.

Notes Copying Files
Files do not “disappear” from a disk. The disk (both floppy disks and hard
disks) may become corrupted, however, which would result in lost data and
unusable files (both original and backup). It is for this reason that we suggest
making backup copies of your files on a separate diskette regardless of whether
you use Original Backup or not.

For more information on copying files, see List Files in Reference.

Disks can become corrupted by a variety of things such as static, power surges, magnets,
etc.
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Backup, Timed

Filename Extensions

Files that have the same name but a different extension (e.g., LETTER. ],
LETTER.2) share the same original backup file. As you save and replace these
files, the latest file you replace receives the backup.

Location of Backup Files
Original backup files will be stored in the same directory as the files they are
backing up.

Retrieving Original Backup Files
In order to retrieve an original backup file, use the Rename feature in List Files

(see List Files in Reference) to rename the backup file, then retrieve it as you
would any other file.

Important: 1fyou don't rename an original backup file, its contents will be changed in
subsequent backups. Don 7 rename original backup files with a ,BK! extension.

Also, turning off the Original Backup option deletes the original backup file the next time
you save the document. This means you should rename original backup files before you
turn off Original Backup.

Timed Backup

Timed Backup is another WordPerfect backup option. It is used to safeguard
against losing text during a power outage, machine failure, etc. Its function is
different from Original Backup, so it may or may not help you in the situations
where an original backup is most helpful.

You can use both original and timed backup at the same time (see Backup.
Timed in Reference).

See Also: Backup, Timed; Save

One of the most frustrating things you may encounter as a computer user is the
loss of large amounts of work due to machine failure, power outage, etc. The
WordPerfect Timed Backup option lets you safeguard against such an
experience.

Basically, Timed Backup "backs up" or makes a copy of your document at
specified intervals. Every few minutes, a "Timed Backup” message is displayed
on the status line, and the file is copied to the directory you specify in the
Location of Files feature (see Location of Files in Reference).

While Timed Backup is a powerful option, it is not a substitute for saving yourfiles on
disk or making extra copies of your files on backup diskettes.
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Timed backup files are deleted when you properly exit WordPerfect.
To set Timed Backup,

1 Press Setup (Shift-FI) to display the Setup menu.

~9 Select Setup from the File menu.

2 Select Environment (3), then select Backup Options (1) to display the Setup:
Backup menu.

3 Select Timed Document Backup (1).

4 Type y to tell WordPerfect you want to back up your documents at a
specified time interval.

5 Enter the time interval (in minutes).
5 Press Exit (F7) to exit the Setup: Backup menu.

Copying Files

Files do not “disappear” from a disk. The disk (both floppy disks and hard
disks) may become corrupted, however, which can result in lost data and
unusable files (both original and backup). It is for this reason that we suggest
making backup copies of your files regardless of whether you use Timed Backup
or not.

For more information on copying files, see List Files in Reference.

Disks can become corrupted by a variety of things such as static, power surges, magnets,
etc.

Old Backup File Exists— Rename or Delete

If you receive the message, “Old Backup 1 File Exists or Old Backup 2 File
Exists. 1 Rename; 2 Delete;” WordPerfect cannot back up the document
currently on your screen because a backup file of another document exists. This
happens when you restart WordPerfect after a power outage, machine failure, etc.

If you select Rename (1), you can enter a new name for the backup file and let
WordPerfect properly back up the file currently on the screen. If you select
Delete (2), WordPerfect will still properly back up the file currently on the
screen, but the old backup files will be erased.

Important: You must rename the file if you want to retrieve it. This is how you save your
backup files. 1fyou don't rename it at this point, the file is deleted.

Original Backup

Original Backup is another WordPerfect backup option. It is used to safeguard
against mistakenly replacing a document that you do not want to replace. Its
function is different from Timed Backup, so it may or may not help you in the
situations where a timed backup is most helpful (see Backup, Original in
Reference).



Beep Options

You can use both original and timed backup at the same time.

Retrieving Timed Backup Files

Timed backup hies are temporary hies that are stored in the directory you
specified for Backup Files (1) in Location of Files (Shift-F1,6). If you did not
specify a backup location, WordPerfect saves the backup files to the directory
containing the WP.FIL file. If WordPerfect cannot write to that directory (e.g.,
you do not have network rights), the backup file is saved in the directory you
specified for Documents (7) in Location of Files. If you did not specify a
documents directory, the backup file is saved in the current default directory.

When you exit WordPerfect properly, timed backup files are deleted.

WP{WP}.BK1 is the name of the timed backup file for the document on the
Document 1 screen, while WP{WP}.BK2 is the name of the timed backup file
for the document on the Document 2 screen. If you have documents on both
screens, only the document on the screen at the time of the backup interval is
backed up. After the first backup, a document is backed up again only if you
have made changes.

A network timed backup file is called WPxxx/.BK] (where XXX is the user's ID).

In order to retrieve a timed backup file, use the Rename feature in List Files to
rename the backup file, then retrieve it as you would any other file (see List
Files in Reference).

See Also: Backup, Original; Save

Use the Beep Options feature if you want your computer to notify you with a
“beep” when certain WordPerfect messages are displayed on the status line.

1 Press Setup (Shift-F 1) to display the Setup menu.
Ol Select Setup from the File menu.
Select Environment (3), then select Beep Options (2).
3 Select an option (see the option headings under Notes below).
4 Press y to turn on the option.
or
Press n to turn off the option.
5 Repeat steps 3 and 4 above for any other options you want to change.
6 Press Exit (F7) to exit the Setup: Beep Options menu.

BEEP OPTIONS
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Beep on Error
This option determines whether the computer will beep when an “ERROR: ...”
message appears on the status line.

Eleep on Hyphenation
This option determines whether the computer will beep when Hyphenation is on
and the “Position Hyphen; Press ESC ..." message appears on the status line.

Beep on Search Failure
This option determines whether the computer will beep when the “*Not Found*”
message appears on the status line after a search.

See Also: Hyphenation; Search; Appendix E: Error Messages.

If you are planning to bind your two-sided documents, you can use the Binding
feature to shift text away from the bound edge. The text is shifted to the right
on odd-numbered pages and to the left on even-numbered pages.

This feature is especially helpful with printers that print in duplex (see Double-Sided
Printing under Paper Size/Type in Reference).

1 Press Print (Shift-F7) to display the Print menu.
ce Select Print from the File menu.

2 Select Binding Offset (b), then enter the amount (in inches, points, etc.) you
want the text shifted.

3 Press Exit (F7) to exit the menu.

Changing the Default

If you want to change the default binding offset for all new documents, use the
Print Options feature on the Setup: Initial Settings menu (Shift-F1,4,8,1) (see
Initial Settings in Reference).

Documents previously saved with a different binding offset must be retrieved, have the
binding changed, then be saved again.

Codes

A code for binding is not inserted into your document; however, the binding
offset is saved with the document. This setting remains in effect for that
document until you change it again. When you exit the current document, the
Binding Offset setting on the Print menu returns to the default.



A left margin
A BINDING OFFSET

Labels

Binding width operates on logical pages rather than physical pages. Briefly,
WordPerfect considers a sheet of labels one physical page, but each individual
label as a logical page. (See Physical Page vs. Logical Page under Labels in
Reference for a more extensive definition of physical and logical pages.) This
means that binding width will affect odd labels differently than even labels on
the same page.

Margin Settings

The binding offset shifts text on a page. On odd pages, the left margin is
increased by the amount entered for the binding offset and the right margin is
decreased by that same amount. On even pages the reverse is true. In other
words, if your left and right margins are set to 1" and you want the text to start
printing 1.5" from the left edge of the page, enter .5" as the binding offset. The
right margin will then be only .5" wide.

If you want the margins to be even (not including the binding offset) on both
odd and even pages, there is a formula you can follow. First, decide what you
want your binding offset to be (e.g., .5"). Next, divide that number by 2 (e.g.,
.25"), then enter that number as the binding offset in step 2 above. Now you
need to change the left and right margin settings. If you want 1" margins on
both sides (not counting the binding offset), add the amount you entered for the
binding offset to the left and right margin settings (e.g., enter 1.25" for left and
right margins) (see Margins, Left and Right in Reference).

What this formula effectively does is increase the bound edge of the page to a
1.5" margin (allowing .5" for binding) and decrease the other edge of the page to
a 1" margin, regardless of whether the page is odd or even.
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One-Sided Documents
If you are creating a one-sided document, increase the left margin rather than
using the Binding feature.

Resetting
If you want to change the binding offset back to zero, repeat steps 1 through 3
above, entering 0 as the binding offset.

Top Binding

You can add the binding offset to the top rather than the side of the page using
the Binding Edge option (7) on the Format: Edit Paper Definition menu (Shift-
F8,2,7,5) (see Paper Size/Type in Reference). If you select Top (1), the binding
offset you enter in step 2 above will move the text up or down on the page
rather than left or right.

See Also: Print, Document on Disk; Print, Document on Screen; Print Options;
Printing—General Information

Block is used to highlight (usually in reverse video) any portion of the on-screen
document file. You can then use the block of text with many other WordPerfect
features (see Associated Features below).

To define a block,
1 Move the cursor to one edge of the text you want to block.
2 Press Block (Alt-F4) to turn on the Block feature.

CO Select Block from the Edit menu to turn on Block (see Mouse below).



3 Highlight the text by moving the cursor to the opposite edge of the text.

4. All employees should come to work at B a.n.

5. Food may be eaten at an employee”s desk os long as any trash
is diaposod of as soon as possible.

There should be no need
to wring any supplies or equipment of your own for work related
projects. If you don™t find what you reed contact your department
receptionists and they should be able to order it.

Doc 1 Pg 1 Ln 7.53" Pas SUM

4 Select the feature you want to use.#

Notes Associated Features
You can use Block with Move (Ctrl-F4) to move any part of your text from
place to place in your file, and even from file to file (see Move, Block in
Reference).

However, moving text is just one of the many uses of the Block feature. Once a
block is defined, you can do a variety of things with it. For example, pressing
Bold (F6) or Underline (F8) bolds or underlines the block of text. Pressing
Font (Ctrl-F8) and selecting an attribute gives the block the attribute. Pressing
Save (F10), and entering a filename saves the block as a file.

The following features work with Block:

* Append e Print

 Attributes (Appearance, Size) * Replace

« Block Protect e Save

» Bold e Search

« Capitalization (Case Conversion) e Shell (Append to Clipboard,
e Center Save to Clipboard)
e Comment * Sort

e Delete e Spell

¢ Flush Right o Styles
 Justification (Center, Flush Right) ¢ Switch

e Mark Text (Index, List, Table of e Underline

Authorities, Table of Contents)
* Move (Block, Rectangle, Tabular
Column)

Often, you are given the chance to confirm that you want to use a feature with
the block. For example, when you press Backspace or Delete (Del) to delete a
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block, you are asked to confirm that you really want the block deleted. You can
then type y to delete the block or n to cancel the command.

For more information on a specific feature, see that section in Reference.

Canceling Block
Block turns off after you perform a function. To cancel a block without
performing a function, either press Block (Alt-F4) again or press Cancel (FI).

You can also cancel a block using the mouse (see Mouse below).

Codes

Since WordPerfect codes can be included in a block, you may want to press
Reveal Codes (Alt-F3) before defining a block to be sure of the cursor's
location in relation to existing codes. When Block is on, a Block code [Block]
in the codes portion of the screen pinpoints the location where the block begins.

Cursoi Movement

When Block is on, typing any character moves the cursor forward to the next
occurrence of that character. If the character is not found within approximately
2000 characters, the cursor remains in place and a beep sounds.

Pressing Enter blocks the text from the cursor to the end of that paragraph (the
next Hard Return code [HRt]).

Whik: Block is on, you can block text in either a forward or reverse direction by
using the arrow keys, or by using ¢Search (F2) or Search (Shift-F2) to search
for arid highlight to the end of the search string (see Search in Reference).

Mouse

To block text with the mouse, position the mouse pointer on one end of the text
you want to block. Then press and hold down the left mouse button as you
move the mouse pointer to the other end of the text you want to block. Finally,
release the left mouse button. The text you blocked is highlighted.

Once you have blocked the text, you can use all of the features you normally use
with a block (see Associated Features above).

Once a block is defined and you have released the left button, you can change
the b ock size by pressing the arrow keys, or by using #Search (F2) or ¢Search
(Shift-F2) to search for and highlight to the end of the next search string (see
Search in Reference).

To cancel a block using the mouse, click the middle mouse button on a three-
button mouse, or hold down either button on a two-button mouse, then click the
other mouse button.



Block Protect

On-Screen Display

Normally, blocked text appears on the screen in reverse video. You can change
the appearance of the block using Colors/Fonts/Attributes (Shift-F 1,2,1) (see
Colors/Fonts/Attributes in Reference).

Redefining a Block

You may sometimes want to perform more than one function on the same block
of text. For example, you might want to underline, and then bold the same
block. To redefine the block, press Block (Alt-F4), then press Go To (Ctrl-
Home) twice.

Saving and Retrieving

Once a block has been defined, you can press Save (F10), then enter a filename
to save the block to a permanent file, or press Enter to save the block as a
temporary buffer.

If a block exists in the temporary buffer, pressing Retrieve (Shift-F 10) then
pressing Enter retrieves the block at the cursor. This temporary buffer is deleted
when you exit WordPerfect, or when you save another block to the temporary
buffer.

Short Cuts

On keyboards with an enhanced BIOS, you can also move a block of text by
blocking the text, then pressing Block Move (Ctrl-Delete) to move the block, or
Block Copy (Ctrl-Insert) to copy it. A prompt appears at the status line
informing you that pressing Enter will retrieve the text you have just moved.
You can then move the cursor to the place where you want the text, and press
Enter to insert the text.

If you do not have a keyboard with an enhanced BIOS, you can re-assign or map
the short-cut keystrokes to the keys of your choice. You can also map Block
Append to a key on your keyboard (see Keyboard Layout. Edit in Reference).

See Also: Mouse Support; Move, Block

Block Protect is used to keep a block of text from being split between two
pages.

When you are working with a document where the number of lines it contains is
constantly increasing or decreasing, you can use Block Protect to keep a block of
text (e.g., a table or chart) intact. You can add and delete text from the block
itself or from the document. As long as the block is less than a page in length,
it will remain together on the same page.
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52  BLOCK PROTECT

To protect a block,

1 Use Block (Alt-F4) to block the text you want protected. It must be less
than a page in length.

2 Press Format (Shift-F8), then type y to confirm that you want to protect the
block.

r-B Select Protect Block from the Edit menu.

The block is protected by codes (see Codes below). If part of the protected
block has to be moved to the next page, the entire block will be moved to the
next oage.

Block Protect and Hard Returns

Two consecutive protected blocks must be separated by at least one Soft Return
code [SRt] or Hard Return code [HRt] (see Page, Soft and Hard in Reference).
Otherwise, the blocks are treated as one large block. Consequently, when you
are protecting blocks of text, you can avoid problems by always defining blocks
from character to character (e.g., the first word in a paragraph to the last word in
a paragraph) and never including Hard Return codes.

Block Protect vs. Conditional End of Page

While Block Protect protects a block of text. Conditional End of Page protects a
specific number of lines. When you want to keep a block of text together as you
add or delete text from the block (such as a table), it is best to use Block
Protect. However, if you want to keep certain lines together (such as a heading
and the first two lines of a paragraph), it is best to use Conditional End of Page
(see Conditional End of Page in Reference).

Code!;
Protecting a block places a Block Protect On code [Block Pro:On] at the
begirning of the block and a Block Protect Off code [Block Pro:Off] at the end.

Howev-sr, Steven obtained the contract without compromising our
corporate integrity. He presented the information in a clear and
concise manner, without going into the rudimentary details
concerning completion of the project.

The proposed locations for the facility are:
2425 Crowley Avenue, Twin Falls. 1D
121 Knudsen Corner. Salt Lake City, UT
1665 Anne Street. Charlottesville, VA

a:\STEVEN.BLP 1'1Ln 2.33% Po«

* Rt
,\/||[H,,,;|, proposed locations for the facility are:(HRt
ey Avenue. Twin Falls, ID[HRt]
1921 Knudsen Corner, Salt Lake City, UTIHRt]
ent]1665 Anne Street, Charlottesville, VA[Block Pro:0ff]

Press Reveal Codes to restore screen



Even if the Block Protect On code does not come at the beginning of the line,
the entire line of text is protected.

You can cancel the block protection by deleting the codes. Deleting either code
deletes the pair. If you delete a Block Protect code while in the normal editing
screen, you will be asked to confirm the deletion.

Parallel Columns Without Block Protect

If you are using parallel columns without block protect (Alt-F7,1,3,1,2), you can
only block protect one column when you are within the [Col On] and [Col Off]
codes, regardless of how many columns are blocked. If you want to block the
whole group of columns, you must be in front of the [Col On] code when you
turn the block on.

See Also: Block; Conditional End of Page
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C Cancel

Notes

Cancel may be the most commonly-used WordPerfect feature. Why? Because it
is a way to get you out of places you don’t want to be. It is also the key to
press when you don’t want to save the changes you have made.

Press Cancel (FI) to do any of the following:

« Back out of a WordPerfect menu or status line message without saving
changes.

e Cancel a hyphenation request, forcing the word to wrap to the next line.
* Recover up to three levels of deleted text.
e Turn off Block.

e Cancel a search or macro in operation.

Backing Out of Menus and Options
You can back out of a menu by pressing Cancel (FI).

From some menus, you must press Cancel more than once to return to the
normal editing screen.

If you want to save the changes you have made to a menu, the keystroke to
press is Exit (F7) (see Exit in Reference). Pressing any letter or number that is
not listed as a menu option will also back you out of a menu, saving any of the
changes you have made.

Canceling with a Mouse

In a WordPerfect menu or when a prompt is displayed on the status line, clicking
the middle mouse button on a three-button mouse or holding down either mouse
button, and clicking the other mouse button on a two-button mouse performs the
same function as pressing Cancel (FI).

Help Menus

Pressing Cancel (FI) does not back you out of the Help menus. Pressing Enter
or the Space Bar does. Pressing Cancel in a Help menu displays the help
screen for the Cancel feature.

Macros

While pressing Cancel (FI) cancels a macro in operation, it does not cancel a
macro definition. To end a macro definition, press Macro Define (Ctrl-FIO).
Pressing Cancel in a macro definition simply inserts the Cancel keystroke into
the definition (see Macros in Reference).
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Pull-Down Menus

Wher you are using the pull-down menus, pressing Cancel (FI) or Escape (Esc)
takes you back one level. Pressing Exit (F7), takes you all the way out of the
menus. Clicking the center button on a three-button mouse takes you back one
level. Holding down either mouse button, then clicking the other mouse button
on a :wo-button mouse takes you back one level. Clicking the right button on a
mouse takes you all the way out of the menus.

Recovering Text

When you press Cancel (FI) in the normal editing screen, a highlighted block
appears in your document and a message appears on the status line asking if you
want to restore that block.

The highlighted block contains the last text and/or codes you deleted from your
document. It appears at the point on which the cursor is resting. If nothing
appears in the block in the normal editing screen, you can press Cancel (Fl),
press Reveal Codes (Alt-F3), then press Cancel again to see the codes inserted
into your document.

Select Restore (1) to restore the highlighted block, or continue selecting Previous
Deletion (2) or pressing Up Arrow (T) or Down Arrow (4) to display up to
your last three deletions. WordPerfect stores the three previous deletions in
temporary files. These temporary files are erased when you exit WordPerfect.
You can also use deleting and restoring text as a method of moving text in a
document (see Undelete in Reference).

Reveal Codes

Pressing Cancel with the Reveal Codes screen displayed does not turn off
Reveal Codes. You must press Reveal Codes (Alt-F3) (see Reveal Codes in
Reference).

See Also: Exit; Mouse Support; Undelete

Capitalizing individual characters is as easy as typing the character while holding
down the Shift key. However, using this method to capitalize a long string of
characters can be tedious. You can also use the Caps Lock key to type
uppercase letters.

1 Press Caps Lock to begin typing uppercase letters.
2 Type the text.

3 Press Caps Lock again to end typing uppercase letters.



Notes

Converting Existing Text
To convert existing text to all uppercase or lowercase letters,

1 Block the text.

2 Press Switch (Shift-F3).

CS Select Convert Case from the Edit mem.

3 Select Uppercase (1) or Lowercase (2).

WordPerfect is case sensitive. This means that words that start with “I”
followed by an apostrophe (I’m, I'd, etc.) and the first words of sentences remain
capitalized when you select Lowercase. When you block text to be converted,
include the punctuation from the end of the preceding sentence in the block to
make sure that WordPerfect recognizes the first letter of a sentence. If there is
no preceding punctuation, WordPerfect does not recognize the beginning of a
sentence and therefore will not leave a capital letter there.

Shift and Caps Lock

Caps Lock affects only letters (A through Z). To type the characters displayed
above the numbers at the top of the keyboard (e.g., @, #, $, etc.), you still have
to press Shift, then the number. When Caps Lock is on, pressing Shift causes
letters to be typed lowercase.

Small Caps

If your printer has a small caps font, you can select it using the Attributes
feature (see Attributes in Reference). All the text you type will then be printed
in the small caps font with slightly larger letters for the letters you type in
uppercase.

Status Line

When Caps Lock is on, “Pos” on the status line is displayed in all uppercase
letters (i.e., POS).

See Also: Attributes; Block; Switch

Cartridges/Fonts/Print Wheels

Many printers let you access additional fonts with interchangeable print
cartridges, print wheels, or downloadable font files. The Cartridges/Fonts/Print
Wheels feature in WordPerfect lets you mark the cartridges, soft fonts, and print
wheels you plan to use with your printer.

Ifyou have not purchased any softfonts, cartridges, and/or additional print wheelsfor
your printer, you do not need to go into the Cartridges/Fonts/Print Wheels menu at all.
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1 Press Print (Shift-F7) to display the Print menu.
LB Select Printfrom the File menu.
2 Choose Select Printer (s), then move the cursor to the desired printer.

You need to have already selected a printerfor this feature to work (see Printer, Select in
Reference).

2 Select Edit (3), then select Cartridges/Fonts/Print Wheels (4) to display a list
of font categories (built-in, cartridges, soft fonts, and/or print wheels) your
printer supports.

Ifyou receive a "Printerfiles notfound" message, WordPerfect cannotfind the .ALL file
that was used to define your printer. You need to specify the directory where the .ALL
file was copied during installation (see the Installation Instructions card).

4 Move the cursor to the type of font you want to mark (see Font Category
below), then choose Select (1) to display a list of all fonts of that type that
V/ordPerfect supports.

If you choose Select with the Soft Fonts category highlighted, a Font Groups
screen might be displayed. If it is, move the cursor to the group containing the
font you want to mark and choose Select (1). A list of fonts in that group is
displayed.

3 Move the cursor to the cartridge, font, or print wheel you want to use with
your printer, then mark it as Present When Print Job Begins (*) and/or Can
be Loaded/Unloaded During Job (+) (see Marking Cartridges/Fonts/Print
below).

CB Mark a cartridge, font, or print wheel in the Select Printer: Cartridges/Fonts/Print
Wheels lists by double-clicking on the item. Items that can be marked with a plus
sign (+) or an asterisk (*) are marked with a plus sign (+).

Important: Do not mark fonts you do not have. WordPerfect does not create fonts, nor
does it provide them—it simply accesses the font capabilities of your printer.

li Press Exit (F7) to save the markings and return to the list of font categories.

You may need to press EXit twice to return to the list offont categories, depending on
whether or not a Font Groups screen was displayed.

At this point you can select another font type and repeat steps 4 through 6 or
press EXxit to return to the Select Printer: Edit menu. WordPerfect updates the
fonts before returning to this screen if you have made any changes in font
seleclion.

Available

The Available column on the Select Printer: Cartridges/Fonts/Print Wheels screen
shows you the quantity available for cartridges, fonts, and/or print wheels. This
amount is decreased when you mark cartridges, soft fonts, or print wheels with
an asterisk (*) (see Mmarking Cartridges/Fonts/Print below). This keeps you
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from selecting more cartridges, soft fonts, or print wheels than your printer can
accommodate.

If you change the total quantity (see Quantity below), the Available quantity is
also changed by the same amount.

Cartridges

The Available column for cartridges shows how many slots are still

available. For example, if you have two slots for cartridges, but have not yet
marked any cartridges, the Available column will show "2.” Each cartridge
you mark with an asterisk (*) decreases this amount by 1

Print Wheels

The Available column for print wheels gives the number of print wheels your
printer still has available. Each print wheel you mark with an asterisk (*)
decreases this amount by 1

Soft Fonts

The Available column for soft fonts shows the amount of memory still
available. This amount is decreased when you mark fonts with an
asterisk (*).

Base Font

The fonts you mark using the above steps appear on all of the Base Font menus
as long as they match the Font Type (which is set with the Paper Size/Type
feature). In other words, if you have landscape fonts available, they will not
appear on the Base Font menus until you select a landscape paper type (see
Paper Size/Type in Reference). The printer's built-in fonts also appear on the
Base Font menus if they match the Font Type (see Font in Reference).

Built-In

Built-In is one of the font categories on the Select Printer: Cartridges/Fonts/Print
Wheels screen for dot matrix and laser printers (not for daisy wheel printers);
however, no amount is listed under the Quantity or Available headings.
WordPerfect marks all these fonts automatically to indicate they are currently in
the printer. You can unmark these fonts (see Marking Cartridges/Fonts/Print
below) if you do not want WordPerfect to access them.

WordPerfect makes the built-in fonts available (includes them on the Base Font
menus) when you select a printer. Information about each printer’s built-in fonts
is copied to the .PRS file when you add a printer to the printer definition list
(see Printer, Select in Reference).

Downloading Soft Fonts

Soft fonts are purchased as software (on diskettes) and must, therefore, be sent
from your computer to your printer. This process is called “downloading” fonts.
WordPerfect can dowmload fonts in either of two ways. If you mark a soft font
with an asterisk (*) (see Marking Cartridges/Fonts/Print Wheels below), you will
have to initialize your printer (Shift-F7,7) every time you turn it on. This sends
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MARKED FONTS

all fonts marked with an asterisk to the printer. These fonts remain in the printer
(even if you exit WordPerfect) until you turn off the printer (or until you unmark
the fcnt, then reinitialize the printer).

If you mark a font with a plus sign (+), WordPerfect will only download that
font when it is needed for a print job, then deletes the font from the printer’s
memory once the print job is completed.

If you change your font selection (marking or unmarking fonts with asterisks and
plus signs), you will need to reinitialize your printer to make sure the proper
fonts are available. If you only mark fonts with a plus sign (no asterisks), you
will not need to initialize your printer.

Important: Marking fonts tells WordPerfect which fonts you have. You must tell
WordPerfect where these fonts are by specifying a path using the Path for Downloadable
Fonts and Printer Command Files option on the Select Printer: Edit menu (Shift-F7,s,3,6)
(see Printer, Edit in Reference).

Font Category

This heading on the Select Printer: Cartridges/Fonts/Print Wheels screen lists the
different types of fonts available for your printer. The choices for this column
might include: Built-In. Cartridges, Print Wheels, Slot Fonts, and Soft Fonts. If
your orinter only has its built-in fonts available, that is the only thing listed
under this heading.

Font Croups

If you choose Select (1) with the Soft Fonts category highlighted in step 4
above, a Font Groups screen could be displayed (depending on your printer).
You would then need to select the font group containing the fonts you want to
mark. Once you mark fonts (see Marking Cartridges/Fonts/Print Wheels below),
the fcnt group containing the marked fonts is displayed with a bullet (¢).

Select Printer: Soft Fonts
Font Groups:

>

HP AD TmsRmn/Helv RB
HP AE TmsRmn/Helv US
HP AF TmsRmn/Helv R6
HP AG Helv Headlines PC-8

1 Seiect; N Name search: 1
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A QUANTITY

Marking Cartridges/Fonts/Print Wheels

After you choose Select (1) in step 4 above, WordPerfect displays a list of those
cartridges, soft fonts, or print wheels (depending on which font category you
select) that are available for your printer at the time your version of WordPerfect
is released. (If you selected soft fonts, you may need to select a font group
before the list is displayed.) The list includes each font, cartridge, or print wheel
name and the quantity it represents.

Select Printer: Soft Fonts Quantity * Fonts
Total : 350 K 32
Available: 301 K 26

HP AC TmsRmn/Helv US Quantity Used

ry JK3C31X T1I
- (R

Gpt  (band ) ak
Mels 6pt Bold 0 K
Helx 6pt Bold (Land) 8 K
(AC) Helv 6pt italic a k
Helv 6pt Italic (Land) -
Helv 8pt
Helv Bpt (Land) gK
Helv apt Bold 11 K
Helv 8pt Bold (Land) 1 K
Helv 8pt italic 10 K
Helv 8pt Italic (Land) 10 K
Helv I0pt 13 K
ACY Helv 10pt (Land) 13 K
Helv 10pt Bold 13 K
(m Helv 10pt Bold (Land) 13 K
Mark: * Present when print job begins Press Exit to save
+ Can be loaded/unloaded during jab Press Cancel to cancel

In the upper right corner of the screen, WordPerfect displays the total quantity of
that type of font that your printer can support, along with the quantity still
available. In addition, if you are marking soft fonts, the number of fonts your
printer allows you to mark with an asterisk (*) at one time may be displayed.

For example, if you are marking soft fonts and your printer has 350K of
memory, the Available Quantity and the Total Quantity start at 350. As you
mark soft fonts with an asterisk (*), the Available Quantity is decreased by the
amount of memory needed by those soft fonts, while the Available number of
fonts is decreased by one for every font marked.

Depending on the printer, there may be a limit to the number of soft fonts you
can mark with an asterisk, regardless of the memory available. (This limit is
displayed in the Select Printer: Soft Fonts screen to let you know when you are
approaching the limit.) For example, if your printer lets you mark 32 fonts
(displayed under “* Fonts” in the upper right corner of the Select Printer: Soft
Fonts screen) and you mark 32 fonts, you cannot mark another font with either
an asterisk (*) or a plus sign (+), even if you have memory available.

Mark the soft font(s) or print wheel(s) you have available for your printer with
one or both of two possible settings: Present When Print Job Begins (*) or Can
be Loaded/Unloaded During Job (+). Cartridges can only be marked with an
asterisk.

CARTRIDGES/FONTS/PRINT WHEELS 61



62

You can mark soft fonts until the maximum quantity (in memory or number of
fonts) is reached. WordPerfect counts all fonts you mark with an asterisk (*)
when calculating the available quantity.

CARTRIDGES/FONTS/PRINT WHEELS

Can be Loaded/Unloaded During Print Job

Mark a print wheel with a plus sign (+) if you want to be prompted to
change the print wheel. Mark a soft font this way if you want WordPerfect
tc load and unload the soft font during a print job. Because fonts marked
with a plus sign are downloaded only when needed, marking a font or print
wheel with this option does not decrease the available quantity; however, be
aware that you cannot mark a font with a plus sign (+) if that font is larger
than the remaining available quantity or if the “* Fonts" amount displays 0.
For example, if you have 350K of memory and have marked 300K of fonts
with an asterisk, you cannot mark any single font that is larger than 50K
with a plus sign. (You cannot mark it because WordPerfect would not be
able to load that font during a print job.)

If you have marked a print wheel with a plus sign and selected that font in
your document, the printer stops and your computer beeps to signal a print
wheel change. When this happens, display the Printer Control screen
(Shift-F7,4), follow the displayed instructions (shown next to “Action:"), then
select Go (4) to continue the print job.

IJyou have one print wheel you use more than any other, mark that print wheel with
an asterisk (*) (see Present When Print Job Begins below). Otherwise, you will be
prompted to insert it every time you print with that print wheel.

Some printers can load and unload soft fonts during a print job. Others can
oily load fonts during a print job and unload them after the job is finished.
And still others will not let you load and unload fonts at all during a print
job. If the fonts can be loaded and unloaded, the “+ Can be
Loaded/Unloaded During Job" message appears at the bottom of the screen.
If this message does not appear, WordPerfect will not let you mark any fonts
with a plus sign. In this case, the fonts you intend to use during a print job
must be present when the print job begins (marked with an asterisk).

Marking with Both Settings

Fonts on some printers can be marked with both an asterisk (*) and a plus
sign (+). If a font is marked with both settings, it is considered “swappable”
aid WordPerfect will unload it if the space is needed in the printer’s memory
to swap in another font. Swappable fonts (those marked with an asterisk and
a plus sign) are reloaded at the end of the print job if they were swapped out
during the print job.

A.ny fonts marked with both settings remain marked as initially present each
time WordPerfect is started.



Center Page

Present When Print Job Begins

Mark a cartridge, soft font, or print wheel with an asterisk (*) if the cartridge
is in a slot, the soft font is in the printer memory, or the print wheel is
already installed when you start a print job. Marking a cartridge, soft font,
or print wheel with this option decreases the available quantity.

You must select the Initialize Printer option on the Print menu (Shift-F7,7)
every time you turn on your printer to download soft fonts marked with this
option (see Downloading Soft Fonts above).

Quantity

Quantity refers to the number of slots available for cartridges, the amount of
printer memory available for soft fonts, or the number of print wheels available.
The quantity number is preset to original printer specifications. If you have
added more memory to your printer, you can change the quantity number by
selecting Change Quantity (2) from the Select Printer: Cartridges/Fonts/Print
Wheels menu, then entering the new quantity. The largest number you can enter
for the quantity is 65535.

Important: Increasing the quantity of memory available for softfonts will work properly
only ifyou have physically installed more memory in your printer. 1fyou increase the
quantity number and mark more fonts than can be downloaded to your printer’s memory,
documents will not print properly when using the font(s) that are not completely
downloaded.

Soft Font Programs

Some third-party soft font programs have installation programs that can add
names of fonts and information about those fonts to your printer files. If you
have used such a program, the names of those fonts will appear on the Select
Printer: Soft Fonts screen when you are marking fonts.

Unmarking Cartridges/Fonts/Print Wheels

To unmark a cartridge, font, or print wheel, type an asterisk (*) if the item is
marked with an asterisk, or type a plus sign (+) if the item is marked with a plus
sign.  You can unmark all items marked with a plus sign by pressing Home,+.
You can unmark all items marked with an asterisk by pressing Home,*.

See Also: Font; Printer, Edit; Printer, Select

To center text vertically (between the top and bottom margins) on just one page,
use the Center Page feature.
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CENTER PAGE

The following letter is centered vertically on the page.

1 Press Go To (Ctrl-Home), then press Up Arrow (T) to move the cursor to
the top of the page you want to center, before any codes (see Codes below).

2 Press Format (Shift-F8), then select Page (2) to display the Page Format
menu.

Oi Select Page from the Layout menu.

3 Select Center Page (top to bottom) (1), then type y to turn on this option.

4 Press Exit (F7) to exit the Page Format menu and return to the document.

Center Lines of Text

To center individual lines of text between the left and right margins, use Center
(Shift-F6) (see Center Text in Reference). To center several lines of text, use
Center Justification (Shift-F8,1,3,2) (see Justification in Reference).

Codes
Selecting Center Page (1) inserts a Center Page code [Center Pg] at the location
of the cursor.

Usually, the Center Page code should precede any codes on a page. The two
except ons are the Paper Size/Type code [Paper Sz/Typ] and Top/Bottom Margin
code [T/B Mar], When these codes are used, they should always precede the
Center Page code. The order of the codes should be [Paper Sz/Typ][T/B Mar]
[Center Pg].

For a block of text to be correctly centered on a page, it cannot have any extra
Hard Return codes [HRt] before or after it. Consequently, when you need to



Center Text

force a page break at the end of a block of text that you want to center on a
page, you should press Hard Page (Ctrl-Enter) rather than continuously pressing
Enter to insert a series of extra Hard Return codes. The extra hard returns
would just keep the text from being centered correctly.

Footnotes and Endnotes
You should not center a page that contains endnotes. When centering text on a
page that contains footnotes, only the text is centered. The footnote remains at
the bottom of the page.

On-Screen Page

Center Page affects only the way the page is printed or displayed in View
Document (Shift-F7,6). It does not change the way text is displayed on the
normal editing screen.

Uncentering a Page
Once you have turned on the Center Page option, you can turn it off for that
page simply by deleting the Center Page code.

You can also uncenter a page by setting the Center Page entry to No
(Shift-F8,2,1,n). WordPerfect will then find and delete the Center Page code on
the page where the cursor is located.

See Also: Block; Center Text; Justification

Use Center to center text between the left and right margins or over a particular
point in a line.

CENTER TEXT 65



Notes

66 CENTER TEXT

The page displayed below shows a title centered between the left and right
margins as well as several titles centered over columns of text.

Welcome New Employees

TAKE NOTE

Outgoing Kail

only corporate
business correspon-
dence is to be

mailed in business
letterhead envel -
opes. Postage for
all other mail
should be paid for
by the employees.

Long Distance
Calls

Any nonbusine9s
long distance phone
calls will be paid
for by the employee
upon receipt of the
billing statement.

Dress Standard

All employees will

Employee Parking

All cars parked in
company parking
lots are to be
registered with
personnel. Parking
guidelines gen-
erally parallel the

state laws re-
garding hotor vehic-

parklng in
red zones. No

double parking.
Parallel or angle
parking is per-
mitted only where
specified. Unautho-
rized cars found in
company lots or re-
served parking
areas may be towed.
Cars should be
Tocked for the
employee®s own sec-
urity and to reduce
opportunity for
theft.

resources of the
company . There
should be no need

to bring any
supplies or
equipment of your
own for work

related projects.
If you don*t find
what you need
contact your de-
partment recep-
tionist and they
should be able to
order it.

Important Dates

7/3 Managers Conf.
7/8 New Emp. Mtg.
7/12 Company Party
7/23 End-user Conf.
8/17 Acc. Training
B/23 Summer Social

Company Party

Don*"t forget that

wear shoes and July 12th is our

When you type new text, you can center a line of text between the left and right
margins.

1 Move the cursor to the left margin.
2 Press Center (Shift-F6) to move the cursor to the center of the line.
r~B Select Align from the Layout menu, then select Center.
3 ype the text you want centered.
4 Press Enter to end centering.
or

Press Format (Shift-F8), select Other (4), then select End
Centering/Alignment (9) to end centering.

Centsr Code

Pressing Center (Shift-F6) inserts a Center code [Center] into your document.
Pressing Enter inserts a Hard Return code [HRt] and ends the centering.
Selecting End Centering/Alignment (9) from the Format: Other menu inserts an
End Centering/Alignment code [End C/A] and allows the cursor to remain on the
same line when centering ends.

A Center code affects only the line of text which it is on. Consequently, if you
insert a Center code at the beginning of a line and type text that extends beyond
that line, only the first line of that text will be centered. The code will not affect
subsequent lines of text.



A Center code takes precedence over other text. Consequently, if you are in the
middle of a line of text when you press Center (Shift-F6), or if the text you are
typing runs into a Center code, on-screen text may seem to disappear. When this
happens, use Reveal Codes (Alt-F3) to view and delete the unwanted text or
code.

Centering at a Specific Position

You do not always have to center text between margins. In fact, if the cursor is
not at the left margin, and if it is preceded by a Tab code, or at least two spaces,
pressing Center (Shift-F6), then typing text centers that text over the cursor
position.

For example, to center text over a tab stop at position 5", tab to that position,
press Center (Shift-F6), then type the text. You can perform this type of
operation more than once on a line as long as the text is preceded by a tab, or at
least two spaces. However, when you center text at a line position, you should
be aware that it may overlap any preceding text, both on-screen and when the
document is printed.

Centering Existing Text
You can center an existing line of text by moving the cursor to the beginning of
the line of text, and then pressing Center (Shift-F6).

This method will not work if the cursor is not at the beginning of the line when
you press Center. When the cursor is anywhere other than at the beginning of
the line or just two spaces in from the beginning of a line, pressing Center
centers the text which is to the right of the cursor at the cursor position. This
can cause overlapping text.

Dot Leader
When centering text between margins, you can insert a dot leader from the left
margin to the beginning of the centered text by pressing Center (Shift-F6) twice.

To continue the dot leader to the right of centered text, press Flush Right
(Alt-F6) twice.

You can also insert a dot leader using the Home keystrokes (see Hard Center
Tab below).

Hard Center Tab

A Hard Tab is a tab that does not change its alignment (e.g., left, right, center,
or decimal), even if you change the setting with the Tab Set feature (see Tab in
Reference). You can insert a Hard Center Tab over the next tab stop by pressing
Home,Center (Shift-F6). WordPerfect inserts a [CENTER] code in the
document. To insert a Hard Center Tab with dot leaders, press
Home,Home,Center.
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Pages of Text
You can use Center Page to center an entire page of text vertically (see Center
Page in Reference).

Removing Centering
Remove centering by deleting the Center code [Center]. Since the centered text
is visible on-screen, you are not asked to confirm the deletion of a Center code.

Text ir Columns

If you are centering text in columns created with the Columns feature, move to
the left margin of the column, then follow the centering steps given at the
beginning of this section.

If you are centering text in columns created with tabs or indents, use the method
for centering text at a specific line position described under Centering at a
Specific Position above.

See Also: Block; Center Page; Justification

Colors/Fonts/Attributes

68  COLORS/FONTS/ATTRIBUTES

WordPerfect supports several display cards and monitors. Depending on the
capabilities of your display card and monitor, WordPerfect can display text with
and without attributes (e.g., bold, underline, italics) in a variety of ways.

For example, WordPerfect may be able to highlight bolded characters on the
screeri. It may also be able to assign a color to underlined text.

The Colors/Fonts/Attributes feature determines what text with and without
attributes will look like on the screen. Tailored to your display card and
monitor's capabilities, it offers you options for changing text display.

The information about your graphics card isfound under the Graphics Screen Type and
Text Screen Type options. For more information, see Graphics Screen Type and Text
Screen Type in Reference.

As you use this feature, you must remember that this only affects the way text is
displayed on your monitor screen. It does not affect the way text will be printed.
For irformation on printed text, see Font in Reference.

1 Press Setup (Shift-FI) to display the Setup menu.
[ B Select Setup from the File menu.
2 Select Display (2), then select Colors/Fonts/Attributes (1).

The screen that appears at this point varies according to your display card and
monitor. If you have a monochrome monitor (with no Hercules card), skip to
step 4.
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3 Select Screen Attributes (or Screen Colors) (1).

4 Assign a screen color or screen font to each attribute listed (see Assigning

Fonts and Colors below).

5 Press Exit (F7) until you return to the normal editing screen.

These settings are in effect for the current editing screen only (see the “Doc”

heading on the status line). If you want to set them for the other editing screen,

see Document 1 and Document 2 below.

All settings you make with this feature are stored in the WP{WP}.SET file and

are in effect each time you start WordPerfect.

Assigning Fonts and Colors

When you assign fonts and colors to the WordPerfect attributes with the
Colors/Fonts/Attributes feature, you are assigning screen fonts and screen colors.

The options you have to choose from vary according to your display card and

monitor. The way text appears on the screen is independent of the way it is

printed.

As you begin to assign screen fonts and screen colors to WordPerfect attributes,

you will notice that the left-most column of the Setup: Colors/Fonts/Attributes

menu is a list of the size and appearance attributes found on the Font key, plus a

few others. The right-most column is a sample column that will show you the

result of your selections.

Between the left and right columns are columns which you use to assign screen
fonts or screen colors to the listed attributes. The number and types of these
columns vary according to your display card and monitor’s capabilities. The
screen shown below is the Setup: Colors/Fonts/Attributes menu for a

monochrome monitor.

Setup: Attributes

Attribute Blink Bold Blocked Underlin*= Normal
Normal N N N N Y
Blocked N N Y N N
Underline N N N Y N
Strikeout N N N N M
Bold N Y N N Y
Double Underline N N N N Y
Redline N N N N Y
N N N N Y
Italics N N N N Y
Small Caps N N N N Y
Outline N N N N Y
Subscript N N N N Y
Superscript N N N N Y
Fine Print N N N N Y
Small Print N N N N Y
Large Print N N N N Y
Very Large Print N N N N Y
Extra Large Print N N N N Y
Bold £ Underline N Y N Y N
Other Combinations N N N N Y

Switch documents; Move to copy settings

Doc 1

sample

EHBnng
sample
Sample
Sample
Sample
Sample
Sample
Sample
Sample
Sample
Sample
Sample
Sample
Sample
Sample
Sample
Sample
sample
Sample
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Move your cursor to the row representing the attribute appearance you want to
change, then change the settings by pressing a letter or number. Again, the
options you have to choose from vary according to your display card and
monitor's capabilities.

For example, if you want to change the Redline attribute to blinking, bolded text
in the screen above, use the Up or Down Arrows (T,f) to move to the Redline
line, then type y under the Blink column and y under the Bold column. The
Left end Right Arrows (<-,—) move you from column to column.

There may be some attributes on the list that you cannot change because the
setting for one attribute controls the settings for a group of related attributes.
The cursor will skip over these attributes.

Ifyou ever have a question as to how text with a particular attribute will appear on the
screen look at the sample column for that attribute.

More information on the various display card and monitor types can be found
under Monochrome, CGA/PC3270/MCGA, EGAJVGA, and Hercules Cards
below.

Attribute Combinations
Text can have more than one attribute at a time. For example, text can be both
bolded and italicized.

The Setup: Colors/Fonts/Attributes screen does not list all possible combinations.
It does, however, list an Other Combinations heading. Most attribute
combinations will be displayed according to the Other Combinations setting.

However, with color settings, certain attributes are provided by the hardware.
These are attributes such as Bold and Underline on a monochrome monitor,
Strikeout on a Hercules Card with RamFont, or Italics on an EGA card with the
italics font loaded. WordPerfect can always display such hardware attributes
regarcless of any other attributes that might be active. Also, such hardware
attributes are removed from the list of active attributes when WordPerfect is
considering what screen attributes will appear.

For example, suppose you have an EGA monitor with an italics font loaded and
the Italics and Small Caps attributes are on. WordPerfect will detect that Italics
is a hardware attribute and use the italic font. The remaining active attribute is
Small Caps. WordPerfect will now look in the list of colors and attributes
specifed by the user to find out which color to use for Small Caps. The final
result: text with the combination of Italics and Small Caps attributes will display
as italicized characters in the Small Caps color.

However, if the active attributes had been Small Caps and Outline, WordPerfect
would have detected that neither attribute is a hardware attribute. In this case,
WordPerfect would use only the color specified for Other Combinations.



CGA/PC3270/MCGA

If you are using one of these types of display cards or monitors, you are given
two options after you select Colors/Fonts/Attributes. You can select an option by
pressing the number corresponding to the option.

If you select Fast Text Display (2), you can have WordPerfect speed up text
display. If you type y for Yes, there is a chance that “snow,” or static, may
appear on the screen as WordPerfect writes to the screen. If this is the case, you
can type n to disable this option. If the setting for this option is N/A, the setting
cannot be changed.

If you select Screen Colors (1), you can select a foreground and background
color for each attribute in the menu. To assign a color, move the cursor to the
Foreground or Background column for the attribute you want to change, then
type the letter of a color listed at the top of the screen. If you see a letter that
appears to represent no color, it simply means that letter represents the current
background color.

Document 1 and Document 2

When you set attributes, you are setting them for the current editing screen only.
In other words, if you are in the Document 1 screen, you are setting them for
Document 1. If you are in the Document 2 screen, you are setting them for
Document 2. Check the “Doc” heading on the status line to find out which
editing screen you are in.

If you want to simply copy the settings from one editing screen to the other,
press Switch (Shift-F3) to switch editing screens. Next, go to the Setup:
Colors/Fonts/Attributes screen by following the steps at the beginning of this
reference section, press Move (Ctrl-F4), then type vy.

For example, if you want to copy the settings from the Document 1 screen to the
Document 2 screen, press Switch (Shift-F3) while in the Document 1 screen to
switch to the normal editing screen of Document 2. Next, go to the Setup:
Colors/Fonts/Attributes screen for Document 2 by following the steps at the
beginning of this reference section, pressing Move (Ctrl-F4), typing v.

EGANGA

If you are using an EGA or VGA display card or monitor, you can choose from
five screen font options after selecting Colors/Fonts/Attributes. You can select
an option by pressing the number corresponding to the option. An asterisk (*) is
displayed next to the option that is currently selected.

Ifyou are presented with only two options, you do not have enough memory on your
EGA/VGA card to use screen font capabilities, or you may have your EGAJVGA card and
monitor setfor an extended text mode (see Text Screen Type in Reference). If this is the
case, follow the procedure for CGA display cards and monitors (see
CGA/PC3270/MCGA above).
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If you select Normal Font Only (6), the procedure for assigning attributes
becomes like the procedure for CGA cards and monitors (see
CGA/PC3270/MCGA above).

The four other screen font options take advantage of the EGA/VGA'’s ability to
utilize one additional screen font in foreground appearance. As you should be
able to tell by the menu, this screen font can be italics, underline, or small caps.
Or, it can also be a “font” that increases the number of displayable characters
from 1156 to 512. You can only select one of these screen fonts, but if you do,
you will be limited to eight foreground colors.

If the asterisk does not move to the screen font when you try to select it, make
sure that all files ending in .FRS are installed in the directory that contains
WP.EXE. These files are installed with the Graphics files (see the Installation
Instructions card).

After you select the screen font option of your choice, select Screen Colors (1).

To assign an appearance to an attribute, move to the Foreground or Background
column for the attribute you want to change, then type the letter of a color listed
at the top of the screen. If you see a letter that appears to represent no color, it
simply means that letter represents the current background color.

To assign the screen font you selected to an attribute, move to the Font column,
then type y. Type n to turn off the screen font.

Hercules Cards

If you have a Hercules Graphics Card Plus with RamFont or a Hercules InColor
Card with RamFont, you are given three screen font options after selecting
Colors/Fonts/Attributes. You can select an option by pressing the number
corresponding to the option. An asterisk (*) is displayed next to the option that
is currently selected.

Setup: Fonts/Attributes
1 - Screen Attributes
2 - 12 Fonts, 256 Characters
3 - 6 Fonts, 512 Characters

*4 - Normal Font Only

Selection: 0



If only two options appear, you may have your card and monitor setfor an extended text
mode (see Text Screen Type in Reference).

If you select Normal Font Only (4) then select Screen Attributes (1), the
procedure becomes like that of a monochrome monitor (see Monochrome below).

If you select 12 Fonts, 256 Characters (2) or 6 Fonts, 512 Characters (3), you
can use 12 or 6 of the Hercules screen fonts. Depending on your selection, you
can also display 256 or 512 different characters on the screen.

Ifyou select option 2 or 3, you must have HRFI2.FRS or HRF6.FRS (respectively) in the
directory that contains WP.EXE. Thesefiles are installed with the Graphicsfiles (see the
Installation Instructions card).

After you select one of the options, then select Screen Attributes (or Screen
Colors) (1), you are placed in the Setup: Colors/Fonts/Attributes screen. If you
selected the 12 or 6 font options, you will notice that a column titled “Font” is
displayed on the screen.

Setup: Fonts/Attributes

Attribute Font Reverse Bold Underline Strikeout Sample
Normal 1 N N N N Sample
Blocked 1 Y N N N

Underline 1 N N Y N

Strikeout 1 N N N Y Sample
Bold 1 N Y N N Sample
Double Underline 2 N N N N Sample
Redline 1 Y N N N Ei’-ff%ilB
Shadow 5 N N N N i
Italics 3 N N N N Sample
Small Caps 4 N N N N Sample
Outline 5 N N N N SsmipQa
Subscript 6 N N M N

Superscript 7 N N N N Sanple
Fine Print 8 N N N N Sample
Small Print 9 N N N N Sample
Large Print A N N N N Sample
Very Large Print B N N N N Sample
Extra Large Print [ N N N N Sample
Bold & Underline 1 N Y Y N Sanple
Other Combinations 1 N N N N Sample

Switch Documents: Move to Copy settings Doc 1

For 12 fonts, the numbers 1 through 9 and the letters A through C represent the
various screen fonts. For 6 fonts, the numbers 1 through 6 represent the screen
fonts. Move to the Font column for the attribute whose setting you want to
change, then press the number or letter corresponding to your choice. You can
cycle through the screen fonts by pressing Screen Up/Down (+ or - on the
number pad) or the Space Bar.

The other columns are simply toggled with y for Yes and n for No.

Monochrome

If you have a monochrome monitor (no Hercules card), you are placed
immediately in the Setup: Attributes screen after selecting
Colors/Fonts/Attributes. Five monitor capabilities are listed at the top of this
screen.
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Move the cursor to the row representing the attribute you want to change, then
move from column to column, typing y to turn on the capability or typing n to
turn off the capability.

See Also: Display Setup; Graphics Screen Type; Text Screen Type

Displaying columns on the screen side-by-side can slow the speed with which
WordPerfect reformats text as you edit a document.

You can speed up display of columns by turning off Side-by-side Column
Display. Then, rather than appearing on the screen side-by-side, columns are
separated by page breaks, as in the following example.

desk us long as any
trash is disposed
of as soon as
possible.

Employee Parking

All curs parked in

company parking

lots are to be

regis”ered with_
personnel. Parking
guidelines

generally parallel
the state laws

vehicles. No
parking in red
zones. No double
parking. Parallel
or angle parking is
permitted only
Col 1 Doe 1Pg 1Ln 9.76" Pos 2.5"

1 Press Setup (Shift-Fl), then select Display (2).

H9 Select Setup from the File menu, then select Display.

2 Select Edit-Screen Options (6).

3 Select Side-by-side Column Display (7), then type n to turn off this option.

4 Press Exit (F7) to return to your document.

Automiitic Reformatting

When Side-by-side Column Display is off, WordPerfect reformats columnar text
with the same speed it uses to reformat any text. You can also increase the
speed of editing in columns by turning off Automatic Reformatting. Normally,
text reformats each time certain keys are pressed. When this feature is turned
off, the screen is only reformatted as you move the cursor down through text,
and not each time you press certain keys. To turn this option off, repeat steps 1



and 2 above, select Automatically Format and Rewrite (1), then type n. Press
Exit (F7) to return to your document.

Cursor Movement

Even when columns are not being displayed side-by-side on the screen you can
use essentially the same cursor movements to move the cursor through each
column and from column to column (see Moving from Column to Column under
Columns, Parallel and Columns, Newspaper in Reference).

However, there is one change. When columns are not displayed side-by-side on
the screen. Up Arrow (T) and Down Arrow (i) move from column to column
each time the cursor crosses a page break, rather than always remaining in the
same column.

Printing

Regardless of the type of on-screen display you select, newspaper and parallel
columns are always printed side-by-side on a page. You can see how they will
appear in print by using View Document (Shift-F7,6).

See Also: Columns, Newspaper; Columns, Parallel

Columns, Newspaper

Newspaper-style columns let text flow continuously from column to column on a
page, as it does in a newspaper article. WordPerfect users often use newspaper-
style columns to create newsletters like the one shown below.
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If you know the margins you want and the number of equal-sized columns you
want on a page, WordPerfect will do all the work of calculating the actual
widths and spacing of the columns for you. It will then place the text you type
into columns. You can also use Columns to have WordPerfect put existing text
into columns.

To define and create newspaper columns,

1 Move the cursor to where you want the columns to begin.

' Press Columns/Table (Alt-F7), then select Columns (1).

CB Select Columns from the Layout menu.

3 Select Define (3) to display the Text Column Definition menu.

4 Enter the number, and margins of the columns you want (see Number and
Margins below), then press Enter or Exit (F7) to return to your document
with the Columns menu displayed on the status line.

5 Select On (1) to turn on the Columns feature (see Turning Columns On and
Off below).

li  Type the text you want in the columns, if necessary. Press Hard Page
(Ctrl-Enter) if you want to end a column and start a new one before reaching
the bottom of a page (see Text Flow in Newspaper Columns below).

7 Fress Columns/Table (Alt-F7), select Columns (1), then select Off (2) to
turn off the Columns feature.

— Select Columns from the Layout menu, then select Off.

Defin ng Columns

Whenever you want columns in a document, you need to use the
Columns/Definition feature to specify the number and margins of the columns
you want. This is called defining columns (steps 1 through 3 above). When you
define columns, a Column Definition code [Col Def'.column type;
columnstmargins] is inserted into your document. Column type is the type of
columns defined (i.e., Newspaper, Parallel, or Parallel with block protect).
#columns is the number of columns. Margins indicates the left and right
margins for each column. That definition is in effect until another column
definition is inserted.

Once you have defined columns, you can then turn on Columns. If you try to
turn on Columns before columns have been defined, an error message is
displayed. Whenever Columns are turned on, a “Col #” indicator is displayed
before the document number at the status line, where # is the number of the
column where the cursor is currently found. It is not necessary to turn off
columns unless you want to end the columns.

You can have several different column definitions in one document. This
enables you to have standard text along with several different combinations of
multiple columns in one document. However, you cannot enter a new column



definition while Columns are on. You need to turn off Columns, create the new
column definition, and turn on Columns again.

Distance Between Columns

Unless you enter a distance between columns, WordPerfect calculates the
distance for you, at approximately one-half inch. To set your own distance,
select Distance Between Columns (3) from the text Column Definition menu,
then enter a new measurement.

Changing the left and right margin settings of columns can also affect the
distance between columns.

Editing in Newspaper Columns

The cursor keys that move up and down scroll all columns at the same time.
These cursor keys include the Up Arrow (T), Down Arrow (i), Home,Up Arrow,
Home,Down Arrow, Page Up (PgUp), and Page Down (PgDn). The cursor keys
that move left and right, for example. Left Arrow (<-) and Right Arrow (->),
Home,Left Arrow and Home,Right Arrow, move within a column.

The delete keys work inside a single column. For example, if you use Delete to
End of Page (Ctrl-PgDn) only the text from the cursor to the bottom of the
current column is deleted.

You can use Move (Ctrl-F4) within a single column to cut or copy a sentence.
However, you need to use Block (Alt-F4) with Move to move an entire column
of text. Block a column, press Move (Ctrl-F4), select Block (1), then select a
move option. When using move with Newspaper columns, do not select Tabular
Column (2) since this option does not let you retrieve the moved text correctly.

Features
You can create columns while using several WordPerfect features, including

graphics text boxes and headers. You cannot include columns in footnotes,
endnotes, or tables, however.

Ifyou want to include a table in a column, create the table in a graphics box (see Table,
Create in Reference).

Margins

Once you select the number of columns, WordPerfect calculates the settings for
equal columns according to your current margin setting. These settings are
displayed in the text Column Definition menu under Margins. If you do not
want equal columns, or you need to change the displayed column sizes, select
Margins (4) on the Text Column Definition menu. Enter a new measurement for
each setting, or press Enter to skip over a displayed setting.

Remember, however, that changing the margins for your columns does not
change the left and right margin settings of your document. A good rule of
thumb is to always make the left margin of the first column correspond to your
current left margin setting for the page, and the right margin of the last column
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correspond to your current right margin setting for the page. When you try to
place graphic images in columns, problems can occur if these settings do not
correspond.

Moving from Column to Column

Once you have typed text in columns, you can move the cursor from column to
column by pressing Go To (Ctrl-Home), then pressing Right Arrow (->) to
move one column to the right, or Left Arrow (<-) to move one column to the
left. Press Go To (Ctrl-Home), Home, Left or Right Arrow to move to the
first or last column on a page. Pressing Go To, then pressing Lp Arrow (T) or
Down Arrow (i) moves the cursor to the top or bottom of the current column.

You cm also move the cursor to a column by pointing to the correct column with the
mouse pointer and clicking the left mouse button.

Using the arrow keys on keyboards with an enhanced BIOS, you can press Alt-
Left Arrow (<-) and Alt-Right Arrow (->) to move from column to column. If
you do not have a keyboard with an enhanced BIOS, you can map those
functions to other keys of your choice using Keyboard Layout (see Keyboard
Layout. Edit in Reference).

Newspaper vs. Parallel Columns

In the default setting, WordPerfect creates newspaper-style columns. You can
also create parallel columns in which blocks of text are held together side-by-
side on a page, but text cannot flow from column to column (see Columns.
Parallel and Table, Format Columns and Cells in Reference).

Numtier

In the default setting, WordPerfect creates two columns to a page according to
the existing margins in your document. To change the number of columns on
the Text Column Definition menu, select Number of Columns (2), then enter the
number of columns you want across a page (up to 24 are possible). If you have
already entered a column definition, you can change the number of newspaper
columns by placing the cursor immediately after the previous Column Definition
code [Col Def'.column type'#columns',margins] and redefining the columns. The
columns will adjust automatically. You can then delete the previous Column
Definition code.

Removing Columns

If you create columns and then decide that you do not want them, you can return
your text to normal format by deleting the Column Definition code

[Co’ Def.column type;y*columns',margins). This can either be done in Reveal
Codes (Alt-F3) or in the normal editing screen. When you attempt to delete a
Column Definition code in the normal editing screen, you are asked to confirm
the deletion. When you delete a column definition, all the codes that go with
column definition are deleted (i.e., Columns On and Columns Off). The Hard
Page codes [HPg] remain. It’s up to you to delete them. If you want to delete
just one set of columns delete either of the [Col On] or [Col Off] codes.
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If a previous column definition exists in a document when you delete a column
definition, the codes that go with the column definition remain and the existing
columns are formatted according to the previous column definition.

If you have several sets of columns in your document but just want to delete one
set, don’t delete the Column Definition code, delete the Column On [Col On] or
Column Off [Col Off] code for that set.

Text Flow in Newspaper Columns

When the text in a newspaper column reaches the bottom of a page, WordPerfect
inserts a Soft Page code [SPg], and the text moves to the top of the next column
on that page. When WordPerfect reaches the end of the last column on a page,
it inserts a Soft Page break, and the cursor moves to the beginning of the next
page.

To end a column before the bottom of a page, press Hard Page (Ctrl-Enter) to
insert a Hard Page code [HPg]. This moves the cursor to the next column. In
the last column on a page, pressing Hard Page (Ctrl-Enter) moves the cursor to
the first column on the next page.

If your columns are not being displayed on-screen side-by-side, check your
current column display selection in Setup (Shift-F1,2,6,7) (see Columns, Display
in Reference).

Turning Columns On and Off

Columns can be turned on before or after text has been entered. It is sometimes
easier and faster to create and edit a document first, then move to the beginning
of the document and turn on Columns.

To do so, turn Columns on anywhere after a Column Definition code, then turn
Columns off where you want them to end. Be aware, however, that hard page

breaks between the [Col On] and [Col Off] codes end the current column of text
and begin a new one.

See Also: Columns, Display; Columns, Parallel; Table, Create

Sometimes you want columns which contain unequal blocks of text to be printed
side-by-side on a page; yet, you do not want the information in one column to
flow into the column next to it. This is the case, for instance, when you are
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creating a movie script or typing an inventory list. You cannot do this using
tabs, indents, or newspaper columns. You can do this using parallel columns, as
in thelfollowing example.

This same effect can also be easily accomplished using the WordPerfect Tables
feature (see Table, Create in Reference).

To define and create parallel columns,
1 Move the cursor to where you want the columns to begin.
Press Columns/Table (Alt-F7), then select Columns (1).

2

3 Select Columns from the Layout menu.

3 Slelect Define (3) to display the Text Column Definition menu.
4

Select Type (1) to display the choice of columns at the status line, then
select the type of parallel columns you want (see Parallel vs. Parallel with
Block Protect below).

5 Enter the number and margins of the columns you want (see Number and
Margins below), then press Enter or Exit (F7) to return to document with
the Columns menu displayed on your status line.

6 Select On (1) to turn on the Columns feature.

7 "ype the text (see Etitering Text in Parallel Columns below). Press Hard
Page (Ctrl-Enter) whenever you want to end a column and start a new one.

8 Press Columns/Table (Alt-F7), select Columns (1), then select Off (2) to
turn off the Columns feature.

cHi Select Columns from the Layout menu, then select Off.
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Converting Columns to Tables

If you want to turn existing parallel columns into a table, you must block the
text with the Block feature (Alt-F4), press Columns/Table (Alt-F7), select
Tables (2), select Create (1), then select Parallel Column (2). The parallel
column definitions will be used to define the table columns, while Hard Page
codes will define the table rows.

Defining Columns

When putting columns in a document, use the Columns feature to specify the
number and size of the columns you want. This is called defining columns
(steps 1through 4 above).

When you define Parallel columns, a Column Definition code [Col Dti.column
type;#columns\margins] is inserted into your document. When you turn on
columns, a Column On code [Col On] is inserted. After you have entered the
text that you want in your columns, you can then turn off columns. Text
between the [Col On] and [Col Off] codes is formatted on columns.

If you turn on Columns within existing text, the remaining text in the document
from the cursor forward will be formatted within the current columns. While
this is often convenient in newspaper columns (see Turning Columns On and Off
under Columns, Newspaper in Reference), it can be very confusing in parallel
columns. For example, if your first parallel column is only one inch wide, all
the remaining text in your document will suddenly be formatted within a one-
inch width.

Consequently, when you want to insert a group of parallel columns into an
existing document, it is a good practice to turn on Columns, and then
immediately turn off Columns. This inserts a Column On code [Col On] and a
Column Off code [Col Off] into your document, and the format of the
subsequent text returns to normal. You can then move the cursor between the
Column On and Column Off codes, and insert the new text you want in columns.

Distance Between Columns

Unless you enter a Distance Between Columns, WordPerfect calculates the
distance for you, keeping it at approximately one-half inch. To set your own
distance, select Distance Between Columns (3) from the text Column Definition
menu, then enter a new measurement.

Changing the left and right margin settings of columns can also affect the
distance between columns.

Editing in Parallel Columns

With the exception of using Move (Ctrl-F4), editing text in parallel columns
works exactly the same as it does in newspaper columns (see Columns,
Newspaper in Reference).

When editing parallel columns, use Move (Ctrl-F4) to move the columns.
However, when you want to move sets of parallel columns, be sure to pay
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careful attention to the codes which accompany them. In fact, it’s a good
practice to edit columns with Reveal Codes (Alt-F3) on.

Typing a set of parallel columns across a page inserts a Column On code [Col
On] and a Column Off code [Col Off] at the beginning and end of the set.
When you move a set of parallel columns to another place in the same file, you
must block both the Column On and Column Off codes and move them along
with the text. Without the Column On and Column Off codes, the text within
parallel columns is just separated by a series of Hard Page codes [HPg],
Consequently, it is displayed and printed as a series of separate pages.

With Block Protect on, typing a set of columns across a page inserts a Block
Protect On code [Block Pro:On] and Block Protect Off code [Block Pro:Off] at
the beginning and end of each set, just next to the Column On and Off codes.
When you want to move sets of parallel columns that have been created with
Block Protect on, you must also move the Block Protect codes.

lintering Text in Parallel Columns

When entering text in parallel columns for the first time, type the text you want
in the first column, then press Hard Page (Ctrl-Enter) to end that column and
begin the second column. This will insert a Hard Page code [HPg] in your
document; however, it should not cause a hard page break. Press Hard Page to
continue creating columns across the page.

When you reach the last column on the page, pressing Hard Page starts a new
set of columns, placing you in the first column in the set. It also inserts an extra
Hard Return code [HRt] so that each separate set of columns will be separated
by an extra space. If you want your sets of columns to be single-spaced on a
page, you need to go back and delete the Hard Return code [HRt] between each
set of columns.

Featu res

You can create columns while using several WordPerfect features, including
graphics text boxes, headers, and footers. You cannot include columns in
footnotes, endnotes, or tables, however.

If you want to include a table in a column, create the table in a graphics box (see Table,

Create IN Reference!.

Margins

Once you select the number of columns, WordPerfect then calculates the settings
for equal columns according to your current margin setting. These settings are
displayed in the Text Column Definition menu under Margins. If you do not
want equal columns, or you need to change the displayed column sizes, select
Margins (4) on the Text Column Definition menu. Enter a new measurement for
each setting, or press Enter to skip over a displayed setting.

If you define parallel columns, and then decide that you want to change the
column margins, you can do so by entering a new parallel column definition
directly after your existing one and then deleting the old code. The new column



margins will then take effect, and the existing text will be formatted within the
new column margins. You can also change the number of columns. However,
this sometimes disturbs the existing text. For example, when two columns are
combined into one, the text within those columns is also combined.

Remember, however, that changing the margins for your columns does not
change the left and right margin settings of your document. A good rule of
thumb is to always make the left margin of the first column correspond to your
current left margin setting for the page, and the right margin of the last column
correspond to your current right margin setting for the page. This is particularly
important when placing graphic images in columns (see Graphics, Define a Box
in Reference).

Moving from Column to Column

Once you have created columns using Hard Page (Ctrl-Enter), you can move the
cursor from column to column by pressing Go To (Ctrl-Home), then pressing
Right Arrow (->) to move one column to the right, or Left Arrow (<-) to move
one column to the left. Press Go To, Home.Left or Right Arrow to move to
the first or last column on a page. Pressing Go To, then pressing Up Arrow (T)
or Down Arrow (4) moves the cursor to the top or bottom of the current
column.

You can also move the cursor to a column by pointing to the correct column with the
mouse pointer and clicking the left mouse button.

Using the arrow keys on keyboards with an enhanced BIOS, you can press
Alt-Left Arrow (<-) and Alt-Right Arrow (->) to move from column to column.
The Left Arrow and Right Arrow keys are not the arrow keys on the number
pad. If you do not have a keyboard with an enhanced BIOS, you can map those

functions to the keys of your choice using Keyboard Layout (see Keyboard
Layout. Edit in Reference).

Number

In the default setting, WordPerfect creates two columns to a page according to
the existing margins in your document. To change the number of columns on
the Text Column Definition menu, select Number of Columns (2), then enter the
number of columns you want across a page.

While up to 24 columns are possible, if you enter more columns than can fit
within your margins you will get an error message. If this occurs, you might try
reducing the distance between columns (see Distance Between Columns above).

Parallel vs. Newspaper

In parallel columns, blocks of text are held together side-by-side on a page. You
can also create newspaper-style columns where text moves down the first column
to the bottom of the page, then moves to the top of the next column (see
Columns, Newspaper in Reference).
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Parallel vs. Parallel with Block Protect

When creating parallel columns, you can either select Parallel (2) or Parallel
with Block Protect (3). In Parallel (without Block Protect), a single parallel
column can be longer than one page. This is useful when writing scripts.

In Parallel with Block Protect, each set of columns is held together on one page
(unless the text in one of the columns is longer than a page). This is useful
when typing inventories where you want to hold sets of items together as much
as possible.

Remoring Columns

If you create columns and then decide that you do not want them, you can return
your text to normal format by deleting the Column Definition code [Col
Defcolumn type\#columns\margins]. This can either be done in Reveal Codes
(Alt-F3) or in the normal editing screen. When you attempt to delete a Column
Definition code in the normal editing screen, you are asked to confirm the
deletion.

If no previous column definitions exist in a document when you delete a column
definition, all the codes that go with the column definition are deleted (i.e.,
Column On and Column Off). The Hard Page codes [HPg] remain. If you were
using Parallel Columns with Block Protect, the Block Protect On codes [Block
Pro:On] and the Block Protect Off codes [Block Pro:Ofl] also remain. It’s up to
you to delete them.

If a previous column definition exists in a document when you delete a column
definition, the codes that go with the previous column definition remain and the
existing columns are formatted according to the previous column definition.

If you have several sets of columns in your document but just want to delete one
set, don’t delete the Column Definition code, delete the Column On [Col On]
code and Column Off [Col Off] code for that set.

See Also: Columns, Display; Columns, Newspaper

WordPerfect includes many characters beyond those found on your keyboard. A
listing of these is found in the WordPerfect Character Sets (see Appendix P:
WordPerfect Characters). The Compose feature is used to access these
characters.

1 Press Compose (Ctrl-2 or Ctrl-v).
LH Select Characters from the Font menu.

Pressing Ctrl-v displays a “Key =" prompt at the bottom of the screen; the keys
you press in steps 2 through 4 below are displayed. Pressing Ctrl-2 displays no
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prompt and the keys you press do not appear on the screen. However, both
keystrokes perform the same function in the normal editing screen.

2 Type the number of the character set containing the character you want to
create.

3 Type a comma (,).

or
Press Enter.

4 Enter the number of the character you want to create.

For example, if you want to create /E (character number 36 in WordPerfect
Character Set 1), press Compose, then enter 1,36.

Characters on the Screen

Not all characters in the WordPerfect Character Sets can appear on the normal
editing screen. Some are represented by a box. Use View Document
(Shift-F7,6) to see what the characters will look like when they are printed (see
View Document in Reference).

Compose with Limited Characters

If you use Compose to enter a character from a WordPerfect Character Set into a
long document name, macro description, graphics caption, or some other
situation where the number of characters is limited, be aware that you may not
be able to enter as many characters as if you did not use any Compose
characters.

We suggest you do not use any Compose characters in the DOS filename because many
of these characters are not valid in a DOS filename (see Entering Filenames under Exit

in Reference).

Ctrl-v

You can use the Ctrl-v keystroke to access Compose from the normal editing
screen and from many other places in WordPerfect. However, if you press
Ctrl-v from Window Edit structures such as comments and document summaries,
or from Line Edit structures such as macro descriptions and other document
summary fields, the “Key =" prompt will not be displayed on your screen.

You cannot use the Ctrl-v keystroke to access Compose from the Macro Editor.
You must press Ctrl-2 instead.

Digraphs, Symbols, and Diacritical Marks

You can use Compose to access some of the more common digraphs and
diacritical marks from the WordPerfect Character Sets without typing the
character set or character numbers. After pressing Compose, type one character
followed by another character. You do not need to type a comma between the
two characters, nor do you need to press Enter after typing the characters. You
can type either character in the pair first.
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Diacritical Marks

Diacritical marks jre used with characters to represent a certain phonetic
value, Accessing diacritical marks is not as specific as accessing digraphs
and symbols since diacritical marks are allowed for many characters.
Examples of some diacritical marks are listed below. Try the diacritical
marks with the character of your choice, or if in doubt, use the WordPerfect
Character Set number.

Mark Example Result
Acute i |
Caron \'74 z
Cedilla ,C 9
Centered Dot 1 i
Circumflex A a
Crossbar -t t
Dot Above . c
Grave ‘e e
Macron _u u
Ogonek ;a 3
Fling Above @a a
Slash /o 0
Stroke 1
Tilde ~n n
Umlaut “u u

Digraphs and Symbols

The following are some of the digraphs and symbols that can be created with

Compose:

Type Character Result
AE L1,36] M
ae u.37] ®
N [1,138] N
j [1,139] i
CE [1,166] CE
oe [1,167] (0
0X [4,24] n
ss [1,23] B
L- [4,11] £
H [4,5] 1

« [4,9] «

» [4,10] »
Y= [4,12] ¥
Pt [4.13] Pt
c/ [4,19]

+- [6,1] +
<= [6.2]

>= [6.3] >
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Type Character Result

== [61 1 4] =
— [6,13] =
= [6,99] *
tm [4,41] ™
sm [4,42] M
ro [4,22] ®
@ [4,23] ©
rx [4,43] B
i) [4,17] M
14 [4,18] \*
: [43]
- [4.0] .
*0 [4,45] 0
*0 [4,1] 0
ao [1,35] a
f- [4,14] /
= [4,15]

= [4,16] 0
77 [4,8] i
ft [4,7] i
n- [4,33] -
m- [4,34] B

[4,34]

Keyboard Mapping

You may want to “map” characters you frequently use to a specific key (or keys)
on the keyboard. To do so, you can use Compose with Keyboard Layout
(Shift-F1,5) (see Keyboard Layout in Reference).

Printable Characters

If your printer is capable of printing graphics, you will be able to print every
character found in the WordPerfect Character Sets (see Appendix P: WordPerfect
Characters). If your printer does not have a particular character, WordPerfect
creates that character using the .DRS (driver resource) file that comes with
WordPerfect, and then prints this character as a graphic image. When printing
characters with diacritical marks, often only the diacritical mark must be created
graphically (e.g., only the ' of e is printed as a graphic image).

If your printer cannot print graphics, some characters from the Character Sets
will not print. See Printer Program, Customize Substitute Fonts in Reference to
find out how you can increase the number of characters you can print as text.

See Also: Keyboard Layout; Printer Program, Customize Substitute Fonts;
Appendix P
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Conditional End of Page

Use Conditional End of Page to keep titles and subsequent paragraphs together.
This feature protects a specified number of lines from being split between pages.

In the document below, the paragraph title is separated from the paragraph by a
page jreak.

A TITLE

A PAGE BREAK projects. If you don"t find what you need contact your deportment
rece|tionistg and they should be able to order it.

A PARAGRAPH Company Party

Don"t forget that July 12th is our company party. Employees and
theii families are invited. We hope that you will all plan to be
there and have a ball. There will be plenty of food and soda pop.
Bring your softball mitts and swimming suits. There will be lots
of games and plenty for the little children to do. Come and see
Jack Reanoy bob far apples and see Jenine get thrown in the pool
Be sere to RSVP with Julia in HR at Ext. 734.

>Aeet|ng Change

There will be no meeting this Friday because too many people will
be out OF the office so ue will have it next Tuesday the 16th of
June. Please plan to attend, we will be making some changes in
location of management and accounting. We will also need your Input
on seme new ideas that have been suggested for more efficient Han-
dling of paycheck and mail distribution._

Doc 1 Pg 2 Ln 1.75" Fob 5"

In the document below, Conditional End of Page keeps the title and paragraph
on the same page.

A TITLE

A PAGE BREAK projects. If you don"t find what you need contact yuur department
receptionists and they should be able to order it

A PARAGRAPH Company Party

Don*t forget that July 12th is our company party. Employees and
their families are invited. We hope that you will all plan to be
there and have a ball. There will be plenty of food and soda pop.
Bring your softball mitts and swimming suits. There will be lots
of games and plenty for the little children to do. Come and 9ee
Jack Reanoy bob for apples and see Jenine get thrown in the pool
Be sure to RSVP with Julia in HR at Ext. 734.

*

There will be no meeting this Friday because too many people will
be out of the office so we will have it next Tuesday the 16th of
June. Please plan to attend. We will be making some changes in
location of management and accounting. We will also need your input
on sone new ideas that have been suggested for more efficient Han-
dling of paycheck and mail distribution._

Meeting Change

Doc 1 Pg 2 Ln 1.92" Pos 5~

Before using Conditional End of Page, you should determine the number of lines
you want to keep together. You need to enter this number in step 4 below.

1 Move the cursor to the line immediately above the lines you want kept
together (even if there is text on that line).

2 Press Format (Shift-F8), then select Other (4).

CS Select Otherfrom the Layout menu.
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Convert Program

3 Select Conditional End of Page (2).
4 Enter the number of lines to be kept together.

5 Press Exit (F7) to return to the document.

Codes

This feature places a Conditional End of Page code [Cndl EOP:#] in your
document, where # is the number of lines to be held together. Rather than
splitting the protected lines, WordPerfect will insert a soft page break before
them. However, you can still separate these protected lines with a hard page
break, by pressing Hard Page (Ctrl-Enter).

Conditional End of Page vs. Block Protect
Conditional End of Page protects a specific number of lines from a certain point
forward. Block Protect protects a block of text (see Block Protect in Reference).

Line Spacing

When entering the number of lines to be protected, consider any blank lines that
will result from double- or triple-spaced text. For example, to hold together a
heading and the first line of a paragraph in double-spaced text, you would enter
4 and not 2 as the number of lines to protect.

See Also: Block; Block Protect

Files created with other word processing programs often cannot be used directly
by WordPerfect. Similarly, WordPerfect files often cannot be used directly by
other word processing programs. The Convert Program converts files so that
they can be used by programs other than the one with which they were created.

The Convert Program that came with WordPerfect converts files from selected
programs to WordPerfect and vice versa. As much of the format is preserved as
possible. If you simply want to convert a file to ASCII format (without any
word processing codes), you may want to use the Text In/Out feature in
WordPerfect (see Text In/Out in Reference).

Important: The Convert Program file (CONVERT.EXE) needs to be installed properly
before using the program. Ifyou chose not to install the WordPerfect utility programs
when you installed WordPerfect (or have not subsequently installed them), you must do so
now to use the Convert Program. See the Installation Instructions cardfor installation
instructions.
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To us2 the Convert Program,

1 Exit WordPerfect and go to DOS, then change to the drive or directory
where the CONVERT.EXE file is located.

The Installation Program copies thisfile to the directory where WordPerfect (WP.EXE) is
located (usually C:\WP5I) ifyou are using a hard disk, or to the diskette you labeled
“Utilities" if you are using a two disk drive system.

2 Eater convert at the prompt.

3 Eater the pathname of the file to be converted (input file).
4 Eater the pathname for the converted file (output file).

If the output filename you enter already exists, you are asked to confirm that you want
the file overwritten by the new outputfile. Ifyou do, typey. Ifyou do not want the file
overwritten, type n, then enter a new output filename.

Name of Input File? c:\letter
Name of Output File? letter.new

0 ex:T

1 WordPerfect to another format

2 Revisable-Form-Text (I1BM DCA Format) to WordPerfect
3 Final-Form-Text (IBM DCA Format) to WordPerfect
4 Navy DIF Standard to WordPerfect

5 WordStar 3.3 to WordPerfect

6 Mu. tiMate Advantage 1l to WordPerfect

7 Seven-Bit Transfer Format to WordPerfect

8 WendPerfect 4.2 to WordPerfect 5.1

9 Ma.-.1 Merge to WordPerfect Secondary Merge

A Spreadsheet DIF to WordPerfect Secondary Merge
B Word 4.0 to WordPerfect

C DiisplayWrite to WordPerfect

Enter number of Conversion desired

J S:zlect an option from the displayed menu by typing the corresponding
number (see the instructions for each option under Notes below).

Command Line Convert

You can convert files from the DOS command line without going through the
menus. You can also enter several command lines in a batch file if several
conversions are to be done at once.

To use Command Line Convert,

1 If you are using a hard disk system, change to the directory where
CONVERT.EXE is located. (The Installation Program copies it to C:\WP51
unless you specify otherwise.)

or



If you are using a two disk drive system, insert the diskette you labeled

“Utilities” into drive A. (The Installation Program copies CONVERT.EXE
to the diskette you labeled “Utilities.”)

2 On a hard disk system, enter convert inputfilename outputfilename
inputfUetype outputfiletype fielddelimiter recorddelimiter deletecharacters
(Each parameter is separated by a space. See the explanation of these
parameters after this step for more information.)

or

On a two disk drive system, enter a:convert inputfilename outputfilename
inputfUetype outputfiletype fielddelimiter recorddelimiter deletecharacters
(Each parameter is separated by a space. See the explanation of these
parameters after this step for more information.)

The inputfUetype is the number or letter on the Convert Program menu that
represents the format of the input file. You can use the following:

WordPerfect

Revisable-Form-Text (IBM DCA Format)
Final-Form-Text (IBM DCA Format)
Navy DIF Standard

WordStar 3.3

Multimate Advantage Il

Seven-Bit Transfer Format
WordPerfect 4.2

Mail Merge

Spreadsheet DIF

Microsoft Word 4.0

DisplayWrite

OWP OOV D WN

The outputfiletype is the number or letter on the Convert Program menu that
represents the format of the output file, and is only needed if you entered
WordPerfect (1) for the inputfUetype. Use the following list to determine the
outputfiletype'.

Revisable-Form-Text (IBM DCA Format)
Final-Form-Text (IBM DCA Format)

Navy DIF Standard

WordStar 3.3

MultiMate Advantage Il

Seven-Bit Transfer Format

ASCII Text File

WordPerfect Secondary Merge to Spreadsheet DIF

ONOUDWN

Important: If afile already exists by the same name as the output file you specify, it will
be overwritten automatically by the output file generated in the conversion.

The fielddelimiter, recorddelimiter, and deletecharacters are needed only if Mail
Merge (9) is used for the input file type. They are entered the same as they
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would be if you ran the Convert Program using the prompts (see Delimiters and
Delete Characters below).

Remember that spaces are used to separate parameters. Do not enter spaces
between the characters of field delimiters or record delimiters, or between delete
characters. If you do, the conversion will not be performed correctly. For
example, to convert a Microsoft Word 4.0 file named letter located on the
diskette in drive A to a WordPerfect 5.1 document named letter.wp located in
C:\WP51 on your hard drive, you would enter:

convert a:\letter c:\wp51\letter.wp b

To convert a dBase merge file named a:\merge.db to a WordPerfect secondary
merge file named c:\wp51\merge.wp, you would enter the following:

convert a:Vmerge.db c:\wp51\merge.wp 9, {13 10] {34}

where , is the field delimiter, {13} {10} is the record delimiter, and {34} is the
delete character (representing a double quote character (*)) in the input file.

dBase files must be saved in a delimited format (using dBase) before you convert them
with the Convert Program.

Delimiters and Delete Characters

The field delimiter and record delimiter are the characters in the input file that
separate fields and records. Delete characters are any characters you want
deleted in the conversion from the input to the output file. For field and record
delimiters, you can enter either characters or decimal ASCII values enclosed in
braces ({ }). If a Carriage Return and Line Feed follow a delimiter, they must
be specified as part of the delimiter by typing {13} {10}. For more information
on fields and records, see Secondary Files under Merge in Reference.

DisplayWrite to WordPerfect
Converts DisplayWrite to WordPerfect. For information on the .CRS prompt,
see Revisable-Form-Text below.

Filename Patterns

When entering input and output filenames, you can use the question mark (?)
and asterisk (*) characters to create a filename pattern. The asterisk represents
zero or more characters; the question mark represents a single character. For
example, if you want to convert all the files in a directory that end with a .DOC
extension, you would type *.doc for the input filename. The output filename
might be *.wp which would create converted files using the same filenames but
with \WP extensions. When using wildcard characters, any existing output file is
automatically overwritten.

If you enter ** as part of the string, all files are converted, so you need to
outpui the files to another directory.

Ifyou use ** the Convert Program tries to convert all files in the directory, including
executable files. Non-documentfiles may be corrupted.



Final-Form-Text (IBM DCA Format) to WordPerfect
Converts DCA/FFT to WordPerfect. Final-Form-Text (FFT) is used on some
mainframe computers.

IBM Products (Non-PC)
When transferring a file to or from an IBM mainframe, you must transfer the file
as binary data and not as text data. No other conversions should be made.

To attach an IBM PC to an IBM 5520, use the 5520 attachment board. This
board and the software that comes with it causes the emulation of a 5520
workstation and will transfer files (after the Revisable-Form-Text conversion)
from the PC to the 5520 in its DCA word processing format.

To attach an IBM PC to an IBM Displaywriter, use the IBM PC attachment
convenience kit #6403664.

Mail Merge to WordPerfect Secondary Merge

This conversion is useful for dBase, WordStar, or other mail merge files. The
converted file is in WordPerfect secondary merge format ({END FIELD}[HRt]
to separate fields and (END RECORD}[HPg] to separate records).

When you choose this option, you are asked for the field delimiter, record
delimiter and any characters to be deleted from the file. (See Delimiters and
Delete Characters above.)

Microsoft Word 4.0 to WordPerfect
Converts Microsoft Word documents to WordPerfect.

MultiMate Advantage Il to WordPerfect
Converts MultiMate Advantage Il to WordPerfect.

Navy DIF Standard to WordPerfect
Converts Navy DIF to WordPerfect.

Revisable-Form-Text (IBM DCA Format) to WordPerfect

Converts DCA/RFT to WordPerfect. Revisable-Form-Text (RFT) is used on
some mainframe computers. Many other word processors can convert to and
from this format.

When you select this option, the following prompt appears:
Enter name of CRS file or press ENTER for none

A .CRS (conversion resource) file is a file you create in WordPerfect that tells
the Convert Program how you want certain fonts converted. Without a .CRS
file, the Convert Program converts fonts based on its own defaults. If you don’t
want to use a .CRS file, press Enter at the prompt and the conversion will
continue. If you want to create a .CRS file, press Cancel (FI) to exit the
Convert Program, then re-enter WordPerfect in order to create the file.
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The .CRS file contains a list of the GFID font numbers (as listed in your
DCA/RFT product documentation), matched with the WordPerfect font codes
you designate as their equivalents. A sample file might look like this:

1D
1D

ID 12 = [Fort:Dutch 10pt](HRt]
ID 15 - [Font:Dutch 10pt][HRt]

Press Reveal Codes to restore screen

The spaces are optional, and are used to make the file more readable. Be sure to
precede the GFID font number with the letters ID, and follow it with an equal
sign (=) and the WordPerfect base font code (Ctrl-F8,4). Each pair of
equivalents must be separated by at least one Hard Return code. When you have
completed the list of font equivalents, save the file in WordPerfect format using
either Save (F10) or Exit (F7). You may give the file any legal filename.

Once you have created the .CRS file, restart the Convert Program, following the
steps it the beginning of this section. When you see the ""Enter name of CRS
file oi press ENTER for none™ prompt, enter the name of the .CRS file (use a
full pathname if necessary). The file will then be converted using the .CRS file.

Seven-Bit Transfer Format to WordPerfect

Used to convert a previously converted WordPerfect file from seven-bit transfer
format back to its original form. (Use this option after receiving the file through
a 7-bit modem.)

Spreadsheet DIF to WordPerfect Secondary Merge
Converts a spreadsheet DIF file to WordPerfect secondary merge format. Rows
become records and cells become fields.

Startup Option

Use the code page startup option to tell the Convert Program which code page
your hardware (BIOS) system uses. Setting this option lets you access the
proper keyboard and 256-character ASCII character set for which your system is
preset The Convert Program supports the following code pages: 437 Standard
English, 850 PC Multilingual, 851 Greek, 8510 Greek Alternate, 860 Portuguese,
8600 Portuguese Alternate, 861 Icelandic, 863 French (Canada), 865 Norwegian



and Dutch, 866 Russian, 8660 Russian Alternate, and 895 Czechoslovakian. For
more information on code pages, see your DOS manual.

To use the option, enter convert/cp=code page number to start the program.

This startup option has no effect on conversions to or from Revisable-Form-Text (IBM
DCA), Final-Form-Test (IBM DCA), or Navy DIF Standard formats since these formats
use their own tables to convert international characters.

Two Disk Drives

To run the Convert Program on a two disk drive system (no hard disk), change
to the drive or directory where the files you are converting are located (e.g.,
drive B) and insert the diskette you labeled “Utilities” into drive A. (The
Installation Program copies CONVERT.EXE to the “Utilities” diskette. If you
have not installed CONVERT.EXE, you must do so before running the program.)
Enter a:convert. Then follow steps 3 through 5 at the beginning of this section.

WordPerfect 4.2 to WordPerfect 5.1

Used to convert WordPerfect 4.2 documents to WordPerfect 5.1 documents.
Select this option, then enter the correct .CRS filename. If no .CRS filename is
entered, the STANDARD.CRS file is used. If STANDARD.CRS does not exist,
the document is converted without a .CRS file (see Document Conversion,
WordPerfect 4.2 to 5.1 in Reference).

You can also convert a WordPerfect 4.2 file to 5.1 format simply by retrieving it
in WordPerfect 5.1. You should use the Convert Program when you have
multiple files you want to convert (see Filename Patterns above).

WordPerfect to Another Format
Converts a WordPerfect file to one of the following formats.

Name of Input File? c:\wp51\learn\memo.wkb
Name of Output File? c:\wp51\learn\parkmemo

0 EXIT

1 Revisable-Form-Text (IBM DCA Format)

2 Final-Form-Text (IBM DCA Format)

3 Navy DIF Standard

4 WordStar 3.3

5 MultiMate Advantage Il

6 Seven-Bit Transfer Format

7 ASCII text file

B WordPerfect Secondary Merge to Spreadsheet DIF

Enter number of output file format desired

CONVERT PROGRAM 95



Cross-Reference

96

CROSS-REFERENCE

ASCII Text File

Converts WordPerfect to ASCII (DOS) text. You can also use the Text
In/Out feature to convert WordPerfect documents to ASCII text (see Text
MOut in Reference). You should use the Convert Program when you have
multiple files you want to convert (see Filename Patterns above).

Final-Form-Text (IBM DCA Format)
Converts WordPerfect to DCA (used by IBM mainframes).

MultiMate Advantage Il
Converts WordPerfect to MultiMate Advantage II.

Navy DIF Standard
Converts WordPerfect to the Navy DIF.

Revisable-Form-Text (IBM DCA Format)
Converts WordPerfect to DCA (used by IBM mainframes).

When you select this option, the following prompt appears:
Enter name of CRS file or press ENTER for none

See Revisable-Form-Text (IBM DCA Format) to WordPerfect above for
information on using a .CRS file.

Seven-Bit Transfer Format

Useful when transferring documents over a modem or line that only transfers
seven bits. Because WordPerfect codes use the eighth bit, these are usually
stripped during the transfer. With this conversion, they are rearranged in a
seven-bit format, thus preserving all codes. The person receiving the file
should then convert it back to WordPerfect format using the seven-bit format.

WordPerfect Secondary Merge to Spreadsheet DIF
Converts a WordPerfect secondary merge file to spreadsheet DIF format.
Records become rows and fields become cells.

WordStar 3.3
Converts WordPerfect to WordStar 3.3.

WordStar 3.3 to WordPerfect
Converts WordStar (versions 3.3 or earlier) to WordPerfect.

See Also: Document Conversion, WordPerfect 4.2 to 5.1; Retrieve; Text In/Out

The cross-reference is a useful tool for a writer who wants to keep a document
concise and avoid repetition of material. Situations where cross-references are
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useful include legal documents, research papers, or other documents which refer
a reader to a page number, table number, or footnote number.

Examples of cross-references are shown in the illustration below.

Despite advice to the contrary, Metcalf has always maintained that
employees should be given direction instead of management.2 To
that end, he has worked to give employees a voice in both their job
description and the goals of this company.2

Maximizing the Organization

However, in all the attention to employees, the goal to provide
quality merchandise at discount prices (see figure 4) continues to
give purpose and direction to the company. A

As indicated in the Operating Expenses table (again, see page 2),
that goal contributes to the recent venture into retail outlfets

After the opening of several retail stores In 1990, sales increased
by 50% in the last quarter. However, as demonstrated by the table
figures, operating expenses were often more than twice those of the
third quarter.

Operating Expenses
1990

Fourth Third
Expense Quarter Quarter Change

The difficulty with cross-referencing involves maintaining the correct numbers
after editing changes are made. For example, the information that was on page
23 may have been moved to page 25 after an editing change.

Fortunately, the WordPerfect Cross-Reference feature marks and maintains cross-

references for you. Even if you make an editing change, WordPerfect can
update the cross-references.

Cross-referencing with WordPerfect involves three elements: a reference, a
target, and a target name.

The reference is the location from which you are referring. In other words, it is
where you create the text and numbers that send a reader to other parts of the
document. The examples shown at the beginning of this section are references.

The target is the location to which you are referring. In other words, it is where
you are sending the reader. In the examples shown above, the targets are where
you would look after reading the information.

The target name is a unique identifier that ties references and targets together.
When WordPerfect generates or compiles your cross-references, it uses the target
name to match references and targets.

The target name is only used during generation. It is not printed and is only displayed in
the Reveal Codes screen (Alt-F3).
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Creating a cross-reference involves two basic tasks:

* Mark the references and targets and include a target name.
« Generate the cross-references.

The steps below guide you through marking both the reference and target in one
operation, but WordPerfect also gives you the opportunity to mark the reference
and target in separate operations. Notes on those procedures are included under
Mark Reference Only and Mark Target Only below.

To mark both the reference and target in one operation,
1 Move the cursor to where you want to create the reference.

2 Type any introductory text you want to include, then press the Space Bar to
add a space between the introductory text and the location of the reference
(see Introductory Text below).

3 Press Mark Text (Alt-F5), then select Cross-Ref (1).
01 Se'ect Cross-Reference from the Mark menu.

4 Select Mark Both Reference and Target (3) to begin marking both the
reference and target.

[11 Select Both from the Cross-Reference submenu.
5 Select the type of reference you want to use (see Reference Types below).
6 Move the cursor to a position immediately after the target, then press Enter.

You may want to make sure the cursor is located after the target by checking Reveal
Codes (Alt-F3).

7  Eriter a target name (see Target Name below).
8 If necessary, finish typing the introductory text for the reference.
9 Repeat the steps above, marking all references and targets in your document.
1) Priss Mark Text (Alt-F5), then select Generate (6).
Select Generate from the Mark menu.

11 Select Generate Tables, Indexes, Cross-References, etc. (5), then type y to
generate.

The last cross-references generated are the cross-references that are printed.
Therefore, you should generate your cross-references just before you plan to
print the document to ensure that cross-references will be correct. For a more
detailed explanation of Generate, see Generate in Reference.



Notes

Introductory Text

WordPerfect inserts a number, letter, or character at the spot of the reference
when the cross-references are generated. If you want introductory text that
explains the number or letter (e.g,, “See Page”), you must type the text in
yourself.

The only exceptions to this rule occur if you are referencing graphics box
numbers or page numbers. For graphics box numbers, WordPerfect will insert
the Caption Number Style before the box number. If the Caption Number Style
includes text, that text appears when the cross-reference is generated. For more
information about Caption Number Styles, see Graphics Options in Reference.

For page numbers, WordPerfect will insert the Page Number Style. If the Page
Number Style includes text, that text appears when the cross-reference is
generated. For more information about Page Number Styles, see Page
Numbering in Reference.

Mark Reference Only

If you come to a place in your document where you want to create a reference
and know that you plan to create the target later (or already have created the
target), you can create the reference only.

To do so,
1 Move the cursor to where you want to create the reference.

2 Type any introductory text you want to include, then press the Space Bar to
add a space between the introductory text and the location of the reference
(see Introductory Text above).

3 Press Mark Text (Alt-F5), then select Cross-Ref (1).

CB Select Cross-Reference from the Mark menu.

4 Select Mark Reference (1) to begin marking the reference.

US Select Reference from the Cross-Reference submenu.

5 Select the type of reference you want to use (see Reference Types below).

6 Enter a target name. The target name should be the same as the target name
for the target (see Target Name below).

7 If necessary, finish typing the introductory phrase for the reference.

Repeat the steps above for additional references you want to mark separately.
When you mark a reference, [Ref(target namef.type ] can be seen in Reveal
Codes (Alt-F3).

A question mark (?) will appear in place of the reference number. After you
mark targets and generate cross-references, the question mark will be replaced by
the correct information (see Mark Target Only below).
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Mark Target Only
If you have marked or plan to mark a reference separately and want to create a
target, you can mark the target separately.

To do so,

1 Move the cursor to a position immediately after the target.

You may want to use Reveal Codes (Alt-F3) to be sure of the cursor location.
2 Press Mark Text (AU-F5), then select Cross-Ref (I).

L3 Select Cross-Reference from the Mark menu.

3 Select Mark Target (2) to mark the target.

G3 Select Targetfrom the Cross-Reference submenu.

4 Enter a target name. The target name should be the same as the target name
for the reference (see Target Name below).

Repeat the steps above for all targets you want to mark separately. When you
mark a target, [Target (target name)] can be seen in Reveal Codes (Alt-F3).

If you have marked all your references and targets, you are now ready to
generate the cross-references. To do so, press Mark Text (Alt-F5), select
Generate (6), select Generate Tables ... (5), then type vy.

Mastei Documents

If your document is extremely long, you may want to use the Master Document
feature to divide it into smaller files. You can still generate cross-references
which will include any references and targets marked in subdocuments (see
Master Documents in Reference).

Multiple Cross-References

There are two kinds of multiple cross-references that you can create with
WordPerfect. One cross-references the same target with one or more reference
types (e.g., see page 23, figure 2), while the other cross-references one or more
targets with the same reference type (e.g., see pages 10, 24, 29).

To create the first kind of cross-reference, mark a reference for each different
reference type. You only need one target, however, for both references. For
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example, in the following cross-reference you should mark two references, one a

page number reference and one a graphics box reference.

The Next Fifty Years

Whilr the recent upswing in the growth of HALVA International is
a welcome indicator, there are also potential problems that need
to be addressed.

However, if these needs are met, the company can look forward to
g bri%rt and exciting future through the decade of the 1990°s and
eyond.

Expanding Markets

From oriental rugs to_imported jewelry, HALVA International has
always provided a variety of merchandise to Its customers.
However, the variety of products has often been limited to those
items that are a known quantity.

Recent trends indicate, however, that there is profit to be made
in areas such as oriental furniture and music boxes. In fact,
our research indicates that music boxes may become a long-term,
profitable investment (see page 4, figure 2).

Expanding Resources

Then, you only need to mark the target once as long as both references use the
same target name. The target can be marked in the same operation as one of the

references or separate from both of the references.

To create the second kind of cross-reference, you only need to mark the
reference once, but you need to mark each target separately. The targets should

all have the same target name. For example, in the following cross-reference

you should mark one page number reference.

In this report, the past, present, and future status of HALVA
International are reviewed (see pages 4, 10, 12), with an
emphasis, on these characteristics as Jteing vital to the continued
survival of the company.

The European Connection

The year was 1939, and the rumors of war had become a nightmare
of reality. With the transportation of goods between many
countries blocked, and the lines of economic communication
virtually severed, intercontinental business was at a standstill.

""Suddenly, the entire face of economics changed to a survival
industry. Manufacturing resources were transformed overnight
into a war machine. Sacrifice of conveniences became the test of
civil loyalty."”

It was an awkward, if not impossible, time for the birth of an

import/export business. But, then, Bryan Metcalf was no ordinary
individual.

The Roots of Mail Order
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Then, you should mark a target on each of the pages you are referring to. You
can mark one of the targets in the same operation as the reference, but you must
mark at least two of the targets separately. When you generate the cross-
references, they will be separated by a comma and one space.

Reference Types

There are five types of references you can create, or in other words, five items
you can cross-reference. They are page numbers, paragraph/outline numbers,
footnote numbers, endnote numbers, and graphics box numbers.

If you cross-reference a graphics box number, you must also select the type of
graphics box you wish to cross-reference (e.g., figure, text, etc.).

To mark a target for most of these items, move the cursor to the immediate right
of the code that represents that item, then mark the target. For example, mark a
paragiagh number by moving the cursor to the immediate right of the paragraph
number code you want to cross-reference, then mark the target.

You may want to mark the target in Reveal Codes (Alt-F3) to be sure of the cursor
location.

The following are the exceptions:

e If you are marking a page number, simply move to the text on the page that
ycu want to cross-reference, then mark the target. Make sure you mark the
target within the text. This ensures that the cross-reference will be correct
even if the text is moved to a different page.

e To mark a page number for a footnote or endnote, display the footnote or
endnote in its editing screen (Ctrl-F7, Footnote (1) or Endnote (2), Edit (2),
note number) before marking the target.

To mark a page number for an endnote, you must generate endnotesfor the page
number to appear correctly (see Generate in Reference).

e To mark a page number for a graphics box, place the target in the graphics
box caption. If the box “bumps,” the correct page number is still referenced.

 If your reference is located in a graphics box caption, a header, or a footer,
you cannot mark both the reference and the target in the same operation.
You must mark the reference and target separately (see Mark Reference Only
and Mark Target Only above).

Target Name

The Target Name “ties” the reference and target together. When WordPerfect
generates cross-references, it looks for matching target names, then creates the
cross-reference.

The target names must be an exact match. For example, if you type "Bird" at
the rel'erence and mistakenly type “Birds” at the target, the two will not match,
and WordPerfect will not be able to create the correct cross-reference.



Cursor Movement

Notes

Target names are not case specific, however. “BIRD” and “bird” are considered
the same.

Update Cross-References

The last cross-references generated are the cross-references that are printed.
Therefore, you should generate your cross-references just before you plan to
print the document to ensure that cross-references will be correct. For a more
detailed explanation of Generate, see Generate in Reference.

See Also: Generate

The cursor is the on-screen dash that tells you where you are in your document
(see Cursor Appearance below).

You can use the cursor movement keys to move through text a character, a
word, a screen, or a page at a time. You can also quickly move to either edge
of the screen or to either end of your document.

If your computer supports a mouse, you can move the cursor by placing the
mouse pointer on the text and clicking the left mouse button (see Mouse Support
in Reference).

Codes

When you move the cursor through text on the screen, it also moves through any
codes in that text. When editing text, it is often important to know where the
cursor is positioned in relation to the existing codes in your text. If you press
Left Arrow (<-) and Right Arrow (->) and the cursor does not appear to move,
it is probably moving through codes. You can use Reveal Codes (Alt-F3) to
display the codes on the screen as you move the cursor through them (see Reveal
Codes in Reference).

Cursor Appearance

Normally, the cursor is displayed on the screen in WordPerfect as a small
blinking line. The CURSOR.COM program provided with WordPerfect lets you
change the size and appearance of the cursor (see Cursor Program in Reference).

Cursor Movement Keystrokes
The following table lists the keystrokes used to move the cursor through text.

Location Cursor Keys
Left One Character Left Arrow (<-)
Right One Character Right Arrow (->)
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Location

Left One Word

R ght One Word
Left Side of Screen
R ght Side of Screen

Far Left of Line (even when
the line extends beyond the
left edge of the screen)

Far Right of Line (even
wnen the line extends
beyond the right edge of
the screen)

Ui One Line
Down One Line

Top of Screen (then up one
screen at a time)

Bottom of Screen (then
forward one screen at a
time)

First Line on the Previous
Page

Uo One Paragraph

Down One Paragraph

First Line on the Next Page

Beginning of a Document
{after any formatting codes)

Beginning of a Document
{before any formatting
codes)

End of a Document {after
any formatting codes)

Cursor Keys

Word Left (Ctrl-*-
Word Right (Ctrl—)
Home,Left Arrow
Home.Right Arrow

Home,Home,Left Arrow

Home,Home,Right Arrow or End

Up Arrow (T)
Down Arrow (i)

Home,Up Arrow or Minus (-) on the number
keypad

Home,Down Arrow or Plus (+) on the number
keypad

Page Up (PgUp)

Ctrl-Up Arrow (on keyboards with enhanced
BIOS)*

Ctrl-Down Arrow (on keyboards with
enhanced BIOS)*

Page Down (PgDn)

Home,Home,Up Arrow

Home,Home,Home,Up Arrow

Home,Home,Down Arrow

*If you do not have a Keyboard with an enhanced BIOS you can map these
functions with the Keyboard Layout feature (see Keyboard Layout, Edit in
Reference).
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Cursor Program

Cursor Movement Pattern

The cursor can only move through text or codes which already exist in your
document. When you reach a point where there is no more text or codes, the
cursor stops moving.

As you move the cursor up or down through a document, the cursor retains its
current horizontal position, if possible. For example, if the cursor is at Position
4.5" on one line, it stays at Position 4.5" in all the lines it moves through, unless
they are shorter than 4.5" long, in which case the cursor moves to the right edge
of the line.

Escape

You can use Escape (Esc) to move the cursor a specified number of characters,
lines, or pages. Press Escape, type a number, then select the cursor control key
you want repeated (see Repeal Value in Reference).

Go To

You can use Go To (Ctrl-Home) to move the cursor to a specific character or
page, the top or bottom of the current page, a different column, or back to its
original position (see Go To in Reference).

See Also: Go To; Mouse Support; Repeat Value; Reveal Codes

You can use the Cursor Program to change the appearance of the cursor.
Depending on the type of text you are working with, modifying the cursor shape
can make it more or less visible on the screen.

The Cursor Program cannot stop the cursor from blinking.

Important: The Cursor Program file (CURSOR.COM) needs to be installed properly
before using the program. 1fyou chose not to install the WordPerfect utility programs
when you installed WordPerfect (or have not subsequently installed them), you must do so
now to use the Cursor Program. See the Installation Instructions card.

1 Exit WordPerfect and go to DOS.
2 Change to the directory where CURSOR.COM is located.

The Installation Program copies thisfile to the directory where WordPerfect (WP.EXE) is
located (usually C:\WPS5I) if you are using a hard disk, or to the diskette you labeled
"“Utilities" if you are using a two disk drive system.
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3 Type cursor and press Enter.

Use arrow keys to select cursor, then press return
(Press SPACEBAR to see cursor on a line of text)

You may select this cursor from DOS by entering:
A> CURSOR/LM

4 Use the arrow keys to move the cursor on the grid until it is the desired size
and shape.

Some grid combinations will cause the cursor to disappear. In addition, with some
graphics cards, the entire grid cannot be used.

5 1'"you want to see how the cursor looks in text, press the Space Bar. Press
the Space Bar again to return to the grid.

You may want to make a note of the two-letter combination identifying your
cursor (displayed at the bottom of the Screen). The first letter is the grid Tow,
the second is the grid column.

6 When you are finished, press Enter to select the cursor and return to DOS.

Once you know the cursor combination you want, you can select it directly from
DOS. To select it

7 Enter cursor/nn at the DOS prompt (where nn is the two-letter combination
tor your cursor).

For example, to use cursor KL, you would enter cursor/kl at the DOS prompt.

Extent of Use

Because the cursor is changed at the DOS level, the new cursor is used both at
DOS and in any application run under DOS, including WordPerfect. If you exit
D051, however (for example, if you turn off your machine or run BASIC), the
cursor will return to its regular size and shape. To use the new cursor every
time you start your computer, enter the cursor/nn command in your
AUTOEXEC.BAT file (see DOS and WordPerfect in Reference).
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Notes

Some applications may themselves change the shape of the cursor while you are in that

program. Upon exiting many of these applications, the cursor is returned to the default

size and shape, rather than what it was when you started the application. You may need
to run the Cursor Program again to return it to the size and shape you want.

See Also: Cursor Movement; Cursor Speed

You may have noticed that when you hold down certain keys, the character on
that key begins to repeat itself. The Cursor Speed feature lets you increase or
decrease the repeat rate of the keys on your keyboard.

Cursor Speed can be changed from the Setup menu, and its setting remains in
effect each time you start WordPerfect.

1 Press Setup (Shift-F 1).

CB Select Setup from the File menu.

2 Select Environment (3).

3 Select Cursor Speed (3) to display a menu of possible options.
4 Select a repeat speed (see Repeat Speed below).

5 Press Exit (F7) to return to your document.

Repeat Speed

While the repeat speeds are displayed at the status line you can type a number
from 1 through 5 to select intervals ranging from 15 through 50 characters per
second, or you can select Normal (6) to have WordPerfect use your computer’s
normal setting.

Normal for most computers is 11 characters per second. In other words, for
every second you hold a key down, 11 characters appear on-screen. This is the
recommended setting if you are using WordPerfect under a memory-resident
program such as Repeat Performance (see Troubleshooting below).

The default setting is for the fastest repeat speed, 50 characters per second.

Scrolling Speed
Increasing the cursor speed also increases the scrolling speed of the arrow keys.
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Troubleshooting

It is possible that the Cursor Speed feature conflicts with a memory-resident
program on your computer or that it does not work properly with your computer.
If this is the case, select the Normal option to avoid incompatibilities or use the

INC startup option to disable the Cursor Speed feature altogether (see Appendix
N: Startup Options in Reference).

See Also: Cursor Movement; Appendix N



D Date

If you keep the date and time current on your computer, you can use Date to

make sure that the documents you create always have the latest date and time in
them.

Date inserts the current date as text or as a code which is replaced by the current
date each time you retrieve or print that document.

samson Air Freighters

Mr. Cecil Armstrong
The Gr-raf-Gam Pomnar

14 Kel
Housto

Dear M

packag
regula

transp

samson Air Freighters

Mr. Cecil Armstrong

samson Air Freighters

Mr. Cecil Armstrong
The Great Gem Company
14 Keller Rd

Houston, TX 77004

Dear Mr. Cecil Armstrong,

our only reservation in transporting the jade Statuary is the

regulations which determine what we con ship.

our primary concern is the size of the cargo. To maximize safe
transport of the statuary, we suggest that each statue be contained
in palletized crates. This could create a problem since our largest
carrier, the B747F, is limited to crates that are 350 x 260 x 260
cn. in size with a maximum payload of 750 kilograms. The only
alternative is to ship the statues as indivisible items which
requires no packaging. However, we strongly discourage this because
of the statuary"s fragile nature.

You should be aware that Samson Air Freighters can only insure
each piece for 51,000,000, which is included in the $9.60 (per 100
miles X SO kilograms) price we quoted. Any increase in the
insurance will affect the shipping cost. To make it cost effective
for you, you may want to seek an independent insurer to supplement
our schedule.

To use the Date feature,

1
2

Move the cursor to the place where you want the date inserted.

Press Date/Outline (Shift-F5) to display the Date/Outline menu on the status

line.

Select an option to insert either the current date or a Date code into your text
(see Date Text or Date Code below).

Select a Date option from the Tools mem.

DATE
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Date Code

Selecting Date Code (2) from the Date/Outline menu inserts a Date code at the
cursor position. In the normal editing screen and when the document is printed,
the Date code is replaced by the current date. Each time you retrieve the
document at a later date, the Date code is updated to reflect the current date.

You can see the actual code in Reveal Codes (Alt-F3). It is displayed as
[Dateformat] where format represents the format in which the date will be
printed (see Date Format below).

Date Format

Normally, WordPerfect inserts the date as month day, year (e.g., November 19,
1991) but you can change the appearance of the date that is inserted.
WordPerfect offers a wide variety of formats. For example, November 19, 1991
can also be printed as: 19 November, 1991; Sun Nov 19, 1991; 11/19/91
(Sunday), etc. A date can also include the time, single words, or phrases.

To change the way the date is displayed, select Date Format (3) from the
Date/Outline menu to display the date format screen.

Character  Meaning
Day of sthe Momth

Month fnumb rr)t

Month word)

w Year (all four digits)

»Year (last two digits)

Day of the Week (word

Hour %mnuur clock)

Hour (12-hour clock)

Minyte

an [ pn

cCoOBNOU A WN L

Pad numbers less than 10 with a leading zero or
Abbreviate the month or day of the week

anmples; 31, 4 - December 25, 1984
%6 %3 1. 4 = Tue Dec 25, 1984
%2/%1/5 ¢6)\ = 01/01/85 (Tuesday)
52/51/5 se) - 1/ 1/85 (Tue)
6:90 - 10:55am

Date format: 31, 4

Enter a new date format, then press Exit (F7) to return to your document.

The numbers 0 through 9 on the date format screen represent different ways the
parts of the date and time can be written. You can include words, spaces, and
other punctuation with these numbers to create a date format. A format can be
up to 29 characters in total length.

Format Display

314 March 15, 1990

314— 890 March 15, 1990 — 10:55am
DATE: 2/1/5 (6) DATE: 3/15/90 (Tuesday)
TIME: 8:90 TIME: 10:55am



Inserting the percent sign (%) before a format number adds a zero to any number
that is less than ten or abbreviates the names of the months and days.

Format Display

2/1/5 3/6/90

%2/%]I/5 03/06/90

3 14 (6) November 21, 1990 (Monday)
%3. 1, 4 (%6) Nov. 21, 1990 (Mon)

Inserting the dollar sign ($) before a format number adds a space to any number
that is less than ten.

Format Display
2/1/5 3/6/90
$2/$ 1/5 3/ 6/90

The month and day names and their abbreviations are determined by a language
resource file (WP.LRS) provided with WordPerfect. If you want to change the

month and day names or their abbreviations, you can edit the WP.LRS file (see
Language Resource File in Reference).

Changing the date format affects only those date codes which are inserted after
the format has been changed. This lets you have several different date formats
within one document.

Any changes you make to the date format are erased when you exit WordPerfect.
To change your date format permanently, press Setup (Shift-Fl), select Initial
Settings (4), select Date Format (2), enter a new format, then press Exit (F7) to
save your changes and return to the normal editing screen (see Initial Settings in
Reference).

Date Text

Selecting Date Text (1) from the Date/Outline menu inserts the current date at
the cursor as text (e.g., March 18, 1991). The way the date is written is
determined by your current date format (see Date Format above).

Language

If a language code is in effect at the Date code, the text of the date and the date
format correspond with that language code. To change the language being used,
change the language code (see Language in Reference).

You can also change the way the month and day names and their abbreviations
are being written in a particular language by editing the language resource file
(see Language Resource File in Reference).

Merge Files

You can include a {DATE} command or a AD character in a primary or
secondary merge file. WordPerfect then inserts the current date when you
perform the merge. Move the cursor to the place in the file where you want the
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DELETE CODES

code inserted, press Merge Codes (Shift-F9), select More (6), type d to move to
the {DATE} code, then press Enter (see Merge in Reference).

\ifrong Date and Time

WordPerfect does not set the date and time. If your computer clock is working
correctly, but the wrong date and time are being displayed, you can usually reset
the correct time using the date and time commands at the DOS prompt. Refer
to your DOS manual for more information on these commands.

See Also: Initial Settings; Language; Language Resource File; Merge Codes

In WordPerfect, codes determine how your text looks both on the screen and at
the p'inter. However, these codes are not shown in the normal editing screen.
Sometimes unwanted codes or codes in the wrong place can cause problems.
For example, a misplaced Center code [Center] or Indent code [-“Indent] can
cause text to overlap.

When you run into problems with on-screen text, you can move through your
text in the Reveal Codes screen and delete any unwanted codes.

1 Press Reveal Codes (Alt-F3) to display the Reveal Codes screen.

13 Select Reveal Codes from the Edit menu.

The cursor is displayed as usual in the normal editing screen. It is highlighted in
the screen which displays text accompanied by codes (see Reveal Codes in
Reference).

2 Move the cursor to a code using any of the cursor keys or Search (see
Searching for Codes below).

3 Press Delete (Del) to delete the code at the cursor.

or

Press Backspace to delete the code to the immediate left of the cursor.
4 Press Reveal Codes again to return to the normal editing screen.

H Select Reveal Codesfrom the Edit menu.

Normal Editing Screen

You can delete codes while in the normal editing screen. However, since unseen
codes are often very important to your text, when you use Delete (Del) or
Backspace to delete text in the normal editing screen you are usually asked to
confirm the deletion of any codes. Type y to confirm the deletion or type any
other key to skip over the code without deleting it.



Since deleting some codes immediately changes the on-screen appearance of
your text, you are not asked to confirm the deletion of these codes when you use
Delete (Del) or Backspace. For example, you can delete a Center code fCenter],
a Date code [Dateformat], a Tab code [Tab], an Indent code [-“Indent], or a
Double Indent code [->Indent<-] without having to confirm the deletion.

Using any deletion method other than Delete (Del) and Backspace usually deletes
any codes within the deleted text. For example, most codes are deleted when
you use Delete Word (Ctrl-Backspace), Delete to End of Line (Ctrl-End), Delete
to End of Page (Ctrl-PgDn), etc. Most codes are also deleted when you use
Block (Alt-F4) to block text and then delete it.

However. WordPerfect is designed to keep the attributes of text the same unless
you change them. Consequently, if you block only one of the two codes in a
paired code (e.g., bold, underline, etc.) and delete the block, WordPerfect inserts
the necessary code to keep the bolded text bolded, the underlined text underlined,
etc. (see Attributes in Reference).

Should you accidentally delete codes, you can restore them using Undelete (see
Undelete in Reference).

Searching for Codes

Often you may want to delete several occurrences of troublesome codes from
your text. For instance, it's a good idea to delete any unnecessary paired bold
codes (e.g., [BOLD][bold]). You may also want to delete a series of different
margin settings in a document.

An easy way to locate and delete codes is to use #Search (F2) or “Search
(Shift-F2). Press #Search or ¢Search, press the key(s) used for a particular
feature, then press #Search again to begin the search. The cursor moves to the
right of the first occurrence of the code. You can then use Backspace to delete it.

For example, to search for a left or right margin setting you would press ¢Search
(F2), press Format (Shift-F8), select Line (1), then select Margins (6) to insert a
Left/Right Margin code [L/R Mar] in the Search string. Keep in mind that you
cannot press #Search, then type [L/R Mar] to search for the Left/Right Margin
code. You must use the necessary keystrokes to insert the actual code into the
search string (see Search in Reference).

To search for the second code in a set of paired codes, you need to first insert
both codes in the pair into the search string and then delete the first code. For
example, to search for the Bold Off code [bold], press ¢Search (F2), press Bold
(F6) twice to insert a pair of bold codes (i.e., [BOLD][bold]) into the search
string, press Left Arrow (<-) to move to the immediate right of the Bold On code
[BOLD], press Backspace to delete it, then press #Search to begin the search.

Replace (Alt-F2) can also be used to search for troublesome codes and delete
them. If you do not enter a replacement string, the code you search for is
deleted when you do the Replace (see Replace in Reference).

See Also: Replace; Reveal Codes; Search
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Delete Files

When you delete files, keep in mind that once you delete a file it is gone. You
cannot use WordPerfect to get it back.

To help keep close track of the files you are deleting, WordPerfect lets you
display an alphabetical list of all the files (or documents) in a directory. You
can then move the cursor through the filenames on the list and delete one file at
a time, mark certain files and delete them, or mark all the files in a directory and
delete them all at once.

Once a file has been deleted, its name disappears from the file list, and the
remaining files are displayed in alphabetical order.

To delete files,

1 Use List (F5) to display an on-screen listing of the files in a directory (see
List Files in Reference).

1H Select List Files from the File menu.

2 Use one of the Delete features as described in Notes below.

Notes Deleting a Single File
To delete any file on a displayed file list, use the cursor keys or Name Search to
move to the file, select Delete (2), then type v.

Deleting All the Files in a Directory

Files are divided into groups called directories. When a list of files is displayed
on-screen, the name of the directory being listed is displayed at the top center of
the screen. The names of any subdirectories within that directory appear
alphabetically at the first of the list, with a <Dir> to the right of each directory
name.

When a list of the files in a directory is displayed, you can delete all the files in
that directory by pressing Mark Text (Alt-F5) or Home,* to mark all the files
with an asterisk (*), selecting Delete (2), then typing y twice. Because the
deleted files will be lost, you are asked twice to confirm that you want to delete
all the marked files.

You cannot delete a directory until all the files in it have been deleted. Once a
directory is empty, you can highlight the empty directory, select Delete (2), and
type y to delete it (see Directories in Reference).

Deleting Several Files in a Directory

To delete several files at once, move the cursor to each file you want to delete,
type an asterisk (*) to mark each file, then select Delete (2). Type y twice, and
the marked files are deleted.

After pressing Delete (Del) or selecting Delete (2) to delete the marked files, if
you answer No by typing n, you are asked if you want to delete the file on
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Delete Text

Notes

which the cursor is resting even if it is not marked. You can then delete that file
by typing y or skip over it by pressing any other key.

You can unmark a marked file by moving the cursor to the filename and typing
an asterisk (*) again. Before selecting Delete (2), you can mark or unmark any
file on the list. Even after selecting Delete, you can press Cancel (FI) at any
time before completing the deletion process.

Restoring Lost Files

If you delete an important file, you may want to attempt to restore it using a file
recovery program. These recovery programs are not available from WordPerfect
Corporation. See your computer dealer for more information.

Short Cuts

You can display only a certain group of the files in a directory and then use
Mark Text (Alt-F5) to mark and delete those files as described in Deleting All
the Files in a Directory above.

After you press List (F5), the name of the current directory is displayed followed
by **. These three characters cause all the files in that directory to be displayed
(e.g., C:\\PAPERS\*.*).

For example, if a directory contains several files with the .LTR extension,
changing the ** to *LTR (e.g.,, C:\\PAPERS\*.LTR), then pressing Enter will
display only the .LTR files. You can then press Mark Text (Alt-F5) to mark all
the .LTR files, select Delete (2), then type y twice to delete them.

See Also: Directories; List Files

There are many different ways that you can delete part of the document you are
creating in WordPerfect. They are listed under Deletion Keystrokes below.

Codes

As you use Delete (Del) and Backspace to delete text in the normal editing
screen, you can delete both text and codes (see Appendix C: Codes for a list of
codes). When you attempt to delete an unseen code, you are normally asked to
confirm the deletion (see Delete Codes in Reference).

When you use any other deletion keystroke, any unseen codes within the text are
automatically deleted (see Deletion Keystrokes below).
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Deleting Using Block

Block makes it easy for you to delete large portions of text in a document. You
can use Move (Ctrl-F4) or Block (Alt-F4) and the cursor keys to block several
paragraphs or pages of text, and then delete the blocked text simply by pressing
Backspace or Delete (Del) and typing y (see Block in Reference).

Keep in mind that when you delete a block of text any codes within that text
will also be deleted. Consequently, you may want to press Reveal Codes
(AU-F3) before you block the text you are going to delete to avoid deleting any
impo tant codes (see Reveal Codes in Reference).

Deletion Keystrokes
The following table lists the keystroke(s) used to delete text.

Deletion Keystrokes

Character to the left of the cursor Backspace

Character at the cursor Delete (Del)

Word at the cursor Delete Word (Ctrl-Backspace)
Word at the cursor Delete Word (Ctrl-Del)

from the cursor to the end of Delete to End of Line

the line (Ctrl-End)

From the cursor to the end of Delete to End of Page

the page (Ctrl-PgDn), y

Dlocked text Backspace, y or Delete (Del), y
Delete from cursor to beginning Home,Backspace

of word

Delete from cursor to beginning Home,Delete

of next word

Restoring Deletions

If you mistakenly delete text, it is not immediately lost. WordPerfect stores your
last three deletions. Pressing Cancel (FI) displays your last deletion on the
screen and highlights it. You can then select Restore (1) to insert the currently
displayed deletion into your text at the cursor, or select Previous Deletion (2) or
press Up Arrow (T) or Down Arrow (4) to continue displaying up to your last
three deletions (see Undelete in Reference).

See Also: Block; Delete Codes; Reveal Codes; Undelete



Directories

Notes

A directory is a special file that holds the names of a group of files. It helps
you group your files to keep them more organized. You can organize your
directories with the List Files feature in WordPerfect (see List Files in
Reference).

To create a new directory while in WordPerfect,
1 Press List (F5).
3 Select List Files from the File menu.
2 Type an equal sign (=).
or
Press Enter, then select Other Directory (7) from the List Files menu.
3 Enter the name of a new directory (see Pathnames below).

4  Type y to create the directory.

Default Directory

Each time you start WordPerfect, a directory is selected for saving and retrieving
document files. This directory is called the default directory. when you save or
retrieve a document file, simply enter a filename to save the file to or retrieve
the file from the default directory.

You can find out which directory is the default by pressing List (F5). The
directory displayed at the bottom left of the screen is the default directory.

If you specify a documents directory using the Location ot Files feature in Setup
(Shift-FI1,6,7), that directory is used as the default directory in WordPerfect. If
you do not specify a documents directory, the default directory is initially set to
the directory from which you started WordPerfect (the DOS default directory).

Changing the Default

To change the default directory while in WordPerfect, follow the steps above
for creating a directory, but enter the name of a directory that already exists
rather than a new directory. This will change the default while you are in
WordPerfect; however, if you exit and restart WordPerfect, the default
returns to the documents (or DOS) directory.

Deleting a Directory
You can delete a directory from the List Files screen (F5,Enter). However, the
directory must be empty before WordPerfect can delete it.

1 Move the cursor to an empty directory (“<Dir>" appears in the Size column
for all directories) in the List Files screen.

DIRECTORIES 117



2 Select Delete (2).
0,-
Press Delete (Del).
3 Type y to delete the directory.

If the directory contains any files, you will receive an error message indicating
this. Look in that directory (see Look in Reference), delete or move all files
found there, then repeat steps 1 through 3 above.

Directory Alias

You can create an alias name for any existing directory to give the directory a
more descriptive name. This alias is displayed under the Descriptive Name
heading when you have the long display on for List Files (see List Files in
Reft rence).

To create a directory alias, first make sure you are in a blank normal editing
screen, then follow these steps.

1 Type the full name of the directory to which you want to give an alias (e.g.,
c:\wp51\work), then press End Field (F9).

2 Type a descriptive directory alias name (e.g.. My WP 5.1 work directory),
then press End Field.

3 Press Merge Codes (Shift-F9), then select End Record (2).

Yoi: can enter up to 68 characters or spacesfor a long document name. The first 30 of
those characters crm he displayed on the List Files Long Display screen. Characters
entered with Compose may take up more space than regular keyboard characters, so if
you decide to enter characters with Compose, you may not be able to use all 68
characters or spaces for the document name.

4 Repeat steps 1 through 3 for every directory to which you want to give an
alias.



When you finish, your screen should look similar to the following (your
directories and aliases will differ).

C :\wpSI{END FIELD)
My WordPerfect S.1 directorylend field)
(END RECORD}

c:Swp51\icarn{END FIELD)
My wp 5.1 learn directory!END FIELD)
(END RECORD)

c:\wp51\work(END FIELD
My wp 5.1 work directorylend field)
{END RECORD)

G :\work{END FIELD)
My work directory in wp 5.0{END FIELD)
{END RECORD)

C :\wpSO{END FIELD)
My WP 5.0 directory{END FIELD)
(END RECORD)

Field: 1 Doc 1 Pg 1 Ln 1" Pos 1"

5 Press Exit (F7), type vy, then enter c:\wp{wp}.din as the filename. If you are
running WordPerfect from a two disk drive system, enter a: or b: (enter the
letter of the disk drive you started DOS from) in place of “c:”.

The file must be named WPfWPj.DLN and must be saved in the root directory of the
partition you are working in.

Ifyou are running WordPerfect on a network, the file must be named using your initials
(e.g.,, WPDKKJ.DLN).

6 Type n to stay in WordPerfect.

When you want to edit this file (e.g., if you create more directories), retrieve the
file, edit it, then save it in the normal fashion (see Save in Reference).

List Files
The List Files feature lets you display all or some of the files in a directory. (A
directory has “<Dir>" in the Size column of the List Files screen.)

The file size, date, and time it was created (or last revised) are displayed with
each filename. All this information is kept in the directory. Additionally, if you
display the List Files screen in the “long” display (see List Files in Reference),
any directory alias is also displayed (see Directory Alias above).

Pathnames

A full pathname includes the drive letter and any subdirectory names. Each
name is separated by a backslash (\). For example, “C:\WP51” refers to the
WP51 directory (or file) on the C drive. “C:\WPS5I\TEST” refers to the TEST
subdirectory (or file) in the WP51 directory on the C drive.

When you want to specify a document filename that is not found in the default
directory, you should enter the full pathname. For example, if you want to
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retrieve a file named LETTER from the disk in drive A, you must enter a:letter
at the “Document to be Retrieved:” prompt.

See Also: List Files

Display Pitch

When you change the base font in WordPerfect, text may wrap differently on the
screen depending on the size of the font. While the width of the actual on-
screen characters does not change, the number of characters that fit on one line
varies.

In tfe screen below, notice where the text wraps.

Visitors are also welcome to eat at the company cafeteria and can
receive a free drink by showing the sticker they will receive as
they come in the door. Production Inspection personnel will be
demonstrating Halva corporation products and answering basic
questions about equipment and general applications.

Doc 1 Pg 1 Ln 1.67” Pas 6.1"

Here is the same text. Now notice where the text wraps.

Visitors are also welcome to eat at the company
cafeteria and can receive a free drink by showing the
sticker they will receive as they come In the door.
Production Inspection personnel will be demonstrating
Halva Corporation products and answering basic
questions about equipment and general applications.

Doc 1 Pg 1 Ln 2.39“ Pos 7.39"
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The only difference between the two screens is that the first screen represents
text that will be printed in 10pt text, while the second screen represents text that
will be printed in 18pt text. Since 18pt text is not only taller, but, in this case,
wider than 1Opt text, fewer 18pt characters can fit on one line.

WordPerfect doesn’t change the size of the characters on the screen, but it
accurately represents the number of characters that will fit on one line of the
page when the text is printed. It does this by calculating the actual printed width
of characters and spaces (taken from information in the printer files) to
determine how many characters will fit on the line of text.

Occasionally, WordPerfect may run across certain codes (Indents, Tabs, Table
Margins, and Column Margins) that call for an absolute measurement. In other
words, codes that are represented by a specific distance (e.g., 1.5") rather than a
certain number of characters. When WordPerfect encounters these types of
codes, it cannot use character information from the printer files to determine the
correct on-screen representation of the code. Instead, it uses the display pitch.

The display pitch determines the amount of space (in width) one on-screen
character or space represents. It is used to help WordPerfect display codes that
call for an absolute measurement. For example, if the display pitch is set to .1"
a 1" indent occupies the same space as 10 characters or spaces (10 x .1 = 1).

As the display pitch measurement is decreased, the document on the screen
expands horizontally. If you use the \" indent from the example above and
change the display pitch to .05", the indent occupies the same space on the
screen as 20 characters or spaces (20 x .05 = 1).

WordPerfect is initially set to adjust the display pitch automatically. If you wish,
however, you can enter a display pitch of your own. Since WordPerfect uses the
display pitch for Only the few codes mentioned above, you would only want to
change the display pitch when you want to change the space allotted on the
screen to these codes.

Please understand that Display Pitch only affects the way text is displayed on the
screen and does not affect the way text will be printed. If you want to see how
a document will appear when it is printed, use the View Document feature
(Shift-F7,6) (see View Document in Reference).

To set the display pitch,

1 Press Format (Shift-F8), then select Document (3) to display the Format:
Document screen.

LS Select Documentfrom the Layout menu.
Select Display Pitch (2).
3 Press y to have WordPerfect set the display pitch automatically.

N

or

Press n to enter a display pitch of your own.
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Notes

Display Setup
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DISPLAY SETUP

4 Enter a display pitch width. The initial (default) setting is .1".

If you are having WordPerfect set the display pitch automatically, the display pitch you
enter has no effect.

5 Press Exit (F7) to return to the document.

The setting you make with this option is in effect for the entire document.
When you save the document, the display pitch is saved with it. Once you exit
the dccument, the display pitch setting is returned to Automatic.

Codes

Unlike most other features, a display pitch change does not insert a code into
your document. The setting can be changed anywhere in your document and is
in effect for the entire document. When you save the document, the display
pitch is saved with the document. Once you exit the document, the display pitch
setting is returned to Automatic.

Columns

Display Pitch is probably most useful in making columns more readable on the
screen. For example, if text in columns overlaps, you can decrease the display
pitch to increase the amount of space between columns.

Rewrite
If there are no absolute measurement codes in the portion of the document on the
screen, selecting Rewrite (Ctrl-F3,3) resets Display Pitch and adjusts the text.

Tables

Disp ay Pitch can be used to increase or decrease the amount of on-screen space
allotted to table cells. The setting only affects the width of the cells and does
not affect the amount of text that can be entered in a cell.

See Also: Display Setup

The Display Setup feature lets you change the way WordPerfect displays text
and menus on the screen to make document creation and editing easier for you.
For example, you can change the way many things are displayed in the normal
editing screen and the View Document screen.

Read the information below to get a general idea about the options on the
Display Setup feature. More information on each of the options can be found
under specific headings in Reference.

The options on the Display Setup feature do not affect printed text.



1 Press Setup (Shift-FI).
CB Select Setup from the File menu.

2 Select Display (2).

3 Select an option from the Setup: Display menu, then make the necessary
changes.

General information about the options is included under Notes below. More
information can be found under specific headings in Reference.

4 Press Exit (F7) until you return to the normal editing screen.

Settings made with any of the Setup: Display menu options are stored in the
WP{WP}.SET file and remain in effect each time you start WordPerfect.

Notes Colors/Fonts/Attributes
This option determines the on-screen appearance of text with and without
attributes. The choices on its menu are tailored to your display card and
monitor.

For information on using this option, see Colors/Fonts/Attributes in Reference.

Edit-Screen Options

This option lets you change several things on the normal editing screen including
the way WordPerfect formats a document after editing changes. It also
determines how document comments, document filenames, hard returns, merge
codes, the Reveal Codes screen, and columns are displayed.

For information on using this option, see Edit-Screen Options in Reference.

Graphics Screen Type

This option determines the graphics driver WordPerfect will use to produce
correct graphics screens. Graphics screens include the Graphics Editor, the
Equation Editor, and the View Document screen.

For information on using this option, see Graphics Screen Type in Reference.

Menu Options

This option lets you change the way mnemonic selection letters are displayed. It
also lets you change the appearance of your pull-down menus and determines
whether you want the left Alt key to display the pull-down menu bar. For
information on using this option, see Menu Options in Reference.

Text Screen Type

This option determines the text driver WordPerfect will use to display text on the
screen in non-graphics screens. For information on using this option, see Text
Screen Type in Reference.
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View Document Options
This option lets you change the way the View Document screen appears. For
information on using this option, see View Document. Options in Reference.

See Also: Colors/Fonts/Attributes; Edit-Screen Options; Graphics Screen Type;
Menu Options; View Document, Options

Document Comments;
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DOCUMENT COMMENTS

Document Comments lets you add comments, or reminders, to your text which
will not actually be printed as part of the document. These comments appear in
a double-lined box whenever your document is displayed on the screen.

Important nates

3 July Managers Conf.
8 July New Emp. Mtg.
12 July Company Party
23 July Enduser Conf.
17 Aug. Acc. Trainin
Summer Social
E Z Summer Social date With the hotel before announcing it. D

Halva Hosts Open House

Invite your family, friends, and neighbors to take a look at Halva
Corporation, We are celebrating five years of business In Halva
Valley by hosting an open house this Thursday. The public is
invited to participate in conducted tours beginning at the
Reception Lobby every half-hour from 9:00 o.m. to 4:00 p.m. The
tour includes a tilel uvorvioiw of company history, n slide
presentation, and a look at Production Inspection._

C:sSNEWSLET.JUN Doc 1 Pg 2 Ln 6.92" Pos

Comments can serve several purposes. For example, you can use comments to
rem nd you of changes you need to make to a document (information that needs
to be added when it becomes available, etc.). You might include suggested test
questions on a class-study paper as comments. Also, several people who are
read ing the same file can list their suggested changes as comments so that the
original text of the document remains intact.

To create a comment,

1 Press Text In/Out (Ctrl-F5), then select Comment (4).
[[B Select Comment from the Edit menu.

2 Select Create (1).



Notes

An empty comments box is displayed.

3 Type the text of your comment (see Entering and Editing Text below).
4 Press Exit (F7) to save the comment and return to your document.
The comment is inserted at the cursor.

You can also place existing text in a comment. Block the text you want to
include using Alt-F4, press Text In/Out (Ctrl-F5), then type y. Any codes in
the blocked text will be ineffective in the comment, but will become active again
if the comment is converted back to text.

Codes

Creating a comment inserts a Comment code [Comment] into your text. You
can delete the comment by deleting the code, either in Reveal Codes (Alt-F3) or
in the normal editing screen. If you delete a comment accidentally, you can
restore it just as you would restore any other deleted text (see Undelete in
Reference).

When comments are hidden (see Hiding Comments below), you can find them by
using ¢Search (F2) and eSearch (Shift-F2) to search for the Comment code (see
Search in Reference).
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A ONE LINE OF TEXT
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DOCUMENT COMMENTS

A comment may artificially separate a line of text when it does not appear at the
first of the line, as in the following example.

location of management and accounting. We will also need your input
on same new ideas that have been suggested far more efficient Han-
dim3 of paycheck ond mail distribution.

Halva Hosts Open House

Invite your family, friends, and neighbors to take a look at Halva
Corporation. we are celebrating five years of business in Halva
Valley by hosting an open house this Thursday. The public is
inv:ited to participate in conducted tours beginning at the
"Reception Lobby every half-hour from 9:00 a.m.

> nonfirm these times before printing this document.

to 4:00 p.m. The
tour includes a brief overview of company history, a slide
presentation, and a look at Production InspeCtiOn._

Visitors are also welcome to eat at the company cafeteria and can
receive a free drink by showing the sticker they will receive as
thty come in the door. Production Inspection personnel will be
demonstrating Halva Corporation products and answering basic
questions about equipment and general applications.
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However, a comment is always considered as a single code. Consequently, when
you use the arrow keys to move through text, you can pass over the comment
with a single keystroke. Also, the comment will not affect the line of printed
text.

Columns, Tables, and Comments
When you include a comment in text which is formatted in parallel or newspaper

colmns. the comment does not appear on-screen. If you format existing text
into newspaper columns, any comments within the text wut not appear. The

comments will reappear if you remove the Column codes (see Turning Columns
On and Off under Columns, Newspaper in Reference).

The comments also do not appear if they occur within Table codes. However,
the comments will reappear if you remove the Table codes.

Editing an Existing Comment
Tc edit an existing comment, move the cursor just after the comment, press
Text/In Out (Ctrl-F5), select Comment (4), then select Edit (2).

WordPerfect first searches backward for a comment. If it cannot find a
comment it searches forward. WordPerfect then displays the first comment it
finds on the screen in the comments box. You can then edit the comment and
press Exit (F7) to save your changes.

Entering and Editing Text

You can use the standard cursor movement and deletion keys to edit the text of a
comment. You can also use Bold (F6) and Underline (F8) to emphasize text,
and Compose (Ctrl-2) to add any character from a WordPerfect character set to
tile comment (see Compose in Reference).



Document Compare

However, you cannot use the Speller, Thesaurus, or Search while in the
Comments screen.

Pressing Cancel (FI) and typing y while in the Comments screen lets you return
to your document without saving any changes you have made.

A Document Comment can only contain 1024 bytes of information.

Hiding Comments

You may want to edit a document without having on-screen space taken up by
comments. You can keep comments from being displayed on the screen by
turning off Comments Display in Setup (Shift-FI,2,6,2,n) (see Edit-Screen
Options in Reference).

Printing Comments

Neither the Comment code, nor the comment itself has any effect on printed text.
If you want a comment to be printed, you need to change it into text. With the
cursor just after the comment, press Text/In Out (Ctrl-F5), select Comment (4),
then select Convert to Text (3).

WordPerfect searches backward from the cursor. If it does not find a comment
it searches forward. WordPerfect then changes the first comment it finds to text.
Since the characters in the comment are inserted immediately at the comment
code, you may then need to add spacing and punctuation before and after the
comment to blend it correctly into the existing text.

See Also: Edit-Screen Options

With Document Compare you can have WordPerfect compare two different
versions of the same document and note the differences in them.

For example, suppose that you send a disk copy of a report to a co-worker
requesting his or her suggestions. Your co-worker then returns the revised report
to you. You can retrieve the changed report to the screen and use Document
Compare to have WordPerfect mark the passages in the document on the screen
that differ from the original.

Or, suppose that you retrieve a document to the screen and make several changes
to it. You then want to know how it compares with the original. You can use
Document Compare to mark the passages that have been changed.

WordPerfect marks differences phrase-by-phrase and not word-by-word (see
Phrases below). The smaller the document, the less confusing the comparison
can become.
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DOCUMENT COMPARE

You may want to save a backup copy of the document on the screen just before
making the comparison (see Undoing the Comparison below).

To compare a document on the screen with another document on disk,
1 P'ess Mark Text (Alt-F5), then select Generate (6).
[B Select Generate from the Mark menu.

2 Select Compare Screen and Disk Documents and Add Redline and Strikeout
CD.

You are asked to enter the name of a document on disk that you want to
compare with the on-screen document. If the on-screen document has been
saved, its filename is displayed as the default choice.

3 If you have made changes to the document on-screen and you want to
compare it with the original which is still on disk, press Enter.

or
Enter the name of a document on disk.

While the two documents are being compared, a counter appears at the left end
of the status line.

When the comparison is finished, the differences are marked and the cursor is
placed at the beginning of the on-screen document (see Difference Indicators
below).

Difference Indicators
Whim WordPerfect compares the text in the two documents, it uses several
indicators to note the differences.

Difference Indicators

Added Phrases A pair of Redline codes [REDLN][redin] are placed
around the phrase that was added.

Deleted Phrases A pair of Strikeout codes [STKOUT][stkout] are placed
around the phrase that was deleted.

Moved Phrases Inserts THE FOLLOWING TEXT WAS MOVED
before and THE PRECEDING TEXT WAS MOVED
after the phrase that was moved.

Redline and Strikeout codes do not appear in the normal editing screen. They
can be seen in Reveal Codes (Alt-F3).

Normally, Strikeout puts a dash through text (see Redline/Strikeout in Reference).
You have three options as to the way redlined text appears in print (see Redline
Method under Document Format in Reference).

The appearance of Redline and Strikeout text in the normal editing screen
depends upon your monitor and display card capabilities. If Redline and



A ADDED PHRASE
A DELETED PHRASE
A MOVED PHRASE

Strikeout markings are not being displayed in your normal editing screen, you
may want to modify your settings for the Redline and Strikeout attributes under
Colors/Fonts/Attributes in Setup (Shift-F 1,2,1) so that you can clearly identify
these passages (see Colors/Fonts/Attributes iN Reference).

You can also display the marked passages by printing the document, or by
previewing the printed text in View Document (Shift-F7,6), as in the following
example.

tvlrtvne your friands to talcs a look at
Halva Ccrpara-icn

< -m L
feyr -ii0-s-i-irig---a-fr-epeii--k-e-u- s& £ A---TJiuM3v--

-HE-F-OLiOVI-H3— At-SV-E-S-
>"-{'tie pull)'l(?gl is welcome

T-KE-EIEEGE>; P - TEST-¥-A5--fi&V-|-B-

Tours of our facilities will begin, at the
Receptlon Lobby every half-hour  from 9:0

a m to 1:00 pim

The tour . inc Iudes a brief overview of
company histor slide presentation, and
a loot” at Pro uctlon Inspection

Phrases
The phrases used as a basis of comparison are, as much as possible, the
sentences in your document (not the words).

A phrase is defined as the text found between two phrase markers. The phrase
markers WordPerfect uses are those items which normally punctuate sentences,
including punctuation marks (period, comma, exclamation point, question mark,
colon, semicolon), Hard Return codes [HRt], Hard Page codes [HPg], Footnote
codes [Footnote:#;[Note Num] text]. Endnote codes [Endnote:#;[Note Num] text},
and the end of the document.

WordPerfect starts from the first word in your document and compares the text
in the two documents until it reaches a phrase marker. If any change has been
made, WordPerfect marks the phrase, noting the change (see Difference
Indicators above). WordPerfect then starts the comparison again from that point.
It continues on through to the end of the document, marking from phrase marker
to phrase marker.

The comparison includes any text found within the footnotes, endnotes, and
tables in your document. If a change has been made to the text included in these
features, it is marked.

However, the comparison does not include changes made to text found within
graphics boxes, headers, and footers.
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Keep in mind that, since punctuation can vary, the phrases that WordPerfect
marks may not always correspond to the actual grammatical sentences in your
document. For example, in order to cut down on the length of the phrases being
used for comparison, WordPerfect considers any group of words that end with
commas as a phrase. Grammatically, such a group of words is an incomplete
sentence.

Undoing the Comparison

After making a comparison, you may want to restore the document on the screen
to the way it was before the comparison was made. To have WordPerfect
remove the markings, press Mark Text (Alt-F5), select Generate (6), select
Remove Redline Markings and Strikeout Text from Document (1), then type y.

This deletes Redline codes, Strikeout codes (and the text found in between
them), and the notations around the moved phrases (see Difference Indicators
above). Note that this also deletes any Redline codes and Strikeout codes (and
the tect found in between them) that were already a part of your document
before you made the comparison. It leaves the cursor at the end of the
document.

If many differences have been marked, restoring a compared document to its
original state can sometimes become complicated. Consequently, when you are
comparing two documents that you know you will want to keep, it’s a good idea
to have a copy of both documents on disk before making the comparison. You
can then exit the new compared document without saving it and retrieve either
cirigiral.

See Also: Redline/Strikeout

Document Conversion, WordPerfect 4.2 to 5.1
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The following section discusses how to convert a WordPerfect document created
in WordPerfect 4.2 to a WordPerfect 5.1 document. While WordPerfect “4.2” is
used, these instructions are applicable for any WordPerfect documents created
with WordPerfect 4.2 and previous versions.

If you want to convert a WordPerfect 5.1 document to WordPerfect 4.2, see
Document Conversion, WordPerfect 5.1 to 4.2 in Reference.

Ifyou want to convert a WordPerfect 5.0 document to a WordPerfect 5.1 document,
simply retrieve the 5.0 document into 5.1, then save it. All codes should convert
completely. Ifyou want to convert a WordPerfect 5.1 document to WordPerfect 5.0, see
Text In/Out iN Reference.

The easiest way to convert a WordPerfect 4.2 document to WordPerfect 5.1 is to
simply retrieve the document in 5.1. All text and most codes are converted to
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5.1. If you are happy with the document as it is, save it in 5.1 and your
document on disk is converted.

After you retrieve the document, you may notice that some of your 4.2 codes did
not convert (e.g., Font/Pitch, Bin Number). If this is the case, you may want to
use a conversion resource (.CRS) file to convert those codes.

When you retrieve a 4.2 document in 5.1, WordPerfect displays the message
“Document Conversion in Progress.” As part of the conversion process,
WordPerfect searches for a conversion resource file. This file, which you can
create (using the STANDARD.CRS file as a model), translates “untranslatable”
4.2 codes (codes that have no equivalent 5.1 codes). It also inserts codes that
may be necessary to properly format your work at the beginning of your
converted document.

To create a conversion resource (or .CRS) file,
1 Press Retrieve (Shift-FIO).

J Select Retrieve from the File menu.
2 Retrieve the STANDARD.CRS file.

Important: STANDARD.CRS is installed with the WordPerfect utility programs. 1f you
chose not to install the WordPerfect utility programs when you installed WordPerfect (or
have not subsequently done so), you need to do so before you can retrieve
STANDARD.CRS (see the Installation Instructions card).

3 Press Reveal Codes (Alt-F3) to turn on Reveal Codes.
3 Select Reveal Codes from the Edit menu.

4 Modify the commands in STANDARD.CRS.

STANDARD.CRS contains a series of commands represented by capital letters
and. in some cases, numbers and comments. These commands, separated by
hard returns, serve as the basis for the conversion resource file you will create.

Some of the lines of commands are used in the 4.2 to 5.1 conversion process.
These lines start with FO, FF, BN, SZ, CH, BC, and IP. One line, (the one that
starts with MB), is used in the 4.2 to 5.1 conversion process as well as the 5.1 to
4.2 conversion process. The rest of the lines are used in the 5.1 to 4.2
conversion process (see Document Conversion. WordPerfect 5.1 to 4.2 in
Reference).

Each command line contains an equal sign (=). If you think of the file as a
translation file, 4.2 “language” is on the left side of each equal sign, and 5.1
“language” is on the right side of each equal sign (4.2 to 5.1 commands only).
Basically, when WordPerfect converts a document from 4.2 to 5.1, it searches
for 4.2 codes (represented by the letters and numbers on the left side of the equal
sign) and replaces them with 5.1 codes which you will enter on the right side of
the equal sign. The process for editing STANDARD.CRS commands differs
depending on the type of command (see the command headings under Notes
below).
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You should always edit a .CRSfile with Reveal Codes (Alt-F3) on.
5 Press Exit (F7) to save the file and clear the screen.

rBI Seiect Exitfrom the File menu.

6 Type y to save the document.

7  Enter the name (including the complete pathname) of your printer (.PRS) file
(minus the .PRS extension), and include a .CRS extension (e.g.,
C:\WP51\HPLASEII.CRS).

If you don't know the name of your printer file, use List Files to display your
printe mfiles (see List Files and Printer, Select in Reference) or use the Printer:
Edit screen (see Printer Edit in Reference).

You don’t have to rename the .CRS file. If you name the .CRS file with your
printer filename, however, it will be used when that printer is selected. If you
are using more than one printer, you can create a .CRS file for each of your
printers. If you don't have a .CRS file for the selected printer, WordPerfect uses
STANDARD.CRS. If WordPerfect can’t find any .CRS files (STANDARD.CRS
or otherwise), it converts the document without one.

In order for WordPerfect to use .CRS files, they must be located in the directory
where your printer files (.PRS) are located, your default directory, or the
directory where WP.EXE is located (see Location of Files in Reference).

B Type n to clear the screen.

After you create the .CRS file, retrieve your WordPerfect 4.2 documents into 5.1.
You can edit the .CRS file for each document you retrieve, or you can retrieve
them one after another without ever editing your .CRS file again.

Beginning Codes Command

The Beginning Codes command is a way of allowing you to insert codes at the
beginning of your converted documents (after the code for the SZ command) and
is helpful for including any codes such as styles, headers, and footers that you
may want to use to format 5.1 documents.

This command allows you to convert 4.2 documents whose defaults were
changed with the /s option in 4.2.

To edit the BC command.

1 Find the line of STANDARD.CRS that contains the letters BC.
2 Move the cursor to the immediate right of the equal sign (=).

3 Include the codes just as you would in any other 5.1 document.

For example, if you want to include a Tab Setting, press Format (Shift-F8),
select Line (1), select Tab Set (8), then set your tabs. The code is inserted after
the equal sign.
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A BC command in Reveal Codes should look similar to the one below.

BC=[Tab Set:Abs; 2"][HR{]

This particular command will insert the Tab Set code at the top of the converted
document.

You can include as many codes as you like as long as you end the command
with a hard return. In fact, you can enter codes here that you cannot enter in the
Initial Codes feature.

Bin Number Commands

WordPerfect 4.2 Bin Number codes are represented in STANDARD.CRS by
BN #. WordPerfect 5.1 Bin Number replacement codes are represented in
STANDARD.CRS by a comment. If you want to convert Bin Number codes,
you should replace the comment with a 5.1 Paper Size/Type code. In a 5.1
document, this Paper Size/Type code is matched with an existing Paper
Size/Type definition on the Paper Size/Type menu and tells WordPerfect where
to find the form you want to print on (see Paper Size/Type in Reference).

To edit a Bin Number command.

Find the command representing the Bin Number code you wish to replace and
move the cursor to the Comment code on that line.

1 Press Format (Shift-F8), then select Page (2) to display the Page Format
menu.

fB Select Page from the Layout menu.
2 Select Paper Size/Type (7).
3 Select a paper size and type (see Papa Size/Type in Reference).

4 Press exit (F7) until you return to the normal editing screen with
STANDARD.CRS displayed.

5 Delete the comment.

An edited Bin Number command in Reveal Codes should look similar to the one
below.

BN I=[Paper Sz/Typ:9.5"x4",Envelope][HR{]
Extended Character Command

The Extended Character command is for those of you who changed information
in a 4.2 character table with the WordPerfect 4.2 Printer Program.

1 Find the line of STANDARD.CRS that contains the letters CH.
2 Move the cursor to the equal sign (=).

3  Type the 4.2 font number, a comma, the number of the character within that
font that you wish to convert, then a space.
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4 Move the cursor to the immediate right of the equal sign.

5 Using Compose (Ctrl-2 or Ctrl-v), insert a character from the WordPerfect
5.1 character sets (see Compose in Reference).

The result in Reveal Codes should look like the one below.
CH 1,9 =[m: 4,23][HR{]

The 5.1 code located to the right of the equal sign will only expand if the cursor
is resting on it.

Keep in mind that you only need to edit this command if you changed
information in a 4.2 character table. If you did not, the characters convert
correctly without this command.

Font On/Off Commands

The Font On/Off commands (FO #.# and FF ##) in STANDARD.CRS represent
WordPerfect 4.2 Font/Pitch codes. FO stands for “font on” while FF stands for
“font off.” 4.2 Font/Pitch codes are not paired codes and do not have an “on” or
an “off.” You will see why STANDARD.CRS includes “on” and “off’ when
you read the examples that follow.

WordPerfect 5.1 codes on the Font On/Off command lines are represented by a
comment. If you use STANDARD.CRS without making any editing changes,
Font/Pitch codes in 4.2 documents would be replaced by a comment when a
docament is converted. It is the comment that you want to replace as you create
your own .CRS file.

To do so,

1 Find the Font On command line representing the Font/Pitch code you want to
translate, then place the cursor on the [Comment] code.

For example, if you have a [Font Change: 1,10] code in a 4.2 document you want
to convert (where 1is the font number and 10 is the font pitch), move the cursor
to :he comment code associated with the FO 1,10 command.

2 Insert the 5.1 code that will replace the 4.2 Font/Pitch code by following the
same steps you would use to insert the 5.1 code in any document (see Open
Codes and Paired Codes below).

Open Codes
Open codes instruct WordPerfect to change the format of text from a certain
point forward. They are never turned off; instead, they are replaced by other
open codes. If you insert an open code, the Font Off command line (FF ##)
is not needed.

For example, suppose you want to convert a 4.2 [Font Change] code to an
open code such as one of the fonts on the Base Font list. To make the
proper editing change to the Font On command, place the cursor on the
[Comment] code, then perform the following steps.
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Press Font (Ctrl-F8), and select Base Font (4) to display the list of fonts.

Select Base Fontfrom the Font menu.
Move the cursor to the font you want to choose.
Choose Select (1) to insert the Base Font code.

Delete the comment associated with the FO command line.

a A W N O P

Delete the entire FF command line associated with the font you are
working with.

When you are finished, the command in Reveal Codes should look similar to
the one below.

FO I,10=[Font:Helv 14.4pt Bold][HRt]

The font is one of your own choosing, but the important thing to notice is
that the command ends with a hard return and there is no accompanying
Comment code or FF command.

Paired Codes

Unlike open codes, paired codes have a beginning and an end. They are
turned on before a block of text and are turned off following the text (e.g.,
[BOLD][bold]). When you wish to replace a 4.2 Font/Pitch code with a
paired 5.1 code, you must use both the Font On (FO ##) and Font Off (FF
#.#) commands.

As an example, suppose you want to convert a 4.2 Font Change code [Font
Change] to a 5.1 paired code such as one of the font attributes (e.g., Italics).
To make the proper editing change to the Font On and Font Off commands,
make sure the cursor is positioned on the Font On Comment code repre-
senting the Font/Pitch code you want to convert, then perform the following
steps.

1 Press Block (Alt-F4) to turn on Block.
O Select Block from the Edit menu.

2 Move the cursor immediately to the Comment code associated with the
FF #,# command line representing that same Font/Pitch code.

3 Follow the steps you normally would to select the attribute.

4  Delete the Comment codes on both the Font On and Font Off command
lines.

When you finish inserting a paired code, the command in Reveal Codes
should look similar to the one below.

FO 2,10=[ITALC][HRY]
FF 2,10=[italc][HRt]

The FF #,# command line will appear in the attribute that you chose.
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Again, the attribute code would be one of your own choosing, but each
command should not contain a Comment code and must end with [HRt], A
Font Off command is necessary with all paired codes.

Translating Other Font/Pitch Codes

If your Font/Pitch code is not represented by any of the displayed Font
On/Off commands, you can edit one of the existing command lines or create
one of your own. If you create one of your own, use the same syntax as the
rest of the Font On/Off commands.

I: is important that comments for commands representing codes you want to
convert are deleted. If they are not, they will appear in the converted
cocument.

Initial Pitch Command

The Initial Pitch command does not have an equivalent command in 4.2. If your
4.2 document is initially set for a pitch other than 10 pitch, however, you will
need to edit this command.

To co so,

1 Find the letters IP in STANDARD.CRS.

2 Move the cursor to the immediate right of the equal sign (=) on that line.
3 Edit the initial pitch as necessary.

An edited Initial Pitch command in Reveal Codes should look like the one
shown below.

IP= 13[HRtl

As you probably know, 4.2 margins, tabs, indents, tab aligns, and column
margins were based on the current pitch of your document. Similar features in
5.1 are measured absolutely from the margins. (Although tabs in WordPerfect
5.1 can be measured absolutely, the default is for tabs to be measured relative to
the margin.) By specifying the pitch of your 4.2 document, 5.1 absolute
measurements are converted correctly.

Margin Bias Command

The Margin Bias command is similar to the Size and Beginning Codes
commands in that it does not have an equivalent 4.2 code. It is used, however,
to correct adjustments you may have made to features which call for absolute
horizontal measurements (margins, tabs, column margins) because of an
unprintable region.

Most laser printers have an unprintable region. This region is an area measured
from all four edges of a form in which you cannot print. In 4.2, margins, tabs,
and column margins all were measured from the unprintable region. For
example, if you set the left margin to 10 for a 10-pitch font and the unprintable
region was .25", the actual left margin was 1.25" (1" + .25").
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If you compensated in 4.2 for the unprintable region by reducing the margins,
you will not get the same margins in 5.1. Suppose you reduced a margin in 4.2
to 7 for a 10-pitch font to give you a .95" margin (.7" + .25"). In 5.1,

unprintable regions are not taken into account when measuring margins (unless
the margin is less than the unprintable region), so that same margin will result in
a .7" margin in 5.1.

To edit the Margin Bias command,

1 Find the letters MB in STANDARD.CRS.

2 Move the cursor to the immediate right of the equal sign (=) on that line.
3 Edit the margin bias measurement as necessary.

The measurement you type is the number of inches you want to add to your 4.2
measurements. If you type .25, .25" is added to your 4.2 measurements. For
example.

MB=.25[HRtJ

The MB command is initially set to zero. If you delete this zero and do not
enter a number, WordPerfect adjusts for the unprintable region by looking at the
Minimum Margin setting for your printer in your printer definition (.PRS) file.

The Minimum Margin setting is usually very close to the unprintable region
measurement, so you may just want to delete the zero, convert the 4.2 document,
then see how it looks.

Size Command
The Size command is simply a way of telling WordPerfect 5.1 the size of paper

you plan to use. While 4.2 did not actually have such a code, 5.1 needs this
inform ation to Calculate margins, tabs, columns, and tab aligns correctly.

This command has a default setting of Standard 8 1/2" x 11" and does not need
to be edited if you are planning on using that size of paper in 5.1. If you are
using a different paper size,

1 Find the line of STANDARD.CRS that contains the letters SZ.

2 Move the cursor to the immediate right of the equal sign (=) on that line and
delete the existing Paper Size/Type code.

3 Press Format (Shift-F8), then select Page (2) to display the Page Format
menu.

Ia Select Page from the Layout menu.
4  Select Paper Size/Type (7).
5 Select a paper size and type (see Paper Size/Type in Reference).

6 Press Exit (F7) until you return to the normal editing screen with
STANDARD.CRS displayed.
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When a document is converted, the code is placed before any other codes or text.
An edited Size command in Reveal Codes should look like the one below.
SZ=[Paper Sz/Typ:9.5"x4" Envelope][HRt]

See Also: Convert Program; Document Conversion, WordPerfect 5.1 to 4.2;
Text In/Out

Document Conversion, WordPerfect 5.1 to 4.2
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The following section discusses how to convert a WordPerfect document created
in WordPerfect 5.1 to a WordPerfect 4.2 document.

If ycu want to convert a WordPerfect 4.2 document to WordPerfect 5.1, see
Document Conversion, WordPerfect 4.2 to 5. in Reference.

Ifyon want to convert a WordPerfect 5.1 document to WordPerfect 5.0. see Text In/Out
in Reference. Ifyou want to convert a WordPerfect 5.0 document to a WordPerfect 5.1
document, retrieve the 5.0 document into 5.1. then save the document. Alt codes should
convert completely.

The easiest way to convert a WordPerfect 5.1 document to WordPerfect 4.2 is to
use the Save as WordPerfect 4.2 option on the Text In/Out key (Ctrl-F5,3,3).
Most text and many codes are converted to 4.2. If you are happy with the
document as it is, you need to do nothing more.

After you save your document, you may notice that some of your 5.1 codes did
not convert. Most WordPerfect 5.1 codes that have no equivalent in
WordPerfect 4.2 are removed.

Some WordPerfect 5.1 codes that have no equivalent in WordPerfect 4.2 can be
converted to 4.2 codes with the aid of a conversion resource (.CRS) file. This
file, which you create (using the STANDARD.CRS file as a model), translates
some "untranslatable” 5.1 codes (codes that have no equivalent 4.2 codes).
When you use the Save as WordPerfect 4.2 option on the Text In/Out key,
WordPerfect looks for a .CRS file.

To create a conversion resource (or .CRS) file,
1 Press Retrieve (Shift-FIO).

US Select Retrieve from the File menu.

2 Retrieve the STANDARD.CRS file.

Important: STANDARD. CRS is installed with the WordPerfect utility programs. |f you
did not install the WordPerfect utility programs when you installed WordPerfect (or have
not subsequently done so), you need to do so before you can retrieve STANDARD.CRS
(see the Installation Instructions card).
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3 Press Reveal Codes (Alt-F3) to turn on Reveal Codes.
CB Select Reveal Codes from the Edit menu.

4  Modify the commands in STANDARD.CRS.

STANDARD.CRS contains a series of commands represented by capital letters
and, in some cases, numbers and comments. These commands, separated by
hard returns, serve as the basis for the conversion resource file you will create.

Some of the lines of commands are used in the 5.1 to 4.2 conversion process.
These lines start with FT, AO, AF, BP, and WC. One line (the one that starts
with MB) is used in both the 5.1 to 4.2 conversion process as well as the 4.2 to
5.1 conversion process. The other lines are used in the 4.2 to 5.1 conversion
process (see Document Conversion, WordPerfect 4.2 to 5.1 in Reference).

Each command contains an equal sign (=). If you think of the file as a
translation file, 5.1 “language” is on the left side of each equal sign, and 4.2
“language” is on the right side of each equal sign (5.1 to 4.2 commands only).
Basically, when WordPerfect converts a document from 5.1 to 4.2, it searches
for 5.1 codes represented by letters, numbers, and codes on the left side of the
equal sign and replaces them with 4.2 information which you will enter on the
right side of the equal sign. The process for editing STANDARD.CRS
commands differs depending on the type of command (see the command
headings under Notes below).

You should always edit a .CRSfile with Reveal Codes (Alt-F3) on.
5 Press Exit (F7) to save the file and clear the screen.

CB Select Exitfrom the File menu.

6 Type y to save the document.

7 Enter the name (including the complete pathname) of your printer (.PRS) file
(minus the .PRS extension), and include a .CRS extension (e.g.,
C:\WP51\HPLASEII.CRS).

If you don’t know the name of your printer file, use List Files to display your
printer files (see List Files and Printer, Select in Reference) or use the Printer:
Edit screen (see Printer, Edit in Reference).

You don’t have to rename the .CRS file. If you name the .CRS file with your
printer filename, however, it will be used to convert documents when that printer
is selected. If you are using more than one printer, you can create a .CRS file
for each of your printers. If WordPerfect can't find a .CRS file for a printer,
WordPerfect uses STANDARD.CRS. If WordPerfect can’t find any .CRS file
(including STANDARD.CRS), it converts the document without one.

In order for WordPerfect to use a .CRS file, it must be located in the same
directory as your printer (.PRS) files, the default directory, or the directory where
WP.EXE is located (see Location of Files in Reference).

8 Type n to clear the screen.
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After you create the .CRS file, use the Save as 4.2 option on the Text In/Out
menu to save your WordPerfect 5.1 documents as 4.2 documents. If you wish,
you can edit the CRS file for each document you convert, or you can convert
them one after another without ever editing your .CRS file again.

Notes Attribute On/Off Command
The Attribute On/Off command (AO and AF) in STANDARD.CRS represents
WordPerfect 5.1 attribute codes (e.g., Italics, Small Caps). AO stands for
“attribute on” while AF stands for “attribute off.” Attribute codes are converted
to a 4.2 Font/Pitch code.

To edit Attribute On/Off commands,

1 Move the cursor to the immediate right of the AO command.
2 Fress Block (Alt-F4) to turn on Block.

IB Select Block from the Edit menu.

3 Move the cursor to the immediate right of the AF command.
4 Select the attribute you want to convert.

Select the attribute just as you would in any 5.1 document (see Attributes in
Reference).

5 Move the cursor to the immediate right of the equal sign (=) on the AO
command line.

Edit the Font and Pitch command as necessary.

7 Move the cursor to the immediate right of the equal sign on the AF
command line.

8 Edit the Font and Pitch command as necessary.

The Font and Pitch command on the AO and AF command lines do not have to
(and probably will not) be the same. The Font and Pitch command on the AO
command line is the font and pitch you want to use at the beginning of the
surrounded text. The Font and Pitch command on the AF command line is the
font and pitch you want to use at the end of the surrounded text.

An example of an edited Attribute On/Off command as it should appear in
Reveal Codes is shown below.

AO[ITALC]=3,10[HR{]
AF[italc]=I,10[HR{]

In this example, the 5.1 Italics On code is replaced with a 4.2 Font 3, Pitch 10
code. The 5.1 Italics Off code is replaced with a 4.2 Font 1, Pitch 10 code.

The 4.2 font you select on the AF line should usually be the default font for the
document.
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Bin Paper Command

WordPerfect 5.1 Paper Size/Type codes that are used to select paper from a
particular bin location are represented in STANDARD.CRS by BP. WordPerfect
4.2 Bin Number codes are represented by a number.

To edit a Bin Paper command.

1 Move the cursor to the immediate right of the BP command.
2 Delete the existing Paper Size/Type code.

3 Insert a Paper Size/Type code.

Insert the code just as you would in any 5.1 document (see Paper Size/Type in
Reference).

4 Move the cursor to the immediate right of the equal sign (=) on the same
command line.

5 Edit the Bin Number as necessary.

An edited Bin Paper Command in Reveal Codes should look similar to the one
shown below.

BP[Paper Sz/Typ: 9.5"x4", Envelope]=2[HRt)
The command in the example above would convert a 9.5" x 4" Envelope Paper
Size/Type code to a 4.2 Bin Number 2 code.

Font Command

Font (FT) commands in STANDARD.CRS represent WordPerfect 5.1 Base Font
codes (e.g., [Font:Tms Rmn 10pt]). WordPerfect 4.2 Font codes on the Font
command lines are represented by two numbers. For example, Font 1, Pitch 10
is represented by 1,10.

To edit a Font command line,
1 Move the cursor to the immediate right of the FT on the Font command line.
2 Insert the 5.1 Base Font code that you wish to convert.

Insert the code just as you would insert a Base Font code in any 5.1 document
(see Font in Reference).

3 Move the cursor to the immediate right of the equal sign (=) on the same
command line.

4 Edit the Font and Pitch command as necessary.

For example, if you want to convert a 5.1 Times Roman IOpt Base Font to a 4.2
Font 2, Pitch 13 code, the command in Reveal Codes should read:

FT[Font:Tms Rmn 10pt]=2,13[HRt]

You can create as many FT command lines as necessary, but make sure that they
have the syntax shown above.
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Margin Bias Command

The Margin Bias command is used to make adjustments to features which call
for an absolute horizontal measurement (tabs, margins, column margins). This
command is necessary because unprintable regions on some printers cause
WordPerfect to treat absolute horizontal measurements differently in WordPerfect
51 and 4.2.

Most laser printers have an unprintable region. This region is an area measured
from all four edges of a form in which you cannot print. In WordPerfect 5.1,
unprintable regions are not taken into account for features requiring an absolute
horizontal measurement (unless the measurement is less than the unprintable
region), so a 1" margin measurement in 5.1, equals a 1" margin measurement.

In WordPerfect 4.2, however, horizontal measurements are all measured from the
unprintable region. For example, if you set the left margin to 10 for a 10-pitch
font and the unprintable region is .25", the actual left margin is 1.25" (1" + .25").

If you have an unprintable region and are converting a document from 5.1 to 4.2,
you will not get the same measurements. As you can see in the examples given
in the two paragraphs above, a 1" margin in 5.1 becomes a 1.25" margin in 4.2
if you have a .25" unprintable region.

To edit the Margin Bias command,

1 Find the letters MB in STANDARD.CRS.

2 Move the cursor to the immediate right of the equal sign (=) on that line.
3 Edit the margin bias measurement.

Type the number of inches you want to subtract from your 5.1 measurements. If
you type .25, .25" is subtracted from your 4.2 measurements.

Ari edited Margin Bias command in Reveal Codes should look like the one
below.

MB=.25[HRt]

The MB command is initially set to zero. If you delete this zero and do not
enter a number, WordPerfect adjusts for the unprintable region by looking at the
Minimum Margin setting for your printer in your printer definition (.PRS) file.

This setting is usually very close to the unprintable region measurement, so you
may want to delete the zero, convert the document, and see how the document
looks.

VlordPerfect Character Command
The WordPerfect Character command converts WordPerfect 5.1 characters to 4.2
extended characters.
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Document Format

To edit the command,
1 Move the cursor one space to the right of the WC command.
2 Insert a character from a WordPerfect character set.

Insert the character just as you would in any 5.1 document (see Compose in
Reference).

3 Move the cursor to the immediate right of the equal sign (=) on the same
command line.

4 Type a space, then type the font number, a comma, then the character
number of the 4.2 extended character.

For example, if you want to convert the 5.1 character to the character
represented in 4.2 by Font 1, Character 3, type 1,3.

An edited WordPerfect Character command in Reveal Codes should look like the
one shown below.

WC [1:4,23]= 19[HR]

The 5.1 code to the left of the equal sign will only expand if the cursor is resting
on it.

In the example above, 5.1 character 4,23 would be converted to character 9 in
the 4.2 character set and would be printed in 4.2°s Font 1

See Also: Convert Program; Document Conversion, WordPerfect 4.2 to 5.1;
Text In/Out

The Document Format options let you make certain format changes that affect
only the document you are currently working on.

For example, you can use Document Format to change your standard format
settings for just one document, change the initial base font, or create a document
summary.

1 Press Format (Shift-F8), then select Document (3) to display the Document
Format menu.

rH Select Documentfrom the Layout menu.
2 Select an option, then make any necessary adjustments (see Notes below).

3 Press Exit (F7) to return to the normal editing screen.
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DOCUMENT FORMAT

Display Pitch

If you want to change the space on the screen allotted to tabs, indents, or column
“gutters,” you can adjust the display pitch to a setting of your own (see Display
Pitch in Reference).

Changing the display pitch at any point in your document does not insert a code
into your text, but it does affect the on-screen appearance of the text throughout
that document.

Initial Base Font

When you select a printer, an initial base font is assigned with that printer (see
Printer, Select in Reference). This option on the Format: Document menu lets
you override that setting for just one document. The font you select using this
option becomes the base font for that document, unless you change it using Base
Font (Ctrl-F8,4) (see Font in Reference).

Initial Codes

The Initial Codes option on the Format: Document menu lets you display the
codes that you have placed in the Initial Codes option on the Setup: Initial
Settings menu (Shift-FI,4,5). You can then edit these settings or insert new
codes for just one document. Any changes you make using this option override
the settings made on the Setup: Initial Settings menu. The method for entering
the codes is the same for both features (see Initial Codes in Reference).

Although the codes you enter using this option do not appear in your actual
document, they take effect from the first of the document and remain in effect
until you enter new codes within the document to change them.

Redline Method
This feature determines how Redline marking is displayed on the printed page
for a specific document (see Redline/Strikeout in Reference).

Select either Printer Dependent (1), Left (2), or Alternating (3).

Printer Dependent marks the redlined text according to the redline string in the
printer file, as displayed when you print PRINTER.TST (see Font in Reference).
Left marks redlined text with a vertical bar (I) in the left margin. Alternating
marks redlined text with a vertical bar in the left margin for even-numbered
pages and in the right margin for odd-numbered pages.

When you select Left or Alternating, you are asked for a redline character that
will be placed in the margins. The default is the vertical bar (I). You can enter
the redline character of your choice by typing the character or by using Compose
(C:rl-2) to enter any character in the WordPerfect character sets (see Compose in
Reference).

Summary
Select Summary (5) to create or edit a document summary for the document you
are creating (see Document Summary in Reference).



See Also: Display Pitch; Document Summary; Font; Initial Settings;
Redline/Strikeout

Document Summary

Document Summary helps you organize, and then quickly locate, your
documents.

If you create a document summary for a file, that summary is the first thing
which is displayed when you look at the contents of the file in List Files.
Consequently, when you are looking through a directory filled with many large
files, you don’t have to scroll through the text of each file to determine what the
file contains.

Instead, you are presented with a brief on-screen synopsis of each document,
giving you the author, typist, and a short description of the file’s contents.

A Dos NAVE
/' LONG FILENAVE
LA INFORMATION ABOUT Subject  l14mian Baroque Sculpture
THE FILE Account  Caption and Comments for Sculpture Illustrations

Keyuords Bernini, Sculpture, Rome, Florence, Baroque

Author Wendy Muirbrook

Typist Hilary SacHau

Abstract
A 23-page study of Italian Baroque Sculpture and Bernini®s Influence. Many
examples and critiques of sculpture and art from the period.

Look Doc Sujnm: 1 Next; 2 Prev; 3 Look at text; 4 Print Suntm; S Save to File: 0

If you are using the Long Document Name feature, the summary lists both the
DOS name and the long name for each document (see Name and Type below).

The document summary also displays both the date when the summary was
created and the latest revision date of the document itself. If you make several
different revisions of the same file for different purposes, you can edit the
document summary for each revision, indicating the differences. You will then
be able to quickly display a summary of the changes made in that revision,
accompanied by the revision date.

Document summaries also let you narrow the scope of a search when you use
Find in List Files (see the information on keywords under Document Summary
Menu below).

You can create or edit a document summary from anywhere in your document.
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I Press Format (Shift-F8), then select Document (3).
CB Select Document from the Layout menu.
1 Select Summary (5) to display the Document Summary menu.

3 Select the options and enter the information you want included in that
document summary (see Document Summary Menu below).

4 Press Exit (F7) to return to your document and save your changes.
The cursor returns to its original place in your document.

Whiie the Document Summary menu is on-screen, press Cancel (FI) to return to
the previous menu, ignoring any changes you have made.

Create Summary Feature

You can set Create Summary on Save/Exit in Setup (Shift-F 1,3,4,1) to Yes to
have WordPerfect prompt you to create document summaries. When the Create
Summary feature is set to Yes, WordPerfect displays the Document Summary
menu each time you save or exit a document, until you have created a summary
for :hat document (see Document Management/Summary under Environment
Setup in Reference).

Delete

Creating a document summary does not insert any codes into a document. Once
you have created a summary for a document, the only way you can delete it is
by pressing Delete (Del), then typing y while the cursor is on the status line in
the Document Summary menu. This deletes the document summary and returns
you to the normal editing screen.

If you delete a document summary, you cannot restore it. You can only create a
newlsummary for that document.



>>>>> >

REVISION DATE
CREATION DATE

NAME AND TYPE
AUTHOR AND TYPIST
INFORMATION ENTRIES
ABSTRACT

Document Summary Menu

When you display the document summary menu using steps 1 and 2 at the
beginning of this section, it presents any information contained in the current
summary.

> Revision Date
>e - Creation Date 10 02-9* 01:42v
>> Name
Type
>3 Author
Typist
4 - Subject
» 5 - Account
6 - Keywords

Abstract

Selection: 0 IRetrieve to capture: Del to remove summary)

Even when no summary exists for a document, the Creation Date is still
displayed on the Document Summary menu. If the document has a Revision
Date, Long Document Name, or Type, these entries are also displayed.

The Revision Date is the latest date when the document was revised. A revision
date cannot be edited or changed. Whenever you edit and save a document,
WordPerfect updates this date according to your computer's current date and
time.

To Change any enUy on the document summary menu, select the entry, then
enter the information you want. While editing these entries, you can use the
standard cursor movement and deletion keys to edit text. You can also use Bold
(F6) and Underline (F8) to emphasize text, and Compose (Ctrl-2) to add any
character from a WordPerfect character set (see Compose in Reference). How-
ever, you cannot use other editing features such as the Speller, Thesaurus, or
Search. If you change your mind while editing an entry, you can press Cancel
(FI) to leave the entry and ignore your changes.

An explanation of each entry on the document summary menu follows.

Abstract

The Abstract entry (7) can contain up to 780 characters, excluding any space
required for extended characters created using Compose (Ctrl-2). An abstract
is usually a brief summary of a document's contents. You can type an
abstract in this entry, or you can press Retrieve (Shift-FIO) when the cursor
is on the Document Summary menu and type y to retrieve the first 400
characters of the document as its abstract (see Retrieve below).
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Author and Typist

Tie Author and Typist entries (3) can include up to 60 characters excluding
any extra space required for extended characters. You can type names in
these entries, or you can press Retrieve (Shift-FIO) and type y when the
cursor is on the Document Summary menu to retrieve the latest Author and
Typist entries which you saved to a document summary during that editing
session (see Retrieve below).

Creation Date
The Creation Date (1) is the date the document summary was created. It
remains constant unless you change it.

Once you select this entry, you can either edit the existing date and time or
eater a new one. For the date, enter the month, day, and year, separated by
slashes (e.g., 9/9/99 or 09/09/1999). For the time, enter the complete time

(e.g., 10:00a and not 10a for 10:00 a.m.).

Information Entries
Entries 4 through 6 on the Document Summary menu can each contain up to
160 characters excluding any extra space required for extended characters.

Select Subject (4) to enter any information which will help you identify a
document. You can type in a subject or you can move to the status line in
the Document Summary menu, press Retrieve (Shift-FIO), then type y to
retrieve the first 160 characters of the Subject entry from the document (see
Subject Entries below).

S.elect Account (5) to enter any information which will help you identify the
document.

Select Keywords (6) to enter keywords that label a document. When you are
using Find in List Files, you can then search for the Keyword entries from
the document summaries (see Find, Conditions in Reference).

Name and Type

The Document Name entry (2) applies to the Long Document Name (see
Exit in Reference). A long document name can contain up to 68 characters.
A long document type can contain up to 20 characters.

Do not enter a pathname. WordPerfect does not recognize pathnames in
long document names and treats them as part of the long document name.

If a document already has a long name and type, they are displayed in this
entry. You can enter or edit both the long name and type in Document
Summary. If you change them, the new name and type will appear when
you exit or save the document.

Even if you set Long Document Names in Setup (Shift-F 1,3,4,3) to No, any
long document name and type you place in the Document Summary will be
included with that document when you save it. That long document name
will then be displayed on-screen whenever you use the Long Display feature
in List Files (see List Files in Reference).



Retrieve

When the cursor is on the status line in the Document Summary menu, you can
press Retrieve (Shift-FIO) and type y to retrieve all of the following entries into
the Document Summary menu:

e The latest author and typist entries saved with a document summary during
that editing session.

e The first 160 characters of a subject entry in the document as the Document
Summary Subject entry (see Subject Entries below).

e The first 400 characters of the document as the Document Summary Abstract
entry.

These entries are all retrieved at once.

Saving and Printing Summaries

To save a document summary to a file while the Document Summary menu is
on-screen and the cursor is on the status line, press Save (F10), then enter a
filename. If the filename you enter already exists, you are asked if you want to
replace the file or add to it. Select Replace (1) to replace the contents of the file
with the summary text or Append (2) to add the summary text at the end of the
existing file. When it appends a document summary to a file, WordPerfect
inserts a Hard Return code immediately preceding the document summary.

While a document summary is displayed on-screcn, you can print it by pressing
Print (Shift-F7). Whenever you print selected pages of a document on disk, you
can also type s to print the document summary (see Selected Pages under Print,
Document on Disk in Reference). The printed appearance of the prompts on the
document summary menu is determined by the WP.LRS file which is provided
with WordPerfect. You can change the appearance of these prompts in print by
editing the wr.Lrs file (see Language Resource File in Reference).

Subject Entries

Normally, RE: is the standard heading for the subject entry in official documents.
Consequently, when you retrieve a subject from your document by pressing
Retrieve (Shift-FIO) and typing y while the cursor is on the status line,
WordPerfect searches the document for an RE: notation. It then copies the text
immediately following the RE: (up to 160 characters or the next Hard Return
code [HRt]) into the Subject entry.

You can have WordPerfect search for any subject heading of your choice (e.g.,
SUBJECT: or CONTENTS:) by changing the Subject Search Text in Setup.
Press Setup (Shift-FI), select Environment (3), select Document Management/
Summary (4), select Subject Search Text (2), then enter the subject heading.
The heading you enter becomes the notation WordPerfect looks for in the future.

When entering the subject search text, you can enter up to 39 standard
characters, excluding the extra space used by any extended characters you add
using Compose (Ctrl-2).
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System Filename and System Filetype

Wher, you print a document summary, WordPerfect includes entries which do
not appear on the Document Summary menu and adds the necessary information
for them. These entries are System Filename and System Filetype. The system
hlename is the complete DOS pathname for the document (e.g.,
C:\STUDIES\TAX). The System Filetype is the version of WordPerfect used to
create that document (e.g., WP 5.1).

See Also: List Files

DOS and WordPerfect
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DOS AND WORDPERFECT

The Disk Operating System (DOS) is software that directs the operations your
computer performs. It serves as a link between applications software (such as
WordPerfect) and the hardware inside your computer. Without an operating
system, your computer can do nothing. Therefore, DOS must be started before
any other program can be used.

there are different versions of DOS for different computers. The most common
disk operating system is MS-DOS, manufactured by Microsoft Corporation.
Most computer companies have adapted MS-DOS, with permission of Microsoft
Corporation, to run on their machines. DOS is constantly being improved, with
new releases being introduced regularly. WordPerfect 5.1 currently runs on IBM
computers or 100% compatibles that use DOS 2.0 or later versions.

Because DOS serves as the link between WordPerfect and your computer, we
say WordPerfect runs under DOS. It is important to remember, however, that
DOS software is not manufactured by WordPerfect Corporation. WordPerfect
and DOS are two entirely different software products. You can start your
machine with a WordPerfect diskette only if it is also a bootable DOS diskette.

If you are having problems formatting, copying, filing, and in some cases
printing, the problems may be occurring because of DOS and not because of
WordPerfect.

To use WordPerfect effectively, you should know how to use the following DOS
commands and features:

CD Change directory

CHKDSK Check a disk

COPY Copy files from one diskette/directory to another
DIR Display the files in a directory

FORMAT Format a diskette

MD Make a directory

All of the above commands are described in your DOS documentation.
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Some of the operations these commands perform can also be accomplished through the
List Filesfeature. See List Files in Reference.

Backup

You should be sure to keep extra copies of your files to protect against diskette
corruption and similar happenstances which may cause you to lose hours or days
of work. These copies are called backups.

Many people and companies have strict daily backup procedures. Some even
use fire-proof vaults to keep their backup diskettes safe from theft and natural
disaster.

To minimize losses due to power and machine failures, WordPerfect has
provided you with Backup features. The Backup features, however, do not
ensure you against lost work due to damaged or worn out disks (see Backup,
Original and Backup, Timed in Reference).

If you have two disk drives, use the COPY *.* or DISKCOPY commands to
back up diskettes. If you have a hard disk, there is a BACKUP command that
allows you to back up in a number of ways. More about these and other DOS
commands can be found in your DOS manual. In addition, there are many other
software products on the market that perform these backup functions.

You should also keep often-used diskettes free from outdated and seldom-used
files. You can use Look on the WordPerfect List Files menu to quickly check
the contents of each file on a diskette or in a subdirectory (see List Files in
Reference). Delete outdated files and copy seldom-used and questionable files to
an archive diskette. Well-organized, up-to-date diskettes and hard disks keep
backup time to a minimum and program speed at a maximum.

Batch Files and AUTOEXEC.BAT

Batch files (designated with a .BAT extension) hold a series of DOS commands
that are executed when you type the name of the file at the DOS prompt. If you
frequently type the same series of commands at DOS, you may want to put them
in a batch file so that you can execute them without typing each one. See your
DOS manual for more information on batch files.

The AUTOEXEC.BAT file is a special batch file whose commands are executed
each time you start your computer. The AUTOEXEC.BAT file must reside in
the root directory (see Root Directory under Organizing Disks and Directories
below).

You may already have an AUTOEXEC.BAT file. To check,
1 Press List (F5).
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2 Enter the full pathname of the root directory of your hard disk plus *.bat
(e.g., c:\*.bat).

or

For two disk drive systems, insert your DOS diskette in drive B and enter
b:\*.bat.

If yoj have an AUTOEXEC.BAT file, it will appear in the list of files.

There are several commands you may want to have in an AUTOEXEC.BAT file.
For example, you may want to include a Path command (see Path Command
below). You can also include prompt $p$g to display the current directory in
the DOS prompt. See your DOS manual for other commands you may want in
your batch file.

To edit or create an AUTOEXEC.BAT file,

1 ff you do not already have an AUTOEXEC.BAT file, check to be sure you
are in a clear normal editing screen, then skip to step 6 below.

2 From a clear editing screen, press Format (Shift-F8), then select Line (1).

ra Select Line from the Layout menu.

3 Select Margins (7), enter 0 (zero) for both left and right margins, then press
Exit (F7) to return to the blank normal editing screen.

Setting the margins to zero reduces wrapping when you retrieve the AUTOEXEC.BAT file.
Some printers do not allow margins of zero. If the printer currently selected does not. the
minimum margin for the printer appears when you enter margins of zero.

4 Press Text In/Out (Ctrl-F5), select DOS Text (1), then select Retrieve
(CR/LF to [HRt]) (2).

fa Select Text In on the File menu, then select DOS Text (CR/LF to HRt).
5 Enter c:\autoexec.bat to retrieve the AUTOEXEC.BAT file.
or

If you are using a two disk drive system, insert your DOS diskette in drive
B, then enter b:\autoexec.bat.

6 Enter the commands you want in the file.

7 When you are finished, press Text In/Out (Ctrl-F5), select DOS Text (1),
then select Save (1).

Ol Select Text Outfrom the File menu, then select DOS Text.

Be sure you use the Text Outfeature to save thefile instead of the Save or Exitfeatures.
Using Save or Exit will save the file in WordPerfect format instead of DOS Text format,
which makes it unrecognizable to DOS as a batch file.



8 Enter c:\autoexec.bat as the name of the file. (If the file already exists, type
y to replace it.)

or

If you are using a two disk drive system, enter b:\autoexec.bat as the
filename. (If the file already exists, type y to replace it.)

Once you have created (or edited) AUTOEXEC.BAT, you must restart DOS for
the commands to take effect.

9 Press Exit (F7).
-3 Select Exitfrom the File menu.

10 Type n to not save the document (you have already saved it), then type y to
exit WordPerfect.

11 Restart your computer.

Date and Time

When you start DOS, you may be asked to enter the current date and time. This
information is important for some features of WordPerfect, such as List Files and
Date, which use it to label files or insert the date/time in your documents. If you
do not enter the correct date and time, they will be incorrect when you use these
features of WordPerfect.

Some computers have a time card that keeps the date and time automatically,
even when you turn off your computer. In this case, you may only need to enter
the date and time once, not every time you start your computer.

DOS Prompt

After starting DOS and before another program is started, the DOS prompt
appears on the screen. Although you can change the appearance of this prompt,
it normally appears as A>, B>, C>, etc., and marks the DOS command line.
Programs such as WordPerfect can be started from the command line.

Go to DOS

If you are working in WordPerfect and need to quickly execute some DOS
commands (e.g., FORMAT), you can “Go to DOS” without exiting WordPerfect
(see Go to DOS in Reference).

Naming Files
Every operating system has its own rules for naming files. DOS allows up to
eight characters followed by an optional period and three-character extension.

You should develop a system for naming documents which gives you a clue to
the contents of the file. For example, SMITH.LTR or JONES.LTR are much
more descriptive than LETTER. 1 or LETTER.2. Files with matching extensions
can all be copied or deleted in a single operation.
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The following characters can be used in a filename:

A-Z

0-9

10 #3%& () - “"{}A
A period can only be used to separate the first part of the filename from the
filename extension. The following characters cannot be used to create a
filename:

*+=[]:; "~<>?\, (space)
DOS 3.0 or later allows international characters (all non-graphics characters
above ASCII 32) in filenames.

You should not use .EXE, COM, .CON, or .WPM as extensions for WordPerfectfiles.
These extensions are reserved for program and macro files and using them to name

documents might cause confusion. Ifyou give afile one of these extensions accidentally,
just rename the file (see List Files in Reference).

The Long Document Name feature lets you enter a longer, more descriptive
name for your documents (see Environment Setup in Reference).

Organizing Disks and Directories

Diskettes should be organized in such a way that each contains similar data (one

for each client, each class of students, personal correspondence, etc.). You can
further divide files into groups using directories.

Root Directory
livery disk (hard or floppy) has a root directory designated by a single
backslash (\). The full pathname of the root directory includes the drive,

(e.g., C:\). Up to 112 filenames are allowed in the root directory of a floppy

diskette (224 on a 1.2M floppy diskette); hard disks generally have higher
limits.

mSubdirectories can be created from the root directory with no limit on the
number of filenames. A subdirectory of the root directory is given a name
ie.g., WP51 or WORK). Backslashes are used to separate subdirectory
tames (e.g., C:\WP51\MEMOS).

Parent Directories

Each subdirectory has a parent and can in turn be a parent to several
subdirectories of its own. For instance, on a hard disk, you can keep DOS
files in one subdirectory, the WordPerfect system files in another, and
business files in still another. The subdirectory for your business files could



then become a parent directory to other subdirectories for correspondence,
billing, and reports.

C\

WP51

BUSINESS PERSONAL

CORRESPONDENCE ~ BILLING REPORTS

In this example, C:\, WP51. BUSINESS. PERSONAL,
CORRESPONDENCE. BILLING, and REPORTS are all directories. C:\ is
the root directory. WP51 is the parent directory to the BUSINESS and
PERSONAL directories, CORRESPONDENCE, BILLING, and REPORTS
are subdirectories to the BUSINESS directory.

Path Command

In general, you cannot start WordPerfect from a directory other than C:\WP51
unless you specify the pathname (see Pathnames below). However, you can use
a DOS path command to give DOS a list of directories to search through for
executable program files. This allows you to start a program from any
subdirectory listed in the path command, not just the subdirectory containing
software.

The order of the directories in the path command determines the order in which
the directories are searched. For example, you could enter path c:\;c:\wp51
from the DOS prompt to tell DOS to search the root directory (C:\) and then the
WordPerfect directory (\WP51) for a program file. When entering the path
command, separate each directory in the list with a semicolon ().

Unless the path command is in the AUTOEXEC.BAT file (see Batch Files and
AUTOEXEC.BAT above), you must enter it each time you start your machine.

Pathnames

As you save and retrieve files in WordPerfect, you may be asked to specify a
full pathname. A full pathname includes the drive, root, and any subdirectory
names. For example, “C:\WP51” is the full pathname of the WP51 subdirectory.
When you want to retrieve a file from a directory other than the one in which
you are currently working (the default directory), you must enter the full
pathname of the file (e.g., C:\WP51\JONES.LTR).
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Startup Options

Many programs that can be started from DOS (such as WordPerfect and several
other utility programs that come with WordPerfect) have optional commands you
can use when you start the program. Often these options are for your
convenience. Sometimes they are necessary to run the software on your
particular hardware.

Startup options are entered with the name of the program at DOS. They usually
consist of a slash (/), then a letter or letters, then other information pertaining to
the option.

For example, /m-macroname and /w=cm,em are two startup options for
WordPerfect. To execute a macro named layout when you start WordPerfect,
you would enter wp/m-layout at the DOS prompt.

Many startup options can be combined. In the above example, if you wanted to
limit the amount of conventional memory WordPerfect would use to 100K and
run the layout macro when you start WordPerfect, you would enter
wp/w=100/m-layout at the DOS prompt.

If you regularly use startup options with WordPerfect, you may want to include
them in a batch file (see Batch Files and AUTOEXEC.BAT above).

See Appendix N: Startup Options for more information on startup options for
WordPerfect. For a list of startup options for other programs that come with
WordPerfect, see the sections on those programs in Reference.

Set; Also: Backup, Original; Backup, Timed; List Files; Text In/Out;
Appendix N



E Edit-Screen Options

Notes

The way a document is displayed on the screen can make a great deal of
difference in your writing efficiency. WordPerfect lets you change the general
appearance of the normal editing screen with the Edit-Screen options.

The options on this menu do not affect printed text.

1 Press Setup (Shift-F 1).

CB Select Setup from the File menu.

2 Select Display (2), then select Edit-Screen Options (6).

3 Select the option of your choice, then make the necessary changes (see the
option headings under Notes below).

4 Press Exit (F7) until you return to the normal editing screen.

Settings for this menu are stored in the WP{WP}.SET file and remain in effect
each time you start WordPerfect.

Automatically Format and Rewrite

This option determines how WordPerfect formats text on the screen after an
editing change. If the setting is No, WordPerfect formats the text as you scroll
through it. If the setting is Yes, WordPerfect formats the text after each editing
change. Local editing keystrokes are an exception to this rule. These include
inserting a character, Backspace, Delete, Left Arrow, Right Arrow, Word Left,
Word Right, and Delete Word.

When you select No, the editing process is usually faster.

You can manually rewrite the screen at any particular time by pressing Screen (Ctrl-F3),
then selecting Rewrite (3) (see Rewrite in Reference).

Comments Display
This option determines whether document comments are displayed on the screen.
For information on document comments, see Document Comments in Reference.

Filename on Status Line

This option determines whether the document filename is displayed on the status
line. If you set this option to Yes and are editing a document that has been
previously saved, the filename will appear on the left end of the status line.

The filename may be replaced with messages from time to time, even if you set
this option to Yes.

Hard Return Display Character
Normally, when you press Enter to end a paragraph or short line of text,
WordPerfect moves to the next line without displaying any type of character. If
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you want to display a character at each hard return, select this option, then type
the character.

You con enter a character from the WordPerfect character sets with the Compose feature
(Ctrl-2) (see Compose in Reference!

If you have inserted a character and wish to delete that character, go back to the
Hard Return Display option (Shift-F 1,2,6,4), then press the Space Bar.

The Hard Return Display Character will not print or display in View Document.
Merge Codes Display

This option determines whether merge codes are displayed on the screen. For
more information about the Merge feature, see Merge in Reference.

Reveal Codes Window Size

This option lets you enter the number of lines you want to allot to the Reveal
Codes screen (Alt-F3). For example, you can allot 10 lines.

Doc 1 Pg 1 Ln 1" Fas 1"

Press Reveal Codes to restore screen



Environment Setup

Or, you can allot three lines.

Doc 1 Pa 1 Ln 1" Pas 1™

If you choose to allot one line, only the character or code where the cursor is
located is displayed in the Reveal Codes screen. In addition, you will be
prompted for confirmation when you delete codes.

For more information on the Reveal Codes screen, see Reveal Codes in
Reference.

Side-by-side Columns Display

This option determines whether columns created with the Columns feature
(AIlt-F7,1) are displayed on the screen side-by-side or on separate pages. While
columns will always print side-by-side, you can edit a document faster if they
are displayed on separate pages.

For more information on this option, see Columns, Display in Reference.

See Also: Colors/Fonts/Attributes; Display Setup; Menu Options

Like other menus on the WordPerfect Setup key, the Environment Setup menu
offers you several options that let you determine how features will operate the
entire time you are in WordPerfect. This is useful because you can tailor
WordPerfect to your own needs by making the setting once, rather than each
time you create a new document.

The options on the Environment Setup menu let you:
« Set backup options for safeguarding against losing documents.
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Instruct the computer to sound a “beep” when certain status line messages
are displayed.

Control the cursor speed.

« Make default settings for the Document Summary and Long Document
Names features.

Speed up the document saving process.

« Make default settings for the Hyphenation feature.

Determine the units of measure for the status line as well as WordPerfect
features that call for a measurement.

To set the options on the Environment Setup menu,
1 Press Setup (Shift-FI).

CB Select Setup from the File menu.

2 Select Environment (3).

3 Select an option, then make the necessary adjustments. General information
on each of the options is found under Notes below. More information can be
found under specific headings in Reference.

4 Press Exit (F7) until you return to the normal editing screen.

The settings made with this feature are stored in the WP{WP}.SET file and
remain in effect each time you start WordPerfect.

Alternate Keyboard

This option lets you assign Help to FI, Cancel to Escape, and Repeat Value to
F3. If you set this option to Yes, you can still select a keyboard layout (see
Keyboard Layout in Reference).

Backup Options
WordPerfect has two backup options, Timed and Original. Both of these options
act as safeguards against losing your work.

Timed backup makes a copy of the document you are working on every few
minutes. This prevents you from losing large amounts of work due to machine
failure, power outage, etc. Original backup lets you save both the original and
replacement versions of the same document. This prevents you from losing a
document you accidentally replaced.

More information on these options can be found in Backup, Timed and Backup,
Original in Reference.



Beep Options

This option lets you determine whether WordPerfect will have the computer
notify you with a "beep” when it displays an error message, prompts you for
hyphenation, or cannot find search text. More information on this option can be
found in Beep Options in Reference.

Cursor Speed

This option lets you change the speed at which your cursor moves through text.
The speed is measured in characters per second. More information on this
option can be found in Cursor Speed in Reference.

Document Management/Summary
This option lets you make settings for the Document Summary and Long
Document Names features.

Create Summary on Save/Exit (1) lets you determine whether you want
WordPerfect to create a document summary for you when you save a document.
This option is only in effect if you haven’t previously created a summary for the
document.

Subject Search Text (2) determines what WordPerfect should search for when it
is inserting information under the Subject heading in a Document Summary.
And Default Document Type (4) determines what is inserted under the
Document Type heading when you create a Document Summary.

These options are in effect for all document summaries, but the Subject Search
Text and Document Type entries can be overridden for individual document
summaries with the Document Summary feature. Once a document summary is
created, it can be edited only with the Document Summary feature.

More information on these options can be found in Document Summary in
Reference.

Long Document Names (3) determines whether you want to name a document
with a long document name when you save the document. Setting this option to
Yes lets you exceed the limits DOS puts on a filename (eight characters followed
by a three-character extension). It also lets you give a more descriptive name to
your documents.

You can enter up to 68 characters or spaces for a long document name. The first 30 of
those characters can be displayed on the List Files Long Display screen. Characters
entered with Compose may take up more space than regular keyboard characters, so if
you decide to enter characters with Compose, you may not be able to use all 68
characters or spacesfor the document name. Also, do not enter a pathname.
WordPerfect does not recognize pathnames in long document names and treats them as
part of the long document name.

When you save a document after setting Long Document Names to Yes,
WordPerfect will prompt you to enter the long document name, the document
type, and the DOS filename. If you have not previously entered a DOS
filename, one will be provided for you from the characters in the long document
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name and the characters in the document type. You can edit this name as you
wish.

If you set the Long Document Names option to Yes, WordPerfect also displays
the Long Display screen when you use the List Files feature. Once you are in
List Fles, you can then change to the Short Display screen if you like (see List
Files in Reference).

Sort List Files (5) determines whether you want subdirectories and files in List
Files to display in alphabetical order or in the order that they reside on disk. If
you set this option to Yes, List Files displays subdirectories in alphabetical order
followed by an alphabetical listing of files. If you set this option to No, List
Files displays subdirectories and files in the order they reside on the disk. This
will speed display of the file list (especially for very large directories).

Fast Save (unformatted)

If this option is set to Yes (the default setting), WordPerfect saves your
document faster than if this option is set to No. If you are printing from disk,
however, a document saved with Fast Save will usually take longer to print than
a document saved without Fast Save because it must be formatted before it is
printed (see Fast Save in Reference).

Hyphenation

This option lets you determine which dictionary WordPerfect will use to
hyphenate words when Flyphenation is on. You have two choices: External
Dictionary/Rules and Internal Rules.

External Dictionary/Rules (1) tells WordPerfect to use the hyphenation program
and dictionary contained within the WP{WP}US.HYC and WP(WP}US.LEX
files. Internal Rules (2) tells WordPerfect to use a hyphenation dictionary
contcined within WP.EXE itself. The external dictionary is much more powerful
and accurate than internal hyphenation, but it occupies more disk space.

The Prompt for Hyphenation option discussed below determines when
WordPerfect stops to prompt you for hyphenation.

More information on the Hyphenation feature itself can be found under
Hyphenation in Reference.

Prompt for Hyphenation

This option determines when WordPerfect will prompt you for hyphenation
assistance when you are using the Hyphenation feature. Normally, WordPerfect
asks for help only when the hyphenation dictionary it is using cannot determine
how to hyphenate a word. This is what is meant by the When Required (2)
settng.

Never (1) tells WordPerfect to never prompt you for assistance. If WordPerfect
comes to a word that it normally would ask for assistance in hyphenating, it will
wrap that word to the next line without hyphenating it.



Equations

Always (3) tells WordPerfect to always prompt you for assistance. WordPerfect
will stop at every word that needs to be hyphenated and ask you for assistance.

More information on these options can be found under Hyphenation in
Reference.

Units of Measure

This option determines the units of measure WordPerfect will use for the status
line as well as for features that require a measurement (e.g., margins). Inches,
centimeters, points, WordPerfect 4.2 units (lines, columns), and 1/1200ths of an
inch are supported.

For more information on this feature, see Units of Measure in Reference.

See Also: Backup, Original; Backup, Timed; Beep Options; Cursor Speed;
Document Summary; Fast Save; Hyphenation; Units of Measure

Until now, creating a mathematical or scientific equation in a full-featured word
processing program was not easy. Even simple equations were difficult or
impossible to create because they require special mathematical characters as well
as a way to format those mathematical characters.

Now WordPerfect contains an Equation Editor which helps you create
mathematical or scientific equations and include them in WordPerfect documents
such as reports, tests, and research papers.

For example, the following equations can be created in the Equation Editor.
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Important: The Equation Editor helps you create, align, and print (typeset) mathematical
equations. It does not calculate equations for you.

To format an equation, you first define a graphics box that will contain the
equation, then you create the equation itself. You use the WordPerfect Graphics
feature to define the box, then you use the WordPerfect Equation Editor to create
the equation.

Graphics, Edit and Graphics, Define a Box in Reference discuss editing and
renumbering equation boxes and are the sections you should turn to if you would
like to perform any of those operations.

1 Press Graphics (Alt-F9), then select Equation (6).

LSl Select Equation from the Graphics menu.

2 Select Create (1) to display the Definition: Equation screen.
3 Select Edit (9) to display the Equation Editor.

The Equation Editor is displayed any time you select Edit for a box whose
contents are listed as Equation. Once the Equation Editor is displayed, you can
create your equation. The Equation Editor has three windows: the Editing
window, the Equation Palette, and the Display window.

By selecting commands and symbols from the Equation Palette in the Equation
Editor and by typing characters from the keyboard, you can create the equation
in the Editing window. After creating the equation, you can then display it in
the Display window to see a representation of how it will look when printed.
Since there are several commands and symbols included in the Equation Palette,
your equations can be as simple or as complex as necessary.

4 Create your equation (see Editing Window below).

For example, typing a times b in the Equation Editor creates this equation,

axb



Typing {a times b} over ¢ in the Equation Editor creates this equation,

axb

c

And typing x={-b plusminus sqrt {bA2-4ac}} over {2a} in the Equation Editor
creates this equation,

2a

5 Press Screen (Ctrl-F3) or F9 to view your equation (see Display Window
below).

a9 Click in the Display Window.

6 Repeat steps 4 and 5 above until you are satisfied with the appearance of the
equation.

7 Press Exit (F7) until you return to the normal editing screen.

Pressing Cancel (FIl), then typing y while in the Equation Editor cancels any
changes you may have made to the equation you are creating and returns you to
the Definition: Equation screen.

Once you are in the normal editing screen, you can view your equation as it will
appear in the document by selecting View Document (Shift-F7,6).

Editing Window
The Editing window is where you create the equation. It is shown in the screen
that accompanies the numbered steps at the beginning of this reference section.

You can enter numbers, letters, and the following keyboard characters (+-*/ =
<>1?2.1@, ;:)inthe Editing window by pressing the appropriate keys.
Other keyboard characters (" ' " { } ()) as well as pairs of keyboard characters
shown above (e.g., -><= >=) can also be entered but have special meaning to
the Equation Editor (see Equations, Commands and Symbols in Reference for a
description of these characters).

You can enter a character from a WordPerfect character set by pressing
Compose (Ctrl-2), typing the character set number, a comma, the number of the
character within the character set, and pressing Enter (e.g., 7,63). See Compose
in Reference.

You can also enter one of the numerous equation commands and symbols by
pressing List (F5) to move to the Equation Palette, moving the cursor to the
command or symbol you want to include, then pressing Enter or Ctrl-Enter
(see Equation Palette below). If you choose not to enter a command or symbol,
pressing Exit (F7) or Cancel (FI) moves you from the Equation Palette back to
the Editing window.
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Hard returns move the cursor to the next line of the Editing window, but do not
insert Hard Return codes in the equation. In order to create multiple-line
equations in one equation box such as the one shown below, you should use the
pound sign (#), STACK, or STACKALIGN command (see Equations,
Commands and Symbols in Reference).

a+b”c
X+y=z

Likewise, pressing the Space Bar inserts a space in the Editing window, but does
not add a space between characters in an equation. If you want to add a space,
type a tilde (~) for a normal space or a backward accent (') for a thin space. A
thin space is equivalent to one-fourth of a normal space.

Equations are formatted according to established mathematical typesetting
guiaelines which include specific size, attribute, and placement requirements for
characters and symbols. You can include approximately 2000 characters in the
Editing window. Pressing Ctrl-Page Down in the Editing window deletes text
from the cursor forward and resets all display parameters (i.e., Move, Scale) in
the Display window to Automatic.

Equation Palette

The Equation Palette displays the commands and symbols you can use in an
equation. It is shown in the screen that accompanies the numbered steps at the
beginning of this reference section.

To move the cursor from the Editing window to the Equation Palette, you must
be in the Equation Editor. When you are. press List (F5), or click with the
mouse in the Equation Palette window. Once in the Palette, you can use the Up
and Down Arrow keys to move the cursor to the desired command or symbol
within the displayed menu, or press Page Up (PgUp) or Page Down (PgDn) to
show the next menu on the Palette. If the menu extends beyond the screen, you
can scroll to the bottom of the menu to display more commands or symbols.

When the cursor is resting on the command or symbol you want, press Enter or
Ctrll-Enter to insert the command or symbol into the Editing window. Some
symbols can be represented by both text (keywords) and a character. For these
symbols, pressing Enter inserts the keyword, while pressing Ctrl-Enter inserts
the character.

When you are in the Equation Palette, the command or symbol your cursor is on is
highlighted in reverse video. The name of each menu in the Palette appears at the top of
the Palette.

To leave the Equation Palette without entering a command, press Exit (F7) or
Cancel (FI). For more information on the commands and symbols themselves,
see Equations, Commands and Symbols and Equations, Commands Syntax in
Reference. Some of the commands require a special syntax such as a space
between a command and the number or variable you want the command to



affect. Equations, Commands Syntax in Reference contains information on the
proper syntax.

You can enter a command without going to the Equation Palette by typing the command
in the Editing window. Again, this is covered in more detail in Equations. Commands
and Symbols in Reference.

Display Window

After you create or edit an equation in the Editing window, you can view it in
the Display window. The Display window is shown in the screen that
accompanies the numbered steps of this reference section.

You must have a graphics cardfor the equation to display correctly in the Display
window (see Graphics Screen Type in Reference).

To display an equation in the Display window, press Screen (Ctrl-F3) or F9.
Redisplay an equation after you make editing changes by pressing Screen
(Ctrl-F3) again.

If you have some type of syntax error in the equation, the equation will not
display in the Display window. Instead, you will receive the “Incorrect Format"
error message, and the cursor will return to the point in the equation where the
error occurs. This error message could be displayed for a variety of reasons
depending on the command you are using. Check the information pertaining to
the command you are using in Equations, Commands Syntax in Reference.

The size of the equation in the Display window is not the exact size of the
equation as it will appear in the document. The percentage measurement at the
lower right of the screen, however, tells you the viewing magnification. For
example, if the percentage shows 500%, the equation on the screen is 5 times its
printed size.

Press Switch (Shift-F3) to display an equation in the Display window and move
to the Display window. Doing so lets you use the Display window options to
move and resize the equation. While you are in the Display window, you cannot
use the cursor in the Editing window.

When you are in the Display window, a double line appears at the right of the Display
window. When you are not, a double line appears at the right of the Editing window.

The Display window options let you use the arrow keys to reposition the
equation and the Page Up (PgUp) and Page Down (PgDn) keys to enlarge or
reduce the view of the equation. Go To (Ctrl-Home) resets any changes you
made with the arrow. Page Up, and Page Down keys.

Moving or resizing the equation in the Display window with the arrow, Page Up,
and Page Down keys only helps you view the equation. It does not affect the
way the equation will be printed. The Aligning Equations, Fonts, Graphical
Font Size, and Print as Graphics headings below give you more information on
the way the equation will be printed.
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Press Switch (Shift-F3) again or Exit (F7) to move to the Editing window and
display the Editing window options.

Aligning Equations
Several options let you choose the way equations will be aligned in the equations
box.

Alignment options for the box itself are discussed in Graphics, Define a Box in Reference.

Before you change alignment settings for an equation, you should know that
initial or default alignment settings are located on the Setup: Initial Settings
menu (Shift-F1,4,3). Unless you change alignment options for an equation in the
Equation Editor, the equation conforms to the settings on the Setup: Initial
Settings menu. As shipped, the alignment option centers the equation both
vertically and horizontally in the box as shown below.

In the equations above, box lines are shown to illustrate how the equation is centered in
the box. Ifyou have created your equation in an Equation type graphics box and have
not changed the default box options, no box lines will show.

Once an equation is created, it retains the alignment settings it was created
uncer, and the only way you can change those settings is to edit them in the
Equation Editor.

To change the default alignment settings, you must be in the normal editing
screen. When you are, press Setup (Shift-FI), select Initial Settings (4), select
Equations (3), then select Horizontal Alignment (3) or Vertical Alignment (4).
Next, select the alignment option of your choice, then press Exit (F7) to return
to the normal editing screen.



To change the alignment settings for a single equation, make sure you are in the
Editing window of the Equation Editor. When you are, press Setup, then select
Horizontal Alignment (3) or Vertical Alignment (4). Next, select the alignment
option of your choice, then press Exit to return to the Equation Editor.

Deleting in the Equation Editor

If you are in the Editing window of the Equation Editor, you can delete single
letters or symbols with the Delete and Backspace keys. To delete text and
symbols from the cursor forward to the end of the equation in the Equation
Editor, make sure the cursor is located in the Editing window, press Delete to
End of Page (Ctrl-PgDn), then type y. Pressing Ctrl-Page Down in the Editing
window also resets all display parameters (i.e., Move, Scale) to Automatic.

To delete text and symbols from the cursor forward to the end of the line in the
Equation Editor, make sure the cursor is located in the Editing window, then
press Delete to End of Line (Ctrl-End).

If you want to delete the entire equation (including the box), you must delete the Graphics
Box code in the normal editing screen.

Equation Keyboard

If you have used the Keyboard Layout feature, you know that you can reassign
or remap WordPerfect features or characters to different keys on your keyboard.
For example, you can remap Alt-a to be the Greek Alpha character or Alt-i to be
the integral symbol.

Using an option on the Setup: Initial Settings menu, you can assign a specific
keyboard layout to the Equation Editor. In other words, any time you are in the
Equation Editor, that keyboard will be in effect.

To do so, you must be in the normal editing screen. When you are, press Setup
(Shift-FI), select Initial Settings (4), select Equations (3), then select Keyboard
for Editing (5). Next, move the cursor to the keyboard you want to select, then
choose Select (1). Press Exit (F7) until you return to the normal editing screen.

An equations keyboard has been provided with WordPerfect; however, you must
still select it if you wish to use it. For information on the keyboard contents, see
Appendix H: Keyboards.

If you want to learn how to create a keyboard layout of your own, see Keyboard
Layout in Reference.

Equation Setup

While you are in the Equation Editor, you can press Setup (Shift-FI) to display
a menu of options that change equation alignment and determine the printing
options for the equation you are working on. These options are discussed in
detail under Aligning Equations above and Graphical Font Size and Print as
Graphics below.
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Fonts

When WordPerfect prints equation symbols, it prints the symbols in the initial
base font for the document (Shift-F8,3,3) unless there is an Equation Box
Options code preceding the equation in the document.

If there is an Equation Box Options code, all subsequent equations are printed in
the font that is the current base font at the Equation Box Options code. This
may or may not be the same font as the initial base font for the document
depending on whether you made any base font changes in your document.

If you want to change the size of your equation, you can use the Graphical Font
Size option (see Graphical Font Size below), or you can change the size of your
initial base font or change the base font prior to an Equation Box Options code
(see Font in Reference).

More information on Equation Box Options codes can hefound under Graphics Options
in Reference.

If the Print as Graphics option is set to Yes (see Print as Graphics below),
WordPerfect can instruct your printer to emulate three fonts: WP Helv, WP
Roman, and WP Courier. WordPerfect selects the font that is closest in
appearance to the base font preceding the Equation Box Options code (or the
initial base font for the document if there is no Equation Box Options code).
You can change the size of the font with the Graphical Font Size option (see
Graphical Font Size below).

Equations are formatted according to established mathematical equation

typesetting guidelines. Variables, defined as any sequence of alphabetical
characters you type (other than equation commands), are printed in italics if you

are printing equation symbols as graphics characters (see Print as Graphics
below). If not, variables will be printed in the italics font corresponding to your
base font (see Font in Reference).

Second-level characters such as subscripts, superscripts, small fractions,
binomials, and limits are printed in the superscript font. If they are third-level
characters (e.g., superscript of a superscript), they are printed in the superscript
font for the superscript font. Characters at subsequent levels are printed in the
same font as third-level characters (see Font in Reference).

If the second-level characters mentioned in the paragraph above are printed as
graphics characters (see Print as Graphics below), the superscript font is two-
thirds the size of the graphical font size and the superscript font for the
superscript font is one-half the size of the graphical font size (see Graphical
Font Size below).

Graphical Font Size

If you are printing equation symbols as graphics characters (see Print as
Graphics below), you have two choices as to the size of the font that is used to
create the equation symbols. You can set a specific size yourself, or you can
have WordPerfect determine the size for you.



Before you change the graphical font size setting for an equation, you should
know that an initial or default graphical font size setting is located on the Setup:
Initial Settings menu (Shift-F 1,4,3). Unless you change the graphical font size
setting for an equation in the Equation Editor, the equation conforms to the
setting on the Setup: Initial Settings menu. As shipped, the graphical font size
setting is set to Default Font.

Once an equation is created, it retains the graphical font size setting it was
created under, and the only way you can change that setting is to edit it in the
Equation Editor.

To change the initial graphical font size setting, you must be in the normal
editing screen. When you are, press Setup (Shift-F 1), select Initial Settings (4),
select Equations (3), then select Graphical Font Size (2). Next, select the
graphical font size option of your choice, enter information as necessary, then
press Exit (F7) until you return to the normal editing screen.

To change the graphical font size setting for a single equation, make sure you

are in the Editing window of the Equation Editor. When you are, press Setup,
then select Graphical Font Size (2). Next, select the graphical font size option of
your choice, then press Exit until you return to the Equation Editor.

There are two graphical font size options: Default Font (1) and Set Point Size
(2). If you select Default Font, the font size will be the same as the size for the
base font prior to the Equation Box Options code for the equation (or the initial
base font for the document if there is no Equation Box Options code).

If you select Set Point Size, you can enter the point size yourself.

Positioning Equations

It is probably a good idea to become familiar with WordPerfect Graphics Boxes
if you plan to create equations. These boxes are used to position your equations
on the page.

While WordPerfect contains a graphics box type called “Equation,” you do not
need to create an equation in an Equation type box. In fact, you can create an
equation in any type of graphics box by specifying Equation for the box
contents. The Equation type graphics box, however, has an initial appearance
(no box lines, positioned from margin to margin) that is common for many
equations. This is why we suggest using it in the steps of this section.

For more information on the Graphics feature, see Graphics, Create in
Reference.

Print as Graphics

WordPerfect is initially set to print all equation symbols as graphics characters.
You can change this setting to have WordPerfect print an equation symbol as a
graphics character only if you don't have the symbol in one of the printer fonts.

Before you change the Print as Graphics setting for an equation, you should
know that an initial or default printing setting is located on the Setup: Initial
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Settings menu (Shift-FI,4,3). Unless you change the printing setting for an
equation in the Equation Editor, the equation conforms to the default setting.
Once an equation is created, it retains the printing setting it was created under,
and the only way you can change this setting is to edit it in the Equation Editor.

To change the default printing setting, you must be in the normal editing screen.
When you are, press Setup (Shift-FI), select Initial Settings (4), select Equations
(3), then select Print as Graphics (1). Next, type y to print all equation
characters as graphics or type n to print equation characters as graphics only
when necessary. Then, press Exit (F7).

To change the printing setting for a single equation, make sure you are in the
Editing window of the Equation Editor. When you are, press Setup, then select
Print as Graphics (1). Next, type y to print all equations as graphics characters
or type n to print equation characters as graphics only when necessary. Then,
press Exit.

Ifyou have a printer that doesnt print graphics, you should set Print as Graphics to No.

If you set the Print as Graphics setting to No, WordPerfect will search your
automatic font changes and substitute fonts for the symbol it is looking for (see
Printer Program. Customize Substitute Fonts and Printer Program, Modify
Automatic Font Changes in Reference). If it cannot find the symbol, it will print
the symbol as a graphics character.

If your printer does not have a font that contains the symbol WordPerfect is
looking for and cannot print graphics, it cannot print the symbol. Instead, it will
leave a blank space.

Iffor some reason you don t want to ever print an equation symbol for any other
character) as a graphics character, set the Graphics Quality option on the Print menu to
Do Not Print (see Print Quality in Reference).

For a more detailed description of the WordPerfect printing process, see
Printing—General Information in Reference.

Ifyou are printing equation characters as graphics, you can improve the print quality
with the Print Quality feature (see Print Quality in Reference). If the Text Quality option
on the Print menu is set to High, graphics equation characters are printed in high
quality. If the Text Quality option is set to a quality less than High but greater than Do
Not Print, WordPerfect uses the Graphics Quality’ setting to print graphical equations.

Retrieving an Equation

If you want to retrieve an equation that you have previously saved, press
Retrieve (Shift-FIO) while in the Equation Editor, then enter the filename of the
equation. WordPerfect will first look for the equation in the document directory,
then in the default directory (see Location of Files in Reference).

After pressing Retrieve (Shift-FIO), you can press List (F5), then enter a directory name
to display thefiles in a directory. Ifyou select Retrieve (1) while you are in that
directory. WordPerfect will retrieve the highlightedfile to the Equation Editor.



You can also enter the equation filename under the Filename heading on the
Definition: Equation menu to retrieve the equation.

If you retrieve a WordPerfect (non-equation) file to the Equation Editor, all
codes will be removed except hard returns [HRt] and WordPerfect characters.
Soft returns will be changed to hard returns. The file will still be formatted
according to mathematical equation typesetting guidelines, so spaces and hard
returns will not separate text in the printed equation (see Editing Window above).

If there are equation syntax errors in the text, the “Incorrect Format” message
will appear when you try to display the equation. For more information on this
message, see Display Window above.

Saving an Equation
To save the equation you have created to a separate file, press Save (F10) while
in the Equation Editor.

If you have entered a pathname for a documents directory in Location of Files
(Shift-F1,6,7), WordPerfect prompts you to save it in this directory (see Location
of Files in Reference).

If you are saving an equation that you retrieved to the Equation Editor,
WordPerfect displays the pathname to the documents directory (regardless of the
directory you retrieved the equation from) along with the equation filename. If
you want to save the equation in the documents directory under the same
filename, press Enter, then type y if you are asked to replace. If you want to
make changes to the path or filename, make the changes, then press Enter.

If you are saving an equation that you did not retrieve to the Equation Editor,
WordPerfect displays the pathname to the documents directory. If you want to
save the equation to the documents directory, press End, then enter the filename.
If you simply enter a filename without moving to the end of the displayed

pathname, the equation will be saved to the default directory.

If you have not entered a pathname for a documents directory and are saving an
equation, WordPerfect displays the filename for the equation (if the equation was
retrieved to the Equation Editor) or nothing at all. You can press Enter, then
type y to save the equation under the same filename, or you can enter a filename
of your own. Unless you enter a complete pathname, your equation will be
saved to the default directory.

A saved equation can be retrieved into the Equation Editor for other equations
(see Retrieving an Equation above). When you save an equation as a separate
file, none of the alignment or printing options for the equation are saved with the
equation.

Saving an equation is not the same thing as saving the entire document. In order
to save the document, you must be in the normal editing screen.

See Also: Lesson 29; Equations, Commands and Symbols; Equations,
Commands Syntax; Graphics, Define a Box; Appendix D
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This section assumes that you are familiar with entering and exiting the Equation
Editor. If you are not, refer to Equations in Reference.

When you enter the Equation Editor, the cursor is in the Editing window. From
there you can build your equation with commands, symbols, and text.

There are two different methods for entering equation commands and symbols:

* You can enter math commands and letters found on the keyboard, as well as
extended characters, directly from the keyboard.

or

* You can choose commands and symbols from the Equation Palette. The
various menus on the Palette are discussed below.

Write down your equation as you are creating it, just as you would say it aloud.
In most cases, the Equation Editor closely follows the normal conventions for
verbalizing mathematical equations. For example, to produce the following
equation, you might say “y equals 1 over the square root of x.”

1

This is similar to how you would produce the formula in the Equation Editor,
y =1 0VER SQRT x

You could also type the formula in lowercase letters,
y = 1 over sqrt x

and obtain the same result.

The keywords OVER and SQRT are on the Equation Palette. You can select
them from the Palette or type them from the keyboard.

To select an item from the Palette, press List (F5) to switch to the Palette, press
Page Up (PgUp) or Page Down (PgDn) as necessary to locate the desired menu,
use the cursor keys to move to the command you want, then press Enter or
Ctrl-Enter

For items in the menus that contain both a symbol and a corresponding keyword
(e.g., j and INT), pressing Enter puts the keyword (INT) in your equation in the
Editing window. If you prefer to have the symbol (j), press Ctrl-Enter. This
only affects what is shown in the Editing window. In both cases, when you
press Display (F9), or when you print the equation, the appropriate symbol is
displayed or printed. If there is no keyword or if the keyword is the same as the
symbol, there is no difference between Enter and Ctrl-Enter.
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You may find that once you become familiar with the commands and their
syntax, it is easier to simply type them in than to retrieve them from the Palette.

The building blocks of the Equation Editor are commands, symbols, numbers,
and variables. You can access the commands and most symbols from the
Equation Palette. You can create numbers and variables arbitrarily. Each of
these classes is explained below.

Commands

Commands is one of the menus on the Equation Palette. It contains keywords
which the Equation Editor recognizes as commands. Most commands require
you to use a specific syntax, or structure, when you enter the command. All
commands have some formatting function, such as drawing a line or arranging
variables in the equation.

To select a command from the Equation Palette, press List (F5) to switch to the
Palette, press Page Up (PgUp) or Page Down (PgDn) as necessary to locate the
Commands menu, use the cursor keys to move to the command you want, then

press Enter.

All commands on the Commands menu can also be typed in from the keyboard
(either uppercase or lowercase). For example, the Equation Editor views
“OVER” and “over” as the same command. You can also mix case (e.g.,
“Over”) if you find it useful.

If you type a command, you must separate the command from any variable on
either side. You can do this with a space, the Enter key, or with any symbol
that is part of your equation. For example, if you type

x OVER{-y}

the Equation Editor recognizes the command OVER and formats the equation
correctly. (Braces ({ } are used to group items. For more information, see
Grouping Commands below.)

X
-y

When you retrieve a command from the Palette, the Equation Editor adds a
space before the command (unless the command begins the first line in the
Editing window) and a space after the command.

For a description of each command, see Equations, Commands Syntax in
Reference.

Symbols

There are a variety of symbols that you can use in the Equation Editor. You can
use keyboard symbols, symbols from WordPerfect character sets, and six menus

of symbols on the Equation Palette. The following Palette menus are discussed

under Notes below: Arrows, Greek, Large. Other, Sets, and Symbols.
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For a complete list of the symbols available on the Palette, see Appendix D:
Equation Palette.

Variables

The Equation Editor treats all alphabetic character input that it does not
recognize as reserved commands as variables. A variable must begin with an
alphabetic character, can be one or more characters, and can contain numbers. A
variable is terminated by a non-alphanumeric character (such as a symbol, space,
or Enter). For example, x, yl, AlA, abc are valid variables.

Keep in mind that spaces you type in the Editing window are not converted to
spaces by the Equation Editor. If you want to insert spaces into your equation,
use a backward accent O for a thin space, or a tilde (~) for a normal space (4
thin spaces = 1 normal space).

Variables are printed in the italic setting for the current base font. For details,
see Fonts under Equations in Reference.

Numbers

A number is any non-negative integer (0, 1, 32767, etc.) terminated by a non-
integer (a symbol, space, period, alphabetic character). Numbers are formatted
using the base font currently in effect.

You can enter real numbers (including negative and decimal numbers), but the
numbers are treated as separate alphabetic, numeric, or operator parts by the
Equation Editor. For example, -2 is treated as two parts—a minus sign (-) and
2. 100.5 is treated as three parts— 100, a decimal point (.), and 5.

In order to have a construction with more than one part act as a single unit, you
must surround the construction with braces. For example, if you want to print x
raised to the power of negative 2, you would group the minus sign and the 2 as
follows: xA{2}

I

Similarly, if you wanted to divide x by 0.5, you would type x OVER {0.5}

X
05

Arrows
Arrows is a menu on the Equation Palette, It contains a variety of arrows as
well as several hollow and solid figures such as triangles, squares, and circles.

To select an arrow key from the Palette, press List (F5) to switch to the Palette,
press Page Up (PgUp) or Page Down (PgDn) as necessary to locate the Arrows
menu, use the cursor keys to move to the symbol you want, then press Enter.

As you highlight each Arrow symbol on the Palette, the status line shows a
description of that symbol.
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The Left Arrow and the Right Arrow can be entered by typing <- (< and -) and
-> (- and >), respectively.

Each symbol on the Arrows menu can also be entered using the Compose
(Ctrl-2) feature.

For a complete list of the symbols on the Arrows menu, see Appendix D:
Equation Palette.

Commands

Commands is a menu on the Equation Palette. To select a command from the
Equation Palette, press List (F5) to switch to the Palette, press Page Up (PgUp)
or Page Down (PgDn) as necessary to locate the Commands menu, use the
cursor keys to move to the command you want, then press Enter. You can also
type in the command keyword from the keyboard.

As you highlight each command on the Palette, the status line shows the
keyword for that command, as well as a description and an example of the
syntax.

Most commands require you to use a specific syntax, or structure, when you
enter the command. See Equations, Commands Syntax in Reference for details
of individual commands.

Common Operators and Symbols
These common operators and symbols are not on the Equation Palette and must
be entered directly from the keyboard.

+ - * / = < > ! ? . ! @

Dynamic Operators (Delimiters)

Dynamic operators, or delimiters, are special commands used to create symbols
which vary in height, width, or both, depending on the size of the equation part
to which they apply.

There are eight dynamic operators: OVER, LEFT, RIGHT, SQRT. NROOT,
BINOM, LONGDIV, and LONGDIVS. Each of these operators has a specific
syntax that is explained in Equations. Commands Syntax in Reference.

Following is an example using four of the six operators. To create this equation,
type SQRT LEFT (x OVER {x+y} RIGHT )

Functions

Functions is a menu on the Equation Palette. It contains commands that are
recognized as mathematical functions by the Equation Editor (e.g., sin, cos, log).
Function names are formatted in the base font.
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To select a function from the Palette, press List (F5) to switch to the Palette,
press Page Up (PgUp) or Page Down (PgDn) as necessary to locate the
Functions menu, use the cursor keys to move to the function you want, then
press Enter.

As you highlight each function on the Palette, the status line shows the complete
name for that function.

You can also type all function names from the keyboard. You should separate
function names from surrounding items with a symbol, space, or Enter. Function
names retain the case you type them in.

To create the following equation, type cosA2'ital theta'+'sinA2'ital theta'="I

€0s26 +sin26=1

For a complete list of the Functions menu, see Appendix D: Equation Palette.

The Equation Editor also lets you define your own functions. For details, see
User-Defined Functions below.

Greek
Greek is a menu on the Equation Palette. It contains both uppercase and
lowercase Greek characters, as well as some variants.

To select a Greek character from the Palette, press List (F5) to switch to the
Palette, press Page Up (PgUp) or Page Down (PgDn) as necessary to locate the
Greek menu, use the cursor keys to move to the Greek character you want, then
press Enter to insert the keyword into your equation in the Editing window or
Ctrl-Enter to insert the character itself.

As you highlight each Greek character on the Palette, the status line shows the
keyword for that character.

The Greek characters in the WordPerfect character set that are not on the Palette
are available in the Equation Editor only if they are entered with Compose
(Ctrl-2).

The keywords for uppercase and lowercase letters are differentiated only by the
case. If the command contains an uppercase letter, it is assumed to refer to an

uppercase Greek character (e.g., SIGMA or Sigma would produce Z and sigma
would produce a).

Greek letters are not italicized.
For a complete list of the Greek menu, see Appendix D: Equation Palette.

Grouping Commands
Braces ({ }) are used to group (indicate groupings of) equation symbols and

commands in the Equation Editor.
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For example, if you want a group of characters to be used as a superscript, you
can specify xA{y+2}

To determine the order that the Equation Editor uses for ordering commands, see
Precedence below.

Large

Large is a menu on the Equation Palette. The Large symbols make available
operators that can be one of two sizes—small and large (e.g., SMALLSUM and
SUM). The smaller size (e.g., SMALLSUM) is typically used for Character
Equation boxes (e.g., if you wanted an in-line equation). The larger size (e.g.,
SUM) is typically used in other anchor box types. See Graphics, Define a Box
in Reference for more details.

To select a large symbol from the Palette, press List (F5) to switch to the
Palette, press Page Up (PgUp) or Page Down (PgDn) as necessary to locate the
Large menu, use the cursor keys to move to the symbol you want, then press
Enter to insert the keyword into your equation in the Editing window or
Ctrl-Enter to insert the symbol itself.

As you highlight each Large symbol on the Palette, the status line shows the
keyword and a description for that symbol.

You can enter Large commands from the keyboard as either keywords or
symbols. Keywords for large symbols can be uppercase or lowercase.

For a complete list of the Large menu, see Appendix D: Equation Palette.

Other
Other is a menu on the Equation Palette. It contains diacritical marks (accents)
and four orientations of ellipses (see Diacritical Marks and Ellipses below).

To select one of these items from the Palette, press List (F5) to switch to the
Palette, press Page Up (PgUp) or Page Down (PgDn) as necessary to locate the
Other menu, use the cursor keys to move to the item you want, then press Enter
to insert the keyword into your equation in the Editing window or Ctrl-Enter to
insert the item itself.

As you highlight each Other symbol on the Palette, the status line shows the
keyword for that symbol, as well as a description and an example of the syntax.

You can also enter Other symbols from the keyboard as keywords; these
keywords are not case sensitive.

Diacritical Marks
The diacritical command follows the variable to which it applies. For
example, to produce the first example below, you would type e acute
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The diacritical marks are placed according to the height of the base character
to which they apply.

Keyword

ACUTE
BAR
BREVE
CHECK
CIRCLE
DOT
DDOT
DDDOT
DYAD
GRAVE
HAT
TILDE
VEC

Ellipses

Example

X 5 X @® X X X X X X o xX o

The following commands insert ellipses into an equation as described below.
Each ellipsis consists of three dots. The spacing between the dots is the
same for all 4 commands—only the orientation is different.

Keyword

DOTSAXIS
DOTSLOW
DOTSVERT
DOTSDIAG

Description

A horizontal row of dots centered on the axis

A horizontal row of dots on the baseline

A vertical row of dots

A diagonally-aligned row of dots (upper left to lower
right)

For example, to produce the following equation with a horizontal row of dots
on the baseline, type x DOTSLOW x_n

X. Xy

Precedence

The Equation Editor groups elements in a specific order. This order is listed
below, starting with the highest level of grouping.

Groups

Roots

DU WN -

Diacritical marks
Primes, SUB, SUP, FROM, and TO

OVER, BINOM
Other elements group left-to-right

You can override the normal grouping order by using braces ({ }) around those
elements that you want to keep together as a unit. For example, the Equation
Editor treats x + y as three elements, but {x + y) is treated as a single group. If

EQUATIONS. COMMANDS AND SYMBOLS



commands are used inside of braces, these commands are evaluated first. If
braces are used inside of braces, the elements in the inner braces are evaluated
first. Examples with braces are shown below.

Diacritical marks are attached to the variable immediately preceding them. In
the following example, type x VEC '

The vector is first attached to the variable x, then the prime is attached to the
entire unit.

£
Primes are attached to the variable immediately preceding them, In the

following example, type SQRT x '

The prime is first attached to the variable x. then the radical sign is placed over
the entire unit.

=

If you want a subscript and a superscript on the same variable, you must put the
subscript first, then the superscript. For example, to produce the following
equation, type a_iA2

2

a i

If you want a prime and a subscript on the same variable, you must again put the
subscript first. (The prime operates like a superscript.) For example, type x
SUB 2 ' to produce the following equation:

x4

To produce the following equation, type x SUP 2 SUP 3

The 3 is first attached as the superscript of 2, and then the entire unit is attached
as the superscript of x.
i*

X *

The following equation demonstrates how some of these levels of grouping work
together. Type SQRT xA3-1

The superscript 3 is first bound to the x. This group is then bound to the SQRT
function and placed under the square root radical sign. Finally, the remainder of
the equation (-1) is bound.
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Keep in mind that symbols such as plus (+), minus (-), and decimal point (.) are
treated as separate elements by the Equation Editor. To produce the square root
of -1, for example, insert braces as follows:

sgrt {-1}

Otherwise, the square root function would assume that the minus sign was its
sole argument and sqrt -1 would produce the following:

Sets
Sets is a menu on the Equation Palette. It contains set symbols, relational
operators, and some commonly-used Fraktur and hollow letters.

To select a set symbol from the Palette, press List (F5) to switch to the Palette,
press Page Up (PgUp) or Page Down (PgDn) as necessary to locate the Sets
menu, use the cursor keys to move to the symbol you want, then press Enter to
insert the keyword into your equation in the Editing window (if there is no
keyword, the symbol is inserted) or Ctrl-Enter to insert the symbol itself.

As you highlight each Set symbol on the Palette, the status line shows the
keyword for that symbol (if a keyword is available), as well as a description.

For a complete list of the Sets menu, see Appendix D: Equation Palette.

Two common set symbols, union and intersection, are located on the Palette in
the Large menu.

Spaces and Line Breaks
Spaces and hard returns serve as delimiters (i.e., separators) in the Editing
window, but they are not translated into spaces or hard returns in your equation.

If you want to insert spaces in your equation, type a backward accent (') for a
thin space or a tilde (~) for a normal space (4 thin spaces = 1 normal space).
See Equations. Commands Syntax in Reference for more information on the
backward accent (') and the tilde (~).

If you want to insert line breaks into your equation, use the pound sign (#) or the
MATRIX, STACK, or STACKALIGN commands. See Equations. Commands
Syntax in Reference for more details on these commands.

Spacing Commands

Three commands that you can use to manually adjust the spacing of your
equation within the equation box are HORZ, VERT, and LINESPACE. See
Equations, Commands Syntax in Reference for details on these three commands.
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Symbols
Symbols is a menu on the Equation Palette. It contains miscellaneous symbols,
such as oo, £, and =

To select a symbol from the Palette, press List (F5) to switch to the Palette,
press Page Up (PgUp) or Page Down (PgDn) as necessary to locate the
Symbols menu, use the cursor keys to move to the symbol you want, then press
Enter to insert the keyword into your equation in the Editing window or
Ctrl-Enter to insert the symbol itself.

As you highlight each symbol on the Palette, the status line shows the keyword
and a description for that symbol.

You can also type in keywords for each symbol; the keywords are not case
sensitive.

Some of the keywords are actually two or more keyboard symbols typed together
without a break. For example, you can enter a + by typing +-. These unique
sequences of symbols include " (double prime), (triple prime), +- (plus or
minus), -+ (minus or plus), <= (less than or equal), >= (greater than or equal),

« (much less than), » (much greater than), == (equivalent).

You can use any of the symbols on the Symbols menu by itself except for the
three primes. Each prime must be attached to a variable: x . x ", jc m.

For a complete list of the Symbols menu, see Appendix D: Equation Palette.

User-Defined Functions

The Equation Editor formats variables in an italic font. If you want to print a
character string in the normal base font, you must define the string as a function
using the FUNC command. Functions are formatted as normal text and retain
the case with which they are typed in.

For example, suppose you want to spell out "cosine” in your equation. The
Equation Editor treats the word as a variable and italicizes it, but you decide you
do not want it italicized. If you type FUNC cosine in the Editing window, the
Equation Editor formats “cosine” in the normal base font.

If you want to apply FUNC to more than one variable, simply group the
variables with braces ({ } and place FUNC in front of the group. If you want
to italicize an item, use the ITAL command (see ITAL under Equations,
Commands Syntax in Reference).

See Also:  Equations; Equations, Commands Syntax; Appendix D
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Commands

The following words and symbols are keywords that the Equation Editor
recognizes as commands. They are located under the Commands menu on the
Equation Palette. All commands have some formatting function, such as drawing
a line in an equation or arranging variables in an equation.

To insert one of these commands into your equation, switch to the Equation
Palette by pressing List (F5), move the reverse video bar to the command you
want (using Page Up, Page Down, and the cursor keys), then press Enter.

Commands require a specific syntax or structure. An example of the proper
syntax is shown on the status line when you highlight each of the commands.

As an alternative to retrieving the commands from the Palette, you can also type
them from the keyboard in either uppercase or lowercase. For example, the
Equation Editor views “OVER" and “over" as the same command. You can also
mix case (e.g.. "Over") if you find it useful.

In the following descriptions, a subgroup is simply used to refer to a part of an
equation. Also, wherever a variable is indicated in the syntax of a command,
you can substitute a group (enclosed in braces) for the variable.

# (pound sign)

This symbol is a row separator and indicates a line break (or a new subgroup) in
MATRIX, STACK, and STACKALIGN. The basic syntax isx #y #...#z2
although the syntax for each of the above commands is slightly different. For
the correct usage for each command, see MATRIX, STACK, and STACKALIGN
below. At the outermost level of an equation, the pound sign can be used by
itself to separate lines in an equation (e.g., a=b-c#a=d+3).

& (ampersand)

This symbol has two functions. When used in MATFORM or MATRIX, it is a
matrix column separator. The basic syntax is MATRIX [x &y & ... & z) (see
MATFORM and MATRIX below for details).

When used in STACKALIGN, ampersand (&) indicates the character on each
row on which to align. The basic syntax is STACKALIGN {x&y}, where a is
the character on which you want to align (see STACKALIGN below for details).

. (period)

This symbol is used with dynamic operators to indicate that there is no
corresponding opening or closing delimiter (see Dynamic Operators (Delimiters)
under Equations, Commands and Symbols in Reference). LEFT and RIGHT
must always be used together; if you only want one dynamic delimiter, you must
indicate that the other end is open. LEFT . or RIGHT . is the syntax.
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For example, type LEFT LANGLE x OVER {x+1} RIGHT . to create the
following equation:

For more information, see LEFT below.

\ (backslash)

This symbol indicates that the following symbol or command is treated as a
literal. The syntax is Vommand. For example, if you want a tilde to print as a
tilde rather than as a space, you would type \~

You can also use the backslash to print commands such as OVER, rather than
have the command perform its normal function. If you type \OVER. the word is
treated literally, and the command is no longer recognized by the Equation

Editor as a command.

' (backward accent)
This symbol is translated into a thin space (one-quarter space) by the Equation
Editor. Insert this symbol where you want to print a thin space.

Below is an example of no space (x+y), one thin space after the x (x'+y), two
thin spaces after the x (x '+y), and three thin spaces after the x (x'” +y).

Xty Xty X+y X #y
For information on a normal space, see ~ (tilde) below.
I (left brace)
This symbol signals the start of a group. It is used in tandem with the right
brace (}) symbol, which signals the end of a group. The syntax is {jr..y}. For
example, to print the following equation type {x+1} OVER (x—2}

x+1
X-2

Without the braces ({ )) your equation would print like this:

I

) (right brace)
This symbol signals the end of a group (see { (left brace) above).

EQUATIONS, COMMANDS SYNTAX 185



~ (tilde)

This symbol is translated into a normal space by the Equation Editor. Insert this
symbol where you want to print a normal space. Below is an example of no
space (x+y) and one normal space after the x (x~+y).

X+y X+y
For information about thin spaces, see ' (backward accent) above.

ALIGNC

This command aligns its accompanying argument in the center of the current
subgroup or matrix column. Since center alignment is the default for most
commands, ALIGNC is only useful in matrices. The syntax is ALIGNC x.

For more information, see MATFORM below.

ALIGNL

This command aligns its accompanying argument on the left margin of the
current subgroup or matrix column. ALIGNL can be used with OVER, FROM,
TO, etc., as well as with matrices. The syntax is ALIGNL x.

For example, type ALIGNL 1 OVER 10000 to left align the 1 in the equation
below.

1

10000

For more information, see MATFORM below.

ALIGNR

This command aligns its accompanying argument on the right margin of the
current subgroup or matrix column. ALIGNR can be used with OVER, FROM,
TO, etc., as well as with matrices. The syntax is ALIGNR x.

For example, type ALIGNR 1 OVER 10000 to right align the 1

1

10000

For more information, see MATFORM below.

BINOM

This command creates a binomial construction. The left and right parentheses
are placed around the binomial and are dynamically sized. The syntax is
BINOM *y.
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For example, to produce the equation below, type BINOM alpha beta

a

P

BINOMSM
This command works like BINOM with the exception that the entire construction
is printed in the next smaller font. The syntax is BINOMSM x y.

For example, to produce the equation below, type BINOMSM alpha beta

BOLD
This command causes its argument to be bolded. The syntax is BOLD x.

FROM

This command works with TO and provides beginning and ending limits for
symbols. These limits are always placed below and above the symbol. If you
want side limits, use SUB and SUP.

The syntax is operator FROM x TO'y, where operator is some symbol such as
SUM or INT, and x and y are the beginning and ending limits, respectively.

For example, if you want to produce the following equation, type SUM FROM
{k=0} TO INF

£

A-0

FUNC

This command causes any variable to be treated as a function name, rather than
as a variable. The variable is thus printed in the base font. The syntax is
FUNC variable, where variable is a single variable or a group enclosed in

braces ({}).

For example, if you type WordPerfect, it prints in an italic font— WordPerfect.
If you want it to print in a non-italic font, type FUNC WordPerfect

HORZ

WordPerfect calculates correct spacing for equation commands and operators.
The equation itself is centered vertically in the equation box with respect to the
“baseline” of the equation. You can use the following keyword commands to
adjust the spacing manually:

HORZ n
VERT 1
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where n is the percentage of the current font size to move in a relative direction
to the right or left for HORZ and up or down for VERT. If the number is
positive, the direction is right or up; if the number is negative, the direction is
left or down.

For example, if you are using a 12 point font and type HORZ 100 x=y, the
equation is moved 12 points (approx. 1/6") to the right.

UAL

This command italicizes its argument. It is useful for italicizing functions (e.g.,
cos), numbers, or symbols (e.g., INT, SUM). The syntax is ITAL je (Compare
FUNC above.)

If you use ITAL with a symbol keyword (e.g., ITAL SUM), the keyword is still
correctly translated into the symbol (£), but the symbol will be italicized.

LEFT

LEFT or RIGHT inserts a delimiter which expands according to the size of the
subgroup it encloses. The syntax is LEFT delimiter (or RIGHT delimiter),
where delimiter is one of the following delimiters:

Delimiter Description

( left parenthesis

) right parenthesis

/ slash

[ left bracket

| right bracket

DLINE double vertical line (||)
LANGLE left angle bracket (()
LBRACE left brace ({)

LCEIL left ceiling (f)
LFLOOR left floor ()

LINE single vertical line ( )

RANGLE right angle bracket ())
RBRACE right brace (})
RCEIL right ceiling ()
RFLOOR right floor (J)

For example, type LEFT [ STACK {x=I # y=2} RIGHT ) to create the
following equation:

LEFT and RIGHT must always be used together. However, the left and right
delimiters do not need to be identical or from a matched pair (e.g., [ J). You can
choose from any of the above delimiters for either the left or right delimiter.
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If you want one end open, use LEFT or RIGHT followed by a period () to
indicate an open or null delimiter (see . (period) above).

If delimiters are used by themselves (without a preceding LEFT or RIGHT
command), the symbol is inserted without any automatic sizing. The above
equation would look quite different without using the dynamic delimiters. For
example, [ STACK {x=I # y=2})

Delimiters can have limits associated with them. Use the SUB and SUP
commands. For example, to produce the following equation, type LEFT [ x
OVER y RIGHT ] _1AINF

X

A

LINESPACE

This command allows you to change the vertical line spacing within STACK,
STACKALIGN, and MATRIX structures. The command must be placed before
any of these structures, and the syntax is LINESPACE n where n is the
percentage of normal line spacing for these structures. For example,
LINESPACE 200 is double line spacing.

LONGDIV

This command creates the long division character over the accompanying
variable. The long division character expands to cover the variable, The syntax
is LONGDIV X

LONGDIVS
Does the same thing as LONGDIV, but leaves the left end of the long division
character straight.

MATFORM

This command is used in a MATRIX command to indicate the alignment
formats. It is followed by a row of alignment formats: MATFORM {alignment
& alignment & ... & alignment}, where alignment is ALIGNC, ALIGNL, or
ALIGNR, and & is a matrix column separator. In a MATRIX command, you
might use MATFORM as follows: MATRIX {MATFORM {ALIGNL &
ALIGNR} aaa&bbb # ii&jj # x&y}

aaa bbb
» ji

X y
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The first alignment format is paired with the first element in each row, the
second alignment format with the second element, and so on. The number of
alignments should match the number of matrix columns in MATRIX.

MATRIX

This command creates a matrix in the equation. The syntax is MATRIX [x &
Xl &x2#x3 &x4& x5}. where # is used to delimit rows and & is used to
delimit matrix columns. You should not create a matrix with more than 48
columns. The Equation Editor makes no assumptions on the type of brackets
which surround your matrix. With LEFT and RIGHT (see LEFT above), you
have several options for your left and right delimiters. For example, if you
want to produce the following equation, type LEFT LINE MATRIX {1 & 2 &
3#4 &5 & 6} RIGHT LINE

123
456

NROOT

This command creates the nth root of the accompanying argument. The radical
sign expands to enclose the variable. The syntax is NROOT n x, where n is the
nth root and x is the variable. To create this example, type x'='NROOT 3
{-{27 OVER 8}}

OVER
This command generates fractions. The syntax is x OVER Y. Type x OVER
{x+1}to create the following equation:

X
X+1

All fractions appear with a horizontal bar, as in the above illustration. The
Equation Editor does not use the diagonal bar (e.g., a/b). The horizontal bar
expands according to the size of the numerator or denominator, whichever is
larger. (Of course, you can type a/b manually, but the 'V does not expand
dynamically.)
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OVERLINE

This command places a bar over the variable included as its argument. The
syntax is OVERLINE x. Type OVERLINE {Hello,-world.} to create the
following equation:

Hello, world.

OVERSM

This command works like OVER except that the entire construction is printed in
the next smaller font. The syntax isx OVERSMy. Type x OVERSM {x+1} to
create the following equation:

PHANTOM

This command generates a place holder. It is useful for aligning elements in a
stacked equation when the equations do not contain an equal number of
elements. The syntax is PHANTOM x. For example, in the equation below.

X+y =
X =2

if you want the two ;.- to align as well as the equal signs, you would insert a
PHANTOM command containing the elements in the upper equation missing in
the lower equation. You would type

STACK {x+y=Il # x PHANTOM {+y}=2}

This would cause blank space equivalent to that taken up by +y to be inserted
into the lower equation.

RIGHT
For information on RIGHT, see LEFT above.

SCALESYM

This command can scale normal symbols, numbers, or text when you print the
equation as graphics. The syntax is SCALESYM n symbol, where n is the
percentage of the normal size of the symbol. For example, to make the integral
sign 300% larger, enter SCALESYM 300 int.

When printing the equation as text, SCALESYM only scales the delimiters: ()
[1{} When scaling the {or }delimiters, you must precede them with a\
(backslash): SCALESYM 250 \{.
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SQRT

This command creates the square root of the accompanying variable. The square
root radical sign expands to cover the variable. The syntax is SQRT x. For
example, type SQRT {I-x A2} to create the following equation:

\jl-x1

STACK

A stack is a vertically aligned set of groups or subgroups. Although you can
only have one equation per box, you can “stack” equations within a box. An
example is

STACK {+y # a+b}

where # is used to delimit each subgroup or line within the stack, and x+y and
a+b can be any equation.

X+y
a+b

You can also align subgroups horizontally within a stack. To format the
subgroup flush left, flush right, or centered, use ALIGNL, ALIGNR, or
ALIGNC, respectively, before the subgroup that you want to align. For example,
to align the lower subgroup flush right in the equation below, type

STACK {x+y+z # ALIGNR a+b}

X+y+z
a+b

You can also align entire stacks within larger structures. Place the appropriate
alignment command in front of the STACK command.

STACKALIGN

This command allows you to align a stack of equations on an arbitrary symbol or
symbols. For example, you may wish to align your stack on a decimal point or
on an equal sign. The syntax is STACKALIGN {jcalignchar& y # a
alignchar& b}, where alignchar is the character on which you wish to align, &
follows and marks the align character, and # creates a line break. For example,
STACKALIGN {x>&y+z # a+b<=&c} would produce the following:

X>y+z
a+b<c
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SUB or _
Either of these two commands generates subscripts. The syntax is x SUB Yy (or
x™y), where x has the subscript y.

If you want a subscript and a superscript at the same time, enter the subscript
first, then the superscript. For example, type x_1A2

2
*1

If you type xA2_1, the 1 is subscripted to the 2.
X

SUB and SUP are also used to indicate lower and upper limits for functions and
large operators. These limits are always placed on the side of the operator. If
you want bottom and top limits, use FROM and TO.

For example, type INT _0Al 1 OVER x =y to create the following equation:

SUP or A

Either of these two commands generates superscripts. The syntax isx SUPy (or
-tA), where x is to be raised to the power of y. For more information, see SUB
or _ above.

TO
For information on TO, see FROM above.

UNDERLINE
This command places a bar under the variable included as its argument. The
syntax is UNDERLINE x, where jecan be a single variable or a group.

Type UNDERLINE {Hello,-world.} to create the following equation:

Hello, world.

VERT
For information on VERT, see HORZ above.

See Also: Equations; Equations, Commands and Symbols; Appendix D
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Exit

Exit can quickly take you out of an option, a menu, a document, or the
WordPerfect program. It also lets you save any changes you have made.

To exit a document from the normal editing screen,
1 Press Exit (F7) to begin exiting.

EH Select Exitfrom the File menu.

You are asked if you want to save your work.

2 Type n to continue exiting without saving the on-screen document, then go
to step 4 below.

or
If you want to save the document on the screen, type y.
If you type y, you are asked to name the document.

WordPerfect gives you the option of using long document names in addition to
the standard DOS filenames (see Long Document Names below).

3 Enter a filename (see Entering Filenames below).
You are asked if you want to exit WordPerfect.
4 Type y to exit WordPerfect.
or
Type n to clear the screen and begin a new document.

Notes Backtracking
If you change your mind during the exiting process you can press Cancel (FI) at
the Save or Exit prompts to return to the document on the screen.

Built-in Safety Features
WordPerfect has several built-in safeguards designed to protect you from
accidentally losing or replacing the work you have done.

Whenever you exit a WordPerfect document, you are always asked if you want
to save the document you are in. If you have not made any changes to the
document since the last time it was saved, a “(Text was not modified)" message
appears on the right end of the status line. If this message does not appear, you
may have made changes that you will want to save.

WordPerfect will never let you replace an existing document without asking you
if you want to do so (see Entering Filenames below).
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Entering Filenames
A standard DOS filename can include up to 8 characters followed by a period
and up to 3 more characters after the period.

When an existing filename is displayed, pressing any character key erases the
existing filename so you can start typing a new name. However, before you
press a character key, you can use Left Arrow (<-) and Right Arrow (-») to move
through the existing filename and edit it. Use Backspace, Delete (Del), or Delete
to End of Line (Ctrl-End) to delete existing characters. You can also press
Insert (Ins) to move back and forth between inserting and typing over characters
(see Typeover in Reference).

Each time you enter a filename which already exists, a prompt appears asking if
you want to replace the existing file. Type y to replace the existing file with the
document on your screen. If you press n (or any other key), you are prompted
for a new filename. Enter a different filename to keep both the new and the
existing documents.

Unless you enter a full pathname, a file is saved in the current default directory.
If you prefer, you can use the Location of Files feature in Setup (Shift-F1,6,7) to
specify a directory where your files will be saved when you do not enter a full
pathname (see Location of Files in Reference).

Ifyou want to save afile to a diskette in an external drive, you must type the drive letter
and a colon before entering the filename. For example, if you want to save afile to a
diskette in drive A, press Exit (F7), typey, and then enter a:filename.

Exit vs. Save
Exit (F7) lets you save your work and clear the screen so you can begin another

document. While you are editing a document, you may also want to use Save
(F10) to save the document from time to time without actually exiting (see Save

in Reference).

Exiting Menus and Options
You can press Exit (F7) to leave menus and submenus or the special editing
screen you are in when you type a header, footer, footnote, endnote, etc.

When you use Exit to leave a menu or an option, any changes you have made
are automatically saved for you. If you want to ignore the changes you have
made, press Cancel (FI) rather than Exit (F7) (see Cancel in Reference).

Often as you advance through a series of menus, you can press Exit (F7) to
return directly to your on-screen document without having to stop at each
submenu. However, sometimes you may need to press Exit more than once.

Exiting Multiple Documents

In WordPerfect, you can have two documents active in memory at the same time
(see Switch in Reference). If both documents are open when you complete step
3 at the beginning of this reference section, you are asked if you want to leave
the screen you are in (e.g., “Exit Doc 2? No (Yes)”). Type n (or any other key)
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to clear the current screen and remain in it or type y to close the screen you are
in and switch to the other screen.

WordPerfect has a startup option, /n2, that disables the Document 2 screen to
save memory (see Appendix N: Startup Options).

Long Document Names

Long Document Name lets you enter an additional name that is saved along with
the standard DOS filename for each document you create. Whereas the DOS
filename is limited to eight characters plus a three-character extension, the long
document name can contain up to 68 characters and spaces, excluding the
additional space required for extended characters. You can turn on the Long
Document Name feature by setting the Long Document Names entry to Yes in
Environment Setup (Shift-F 1,3,4,3,y) (see Environment Setup in Reference).
Then, when you exit a document, you are asked to enter a long document name
and document type before you enter a standard DOS filename. The “Long
Document Name:" prompt appears immediately after step 2 at the beginning of
this section.

When you enter a long document name, you can include spaces and type any
character on the keyboard. You can also use Compose (Ctrl-2) to add any
character from a WordPerfect character set to the name (see Compose in
Reference). You can use Left Arrow (<-) and Right Arrow (->) to move through
the name and edit it. Use Backspace. Delete (Del), or Delete to End of Line
(Ctrl-End) to delete existing characters. You can also press Insert (Ins) to move
back and forth between inserting and typing over characters.

After you enter a long document name, you are asked to enter the document
type. The document type is another way of categorizing your documents. It can
include any information which will help you group and identify your files. A
document type can include up to 20 characters, excluding any additional space
required for extended characters.

Once you have entered a name and type, the DOS filename prompt appears (i.e.,
“Document to be Saved:-). You can then continue the exiting process as
explained in steps 3 and 4 at the beginning of this section.

Even when a document has a long document name, only the standard DOS
filename is displayed on the left end of the status line in the normal editing screen
when you are editing a document. Long document names are displayed only in the
List Files Long Display screen and in the Document Summary feature.

You can have your documents displayed alphabetically by long document names
when you use List (F5) to list the files in a directory (see File List under List
Files in Reference). You can also display and enter long document names in the
Document Summary menu (see Document Summary in Reference).

See Also: Cancel; Location of Files; Save; Switch



F Fast Save (unformatted)

Notes

Find

Normally, when you save a document in WordPerfect it isfast saved. This

means that WordPerfect does not format the document for printing in order to
speed up the saving process.

When you print a document that has been fast saved from disk, WordPerfect
“retrieves” the document in the background without actually displaying it on-
screen, and moves the cursor completely through it to make certain that it is
correctly formatted before printing.

If you prefer, you can turn off the Fast Save feature, and WordPerfect will then
format each document completely at the time it is saved.

1 Press Setup (Shift-FI).
US Select Setup from the File menu.
2 Select Environment (3).

3 Select Fast Save (unformatted) (5), then type n to turn off the Fast Save
feature.

4 Press Exit (F7) to return to your document.

Disk Space and File Size

Depending on the changes you have made and the features you have used while
editing a document, fast saving a document can increase the size of the
document. Old information concerning settings which are no longer in effect
(e.g., former printer definitions, former styles) is not purged when a document is
fast saved. It is purged when fast save is not on, or when you retrieve a file for
editing.

Each time you save, fast save, or print a fast saved file from disk, WordPerfect
first makes a copy of that file on the same disk. Therefore, you must have
enough available disk space for two copies of your document.

See Also: Print, Document on Disk

It is sometimes difficult to spot the exact file you need. This becomes even
more difficult when there are many files in a directory.

Find gives you several helps in searching through the files in a directory for a
certain file. You can use Find to find a file by filename or to list only those
files which contain a specific word or phrase.
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For example, suppose you know you sent a memo to Mr. Claussen. but you can't
remember what you named your file. You can use Find to search through the
files in your MEMO directory and locate the memo which contains Mr.
Claussen’s name.

To use Find to help you locate a certain file,

1 Use List (F5) to display the files in the directory where the file is located
(see List Files in Reference).

At this point, you can limit your search to only certain files (see Limiting a
Search below).

2 Select Find (9) to display the Find menu.

3 Select an option to specify where you want to search (see Filenames and
Documents below and Find. Conditions in Reference).

You are asked to enter a search phrase,
4 Enter the word or phrase you want to search for (see Search Patterns below).

WordPerfect searches the files, then rewrites your screen, listing only the files
which meet your conditions.

You can then use the cursor keys to move through the remaining filenames,
press Enter or select Look (6) to display the contents of certain files, and use
#Search (F2) within Look to search for the word or phrase. You can also use
Find again to search this reduced group of files. Once you have found the file
you want, you can select Retrieve (1) to retrieve it. Even after you have
retrieved a file, you can still redisplay the reduced list by pressing List (F5)
twice. If no files are found, a “Not Found” message appears briefly at the status
line, followed by a blank List Files screen.

Pressing List twice does not redisplay the list if you have changed the default setting for
the Long Document Name feature (Shift-FI1,3,4.3).

Conditions

Selecting Conditions (5) from the Find menu displays a Conditions screen which
lets you enter specific conditions to further limit a search (see Find, Conditions
in Reference).

Documents

Three of the options on the Find menu let you specify which part of each file
you want to search. Select Doc Summary (2) to search only the text of the
document summaries. Select First Page (3) to search only the first pages or the
first 4000 characters (whichever comes first). Select Entire Doc (4) to search the
entire contents of each document, excluding the document summary.



Filenames
Select Name (1) from the Find menu to search for a file by name.

Whereas in Name Search you have to type in a filename beginning with the first
letter to move to that file, the Name option works more like the Search feature in
the normal editing screen. You can enter just part of a filename to list the
filenames which contain the same letters in that same order. For example, you
can enter et to display files called LETTER, LETTERS. BETTER, GETSET,
etc.

When entering filenames, you can use the question mark (?) and the asterisk (*)
to represent other characters (see Search Patterns below).

Only filenames that match the pattern you enter will remain on-screen when the
search is over.

If you want the filenames that match the pattern you enter to be removed from
the screen and only filenames which do not match the pattern to remain on-
screen, use the dash (-). You can also use other logical operators to limit the
scope of a search (see Search Patterns below).

Using the Name feature on the Find menu lets you reduce a long list of files to a
specific few which match a certain pattern. When you want to quickly move to
a certain filename without changing the current file list, you can use ~Search (F2)
or ¢Search (Shift-F2) (see Short Cats below).

Limiting a Search

Obviously, the more files you search through, the longer your search is going to
take. Consequently. Find offers you many features designed to let you narrow
the scope of your search.

For example, you can search through only parts of files (see Documents above).
In addition, when you display the files, you can use a filename pattern to display
only certain files in a directory. Also, before you begin the search, you can
move the cursor through the filenames and type an asterisk (*) to mark each file
you want to include in the search. Then only the marked files will be searched.

Search Patterns

You can enter a search pattern in response to the “Word Pattern:" prompt that
appears after you have selected options 1 through 4 on the Find menu. You can
also enter a search pattern in any of the entries on options 4 and 5 on the Find:
Conditions screen (see Find, Conditions in Reference). When entering the word
or phrase you want to find, you can include up to 39 characters. No distinction
is made between uppercase and lowercase letters.

The 39 characters cannot consist of more than five words, nor can any word contain
more than 20 characters.

You can use the question mark (?) and the asterisk (*) to represent other
characters within words and phrases. The question mark takes the place of a
single character, while the asterisk takes the place of zero or more characters
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To search for a pattern of words, enclose the pattern in quotation marks. To
search for an exact phrase, include a space between the last letter and the last
quotation mark. If a phrase contains a single quotation mark, use double
quotation marks around the phrase.

The following list gives some examples of patterns.

Pattern Selection

book The files that contain the word "book. ”

d?sk The files that contain words that match the d?sk pattern
(e.g., desk, disk, dusk).

“replace disk " The files that contain the exact phrase "replace disk. ”

"replace disk" The files that contain patterns such as "replace disks™

and “replace diskette. "

"replace*disk" The files that contain a pattern that starts with “replace™
and ends with "disk" plus any other characters. For
example, "replace the B diskette. ”

You can also combine words with the following logical operators: the semicolon
(;) or the space (), the comma (,), and the dash (-). The semicolon (;) or space
() selects files which contain both the words it joins. The comma (,) selects
files which contain either word it joins. The dash (-) works like a minus sign.
Use the dash (-) to conduct an exclusive search. WordPerfect then excludes all
files that match any pattern which follows the dash. To search for an actual
dash (-), enclose the dash within quotation marks (e.g.,

WordPerfect performs the operations from left to right.

The following list gives a few examples of using logical operators:
Operator Selection
Bill Sue or Bill;Sue All files that contain both Bill and Sue.

Bill.Sue All files that contain either Bill or Sue.

Bill,Sue;Ted All files that contain either Bill or Sue and also
Ted.

Bill “replace disk ” All files that contain Bill and the phrase "replace
disk." Bill can occur before or after the phrase.

-way Only the files that do not contain way.

four-way Files that contain four, but do not contain way.

"four-way" The files that contain four-way.



Find, Conditions

Short Cuts
You can use #Search (F2) or ¢Search (Shift-F2) to quickly move to a filename
whenever a file list is displayed on-screen, even after selecting Find (2).

Press #Search or #Search, type a word or phrase found anywhere in the
filename, then press Enter or a search key. As opposed to Name Search, you do
not have to begin the search pattern at the first letter in the filename. This is a
rapid means of moving through a file list, especially when you are using long
document names (see Long Document Names under Exit in Reference). You can
enter a word or word pattern found in either the long name, the type, the DOS
filename, or the subdirectory name.

Some of the Find features work more rapidly than others. In terms of speed, the
fastest way to move to a filename is to use ¢Search (F2). Ranking the options
on the Find menu by speed, they are Name, Document Summary, First Page, and
finally, Entire Document.

Undo

Undo works in much the same way that Undelete does in the normal editing
screen. Once a search has been completed, you can select Undo (6) from the
Find options menu to return the file list to the way it was before you performed
the search. Undo maintains up to three different backup levels of file lists. As
you narrow the scope of a search. Undo lets you back up to a previous list if you
do not find the file you want.

For example, suppose you search for a certain word pattern in a directory which
contains 70 files. You enter a search pattern that reduces the list to 40 files.
You then enter another search pattern only to display a blank screen. You can
select Undo (6) from the find menu to redisplay the 40 files. That way, Undo
spares you from having to start over again from the beginning.

See Also: Find, Conditions; List Files; Search

When you are using Find to search through the files in a directory for a certain
file, you can display a Conditions screen which lets you enter specific conditions
for the search.

To use the Conditions screen.

1 Display the files in the directory where the tile is located (see List Files in
Reference).

2 Select Find (9) to display the Find menu.
Select Conditions (5) to display the Find: Conditions screen.
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When any conditions appear on this screen, only the files which meet all the
conditions will be listed after a search. You can reset this screen at any time
(see Reset Conditions below).

4 Enter the conditions you want to use for this search (see Document
Summary, Text, and Revision Date below).

5 Select Perform Search (1) to perform the search.

WordPerfect searches the files, then rewrites your screen, listing only the files
which meet your conditions.

Document Summary

To limit a search to a specific item within the document summary (creation date,
document name, document type. etc.), select Document Summary (5) from the
Conditions menu, then enter the word or phrase under that item (see Search
Patterns under Find in Reference). You can press bown Arrow (F) OF Up
Arrow (T) to move from item to item. Remember that the Document Summary
Creation Date entry gives the date of the file when the document summary was
created, and not necessarily the date on which the document itself was created
(see Revision Date below).

Perform Search
Once you have entered all the conditions you want, select Perform Search (1) to
perform the search.

Reset Conditions

The conditions of the last search arc in effect until you change them to do
another search. Selecting Reset Conditions (2) completely clears this screen and
empties all existing search conditions.

Revision Date

Select Revision Date (3) from the Conditions screen to search only for files
which have been edited between certain dates. Enter the month, day, and year,
separated by slashes (e.g., 9/9/99 or 09/09/1999).

Text

The options on the Find menu let you limit a search to document summaries, the
first page, or the entire document. Selecting Text (4) from the Conditions screen
lets you combine these three different searches into one. You can enter a
different search pattern for the document summary, the first page, and the
complete document, and then select Perform Search (1) to search for all three
patterns at once (see Search Patterns under Find in Reference). You can press
Down Arrow (i) or up Arrow (T) to move from item to item.

See Also: Find
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Notes

Flush Right aligns dates, titles, or headings flush against the right margin.

Issue 22 Halva

FROM THE PRESIDENT

After looking over the second
quarter reports, | couldn"t
help but be pleased.  HALVA
International has now become
the eighteenth largest import-
export company in the world.

The findings come as more of a
surprise when you remember that
only a little more than a year
ago I predicted in this column
that our growth would stagnate
somewhat.  in this case | am
glad to be proven wrong.

While we must give credit where
credit is due and acknowledge
the growth in the industry as a
whole, we should feel good
about what we have accomplished
thus far in 1990. Once again,
1 must credit all HALVA
employees--people who get the
joh done.

News September 23, 1991

OFFICE CHATTER

As  you may
have noticed,

HALVA has

installed a

new phone

system

While the - .

phone  system Dial 9 First
will no doubt take some getting
used to, we think that it"s the
best system money can buy and
one that will prove useful for
our type of business.

You can also use Flush Right with Home to insert a Hard Right Tab [RGT TAB]

(see Hard Right Tab below).

To align text with the right margin,
1 Press Flush Right (Alt-F6).

Select Align from the Layout menu, then select Flush Right.

The cursor moves to the right margin.

2 Type the text you want aligned at the right margin.

The text you type is inserted at the left of the cursor.

3 Press Enter to open a new line and end the flush right alignment.

or

Press Format (Shift-F8), select Other (4), then select End
Centering/Alignment (9) to end the flush right alignment.

Codes

When you align text, a Flush Right code [Fish Rgt] is placed immediately to the

left of the aligned text. When you press Enter, a Hard Return code [HRt] is

inserted, and the alignment ends. When you select End Centering/Alignment (9)

from the Format: Other menu, an End Centering/Alignment code [End C/A] is

FLUSH RIGHT
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inserted and the cursor remains on the same line when the alignment ends.
These codes can be displayed in Reveal Codes (Alt-F3).

Be aware that a Flush Right code takes precedence over other text.
Consequently, if you are in the middle of a line when you press Flush Right
(Alt-F6) and then type text which runs into existing text, on-screen text may
disappear. When this happens, use Reveal Codes (Alt-F3) to view and delete the
unwanted text or codes.

Dot Leader
When aligning text flush right, you can insert a dot leader before the aligned text
by pressing Flush Right (Alt-F6) twice, as in the following example.

Contents

Preface iii

L0 T = 2
Chapter 2. ... eiiiieieeeaaaeaaeeaaaan 14
0 T = 27
Chapter 4 . ... iiaeeeaeeaaaeeaeeaaaaas 34
Chapter 5.......... 46
APPENd X A e 54
APPENdiX B L eieeeeeeeaeeeeeeeeeeeaaaaaan 59
APPENAIX € et i it e e e ie e eaaeeeaaaeeameaeaaaa e 63

Index

You can also insert a dot leader with a Hard Right Tab LRGT TAB] (see Hard
Right Tab below).

Existing Text

You can flush right an existing line or part of a line of text. Place your cursor at
the beginning of the text you want to flush right, then press Flush Right
(Alt-F6).

Hard Right Tab

A Hard Right Tab aligns text with the next tab stop. To create a Hard Right
Tab at the next tab stop, press Home.Flush Right (Alt-F6). WordPerfect inserts
a Hard Right Tab code [RGT TAB], To create a Hard Right Tab with dot
leaders, press Home,Home,Flush Right (see Types of Tab Settings under Tab
Set in Reference).



Font

Multiple Lines

You can use Block to flush right one or more lines of existing text. Block the
lines you want at the right margin, press Flush Right (Alt-F6), then type y. All
the lines in the block are aligned against the right margin (see also Block in
Reference).

When a block of text is aligned, a Right Justification code [Just:Right] is placed
at the beginning of the text and a code matching the original justification setting
is placed at the end (e.g., Left, Center, or Full). You can remove the alignment
by deleting both codes (see Justification in Reference).

If you block text to the end of your document, and if you do not have a hard
return at the end of your document, WordPerfect will insert a hard return at the
end of your document after you press Flush Right.

Part of a Line

The cursor does not have to be at the left margin when you press Flush Right
(Alt-F6). You can use Flush Right to type new text and align it on lines that
include tabs, indents, and centered text.

Simply move the cursor to the right edge of any existing text or codes, press
Flush Right (Alt-F6), then type the text you want at the right margin. This lets
you create headings with text aligned at the left or right margin, or centered all
in one line.

See Also: Center Text; Justification

Font refers to the appearance of characters on a printed page. A font consists of
three elements: typeface (e.g., Times Roman), weight (e.g., Bold or Light), and
point size (for proportionally spaced fonts) or pitch (for mono-spaced fonts).
Your printer comes with the capability to print in at least one font.

A point is approximately 1/72".

In WordPerfect, the base font is the font in which normal text (text without
attributes) is printed. For example, if your normal text is printed in Times
Roman 10pt. your base font is Times Roman 10pt.

WordPerfect attributes are usually printed in variations of the base font, so the
selection of your base font also selects the fonts for your attributes. For
example, if your base font is Times Roman [Opt, italicized text is probably
Times Roman IOpt italic. Large text is probably Times Roman, but in a larger
point size than 10pt.

"Probably™ is the correct term because it all depends on what fonts your printer
has available. If your printer has one font, then all text is printed in that font. If
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your printer has hundreds of fonts that can be scaled to size, you probably have
a different font for each WordPerfect attribute.

You tell WordPerfect which fonts your printer has available with the Cartridges and
Fonts feature (see Cartridges/Fonts/Print Wheels in Reference).

You can change the base font several ways in WordPerfect.

Important: Do not use more than 255 unique fonts in one document.

Your printer has an initial base font selection. This selection is made on the
Select Printer: Edit menu (Shift-F7,s,3,5) and instructions on how to set it can be
found under Printer, Edit in Reference. Unless you change the base font with
one of the two options discussed below, the setting made on the Select Printer:
Edit menu determines the base font for all documents subsequently created.

Only portraitfonts are shown on the Select Printer: Edit menu.

Document Initial Base Font

The second place you can set the base font is on the Format: Document menu.
This setting is only for the document on the screen, and is used to override the
initial base font setting on the Select Printer: Edit menu.

To change this setting,

1 Press Format (Shift-F8), then select Document (3).
CB Select Document from the Layout menu.

2 Select Initial Base Font (3).

At this point, a list of portrait fonts is displayed on the screen. These fonts are
a duplication of the information entered on the Cartridges/Fonts/Print Wheels
feature (minus any landscape fonts).

3 Move the cursor to the font you want to select as your base font, then choose
Select ().

4 Press Exit (F7) until you return to the normal editing screen.

The setting you make on this menu takes precedence over the setting on the
Select Printer: Edit menu. Unless you change your base font with the option
discussed below, your base font will be printed according to this setting.

Base Font Code

The third place you can set your base font is on the Base Font menu. This
option inserts a code and changes the base font from the location of the code
forward in your document. The code overrides the Initial Base Font option on
both the Select Printer: Edit and Format: Document menus.

To change this option,

1 Move the cursor to the location in your document where you want to change
the base font.



Notes

2 Press Font (Ctrl-F8), then select Base Font (4).

ce Select Base Font from the Font menu.

At this point, a list of fonts is displayed on the screen. Depending on your paper
size/type information, these fonts are either all landscape fonts or all portrait
fonts (see Landscape and Portrait Fonts below). Regardless, all fonts listed are
fonts entered on the Cartridges and Fonts feature.

3 Move the cursor to the font you want to select as your base font, then choose
Select ().

The setting made with this feature inserts a code in your document. From that
point on in the document (or until you make another change with this feature),
the base font is changed to the selection you made.

Base Font codes may be entered in sub-editing screens such as header, footer,
footnote, endnote, and graphics caption screens. When a Base Font code is
located in one of these screens, it affects only the information in that screen.

You may also insert Base Font codes in Setup: Initial Codes and Document:
Initial Codes (see Initial Codes in Reference). A Base Font code in either one of
these screens acts as if you had placed a Base Font code at the top of your
document, so text in the document will be printed in that font. Footnotes,
endnotes, equations, and graphics box captions, however, will use the Document
Initial Base Font unless a Graphics Box Options, Footnote Options, or Endnote
Options code is located in the document (see Document Initial Base Font above).

If one of the options codes listed in the paragraph above is located in the
document, subsequent graphics box captions, footnotes, and endnotes (depending
on the options code) are printed in the base font that is in effect at the options
code.

Attributes

As mentioned at the beginning of this section. WordPerfect attributes are usually
printed in variations of the base font depending on the fonts your printer has and
what your printer can do with those fonts. When you tell WordPerfect about
your fonts in the Cartridges/Fonts/Print Wheels feature and select a base font,
WordPerfect determines which fonts will represent the different attributes.

If you want to determine how attributes with a particular base font will be
printed, retrieve the PRINTER.TST file, select your printer, change the Base
Font code with the Initial Base Font option on the Format: Document menu
(Shift-F8,3,3), then print the document from the screen.

PRINTER.TST is installed separately with the WordPerfect Install/Learn/Utility
files. It is initially installed in the directory where WP.EXE is located.

You can change the font assignments WordPerfect has made for your attributes
in two places.
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The first is with the Size/Attribute Ratio feature (Shift-FI ,4,8,6). This feature
lets you enter sizes for some of the attributes as compared to the base font. It is
discussed in Initial Settings in Reference.

The second is with the WordPerfect Printer Program. This program lets you
change font assignments for all attributes. It is discussed in Printer Program,
Modify Automatic Font Changes in Reference.

For more information on size and appearance attributes, see Attributes in
Reference.

Landscape and Portrait Fonts

The fonts that are displayed on the various Base Font menus are fonts that come
with your printer as well as fonts you mark on the Cartridges/Fonts/Print Wheels
feature. Portrait fonts and landscape fonts, however, cannot be displayed on any
of the Base Font menus at the same time. In fact, landscape fonts can only be
displayed on the Base Font menu (Ctrl-F8,4) and even then, not all of the time.

Whether portrait fonts or landscape fonts are displayed on the Base Font menu
depends on the Font Type of the current Paper Size/Type. If the Font Type is
Portrait, portrait fonts are displayed. If the Font Type is Landscape, landscape
fonts are displayed.

For example, if you want to display landscape fonts, you must first select a
Paper Size/Type with a landscape font type (Shift-F8,2,7,1). As long as the
cursor is positioned after the Paper Size/Type code, only landscape fonts will be
displayed on the Base Font menu. If the cursor is positioned before the Paper
Size/Type code, then portrait fonts will be displayed.

For more information on font types, see Paper Size/Type and Printing,
Landscape in Reference.

Name Search

In all of the menus where you select a base font, you can quickly move the
cursor to the font you are looking for by selecting Name Search (n), then typing
letters to move the cursor to the first font that begins with those letters. Press
Enter or any of the arrow keys to exit Name Search.

If you are defining a macro that selects a font, we suggest you use Name Search
to locate that font.

Printer Selection

Fonts are printer specific. This means that if you enter a base font in a
document, then print the document on a printer that does not have the font, the
font will not be printed. In this situation, WordPerfect makes a “best guess”
from the available fonts and tries to print the document in a similar font.

If you create a document for one printer, then save it with another printer, you
may notice that your Font codes which usually list the name of the font (e.g.,
[Font:Tms Rmn 10pt]) are replaced with Font codes that show an asterisk in



front of the font name (e.g., [Font:*Tms Rmn 10pt]). The asterisk means that

the printer you saved it under does not have the font that you initially entered.
Again, when the document is printed, WordPerfect makes a “best guess” and
tries to print the document in a similar font.

You must make font changes within WordPerfect. WordPerfect overrides any font settings
you set on your printer.

See Also: Attributes; Printer Program, Modify Automatic Font Changes;
Printing—General Information; Cartridges/Fonts/Print Wheels

Footnotes and Endnotes

A
A

FOOTNOTES
ENDNOTES

Footnotes and endnotes are useful for listing sources or providing more detailed
information on an item in your text. Footnotes are usually listed at the bottom
of the page where they are referenced. Endnotes are usually listed at the end of
the document.

When you create footnotes and endnotes, WordPerfect will number and format
them for you. You can type in the text, then have WordPerfect number the notes
and place them on each page, adjusting the text in your document to fit correctly.
WordPerfect places footnotes at the bottom of the page and compiles endnotes at
the end of the document or at a location of your choice.

Even after you have finished your document, you can edit, add, or delete a note,
and WordPerfect will do all of the necessary renumbering and reformatting.
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In this section, the word "note” refers to both footnotes and endnotes.
To create a note,

1 Move to the place in your document where you want the number for the new
note inserted.

2 Press Footnote (Ctrl-F7), then select Footnote (1) or Endnote (2).
CB Select Footnote or Endnote from the Layout menu.

3 Select Create (1).
4 Type the text of the note (see Editing a New Note below).

5 Press Exit (F7) to return to your document.

Adding and Deleting Notes
You can add new notes anywhere in a document (except in columns and
footnotes) by following the steps above.

Creating a note inserts a Note code into your document. The format for the code
is [nore:#;[Note Number/] where note is Footnote or Endnote, # is the note
number and text is the text of the note, up to 50 characters. You can view this
code in Reveal Codes (Alt-F3) and delete the note by deleting the code.

In the normal editing screen, you can delete an existing note simply by deleting
the number representing it and then typing y to confirm the deletion. If you
accidentally delete a note, you can use Cancel (FI) to restore it, just as you
would restore any other deletion (see Undelete in Reference).

When you add or delete a note, the remaining notes in your document are
renumbered automatically. However, you must rewrite the screen (press
Ctrl-F3,3 or move the cursor past the notes that follow the new number code) to
display the renumbered notes.

Editing a New Note
Selecting Create (1) from the Footnote or Endnote menu places you in a special
Note Editing screen. The number, letter, or character for the note you are



creating appears in the upper left corner of the screen. The type of note you are
creating (i.e., Footnote or Endnote) appears on the status line.

A NOTE NUMBER
A NOTE TYPE AThis has been associated \

2 Press Exit when done Doc 1 Pg 1 Ln 2.33" Pos 4.56"

Enter text as you normally would, using the WordPerfect editing features (e.g.,
Bold, Underline, Center, Tab, Flush Right). A single footnote or endnote can
contain up to 65,000 bytes (approximately 65,000 characters). Use Move
(Ctrl-F4), Block (Alt-F4), and Cancel (FI) to move, delete, and restore text
within the note. Move can also be used to move text from your document into a
footnote and back again (see Move in Reference). You can also use the Speller
and Thesaurus while in this screen.

Unless a Base Font code exists in the note, a note is printed in the initial base
font for that document as displayed in the Initial Base Font entry on the Format:
Document screen (Shift-F8,3,3) (see Document Format in Reference).

However, if a note options code precedes a note, the notes from that point on are
printed in the font that is in effect wherever the options code is found (see
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Footnotes and Endnotes, Options in Reference), as the following example
demonstrates.

Remember to press Exit (F7) once you have finished typing the text of the note
to save the note and return to your document. If you forget to exit the Note
Editing screen, you may wind up typing part of your document in the Note
Editing screen by mistake. If this happens, you can use Block (Alt-F4) and
Move (Ctrl-F4) to block the unwanted text and move it back into your document
(see Block and Move in Reference).

Editing an Existing Note
As long as you know the current number, letter, or character for a note, you can
edit any of the notes you have created, at any time, from anywhere in the main
body of the document.

To edit an existing note, press Footnote (Ctrl-F7), select Footnote (1) or
Endnote (2), then select Edit (2). You are asked which note you want to edit.
The number (or letter or character) displayed is one number greater than the
number of the note which immediately precedes the cursor position. Enter the
number of the note you want to edit, using your current numbering style (for a
discussion of numbering styles, see Footnotes and Endnotes, Options in
Reference).

After you enter a number, if that note exists, the note editing screen appears with
the current text for that note displayed on the screen. Edit it (see Editing a New
Note above), then press Exit (F7) to save your changes and return to the normal
editing screen.

If the number you enter is not found, a *Not Found* message appears briefly at
the left end of the status line and you are returned to the normal editing screen.



Endnote Placement

Normally, WordPerfect prints endnotes at the end of your document. Although
there is no code indicating where the endnotes are to be printed, you can see the
endnotes when the document is printed, or when you use View Document to
preview the printed document (Shift-F7,6). If endnotes exceed one page, only
one page of endnotes can be viewed.

Sometimes you may want endnotes at a different location. For example, if one
document contains several chapters, you may want to compile each chapter’s
endnotes at the end of that chapter.

To specify an endnote location, move the cursor to where you want to insert the
Endnote Placement code, press Footnote (Ctrl-F7), then select Endnote
Placement (3). You are asked if you also want endnote numbering to start over
from that point. Type y to have endnotes renumbered from that point or type n
to have numbering continued from the current number. An Endnote Placement
code [Endnote Placement] is inserted at the cursor, followed by a Flard Page
code [HPg], If you chose to have your endnotes numbered from that point, a
New Endnote Number code [New End Num:#] is then inserted, where # is the
first number in the current numbering method (e.g., 1or a).

Whenever you print the document, the endnotes are printed at the location of the
Endnote Placement code. All endnotes either from the beginning of the
document or from the point of the last Endnote Placement code will be printed at
this location.

When WordPerfect inserts an Endnote Placement code, it follows the code with a
Flard Page code to separate the endnotes from the next page of text. If you want
the endnotes to begin on a separate page, you should also insert a Hard Page
code immediately before the Endnote Placement code.

In the normal editing screen, the Endnote Placement code is represented by a
box which contains a message informing you that you must generate your
endnotes. This box is followed by a hard page, as in the following example.

A ENDNOTE PLACEMENT
CODE

A HARD PAGE CODE

dayl3. His philosophy was that man is no better than his
environment. He bought a group of textile mills in Scotland. In
accordance with this new philosophy he tried to eliminate the

typical social evils of the factory system and make his factories
into the model workers® community- He raised wages and improved
factory sanitation. He reduced the hours worked, and even helped

rebuild the workers™ homes and provided schools far their children.

Endnote Placement
> It is not known how much space endnotes will occupy here.
Cenerate to determine.

Doc 1 Pg 11 Ln 1* Pos 1"
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If you use Endnote Placement, you then need to generate the endnotes in that
document if you want to determine how much space they will occupy in the

printed document. To do so, press Mark Text (Alt-FfS), select Generate (6),

select Generate Tables, Indexes, Cross References, etc. (5), then type y. The
message in the box then changes to “Endnote Placement,” indicating that the
endnotes have been generated (see Generate in Reference).

You do not have to generate endnotes in order for them to be printed.

Footnote Placement

When you add a footnote to your text, WordPerfect places it at the bottom of
that page. WordPerfect automatically reduces the text on the page to make room
for any footnotes and inserts a blank line between the footnotes and the text.

If a footnote is too long to fit on one page, WordPerfect tries to keep at least one
half inch of the note on the same page as the number that references that
footnote. If it cannot do this, WordPerfect moves both the footnote and the line
of text containing the footnote reference to the next page.

You can change both the spacing between footnotes and the amount of footnote
text to be kept on a page (see Footnotes and Endnotes. Options in Reference).

Graphics
Only a graphics box with a character anchor type can be included in a note (see
Graphics, Create in Reference).

Master Documents

If your document is extremely long, you may want to use the Master Document
feature to divide it into smaller files. Footnotes and endnotes are numbered
consecutively throughout a master document (see Master Documents in
Reference).

Options

Several available options let you determine the numbering style of your notes
and the way notes are formatted (see Footnotes and Endnotes. Options in
Reference).

Renumbering Notes from a Given Point

When you have a document divided into several files, you may need to start note
numbering at a certain number. To do so, press Footnote (Ctrl-F7), select
Footnote (1) or Endnote (2), select New Number (3), then enter a number using
the current note numbering method (see Note Numbering Method under
Footnotes and Endnotes. Options in Reference).

This Inserts a New Number code into your document, i.e., [New note type
Num:#] where note type is Footnote (Ftn) or Endnote (End), and # is the new
number. All the notes of that type from that point forward in the document will
be numbered consecutively, starting with the new number. However, you must



rewrite the screen (press Ctrl-F3,3 or move the cursor past the notes that follow
the new number code) to display the renumbered notes.

See Also: Footnotes and Endnotes, Options

Footnotes and Endnotes, Options

Notes

WordPerfect offers you several options in determining the numbering style for
your footnotes and endnotes and the way they are formatted on a page. You can
change these options or let WordPerfect select them for you.

To change note options,

1 Press Footnote (Ctrl-F7), then select Footnote (1) or Endnote (2).
j Select Footnote or Endnote from the Layout menu.

2 Select Options (4) to display the Options menu.

3 Select an option and enter the necessary information (see the option headings
under Notes below).

4 Press Exit (F7) until you return to the normal editing screen.

Amount of Note to Keep Together

If a note is too long to fit on a page, it is continued on the next page. This
option sets the amount of space in a note (not necessarily the number of lines)
that is to be kept on one page. The default is one-half inch.

Codes

Changing note options inserts an options code ([Ftn Opt] or [End Opt]) which
can be seen in Reveal Codes (AU-F3). The options code affects only the notes
from that point forward in the document. If you want the new format to affect
all the footnotes in your document, the options code must be placed before any
notes in the document.

An options code cannot be edited. The only way to change your option settings
is to delete the options code or to create a new code by using the steps given at
the beginning of this section.

Each time you display an Options menu, the settings it contains reflect any
changes made by any previous options code.

You can include the options code in your Initial Settings to have the footnote
and endnote options you want placed in every subsequent document you create
(see Initial Settings in Reference).
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Footnote Options
Four options are available only for footnotes:

Footnotes at Bottom of Page

When text does not fill a page, this option determines whether footnotes will
be printed at the bottom of the page or just below the last line of text. If
this option is set to Yes, blank lines are inserted between text and footnotes,
when necessary, to keep all footnotes at the bottom of each page.

Line Separating Text and Footnotes

This option determines whether WordPerfect prints a line to separate text
from footnotes. You can select No Line (1), 2-Inch Line (2), or Margin to
Margin (3), as in the following illustration.

Print Continued Message

When a footnote must be split between two pages, setting this option to Yes
prints “(continued...)” on the last footnote line of the first page and
“(...continued)” on the first footnote line of the next page. You can change
the language in which this message is printed by inserting a language code in
the initial codes for a document (see Language in Reference). You can also
change the text for these messages by editing the WP.LRS file (see

Language Resource File in Reference).

Start Footnote Numbers Each Page
If this is set to Yes, footnote numbering starts at 1 on every page. If this is
set to No, footnotes are numbered continuously throughout the document.

Note Numbering Method
Normally, WordPerfect uses numbers (e.g., 1, 2, 3, etc.) to number notes. The
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Note Numbering Method option lets you select either Numbers (1), Letters (2),
or Characters (3).

When you select Characters (3), you then need to enter the character(s) you want
to use.

The character used most often to number notes is an asterisk (*). However, you
can enter any WordPerfect character using Compose (see Compose in Reference).
A character is used once, then doubled, then tripled, etc. (e.g., *, **, ***, etc.).
If you want a different character for each note, you can enter up to five different
characters (e.g., * t + 8 ¢). WordPerfect uses the first character, then the second,
etc., until it has used them all. It then doubles, then triples the characters. After
each character has been repeated 15 times, they start over at one again.

Spacing Within and Between Notes

Normally, notes will be single spaced with .167" (the height of a 12-point font)
blank space between each note. Within notes, you can enter 1 for single, 1 1/2
for one-and-a-half line spacing, 2 for double, etc. If you want to vary the
spacing for a particular note, you can use Line Spacing in Format (Shift-F8,1,6)
to set line spacing within a note while in the Note Editing screen.

Style for Numbers
You can select how your note numbers appear both in the text of your document
(Style for Number in Text) and in the note itself (Style for Number in Note).

WordPerfect normally displays the note number in superscript in a document
(e.g., Footnote). Within a footnote, WordPerfect displays a superscripted
number which is indented, and within an endnote, WordPerfect displays a
number which is followed by a period (1.).

W hen you select either Number Style option, a “Replace With:""prompt appears.
You may enter characters and use Font (Ctrl-F8) to select any of the
WordPerfect size or appearance attributes (see Font in Reference). You can also
add and delete spacing. Within a style, the Note Number code [Note Num]
indicates where the note number will print. While creating a note numbering
style, you can insert the Note Number code by pressing Footnote (Ctrl-F7),
selecting Footnote (1) or Endnote (2), then selecting Number Code (2).

see Also: Compose; Font; Footnotes and Endnotes

Force Odd/Even Page

Sometimes you may want to make sure that certain pages in a document always
have an odd, or even, page number. For example, it is customary to begin each
chapter in a book on an odd-numbered page.

You can have WordPerfect insert blank pages where necessary to make sure that
a certain page always has an odd or even number.
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1 Move the cursor to the top of the page for which you want to force the
number (see Codes below).

Press Format (Shift-F8), then select Page (2).

Select Page from the Layout menu.

Select Force Odd/Even Page (2).

Select Odd (1) to force the page to have an odd number.

Awgm

or
Select Even (2) to force the page to have an even number.
5 Press Exit (F7) to return to your document.

The page number is forced to odd or even. It appears in the Pg # indication on
the status line.

Codes

Forcing a page number inserts a Force Page code ([Force:OddJ or [Force:Even])
into your text at the cursor position. This code can be seen in Reveal Codes
(Alt-F3).

A Force Page code should always be placed at the top of the page it is forcing.
When necessary, WordPerfect inserts an extra Soft Page code [SPg] directly
before this code to create a blank page and make certain the forced page retains
an odd or even number. If the Force Page code is not at the top of the page, the

blank page will be inserted in the middle of the existing page and create
unnecessary blank space, depending on If the page was already odd or even.

Force Odd/Even Page vs. New Page Number

Forcing a page inserts blank pages where necessary, but it continues to keep the
pages in your document numbered consecutively. If you want a page in your
document to begin with a certain number that is not necessarily in consecutive
order, you can do this without inserting blank pages by using New Page Number
(Shift-F8,2,6,1,#) (see Page Numbering in Reference).

See Also: Page Numbering

WordPerfect offers a wide variety of possible format settings.

Format lets you access any of the options used to format your text. You can
then make changes which will affect the current document.

1 Press Format (Shift-F8) to display the main format menu.
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2 Select Line (1), Page (2), Document (3), or Other (4) to display a submenu
which lists a certain group of Format options (see Line, Page, Document, and
Other below).

CB Select Line. Page. Document, or Other from the Layout menu.
3 Select a format option and change it.

4 Press Exit (F7) to return to the document.

Codes

In WordPerfect, you type text on a clear screen. The default settings being used
to format your text on the page are hidden from sight. They do not appear in
the normal editing screen, and they cannot even be seen at the top of your
document when you use Reveal Codes (Alt-F3).

WordPerfect comes with standard settings for several of the most commonly-
used formatting features (e.g., left and right margins, tabs, top and bottom
margins, etc.). These settings are in place whenever you type a document. For
a list of all these settings, see Appendix G: Initial Settings.

When you want to know the current setting for any Format option, press Format
(Shift-F8) and select the menu which displays that option. The menu displays
any current setting if there is one, and you can then change the setting.

For the Line. Page, and Other Format menus, changing a setting inserts a code
which changes that setting from that point forward in a document. As a rule of
thumb. Line Format codes should come at the beginning of a line, and Page
Format codes should come at the beginning of a page. These codes can be
displayed in Reveal Codes (Alt-F3).

For the Format: Document menu (Shift-F8,3), changing a setting does not insert
a code into your document but it does change that setting for the entire
document.

If you want your own personalized format settings in place whenever you create
a document, you can customize the standard WordPerfect initial format settings
by using Initial Codes on the Setup: Initial Settings menu (Shift-F 1,4,5) (see
Initial Codes in Reference).

Document

The Document submenu options let you make changes that affect the entire
document you are working on. For example, you can use the Document options
to create a Document Summary or change the initial base font for your
document. The Document options are:

« Display Pitch * Redline Method
« Initial Base Font e Summary
* Initial Codes

For more information, see Document Format in Reference.
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Line
The Line submenu options deal with the way text is formatted horizontally on a
line, that is across a page. They are:

* Hyphenation * Line Spacing

* Hyphenation Zone * Margins Left/Right

« Justification e Tab Set

* Line Height » Widow/Orphan Protection

Line Numbering

For more information, see Line Format in Reference.

Other
The Other submenu contains several advanced formatting options. They are:
« Advance ¢ End Centering/Alignment
« Border Options ¢ Language
» Conditional End of Page » Overstrike
e Decimal Align Character/  Printer Functions
Thousands’ Separator * Underline Spaces/Tabs

For more information, see Other Format in Reference.

Page

Th% Page submenu options deal with the way text is arranged on a page, and
from page to page throughout a document. For example, you can use Page
options to center the text vertically on the page. The Page options also let you
have WordPerfect add page numbers and special headings to pages. Page
submenu options are:

« Center Page e Page Numbering
« Force Odd/Even Page » Paper Size/Type/Labels
e Headers and Footers e Suppress

e Margins Top/Bottom
Generally, these codes should be placed at the top of the page. For more
information, see Page Format in Reference.

See Also: Document Format; Line Format; Other Format; Page Format;
Appendix G
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Generating is the final step in creating a table of contents, table of authorities,
list(s), and index(es). Generating also updates cross-references and the space
being used for endnotes (if you are using Endnote Placement), Before
generating, you should have marked the text you want, inserted any Endnote
Placement codes, and defined your table, list, or index. For more information,
see the appropriate Define heading for each in Reference (e.g., Index, Define).
Also see Cross-Reference, Mark Text, or Footnotes and Endnotes.

To generate,

1 Press Mark Text (Alt-F5), and select Generate (6).

US Select Generate from the Mark menu.

2 Select Generate Tables, Indexes, Cross-References, etc. (5).

A message appears asking if you want to replace any existing tables, lists, and
indexes.

3 Type y to generate cross-references, endnotes, tables, lists, or indexes,
replacing any previously existing ones.

or
Type n if you want to return to your document without generating.

Generating begins, and a counter at the bottom of the screen indicates the
progress of generation. All tables, lists, and indexes in the document are
generated, and cross-references and endnote placement are updated—all in one
generating process.

Depending on the number and length of the items you are generating, generating
may be time consuming. Also, don’t be concerned if the counter on the status
line indicates WordPerfect is passing through the document multiple times. That
is a necessary part of the generating process.

You can use generate as many times as you want. Each time, cross-references
and endnote placement are updated, and the previous versions of tables, lists, and
indexes are deleted before the new ones are created—provided you have not
deleted any [Def Mark:] codes (see [Def Mark:] and [End Def] below). This
allows you to generate, mark new entries, create new endnotes, add cross-
references, and generate again, updating the entries in the tables, lists, or indexes.

Be aware that if you make any changes to text you have marked, cross-
references, endnotes or endnote placement, or the definition of tables, lists, or
indexes, your changes will not be included unless you generate again.

Cross-Referencing
When you generate cross-references, question marks are replaced with numbers,
and existing numbers are updated.
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[Def Mark:] and [End Def:]

When you defined your table, list, or index, [Def MarkTv/rc#] (where type
represents the type of reference — ToC, List, or Index — and # represents the
numbering style) was inserted into your document at the cursor position. Each
table, list, or index is generated at its [Def Mark:]. When generating is
complete, [End Def:] is inserted at the end of each table, list, or index. These
codes can be seen in Reveal Codes (Alt-F3).

When you generate again, WordPerfect deletes everything between [Def Mark:]
and [End Def:] before creating a new table, list, or index. You should be careful
when editing your document that you are not adding text between the two codes
(unless you really do want to edit a generated table, list, or index).

If you delete [Def Mark:] and leave [End Def:], WordPerfect briefly displays a
message (the next time you generate) stating that a needed [Def Mark:] is
missing.

WordPerfect needs to have both [Def Mark:] and [End Def:] in order to replace
an old table, list, or index with a new one. If you delete [End Def:J,
WordPerfect leaves your old table, list, or index and generates a new one as
well. Also, if you define a new table, list, or index, you should delete the old
[Def Mark:] or the item will be generated twice. If you find you have duplicate
tables, lists, or indexes, these may be the reasons.

Remember, each time you change the definition for tables, lists, and indexes, you
are also creating a new [Def Mark:] code. Be sure to delete the old [Def Mark:]
when you create a new [Def Mark:].

When generating tahles, lists, and indexes, WordPerfect sorts according to the
language at the point of the [Def Mark:].

Editing Tables, Lists, and Indexes

WordPerfect uses standard formatting features to format tables (contents and
authorities), lists, and indexes. Once they have been generated, you can edit
them like you would any other WordPerfect text. For example, a table of
contents is formatted using indents [“Indent] and margin releases [*Mar Rel],
These codes align on tab stops. If the table is not aligned properly, you may
need to change the tab stops (see Tab Set in Reference). Be aware that if you do
edit the text in a table, list, or index, and then regenerate it, the old table, list, or
index will be replaced with a new one, and you will lose any editing you did to
the old one. It may be better to edit the marked text in the document and then
regenerate.

You should be careful that as you edit you do not delete [Def Mark:] or
[End Def:] before and after the table, list, or index. This will cause problems if
you ever generate again.



Endnote Placement

You can tell WordPerfect to print endnotes someplace other than the end of the
document by using the Endnote Placement feature (see Footnotes and Endnotes
in Reference). When you insert an Endnote Placement code into a document, the
following message appears at the insertion point:

"Endnote Placement. It is not known how much space endnotes will occupy
here. Generate to determine.”

In order to have WordPerfect determine how many pages the endnotes occupy,
you need to use the Generate feature.

After you have generated the document, an “Endnote Placement” message
replaces the original message. This new message takes up as many pages of the
document as the endnotes will require. You can identify the number of pages by
moving the cursor past the message and past the page break under the message.
The status line will reflect which page the rest of the document starts on.

If, after adding or deleting endnotes, you decide you need to know if the
endnotes will take up any more or less pages, regenerate to update the Endnote
Placement code.

Not Enough Memory-Marked Text Block Too Large

When generating a table, list, or index, a message may appear indicating that
your computer does not have enough memory available to complete generation.
You can free up additional memory by making sure Document 2 is empty (press
Switch (Shift-F3) to check and Exit (F7) to close Document 2), or by unloading
any memory resident programs that may be installed. Be sure to save your
document before unloading any memory resident programs.

WordPerfect has a startup option, /n2, that disables the Document 2 screen to
save memory (see Appendix N: Startup Options).

A message also appears if you are using a concordance file and run out of
memory. You can type y for Yes and only the concordance entries scanned up
to that point will be included in the index. Type n for No to stop index
generation (see Index, Concordance and Mark Text in Reference).

Sorting Order

WordPerfect sorts index entries and authorities alphabetically when generating an
index or table of authorities. Entries in lists or a table of contents are sorted
according to the order in which they appear in the document.

Table of Authorities

When you define a table of authorities, you should set a new page number
between the table of authorities definition and the next page of the document
(see Page Numbering in Reference). If you do not, page number references may
not be accurate after the table is generated (since the table itself will likely
introduce new pages into the document). A warning message appears when the
table of authorities is generated if a New Page Number code is not found.
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See Also: Lesson 22; Index; Lists; Table of Authorities; Table of Contents

As you move the cursor through your document, use Go To to move quickly to a
certain location.

To move through text using Go To,

1 Press Go To (Ctrl-Home), then press an appropriate keystroke (see Go To
Keystrokes below).

(13 Select Go tofrom the Search menu.

Go To Keystrokes
The following table lists the keystrokes that can be used with Go To to move the
cursor through text:

Location Keystrokes
To the immediate right of the next Go To, character
occurrence of any character.
To the next Hard Return code [HRt] Go To, Enter
To the top of the current page Go To, Up Arrow (T)
or column
To the bottom of the current page Go To, Down Arrow (F)
To the top of any page in your Go To, page number, Enter
document
To the beginning of a block (when Go To, Block (Alt-F4)
Block is on)

In Columns

When you are using the Columns features (Newspaper and Parallel), you can use
Go To with the Left and Right Arrow keys to move the cursor from column to
column as you edit existing text (see Columns, Newspaper and Columns, Parallel
in Reference).

Not Found

When Go To searches for a character or a Hard Return code [HRt], if that
character is not found within approximately the next 2000 characters, a beep
sounds and the cursor remains in place.
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Previous Position
You can press Go To (Ctrl-Home) twice to return the cursor to its estimated
previous location, after using the following keys:

* Block (AU-F4) * Replace (Alt-F2)

« Escape (Esc) e Screen Up (- on the number pad)

e Go To (Ctrl-Home) e Screen Down (+ on the number pad)
¢ Home.arrow keys e ¢Search (F2)

« Page Up (PgUp) e ¢Search (Shift-F2)

e Page Down (PgDn)

See Also: Columns, Newspaper; Columns, Parallel

When you start WordPerfect from the DOS prompt, if you have enough memory
in your computer, you can return to DOS without exiting WordPerfect.

1 Press Shell (Ctrl-Fl), then select Go to DOS (1).
S Select Go to DOSfrom the File menu.
2 Perform any DOS commands.

3 Type exit and press Enter to return to WordPerfect. You cannot return to
WordPerfect by pressing Exit (F7) (see Caution below).

Your cursor is returned to the same place it was when you left WordPerfect.

Caution

If WordPerfect is still active while you are at DOS, an “Enter ‘EXIT’ to return
to WordPerfect” message is displayed above the DOS prompt. You must type
exit and press Enter to return to the active copy of WordPerfect. Do not try to
return to your currently active copy of WordPerfect by entering wp. This only
loads another copy of WordPerfect into memory.

If you have enough memory, you can run other programs from DOS before
returning to WordPerfect.

While WordPerfect is active, do not use the CHKDSK/F or DELETE commands
on the WordPerfect program files. Also, any DOS command which might affect
WordPerfect should be avoided (e.g., REN).

DOS Command

While running WordPerfect from DOS, you can also perform a DOS command
without leaving WordPerfect. Press Shell (Ctrl-FlI), then select DOS Command
(2). You are prompted for the command at the status line. After the command
has been performed, press any key to return to WordPerfect.
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Memory

When you select Go to DOS (1) or DOS Command (2), a new copy of
COMMAND.COM (a DOS file) is loaded into memory. If there is not enough
memory to load the new copy, an error message appears, and you are returned to
your document.

Under Shell
Different Shell menu options appear when you press Shell (Ctrl-FI) if you are
running WordPerfect under the WordPerfect Shell (see Go to Shell in Reference).

See Also: Go to Shell

When running WordPerfect under the WordPerfect Shell, you can leave
WordPerfect and return to the Shell without exiting WordPerfect.

1 Press Alt-Shift-Space Bar to go directly to the Shell, then go to step 3.
or
Press Shell (Ctrl-Fl) to display the Shell options.

CB Select Go to Shell from the File menu, then go to step 3.

2 Select Go to Shell (1).

The Shell menu is displayed.

3 You can start another program from the Shell menu, select a Shell feature, or
go to DOS to perform one or several commands, depending upon the current
available memory (see Caution below).

4 Select the WordPerfect program letter from the Shell menu to return to
WordPerfect.

Your cursor is returned to the same place as it was when you left WordPerfect.

Caution

If the Shell is still active while you are at DOS, a “(Shell)” message precedes the
DOS prompt at the command line. If WordPerfect is active, do not try to return
to WordPerfect by entering wp from the DOS prompt. This will only load
another copy of WordPerfect. To return to your active copy of WordPerfect,

you need to first enter exit to return to the Shell, and then go to WordPerfect.

While WordPerfect is active, do not use the CHKDSK/F or DELETE commands
on the WordPerfect program files. Also, any DOS command which might affect
WordPerfect should be avoided (e.g., REN).



DOS Command

While running WordPerfect from the Shell, you can also perform a DOS
command without leaving WordPerfect. Press Shell (Ctrl-FI), then select DOS
Command (5). You are prompted for the command at the status line. After the
command has been performed, press any key to return to WordPerfect.

Library 1.1

We strongly recommend that you use WordPerfect Library 2.0 or WordPerfect
Office 2.0 dated 6/30/88 or later when using WordPerfect 5.1. If this is not
possible, be aware of the following:

e The Save and Append options on the 5.1 Shell menu will not work. Use the
Library Screen Copy feature to save text to the Clipboard (see Screen Copy
in Shell Reference in the WordPerfect Library or WordPerfect Office
Manual).

« If you are using a version of the Shell program dated earlier than 6/30/88
and are receiving the "Error 258” prompt, you need to order an upgrade from
Library 11 to Library 2.0 in order to run WordPerfect from the Shell.

* WordPerfect Merge files need to be exported in 4.2 format in order to be
compatible with the Library 11 Notebook (see Text In/Out in Notebook
Reference in the WordPerfect Library or WordPerfect Office Manual).

« With any version of File Manager prior to 6/30/88, you can only lock
WordPerfect files in 4.2 format. This means that any 5.1 files locked with
File Manager must be unlocked with File Manager before they can be used
in WordPerfect 5.1.

Memory

The number of other programs you can run While you have WordPerfect resident
in memory depends on the available memory in your computer (see Memory
Map in Shell Reference in your WordPerfect Library or WordPerfect Office
Manual).

Shell Clipboard
The Clipboard is a special file the Shell uses to hold the text you transfer from
program to program.

While running WordPerfect under the Shell, pressing Shell (Ctrl-FI) from the
normal editing screen displays the Shell Clipboard options. You can then select
Save (2) to save the current document to the Clipboard, Append (3) to add the
current document at the end of any existing text in the Clipboard, or Retrieve (4)
to retrieve the contents of the Clipboard at the cursor.

If block is on when you press Shell and select Save (2) or Append (3), only the
blocked text is saved or appended to the Clipboard (see also Clipboard in Shell
Reference in your WordPerfect Library or WordPerfect Office Manual).

See Also: Go to DOS
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The Graphics Conversion Program converts files in a number of graphics formats
to WordPerfect (WPG) format. Many files can be converted directly through
the Graphics feature in WordPerfect. Some formats, such as AutoCAD DXEF,
must be converted with the Graphics Conversion Program. See Graphics,
Formats and Programs in Reference for more information before using the
Graphics Conversion Program.

You might want to use the Graphics Conversion Program to convert files in
supported formats if:

e The file is in DXF format. (All DXF files must be converted through the
Conversion Program.)

¢ You want to use some of the startup options available with the Conversion
Program that affect the way the file is converted (see Startup Options
below).

* You want to convert multiple files (see Multiple Files below).

e You are using the Graphic on Disk feature and want to save time in printing,
viewing, and editing the display parameters of the graphic (see Graphic on
Disk below).

Important: The Graphics Conversion Program file (GRAPHCNV.EXE) needs to be
installed properly before using the program. Ifyou chose not to install the utility
programs when you installed WordPerfect (or have not subsequently installed them), you
must do so now to use the Graphics Conversion Program. See the Installation
Instructions cardfor installation instructions.

To run the program,
1 Go to DOS.
2 Change to the directory where GRAPHCNV.EXE is located.

The Installation Program copies thisfile to the directory where WordPerfect (WP.EXE) is
located (usually C:\WP51) if you are using a hard disk, or to the diskette you labeled
“Utilities™ if you are using a two disk drive system.

3 Enter graphcnv to start the program.

4 Enter the full pathname of the file to be converted (input file).
5 Enter the full pathname of the converted file (output file).
When you see the “->0k” message, the conversion is complete.

6 Press any key to exit the program.
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Notes Error Messages
As the Graphics Conversion Program tries to convert your files, the following
error messages may appear.

Bad Format

The input file is in a format not converted by the Graphics Conversion
Program. Try exporting the file to another supported format (use your
graphics program). For a list of supported formats, see Graphics, Formats
and Programs in Reference.

Bad Input File

The input file cannot be accessed. This error occurs when the specified path
to the input file cannot be found or does not exist, or when the graphics file
you want to convert is marked “Read Only.” This message may also
indicate that an error occurred while converting a file. For example, the
input file may be corrupt, or it may contain information not expected given
the type of the input file.

First check whether you entered the path correctly. If not, run the Graphics
Conversion Program again and enter the correct path. If the original path
was correct, try re-exporting the file with your graphics program, then run
the Graphics Conversion Program again.

Disk Full
This error occurs when there is not enough room on disk to convert the file.
If you can, make room by deleting files, then try again.

End of File

An unexpected end of file was encountered while trying to convert the file.
Try exporting the file in another supported format (use your graphics
program). See Graphics, Formats and Programs in Reference for a list of
supported formats.

File Not Found
The specified file could not be found. Check to be sure you entered the
correct path and name of the file.

Graphic on Disk

When WordPerfect needs to use an image located in a graphic file on disk, it
must find the file and convert it. The converted file is placed in a temporary file
which is then deleted when WordPerfect no longer needs it. This conversion
takes time, and occurs every time you print or view a document using a graphic
on disk, or when you edit the display parameters of a graphic on disk (see
Graphics, Edit in Reference for more information).

If you pre-convert the file by using the Graphics Conversion Program, you will
reduce the time required for these tasks. Note, however, that if you convert the
graphic on disk, the graphics program you used to create the file may not be able
to edit the converted file.
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Multiple Files

You can use wildcard characters when specifying the input filename to convert
multiple files. Use “?” to represent a single character, and to represent zero
or more characters in succession. The output filenames will match the input
filenames except that they will have a .WPG extension.

For example, if you have a series of graphics named GRAPHICI.DXF,
GRAPHIC2.DXF, GRAPHIC3.DXF, etc., you could convert them all at once to
WordPerfect format by entering graphic?.dxf as the input filename. The output
files would be named GRAPHIC1.WPG, GRAPHIC2.WPG, GRAPHIC3.WPG,
etc. To convert any file with a DXF extension to WordPerfect format you would
enter *.dxf as the input filename.

Startup Options
The following startup options can be used with the Graphics Conversion
Program:

inputfilename outputfilename

You can designate both the input filename and output filename when you
start the Graphics Conversion Program by entering graphcnv inputfilename
outputfilename, where inputfilename is the name of the file to be converted,
and outputfilename is the name of the output file.

You can also use wildcard characters in the input filename without using an
output filename to convert multiple files. See Multiple Files above for more
information.

Ib=#
Sets the background color for the .WPG output file, where # represents one
of the following colors:

I=Black, 2=Blue, 3=Green. 4=Cyan, 5=Red, 6=Magenta, 7=Brown, 8=White
If no number is specified, the background color defaults to intense white.
lc=2

Converts color values in the input file to monochrome (black and white)
values.

/c=16
Converts color values in the input file to the WordPerfect standard 16-color
palette.

/c=256
Converts color values in the input file to the WordPerfect standard 256-color

palette. (Use this option when you have a graphics adapter capable of
displaying 256 simultaneous colors.)

/c=b
Converts all color values in the input file to black.
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lc=w
Converts all color values in the input file to white.

If=#
After a color or gray scale conversion (with /c or /g), you can use this option
to change the fill color. # represents the following colors:

I=Black, 2=Blue, 3=Green, 4=Cyan, 5=Red, 6=Magenta, 7=Brown. 8-Gray,
9=Dark Gray

/g=16
Converts color values in the input file to the WordPerfect standard 16 shades
of gray palette.

/g=256

Converts color values in the input file to the 16 shades of gray present in the
WordPerfect standard 256-color palette. (Use this option when you have a
graphics adapter capable of displaying 256 simultaneous colors.)

/h
Displays helpful information about the Graphics Conversion Program.

n
Lets you send conversion status messages for each converted file to the
standard printer device. See also /I=filename below.

H=filename
Lets you send conversion status messages for each converted file to the
specified file. See also // above.

/m
Inverts monochrome bitmapped images.

In=#
After a color or gray scale conversion (with /c or /g), you can use this option
to change the line color. See /f=# above for a list of colors.

/o

Lets you override the “Replace files?" user prompts. This is known as
unattended mode. When the Graphics Conversion Program writes an output
file with a filename that already exists, it will replace the existing file
without issuing a prompt.

Iw

As WordPerfect 5.1 converts HPGL plotter files, all measurements are
scaled. WordPerfect 5.0 translated pen widths as “hairline” with no width
conversion. If you still want WordPerfect to translate pen widths as hairline,
start the 5.1 Graphics Conversion Program with the /w startup option.

See Also: Graphics, Create; Graphics, Edit; Graphics, Formats and Programs;
Screen Capture Program

GRAPHICS, CONVERSION PROGRAM 231



Graphics, Create

The Graphics feature lets you incorporate pictures or images from many sources
into your document. The capability to mix text and graphics in the same
document makes it easy to produce newsletters, instructional materials, and other
documents where figures, diagrams, logos, and/or pictures are needed.

To see a list of the graphics formats that WordPerfect supports (and the programs that
produce those formats), see Graphics, Formats and Programs in Reference.

Using the Graphics feature, you can create a box around which you can wrap
text. The location, appearance, and size of the box can be adjusted as needed,
and a graphics image, an equation, or even another document (less than a page
long) can be retrieved into the box. You can even define columns, create tables,
enter merge codes, and import a spreadsheet into a graphics box.

On the normal editing screen, an outline of the graphics box is displayed in your
document if you are wrapping text around the box (see Wrap Text Around Box
under Graphics, Define a Box in Reference). To see the contents of the box, you
must use View Document (Shift-F7,6) or select Edit (9) on the box definition
menu (see Graphics, Edit in Reference).

You can also place horizontal or vertical lines on a page with the Graphics
feature.

You can include graphics in a document even if you do not have a graphics
display card installed in your computer; however, WordPerfect will only be able
to display a rough image of graphics figures. We suggest investing in a graphics
display card if you want to take full advantage of the graphics capabilities in
WordPerfect (see Graphics Screen Type in Reference).
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Notes

As long as your printer supports graphics, you can print both text and graphics in
a document even if you do not have a graphics display card installed (see Print,
Document on Disk and Print, Document on Screen in Reference).

To create a graphics box,

1 Press Graphics (Alt-F9), then select a box type (see Box Types below).

O Select a box type (Figure, Table Box, Text Box, User Box, or Equation) from the
Graphics menu.

2 Select Create (1), then define the box (see Defining a Box below).

3 Press Exit (F7) to return to the document.

Box Types

There are five box types from which you may choose (all are considered
graphics boxes): Figure, Table, Text, User, and Equation. The Line option on
the Graphics menu is not a box but rather an option that lets you place horizontal
and vertical lines on the page (see Graphics Lines in Reference).

There are only three differences among the five types of graphics boxes: 1) they
each belong to a separately numbered list (see Lists, Define in Reference)’, 2)
they have different default options on the Graphics Options menu (e.g., border
style, numbering method); and 3) Equation boxes have different Caption Position
choices (see Graphics Options in Reference).

You can retrieve graphic images, text, or equations into any of the box types, or
you can leave a box empty. The box type does not necessarily refer to the
contents of the box, but rather to which of the independent lists of graphics
boxes it belongs.

Each box type is numbered on a separate list and has its own set of options. For
example, the default numbering mode for Table boxes is Roman numerals (Table
I, Table Il, etc.), while the default numbering mode for Figure boxes is numbers
(Figure 1, Figure 2, etc.). The numbering mode, border styles, and other options
can be changed with the Graphics Options menu (see Graphics Options in
Reference).

A separate list for each box type can be generated with the List feature (see Lists
in Reference).

You may want to use Figure boxes for graphic images, diagrams, and charts;
Table boxes for WordPerfect tables, tables of numbers, maps, and statistical data;
Text boxes for quotes, sidebars, or other special text that is set off from the rest
of the document; and Equation boxes for mathematical and scientific equations
(see Equations in Reference). User boxes could be used for any images in the
document that do not fall into any of the other categories.

If you are editing or creating a graphics box and need to change the box type
(e.g., change a Table box into a Figure box), press Graphics (Alt-F9) while in
the box definition menu and select the desired box type.
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Defining a Box

After you select a box type and select Create (1) to create a graphics box, you
need to define the box. You can simply retrieve a graphics image into a box by
selecting Filename (1) at this point, then entering the name of a file created in
one of the many graphics formats that WordPerfect supports (for a list of
supported graphics formats and the programs producing those formats, see
Graphics, Formats and Programs in Reference). You can also retrieve a table or
text by entering the name of a WordPerfect file containing one of these (see
Table, Create in Reference). If you want to retrieve an equation into a box, you
must first select Equation (4) as the contents (see Contents under Graphics,
Define a Box in Reference).

If you want to include the graphics image, table, text, or equation in your
document with all the default settings, you can press Exit (F7) to exit the
definition menu at this point. If you would like to change any of the settings
(e.g., size and position of the graphics box on the page), refer to Graphics,
Define a Box in Reference.

New Number
Graphics boxes are numbered consecutively according to the box type. You can
start numbering with a new number at any point in the document.

1 Move the cursor to where you want to enter the new number.

Use Reveal Codes (Alt-F3) tofind the box code (e.g., [Fig Box:3;filename; caption]),
then make sure your cursor is before the box code you want renumbered (see Reveal
Codes in Reference).

2 Press Graphics (Alt-F9), then select the type of box you want to renumber.

TB Select the type of box you want to renumber (Figure. Table Box. Text Box, User Box,
or Equation) from the Graphics menu.

3 Select New Number (3), then enter a number.

From that point forward in the document, graphics boxes of the type you
selected in step 2 are renumbered starting with the new number.

The maximum number for any type of graphics box is 2047. After that, numbering starts
over with 1

See Also: Equations; Graphics, Define a Box; Graphics, Edit; Graphics Lines;
Graphics Options



Graphics, Define a Box

Notes

When you want to place a graphics box in your document, an essential part of
the process is defining the box. You can use the default settings for any box
type. However, if you want to change any of these settings, WordPerfect
provides a way of editing them.

1 Press Graphics (Alt-F9), then select the type of box you want to define.

LB Select a box type (Figure, Table Box, Text Box, User Box, or Equation) from the
Graphics menu.

2 Select Create (I), then select an option and enter any necessary information
(see the information for each option under Notes below).

3 Press Exit (F7) to return to the document.

Anchor Type

This option (4) determines whether the graphics box moves with the text that
wraps around it (paragraph type), remains placed at a fixed position on a page
(page type), or is treated as part of the text on a line (character type).

Bumping Graphics Boxes

If you edit a graphics box (or the text surrounding the box) after it has been
created so that it no longer fits on the current page (e.g., it is contained in a
paragraph too near the bottom of the page), it is bumped to the next page.
If. then, you edit another box so that it cannot fit on the first page, it is
bumped, too. However, if the two boxes cannot fit together on the next
page, the second box is bumped again. A box can be bumped up to 255
pages. (After that, the graphics boxes will overlap.)

Character
Boxes with a character anchor type are treated as a single character,
regardless of the box size. When the line containing the box is wrapped, the
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next line starts below the box. Use this anchor type to position images or
equations in a line of text.

The code for a character box (see Codes below) is placed at the cursor
position.

The outside border space (see Outside Border Space under Graphics Options in
Reference) is not used with character type boxes.

Page

If you want the graphics box to stay at a fixed position on a specified page,
make sure the cursor is at the top of the current page when you create the
box, select Page (2) as the anchor type, then enter the number of pages you
want skipped. For example, if you want a page type box to appear on the
current page, enter 0 as the number of pages to skip. If you want the box to
appear on page 3 and the cursor is on page 1 enter 2 as the number of pages
to skip. Make sure the cursor is at the top of page 1, and the graphics box
will appear on page 3. If you edit the text after creating the box, make sure
the graphics box code (see Codes below) remains at the top of the page.

Be aware that if your document does not contain as many pages as the
“pages to skip” number you enter, the box will appear on the page following
the last page of the document. For example, if your document has only one
page and you enter 4 as the number of pages to skip, the box will appear on
page 2.

The code for a page box (see Codes below) is inserted at the cursor position.



A CURRENT BOX NUMBER

Paragraph

If you want the graphics box to stay with its surrounding text, select
Paragraph (1). The code for a paragraph box (see Codes below) is placed at
the beginning of the paragraph the cursor is in (after the last hard return or
hard page code).

If the paragraph is too close to the bottom of the page for the graphics box
to fit on the page, the box is bumped to the top of the next page or column.
However, the text of the paragraph containing the box does not move with it.

When the box is bumped, text that normally follows the box is moved in
front of the box to fill the empty space.

You can use Block Protect (see Block Protect in Reference) to keep the text of the
paragraph with the graphics box.

When editing the paragraph, be sure you do not add text in front of the
graphics box code; the code should be the first thing in the paragraph.

Caption

When you select this option (3), you are placed in a special editing screen where
you can create a caption for the box with WordPerfect text and codes. The
current box number is a numbering code that is displayed when you enter this
screen. This number automatically updates as you create other boxes of the
same type (all Figure boxes are numbered consecutively, as are all Table boxes,
Text boxes, etc.).

Bon Caption: Press Exit when done Ln 1* Poa 1.5%

You can choose to use the number or you may delete it in the caption editing
screen with Backspace. Press Graphics (Alt-F9) in this same screen to reinsert
the number.

Any changes you make to the numbering code in the caption editing screen will override
the Caption Number Style on the Graphics Options menu (see Caption Number Style
under Graphics Options in Reference).
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The text for the caption wraps according to the width of the graphics box you
are defining. You may use as many as 256 bytes in the caption.

If you want to change the position of the caption relative to the box or the
caption numbering style, use Graphics Options (see Graphics Options in
Reference).

Important: 1f you do not select Caption (3) from the box definition menu, a caption will
not display or print with your graphics box.

If, after you have created a caption, you decide you do not want it to print or
display, select Caption (3) from the box definition menu and delete all text and
codes from the caption editing screen.

Press Exit (F7) when you finish creating the caption to return to the box
definition menu.

Changing a Box Definition

If you have already created a graphics box following the steps above and want to
edit the box definition, select Edit (2) rather than Create in step 2, then enter the
number of the box you want to edit. (The number displayed is one higher than
the box number preceding the cursor position.) The same box definition menu is
displayed and the options work identically whether you are creating or editing
the box.

Codes

A code is inserted into your document when you create a graphics box. Its
placement depends on the anchor type (see Anchor Type above for details). The
code contains the name of the type of graphics box (Figure, Text box, etc.), plus
the box number, filename, and caption (e.g., [Figure:! \filename:caption\ where
caption includes the first part of the text you enter for the caption). To delete
the box, delete the code.

Contents

This option (2) displays a menu that lets you choose the kind of information you
want to put in the graphics box. The Contents option you select determines
which Editor (i.e.. Equation, Graphics, or Text) will be displayed when you
select Edit (9) from the box definition menu (see Graphics, Edit in Reference).

It also lets you decide whether or not graphics information is kept on disk in a
separate file or as part of the document.

If you specify a filename before selecting this option (see Filename below), the
Contents option will display a default depending on the type of file you
specified. For example, if you retrieve a graphics file, the Contents option will
default to Graphic.

If there is information inside the box and you select a Contents option that
differs from the option already displayed, you will be asked if you want to delete
the current contents of the box. For example, if you retrieve a text file into a
box, the Contents option will display “Text.” If you then change the Contents



option to Graphic, WordPerfect asks if you want to delete the current contents.
Type y if you want to replace the text file in the box with a graphic image.
Type n if you want to leave the text in the box.

The Contents menu options are:

Equation
Select this option (4) before creating or editing an equation. Selecting Edit
(9) will then display the Equation Editor (see Equations in Reference).

Graphic

This option (1) is the Contents default if you have specified a graphics image
with the Filename option (see Filename below). (If you select this option
with “Graphic on Disk” already displayed, the graphics image will be
retrieved from disk into the document.)

If you select this option and then select Edit (9), the image will be displayed
in the Graphics Editor (if an image has been retrieved into the box and if
you have a graphics display card installed). If you have not yet retrieved a
graphics image into the box, the Contents option will display “Empty” and
selecting Edit will display the Text Editor. See Graphics Editor and Text
Editor under Graphics. Edit in Reference for details on the Graphics and
Text Editors.

Graphic on Disk

Select this option (2) to have your graphics information kept in a separate
file on disk, rather than being saved with the document. This option is the
only method for placing a graphics box containing a graphics image into a
style (see Style in Reference). It also lets you reference the graphics image
multiple times in a document without saving the information in the document
each time. This conserves space in the document file.

WordPerfect prompts you to save your graphic image to disk whenever you

change Contents from Graphic to Graphic on Disk. This prevents you from

losing the image if the file is not already in the Graphics or default directory.
You can press Cancel to bypass this saving process (if the file already exists
in one of the directories); however, if the file is not in the right directory, it

will be lost.

Selecting Edit (9) after selecting this option retrieves the image from disk
and displays it in the Graphics Editor if you have already specified a
filename. If you have not yet specified a filename, selecting Edit does
nothing.

When you want to view the graphics image in the View Document screen
(Shift-F7,6) (see View Document in Reference) or from the Graphics Editor
(by selecting Edit from the box definition menu), or when you want to print
the document, WordPerfect looks for the graphics file first in your graphics
directory (set using Location of Files in Setup (Shift-FI,6,6)), then in the
default directory. It then places the graphics image in a temporary file.
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When you finish viewing or printing, the image is deleted from the
temporary file.

If WordPerfect cannot find the graphics file and you are trying to view the
graphics image in the View Document screen, a blank box is displayed. If
you are trying to view it in the Graphics Editor, an error message appears
stating that the graphics file cannot be found. Copy the file into your
graphics or default directory, then select Edit (9) from the box definition
menu to display the image.

If you are trying to print the graphics image and WordPerfect cannot find the
file, an error message stating that the graphics file cannot be found appears
in the Printer Control screen (Shift-F7,4). Type c to cancel the print job or
you can copy the file into your graphics or default directory, then type g
from the Printer Control screen to continue printing.

If you type g to continue without copying the graphics file into your graphics
or default directory, a blank box is printed.

Ifyou save your document to a floppy disk and print itfrom another computer, you
will have to copy the graphics file into that computer's graphics or default directory
before printing.

Text

This option (3) identifies the contents of a graphics box as text. Selecting
Edit (9) will display the Text Editor where you can type or enter text and/or
WordPerfect codes (see Text Editor under Graphics, Edit in Reference for
details on the Text Editor).

Edit

This option (9) lets you rotate, scale, and move a graphics image in the box (see
Graphics, Edit in Reference) if a filename has been specified and the Contents
option is set to Graphic or Graphic on Disk. If the Contents option is set to Text
or Empty, this option displays the Text Editor where you can type or edit text in
the box. If the Contents option is set to Equation, this option displays the
Equation Editor (see Equations in Reference).

Filename

Select this option (1) to specify a file you want put into a graphics box. If you
want to retrieve text into the box, specify the name of a WordPerfect document.
If you want to retrieve a graphics image, enter the name of a file created in one
of the many graphics formats that WordPerfect supports (for a list of supported
graphics formats and programs producing those formats, see Graphics, Formats
and Programs in Reference). If you want to retrieve an equation, select
Equation (4) from the Contents menu (see Contents above), then specify the
filename of an equation you have previously saved in the Equation Editor. (If
you do not select Equation before specifying a filename, WordPerfect will
interpret the file as text.)



You can press List (F5) at the “Enter Filename" prompt and retrieve afile from the List
Files screen if you want. Your graphics directory is displayed as the default when you
press List (see List Files in Reference). You can also press Shell (Ctrl-FI) at the “Enter
Filename” prompt (if you are running WordPerfect under the WordPerfect Shell), then
type y to retrieve the contents of the Clipboard into a graphics box (see Shell Clipboard
under Go to Shell in Reference).

After you specify a filename, WordPerfect determines the format of the file and
retrieves the image or text into the box. If the file was not created in a
WordPerfect supported format, an error message is displayed. For a list of
supported graphics formats and programs producing those formats, see Graphics,
Formats and Programs in Reference.

If you want to leave the box empty, do not enter a filename for the box. If you
want to delete the contents of a box without deleting the box itself, select
Filename (1), press Delete to End of Line (Ctrl-End), press Enter, then type y.
The Contents option on the menu is changed to “Empty.” (If the Contents
option says “Graphic on Disk” before you delete the filename, it will stay
"Graphic on Disk.”)

Horizontal Position

This option (6) is tailored to the choice you made for the Anchor Type option
(see Anchor Type above). These choices and their effects on this option are
described below.

Character
If you selected Character (3) as the anchor type, you cannot enter a
horizontal position. The box is positioned after the character to its left.

Page
If you selected Page (2) as the anchor type, you have three options to choose
from: Margins, Columns, or Set Position.

Selecting Margins (1) displays a menu that lets you align the box with the
Left (1) or Right (2) margin, Center (3) it between the margins, or expand
the box to the Full (4) horizontal width between the left and right margins.
This last option also aligns the box with the left and right margins.

Columns (2) lets you enter a column number(s), then align the box with the
Left (1) or Right (2) edge of, or Center (3) it between, one or more columns.
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If you enter a range of columns (e.g., 2-3), the box is left aligned, right
aligned, etc., over that range of columns.

You can also select Full (4) to expand the box to align with the specified
column margins. If no columns are defined when you select this option, the
box is aligned with the margins.

Set Position (3) lets you enter an absolute measurement from the left edge of
the form to position the box horizontally. This positions the outside border
space at that measurement.

Paragraph

If you selected Paragraph (1) as the anchor type, you can have the box
aligned with the Left (1) or Right (2) edge of, or Center (3) it in the area
where the text currently wraps. You can also select Full (4) to have the box
fill this area from left to right. A box with a paragraph anchor type honors
any indents, columns, or other graphics boxes in effect and can be positioned
only within the area where the text currently wraps.

Size

There are four Size options you can choose from when defining a graphics box.
Three of these options include complete or partial automatic sizing by
WordPerfect. When you select option 1, 2, or 4, the automatic part of these
options is displayed in parentheses next to the Size option. For example, if you
select Set Height/ Auto Width (2), the word “wide” appears in parentheses
following the measurement because WordPerfect determined the width.

The default width for all graphics boxes (except Equation boxes) is equal to one
half of the available space between the left and right margins. For example, if
you have 1" margins on an 8.5" x 11" form, there are 6.5" of available space.



The default width for a graphics box is then 3.25". Equation boxes default to fill
the space between the margins (6.5" in this example).

The Size options are:

Auto Both

Select this option (4) with a graphics image or equation to restore the
dimensions the image or equation had when it was originally created (rather
than when the graphics box was created). WordPerfect automatically
calculates both the height and width, preserving the original shape of the
graphics image or equation.

When you retrieve a scanned image into a graphics box, WordPerfect scales the
image tofit in the box. The Auto Both option can help restore the original
dimensions and resolution of the scanned image.

If you select this option for a Text box and there is only one line of text, the
box fits just around the words. If there is more than one line of text, the
height fits the text and the width returns to the default.

Set Both
Select this option (3) if you want a particular height and width, then enter
the measurements.

Be aware that because you are manually changing the dimensions, a graphics
image may appear and print distorted.

Set Height/Auto Width

Select this option (2) if you want the box to be a particular height, but want
WordPerfect to calculate the width automatically, preserving the original
shape of the graphics image.

For text and equations, the automatic width is determined by the last width
measurement entered, and the text or equation will not reformat in the box.

Set Width/Auto Height

Select this option (1) if you want the box to be a particular width, but want
WordPerfect to calculate the height of the box automatically so that the
original shape of the graphics image is preserved.

With this option, text will reformat to the width you enter and adjust the
height accordingly. Equations will be centered horizontally and the height
will adjust as needed. You can change this default setting for equations
using Equations Options (see Equations in Reference).

When WordPerfect must reduce the desired height/width settings for a box to
fit within the margins on the page, it remembers the original settings and will
readjust should space become available after editing.

Vertical Position

This option (5) is dependent on the choice you made for the Anchor Type option
(see Anchor Type above). These choices and their effects on this option are
described below.
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Character

If you selected Character (3) as the anchor type, a menu is displayed that lets
you position the box so that the Top (1), Center (2) or Bottom (3) of the box
is aligned with the baseline of the line of text containing the box. You can
also select Baseline (4).

If you select Baseline for a box containing an equation, the baseline of the
equation is aligned with the baseline of the line of text containing the box.
If the box contains text, the baseline of the last line of text inside the box is
aligned with the baseline of the line of text containing the box.

If you want to align the bottom of a graphics image box with the baseline of
the line of text containing the box, select Bottom (3).

Page

If you selected Page (2) as the anchor type then entered the number of pages
to skip, a menu is displayed that lets you align the box with the Top (2)
(even with the first line of text—below any headers, page numbers, etc.) or
Bottom (4) (above any footers, page numbers, footnotes, etc.) of the page.
You can also Center (3) the box on the page or select Set Position (5), then
enter an offset measurement from the top edge of the form.

If you select Full Page (1), the graphics box fills the page area within the top
and bottom margins. (A graphics image will maintain the proper
dimensions.)

Paragraph

If you selected Paragraph (1) as the anchor type, enter an offset measurement
from the top of the paragraph your cursor is on. For example, enter 0 to
align the top of the box with the top of the first line of the paragraph.

Ifyou enter anything other than 0 for this option, the outside border space (rather
than the top edge of the box) is placed at that vertical position.

After creating the graphics box, the default shown for the Vertical Position
option is the distance the cursor is from the top of the current paragraph.
The offset you enter changes the setting unless the paragraph is so close to
the bottom of the page that the box does not fit on the page. In this case,
the box is moved up in the paragraph to try to keep the box within the
paragraph. If there is still not enough room on the page, the box is bumped
to the next page.

You control how far the box can move up in the paragraph before being
bumped to the next page with the Minimum Offset from Paragraph option on
the Graphics Options menu (see Graphics Options in Reference).

Consider the following example of how this feature works: Set the
Minimum Offset option on the Graphics Options menu to .5" and the
Vertical Position option on a paragraph type box to 1. The paragraph
containing the box is moved down the page (e.g., text is inserted before it);
when the bottom of the box reaches the bottom margin of the page, the box
starts moving up in the paragraph. If there is still not enough room when the



top of the box reaches the .5" mark in the paragraph, it is bumped to the
next page.

Wrap Text Around Box

If you want WordPerfect to ignore the box and continue printing text from
margin to margin, type n for this option. Setting this option (8) to No is a
method you can use (in conjunction with the Advance feature) to superimpose
one graphics box on top of another or to print text on top of a graphics image, as
shown in the illustration below (see Advance in Reference).

HELP!

When this option is set to No, the box outline is not shown in the normal editing
screen. To view the box on the page, you must use View Document (Shift-F7,6)
(see View Document in Reference).

If you set this option to No for a box with a Paragraph anchor type, the figure
cannot be bumped to the following page. If there is not enough room for the
figure to fit entirely on the current page, only the amount of the figure that fits
on the page is printed.

WordPerfect can wrap text around a maximum of 100 boxes on any one page.
More boxes can be created, but this option must be set to No.

100 boxes may not be possible in all cases; your computer must have sufficient memory.

See Also: Graphics, Create; Graphics, Edit; Graphics Options
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Graphics, Edit

As you are creating a graphics box (or after you have created one) in your
document, you may need to edit the way the graphics image is displayed. The
Graphics feature in WordPerfect provides an option for doing this.

Remember as you are editing graphics that regardless of the type of box you are
editing, you can change the contents of the box to a different type (e.g., you can
retrieve a graphics figure into a Text box or an equation into a Figure box).

1 Press Graphics (Alt-F9), then select the type of box you want to edit.

i_3 Select a box type (Figure, Table Box, Text Box, User Box, or Equation) from the
Graphics menu.

2 Select Create (1).
or
Select Edit (2), then enter the number of the box you want to edit.

The screen displayed is the box definition menu, and it lets you define the
graphics box (see Graphics, Define a Box in Reference for details on this menu).

3 Select Edit (9) from the box definition menu.

Three different screens can appear depending on the type of information you are
editing: the Equation Editor, Graphics Editor, or Text Editor (see the different
editors listed under Notes below).

4 Select an option (e.g.. Scale, Rotate) or press a feature whose name is
displayed at the bottom of the editing screen (e.g., Graphics, Switch, Setup),
then enter any necessary information (see the information for each editor
under Notes below).

5 Press Exit (F7) twice to return to the document.

Notes Equation Editor
If you are creating or editing an equation (i.e., the Contents option on the box
definition menu is set to Equation), selecting Edit (9) from the box definition
menu displays the Equation Editor. This screen lets you create and edit
scientific and mathematical equations (see Equations in Reference).
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Graphics Editor

If you are editing a graphics image (i.e., the Contents option on the box
definition menu is set to Graphic or Graphic on Disk and a filename has been
specified), select Edit (9) to display the Graphics Editor.

Black & White
Select this option, then type y to display/print a color image with black and
white instead of a shading or fill pattern.

DrawPerfect

This option enables you to go directly into DrawPerfect to edit a graphics
image. It is explained in detail in the Shell documentation included with
DrawPerfect.

Go To

Press Go To (Ctrl-Home) to redisplay the image with the default settings.

Insert (% Change)

Press Insert (Ins) to change the percentage amount displayed in the lower
right corner of the screen to 1,5, 10, or 25 percent. This percentage amount
determines the extent to which the arrow keys, Page Up/Down, and Screen
Up/Down affect the image for moving, scaling, and rotating.

Invert On/Off

If this option says “Invert On,” select it for a bitmap image to display the
complementary color of each dot in the image (black becomes white and vice
versa). Select it again to return to the original display.

With figures that are line drawings (vector-type graphics), select this option
to switch just the background color. If the background color is white, it
becomes black. You need to realize, however, that if you switch the
background color to black and the print color is black, nothing will print
when you print the graphic. WordPerfect will not try to print color values
that match the background color.
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Graphics from scan and paint programs are usually considered bitmapped, while
graphicsfrom CAD and draw programs are usually considered vector-type graphics
(see Graphics, Formats and Programs in Reference).

You will not see the Invert effect on color monitors, but the image will print
inverted.

Move

The Move option (and the arrow keys) lets you move the image horizontally
and vertically in the box. You can move the image the percentage displayed
in the lower right comer of the screen by pressing the arrow keys. You can
move the image a specific amount by selecting Move (1), then entering the

horizontal and vertical measurements in positive or negative numbers.

Entering positive numbers for horizontal and vertical moves the image up
and to the right; a positive horizontal and negative vertical moves it down
and to the right; negative numbers for both moves it down and to the left;
and a negative horizontal and positive vertical moves it up and to the left.

When you enter horizontal and vertical measurements, the numbers you enter
move the image from the starting point, not from any measurements you
have previously entered. For example, if you enter .5 for both the horizontal
and vertical measurements, the image moves up and to the right. If you
decide you want the image moved half again as far up and to the right, you
would not enter .25, you would need to enter .75.

Ifyou move the image in the screen, then want to move it back to the original

position, press Go To (Ctrl-Home). This will also reset any other changes you have
made.

Rotate

The Rotate option (and the Screen Up (-) and Screen Down (+) keys) lets
you rotate the image. You can rotate the image the percentage displayed in
the lower right corner of the screen by pressing Screen Up (-) or Screen
Down (+). You can rotate the image a specific amount by selecting Rotate
(3), then entering the number of degrees.

To understand how Rotate works, think of the image as having a tack stuck
in the middle of it. As you rotate the image using the Rotate option, it
moves counterclockwise, pivoting around the tack. (Pressing Screen Up
rotates it counterclockwise, while Screen Down rotates it clockwise.)

When you enter the number of degrees, the image is rotated from the starting
point, not from any rotation amount you have previously entered. For
example, if you enter 180 to move the image halfway around in the box, you
cannot enter 180 again to return it to its previous position. You would need
to enter 360 (or 0) to return the image to the starting point.

If you select Rotate, you are asked if you want a mirrored image. A
mirrored image changes the dots in the image so they display from right to
left instead of left to right. For example, if the box contained a profile of a
person facing right, the mirror image would show the profile facing left.



Ifyou rotate or mirror the image in the screen, then want to return it to the original
position, press Go To (Ctrl-Home). This will also reset any other changes you have
made.

Save

Once a graphics image is displayed inside the Graphics Editor, it can be
saved in WordPerfect graphics format by pressing Save (F10) and entering a
filename. If you have specified a graphics directory using Location of Files
on Setup (Shift-F1,6,6), the filename displayed includes your graphics
directory in the path. A .WPG extension is added unless you specify a
different extension.

When you enter a filename, just the data inside the image is saved, not any
editing changes you have made. So if you retrieve the saved file as a
graphics image in another box, any editing changes you made before saving
will not be displayed.

Scale

The Scale option (and the Page Up (PgUp) and Page Down (PgDn) keys)
lets you expand or contract the image in a horizontal and vertical direction.
You can scale the image the percentage displayed in the lower right corner
of the screen by pressing Page Up (PgUp) and Page Down (PgDn). You
can scale the image a specific amount by selecting Scale (2), then entering
the horizontal (x) and vertical (y) percentages.

For example, if you select Scale, then enter 80 for the x value and 80 for the
y value, the image will be 80% of the original size. If, however, you enter
80 for x and 110 for y, the image will be 80% as wide, but 110% as tall as
the original size. (Page Up and Page Down automatically scale x and y the
same amount.)

When you enter x and Yy percentages, the image is scaled from the starting
point, not from any x and y amounts you have previously entered.

Ifyou scale the image larger or smaller, then want to return it to the original size,
press GO To (Ctrl-Home). This will also reset any other changes you have made.

Shell

If you are running WordPerfect under the WordPerfect Shell, you can press
Shell (Ctrl-FI) while in the Graphics Editor to Go to Shell (1), Save (2) the
graphics image to the Clipboard, or Retrieve (3) the contents of the
Clipboard into the Graphics Editor.

This feature will let you more fully integrate WordPerfect with other
programs you are running under the Shell. For example, you can save a
graphics image to the Clipboard, go to Shell and start another program (such
as DrawPerfect), then retrieve the contents of the Clipboard into that
program. Once there, you can make changes to the image, then repeat the
process to come back to WordPerfect and Retrieve (3) the contents of the
Clipboard into the Graphics Editor (see Shell Clipboard under Go to Shell in
Reference).
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Switch
Pressing Switch (Shift-F3) in the Graphics Editor does the same thing as
selecting Invert On/Off (4) (see Invert On/Off above).

Text Editor

If you are creating or editing text inside a box (i.e., the Contents option on the
box definition menu is set to Text or Empty), selecting Edit (9) displays a blank
Text Editor (if you have not yet entered a filename for the graphics box) or the
Text Editor with text in it (if you are editing existing text). You can enter the
text and/or WordPerfect codes you want placed inside the box. Press Exit (F7)
to exit the Text Editor or press Graphics (Alt-F9), then select the option with
the number of degrees you want to rotate the text in the box (text is rotated
counterclockwise). To print rotated text in a box, your printer must be able to
rotate fonts (see Printing, Landscape in Reference).

If you retrieve a document that is longer than one page, you will get an error
message saying that the file contains too much text when you try to exit the Text
Editor. At this point, you must delete text or use Block (Alt-F4) and Move
(Ctrl-F4) to move text until the remaining text fits on the page (see Move, Block
in Reference).

WordPerfect Features in the Text Editor

Once inside the Text Editor, you can use several WordPerfect features. You
can define columns in the box (see Columns, Newspaper and Columns,
Parallel in Reference), use Text In/Out (Ctrl-F5) to import and export files
(including spreadsheets) to and from the box (see Text In/Out in Reference),
enter Merge commands into a box (see Inserting Commands under Merge in
Reference), and create WordPerfect Tables in a box (see Table. Create in
Reference).

You can also use Retrieve (Shift-FIO) to retrieve a WordPerfect document or
DOS text file into a box, or use List (F5) to display the files in a directory.
Press Shell (Ctrl-FI) (if you are running WordPerfect under the WordPerfect
Shell) to Go to Shell (1), or Save to (2), Append to (3), or Retrieve from (4)
the Clipboard. You can also enter a DOS Command (5) from the Text
Editor (see Go to Shell in Reference).

See Also: Graphics, Create; Graphics, Define a Box; Graphics Options



Graphics, Formats and Programs

A CONVERSION A
A CONVERSION B

WordPerfect supports several graphics formats. If a graphics program is able to
save files in a WordPerfect-supported format, the graphics files can be used with
the Graphics feature of WordPerfect to create images on the printed page.

In order for a graphic file to be used by WordPerfect, it must ultimately be
converted to .WPG (WordPerfect Graphic) format. The following diagram
illustrates this conversion process:

UNSUPPORTED N SUPPORTED n WPG
FORMAT A FORMAT A FORMAT

As you can see in this diagram, there are two major conversions that must occur.
Conversion A is the conversion of the file from a format not supported by
WordPerfect to one that is supported. Your graphics program must perform this
conversion. Each graphics program may be able to save files in a variety of
formats.

If your graphics files are already in a format supported by WordPerfect, this
conversion is unnecessary. (You may. however, want to convert it to another
supported format. See Supported Formats, Conversion Notes below for more
information.)

The following is a list of the formats currently supported by WordPerfect:

CGM Computer Graphics Metafile
DHP Dr. Halo PIC Format

DXF AutoCAD Format

EPS Encapsulated PostScript

GEM GEM Draw Format

HPGL Hewlett-Packard Graphics Language Plotter File
IMG GEM Paint Format

MSP Microsoft Windows Paint Format
PCX PC Paintbrush Format

PIC Lotus 1-2-3 PIC Format

PNTG Macintosh Paint Format

PPIC PC Paint Plus Format

TIFF Tagged Image File Format

WPG WordPerfect Graphics Format

If your graphics program cannot save files in any of the supported formats, see Screen
Capture Program below.

Conversion B in the diagram is from a WordPerfect-supported format to .WPG
format. This conversion can occur in one of three ways:
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* You retrieve the graphics file into WordPerfect through the Graphics feature
(see Graphics, Define a Box in Reference). Retrieving the graphic into a
graphics box automatically converts it to .WPG format.

e You print or preview a document that uses a graphic on disk, or you edit the
display parameters of a graphic on disk in a WordPerfect document (see
Graphics, Define a Box and Graphics, Edit in Reference). This conversion is
only temporary and does not affect the graphics file on disk, but does allow
WordPerfect to use the image.

e You use the Graphics Conversion Program (a utility program that comes with
WordPerfect) to convert the file. The Graphics Conversion Program creates
a copy of the image and stores it in a .WPG formatted file. (See Graphics,
Conversion Program in Reference.) This file can then be retrieved through
the Graphics feature or used as a graphic on disk.

Graphics files in any of the formats on the above list (except DXF format) may
be converted by retrieving the graphic in the Graphics feature, without any
additional conversion.

Files in DXF format must be converted by the Graphics Conversion Program
before they can be retrieved into the Graphics feature of WordPerfect.

The Graphics Conversion Program can be used to convert files of any of the
supported formats to .WPG format. Whether you should use the Graphics
Conversion Program to accomplish the conversion or simply retrieve the file
through the Graphics feature of WordPerfect depends on several factors. See
Graphics, Conversion Program for more information.

Graphics Programs

The following is a list of graphics programs that have been tested with
WordPerfect 5.1. If your graphics program is not on this list, you may still be
able to use it with WordPerfect if it can generate a WordPerfect supported
graphics format (see the list of supported formats above).

The Export column lists the WordPerfect compatible formats that can be created
with each particular graphics program. You may need to consult your graphics
program documentation for information on creating a particular format.

A Yes entry under the Grab column indicates that the WordPerfect Screen
Capture Program can be used with that graphics program to capture an image
from the screen (see Screen Capture Program below and in Reference). N/A in
this column means not applicable (e.g., from Macintosh or IBM host). If no
formats are listed under the Export column, use the Screen Capture Program to
capture the image.

Program Export Grab
Adobe Illustrator EPS N/A
Anvil-5000 HPGL

Arts & Letters CGM
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Program

AutoCAD 9.0, 10.0
AutoSketch 1.03
Boeing Graph 4.0
CCS Designer
ChartMaster 6.21
Chemfile 11

Chemtext

CIES (Compuscan)
Designer 1.2 (Micrografx)
Designer 2.0 (Micrografx)
DFI Handy Scanner
DiagramMaster 5.02
Diagraph

Dr. Halo II, 11l
DrawPerfect

Easyflow 4.4

Enable

Energraphics 2.1
Framework Il
Freelance Plus 2.0, 3.0
GEM Draw

GEM Paint 2.0

GEM Scan

Generic CAD

GeniScan Scanedit (2.07 and earlier)

GeniScan Scanedit Il 2.08
Graph-in-the-Box 2.0

Graph Plus 1.3 (Micrografx)

Graphics Editor 200
Graphwriter

Harvard Graphics 2.1
HiJaak

HOTSHOT Graphics 1.5
HP Scanning Gallery A.01
IBM CADAM

IBM CATIA

IBM CBDS

IBM GDDM

IBM GPG

Javelin Plus

Logitech Ansel

Lotus 1-2-3 1A, 2.0
Lotus 1-2-3 3.0
Macintosh Paint 1.5

Export

DXF.HPGL
DXF,HPGL
IMG
HPGL
HPGL
HPGL

EPS

TIFF
HPGL

EPS,CGM,PCX,TIFF

IMG, TIFF
HPGL

HPGL

DHP (PIC)
CGM,HPGL,WPG
HPGL

IMG, TIFF

CGM

GEM
IMG,TIFF
IMG,TIFF
HPGL
MSP,PCX
TIFF,MSP,PCX
HPGL
HPGL,EPS,CGM,
PCX,TIFF
HPGL

CGM
HPGL,CGM,EPS
WPG

WPG
TIFF,PCX
HPGL

HPGL

HPGL

HPGL

HPGL

HPGL
TIFF.PCX,EPS
PIC

PCX,CGM
PNTG

Gral

Yes

Yes
Yes

Yes
Yes

Yes
Yes
Yes
Yes

Yes
Yes
Yes

N/A
Yes
Yes

N/A
N/A
N/A
N/A
N/A

Yes
Yes
N/A
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Program

MathCAD

Microsoft Chart
Microsoft Excel
Mirage

Paradox 3.0

PC Paint Plus 1.5, 2.0
PicturePak

Pixie

Pizazz 1.01
PlanPerfect 3.0*%, 5.0
PFS: First Publisher
PrintMaster
Professional Plan
Reflex 2.0

Quattro

SAS/Graph (6.03 and earlier)
SAS/Graph (6.04 and later)
ScanMan

Schema

SignMaster 5.11

Silk

SlideWrite Plus 2.1
SuperCalc 4
Symphony

Twin

Versacad

VGA Paint

VP Graphics

VP Planner
Windows Draw
Windows Paint 2.11
Words & Figures
Z-Soft PC Paintbrush

WordPerfect Corporation
Attn: Information Services
1555 N. Technology Way
Orem, UT 84057

(801) 225-5000

The files created are named METAFILE.DAT.
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Export

HPGL
HPGL

HPGL

PIC

PPIC
WPG,CGM,PCX
CGM

PCX,TIFF
CGM

PCX (MAC)

PIC
PIC.EPS
HPGL
CGM
TIFF
HPGL
HPGL

HPGL,TIFF,PCX
PIC
PIC

HPGL
WPG,PCX, TIFF
HPGL

PIC

HPGL

MSP

PIC

PCX

Grab

Yes
Yes
Yes

Yes
N/A

Yes

Yes
Yes
Yes
Yes

Yes
Yes
Yes
Yes
Yes

Yes

Yes
Yes

*PlanPerfect 3.0 requires the META.SYS (GSS Metafile) graphics driver in

order to produce CGM files. The driver may be included on the PlanPerfect
Graphics Drivers diskette (depending on the date of your version).
have the driver, and are interested in obtaining it, write to or call:

If you do not



Screen Capture Program

If your graphics program cannot save an image file in a WordPerfect-supported
format, you may be able to use the Screen Capture Program (GRAB.COM) to
capture the image in a file that can be retrieved in WordPerfect. However, if
given the choice, use WordPerfect-supported graphics formats rather than the
Screen Capture Program. Because the Screen Capture Program only captures
data in the resolution of the screen, images captured with the program are
usually of a lesser quality than images created in a WordPerfect-supported
format. For more information on using the Screen Capture Program, see Screen
Capture Program in Reference.

Supported Formats, Conversion Notes

WordPerfect-supported graphics formats are listed below with information
regarding the conversion of each format to .WPG format.

CGM (Computer Graphics Metafile)
« Fonts are converted to one of the following WordPerfect vector fonts:
WP Courier, WP Helv, or WP Roman.

e CGM colors are used to create a custom color table that is used to
display the image. The background and foreground colors are colors 0
and 1, respectively, of the custom color palette.

« Multiple pictures within a single file are superimposed.

DHP (Dr. Halo PIC Format)
e Supported up to Dr. Halo IIl.

« Area cut pictures are not supported.

e In Dr. Halo Ill, set your screen type to CGA, EGA, or Hercules. VGA
pictures are not supported.

DXF (AutoCAD Format)
« The following DXF attributes are not converted: text obliquing, text
control codes and special characters, curve fitting, and 3D rendering.

« DXF files must be converted to .WPG files with the GRAPHCNV.EXE
program. GRAPHCNV.EXE changes the background color to white (not
intense white) and changes all white information to black.

EPS (Encapsulated PostScript)

e An EPS file should conform to version 2.0 of the Adobe PostScript
document structuring conventions.

e EPS files may begin with either the standard 30 byte header or the
following string: “%%PS-Adobe” or “%!PS-Adobe-2.0.” The string
indicates a PostScript-only file.s

e The Show Page, Copy Page, and Erase Page commands are redefined to
be null commands since page handling is controlled by WordPerfect.
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« The EPS file may have a graphics screen representation that can be
manipulated and displayed in WordPerfect. If contained within the file,
only TIFF bitmap images are supported. The TIFF representation is also
used to print the graphic with a non-PostScript printer.

« If no graphics screen representation is available, the image will be
represented as a box with the message “Graphics Contains Data for
PostScript Printers Only” in the Graphics Editing and View Document
screens. The image can only be printed with a PostScript printer.

GEM (GEM Draw Format)
* Rounded boxes are not supported. They are converted as regular boxes.

e End of line types (including arrows) are not supported.

HPGL (Hewlett-Packard Graphics Language Plotter File)
« Several graphics programs can create HPGL plotter files by redirecting
the output to a disk file rather than directly to the plotter. If given the
choice, select the HP 7475A plotter.

e Fonts are all converted to Monospaced WP Helv.

« Not all plotters support the same HPGL commands. The most
commonly used commands, however, are supported.

IMG (GEM Paint Format)
* Tested with version 2.0.

MSP (Microsoft Windows Paint Format)
* The images are saved as a full page.

PCX (Zsoft PC Paintbrush Format)
e PC Paintbrush files are created using the Save As option.

PIC (Lotus 1-2-3 PIC Format)
e Once a graph is created in Lotus 1-2-3, a .PIC file can be saved with the
/GS command.

PNTG (Macintosh Paint Format)
e The MacPaint version used to create the image must be prior to version
2.0.

 Pictures are always transferred as a full 8 1/2" x 11" page. Images
conforming to the size of the Macintosh screen are reproduced in the
upper left corner of the page.

« Use of a network or other communication link is necessary to transfer
the data fork of the Macintosh file to the IBM PC.

« Macintosh screen grabber output is also compatible. The Macintosh
screen grabber is activated by pressing Shift-Command-3. This creates
files named SCREEN.* where j is the sequential number of the file
created.
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PPIC (PC Paint Plus Format)
» Packed picture file format is supported (PC Paint Plus 2.0 and PC Paint
1.5).

« Unpacked picture file format is supported (PC Paint 1.5).
¢ BSAVE format is not supported (PC Paint 1.0 or 1.01).

TIFF (Tagged Image File Format)
* WordPerfect supports the modified CCITT/3 (standard compression) and
PackBits compression formats.

* WordPerfect supports version 4.2 of the TIFF specifications.
« Version 5.0 color TIFF files are not supported.

« WordPerfect supports monochrome TIFFS, and either 16 or 256 level
grayscale TIFF images.

e Six-bit-per-sample images are not supported.

WPG (WordPerfect Graphics Format)
e This is the internal graphics format that WordPerfect uses.

« Detailed specifications for creating this format are available by
contacting Information Services at (801) 225-5000.

See Also: Graphics, Conversion Program; Graphics, Create; Graphics, Define a
Box; Graphics, Edit; Screen Capture Program

If you want to place horizontal and vertical lines in your document, you can use
the Graphics Lines feature. The lines can be black or shaded a percentage of
black.

1

Press Graphics (Alt-F9), then select Line (5).

CB Select Line from the Graphics menu.

2
3

Select Create Horizontal Line (I) or Create Vertical Line (2).

Select an option, then enter any desired information (see Horizontal Lines
and Vertical Lines below).

Press Exit (F7) to return to the document.
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Codes

The Graphics Lines feature inserts a code (e.g., [HLin".horizontal
position,vertical position,length of line,width of line,gray shading] for a
horizontal line) in your document that puts a horizontal or vertical line at that

position.

Editing a Line

You can edit a graphics line by selecting Edit Horizontal Line (3) or Edit
Vertical Line (4) in step 2 above. WordPerfect searches backward from the
cursor for the first graphics line of that particular type (horizontal or vertical).

If

it cannot find one. it returns to the cursor position, then searches forward before

displaying the Graphics Line definition. You can edit the definition as

necessary.

Horizontal Lines

Although the options found on the Horizontal Line menu match those on the
Vertical Line menu, some options work somewhat differently.

Gray Shading
This option (5) lets you determine how much a line should be shaded (100%
is black).

Horizontal Position

This option (1) lets you position the line against the Left (1) or Right (2)
margin, Center (3) it between the left and right margins, or start at a Set

Position (5) from the left edge of the page.

The
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You can also select Full (4) to have the line fill the area from the left to the
right margin.

These lines are positioned against the margins in effect at the time. For
example, if you press Undent (F4) before creating a horizontal line, then
select Left as the horizontal position, the line will be positioned against that
temporary margin.

Length of Line
This option (3) lets you specify the length of a horizontal line.

For lines that have a horizontal position of Left or Right, the default line
length is calculated from the cursor to the specified margin. If a line has a
horizontal position of Full, you cannot change the line length. If a line has a
horizontal position of Center, the default line length is 0", and you will need
to enter a line length.

Line Height

If you place a horizontal line in your document (with the vertical position set
to Baseline), and that Horizontal Line code [HLine] is the only thing on the
line (no other text or codes), the height of that line is determined by the
width of the horizontal line. However, if there is any text (even a space) on
the same line as the Horizontal Line code, the line height is determined by
the font and point size currently being used (see Line Height in Reference).

Vertical Position

Select Baseline (1) to align the bottom of the graphics line with the baseline
of the line of text that contains the Graphics Line code [HLine], Select Set
Position (2) to specify a distance from the top of the form for the horizontal
line.

Width of Line

This option (4) lets you specify how thick (wide) the line should be. As you
make the line wider, the top of the line stays in the same position and the
line expands down if the vertical position is set to Set Position. If the
vertical position is set to Baseline, the bottom of the line stays in the same
position and the line expands up.

Vertical Lines
Some options on the Vertical Line menu work somewhat differently from the
corresponding options on the Horizontal Line menu.

Gray Shading
This option (5) lets you determine how much a line should be shaded (100%
is black).

Horizontal Position
This option (1) displays a menu that lets you position the line slightly to the
Left (1) of the left margin or slightly to the Right (2) of the right margin.
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You can also select Between Columns (3) and enter a column number to
position the line between that column and the one to its right.

Set Position (4) lets you enter a specific horizontal offset from the left edge
of the form for the vertical line.

Length of Line
This option (3) lets you specify how long you want a vertical line to be.

For lines with a vertical position of Top or Bottom, the default line length is
calculated from the cursor to the specified margin. If a line has a vertical
position of Full Page, you cannot change the line length. If a line has a
vertical position of Center, the default line length is the distance between the
top and bottom margins.

Vertical Position

This option (2) displays a menu that lets you position the line against the
Top (2) or Bottom (4) margin, Center (3) it between the top and bottom
margins, or start a Set Position (5) from the top of the form.

Select Full Page (1) to have the line extend from the top to the bottom
margin.

Width of Line

This option (4) lets you specify how thick (wide) the line should be. As you
make the line wider, it will always expand to the right, regardless of the
Horizontal Position.

See Also: Graphics, Create; Graphics Options



Graphics Options

When you create a graphics box in your document, you need a way of adjusting
certain settings (e.g., caption style, border style, gray shading) for that box. The
Graphics Options menu lets you make changes to these settings.

1 Move the cursor to where you want to change the option.

Important: Make sure you place the cursor before the graphics box codes you want
affected by the option change.

2 Press Graphics (Alt-F9), then select the type of box whose option(s) you
want to change.

03 Select the type of box you want to change (Figure, Table Box, Text Box. User Box,
or Equation) from the Graphics menu.

3 Select Options (4) to display the Graphics Options menu.

4 Select an option, then make the necessary changes (see the information for
each option under Notes below).

5 Press Exit (F7) to return to the document.
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The following table lists the default graphics options for each type of graphics
box.

GRAPHICS BOX OPTIONS

Figure Table Box Text Box User Box Equation

Ll — 1
biN f p 3 4
% - *2 1

Figure 1 Caption

BORDER STYLE

Left Single Left None Left None Left None Left None
Right Single Right None Right None Right None Right None
Top Single Top Thick Top Thick Top None Top None
Bottom Single Bottom Thick Bottom Thick Bottom None Bottom None

OUTSIDE BORDER SPACE

Left 0.167" Left 0.167" Left 0.167” Left 0.167” Left 0.083”
Right 0.167" Right 0.167" Right 0.167" Right 0.167~ Right 0.083"
Top 0.167" Top 0.167" Top 0.167" Top 0.167" Top 0.083"
Bottom 0.167" Bottom 0.167" Bottom 0.167" Bottom 0.167" Bottom 0.083”
INSIDE BORDER SPACE
Left 0’ Left 0.167" Left 0.167" Left o" Left 0.083"
Right 0" Right 0.167" Right 0.167" Right o Right 0.083"
Top 0’ Top 0.167" Top 0.167” Top o" Top 0.083"
Bottom 0’ Bottom 0.167" Bottom 0.167" Bottom o" Bottom 0.083”
FIRST-LEVEL NUMBERING
Number Rommi Number Number Number
SECOND-LEVEL NUMBERING
Off O ff Ooff Ooff Off
CAPTION NUMBER STYLE
(BOLDIFigure1told] [B()I.D]Tablel[ bold) |BOM)I1[bold] [BOLD 11[bold] [BOLD]1[bold]
POSITION OF CAPTION
Relnvt box, outside Above box, outside Below box, outside Below box, outside Right side
borders borders borders borders
MINIMUM OFFSET FROM PARAGRAPH
0" 0" 0 0 0
GRAY SHADING
n% 0% 10% 0%
Notes Border Style

This option (1) displays a menu of border styles you can use for each of the four
borders of your box. Select an option for each border or press Enter to leave a
setting as it is and continue on to the next border setting.
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A EXTRA THICK

A

SINGLE

To make settings for each type of border you can create (e.g., Single, Thick),
select Border Options (Shift-F8,4,8). This menu determines the appearance of
the border type you select.

You can use this option to give the border of your box a 3-dimensional effect.
As you are selecting an option for each border, select Thick (6) or Extra Thick
(7) for two adjacent borders and select Single (2) for the other two adjacent
borders.

The HALVA Report

An Intercompany Report on the Golnga On at HALVA International

FROM THE PRESIDENT best system money can buy and
one that will prove useful for
After looking over the second our type of business.
quarter reports, 1 couldn™t
help but be pleased. HALVA

international has now become

the eighteenth largest import-

export company In the world.

The findings come aa more of a *1
surprise when you remember that

only a little more than a year

ago | predicted in this column

that our growth would stagnate

somewhat. In this case 1 am

glad to be proven wrong.

While we must give credit where

credit is due and acknowledge

the nrriwt-h In the Induet™ ns n SALES

If you want to create a full-page border, increase the dimensions of your graphic
to the largest size allowable. You can set dimensions from the box definition
menu when you create Or edit a graphics box (see Graphics, Define a Box in
Reference).

If you want to create a border for multiple pages, place the border in a header
(Shift-F8,2,3). See Headers and Footers in Reference for more information.

Caption Number Style

This option (6) lets you use text and WordPerfect codes to define a style for
caption numbers. The caption numbering style is printed or displayed when
WordPerfect encounters a numbering code [Box Num] in a caption. You can set
dimensions from the box definition menu when you create or edit a graphics box
(see Graphics, Create or Graphics, Edit in Reference). Enter 1 in the style where
you want the first level caption number. Enter 2 in the style where you want the
second level caption number (see Level Numbering Methods below).

For example, entering “Fig. 1-2” causes numbering codes in captions to display
“Fig. ” followed by the first level box number, a dash, and the second level box
number. You can include Bold, Italics, Underline, and Small Caps, as well as
text, in the caption style (see Attributes in Reference).
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Second level numbering only goes as high as 31. After that, the first level moves
up one number and the second level starts over (e.g., 1-31 is followed by 2-1).

The numbering method for second level numbering must be turned on before it will
appear in the caption, even ifyou have entered it in the Caption Number Style.

If you do not want your first level caption number to print, select Caption
Number Style (6) from the Graphics Options menu, delete all text and codes,
then press Enter.

Any changes you make to the numbering code in the caption editing screen will override
the Caption Number Style (see Caption under Graphics, Define a Box in Reference).

Codes

A code (e.g., [Fig Opt] for a Figure box) is inserted into your document when
you use this feature. Any options you change for that box type are changed
from the code forward in the document.

You cannot edit a graphics options code; you must insert a new code, then delete
the old code if you want to change the options again.

Font

Graphics box text and captions are printed in the font that is the base font where
the option code is located. If there is no option code, text and captions are
printed in the initial base font for the document (see Font in Reference).

Gray Shading

Select this option (9) to enter a shading intensity (by percentage) for graphics
boxes of a particular type (e.g., all Figures). The closer the percentage is to 100,
the more the box is shaded (100% means the box is black).

Initial Settings

The initial settings for this menu vary according to the type of box (e.g., Text
Box options have different settings from Figure Box options). Once you have
changed the settings, you can delete the code to return to the initial settings.

You can change the initial settings using Initial Codes in Setup (Shift-F 1,4,5)
(see Initial Settings in Reference). These settings will be in effect each time you
create a document.

Inside Border Space

The measurements in this option refer to the amount of space you want between
each border of your box and the information inside the box. Select this option
(3), then enter a setting for each border or press Enter to leave a setting as it is
and continue on to the next border setting.

Level Numbering Methods
There are two level numbering methods listed on this menu: First (4) and
Second (5). These methods let you define up to two levels of numbering for



captions. Select either option, then select a numbering style from the menu
displayed.

Although Off is displayed as an option for both numbering methods, you cannot
select it for the first level. For information on printing captions without first
level caption numbers, see Caption Number Style above.

Letters or Roman numerals are shown in uppercase when used for first level
numbering and lowercase when used for second level numbering. For example,
if you are writing a book with several illustrations in each chapter, and your
second level numbering method is Letters, the illustrations could be numbered
l.a, Lb, l.c, etc. for chapter 1, 2.a, 2.b, 2.c, etc. for chapter 2, and so on.

Minimum Offset from Paragraph

When you position a paragraph type graphics box a specific distance (offset)
from the top of the current paragraph (see Graphics, Define a Box in Reference),
the offset you specify is honored unless the paragraph is too close to the bottom
edge of the page for the box to fit. If this is the case, the offset measurement is
reduced to try to keep the text and box together on the same page. If the offset
cannot be reduced enough to fit the box on the page, the box is bumped to the
top of the next page (or column).

The Minimum Offset option (8) lets you specify how far the box can move up
into the paragraph when WordPerfect needs to reduce the offset measurement.
For example, if you enter 1" for this option, graphics boxes can move up to 1"
from the top of the paragraph before being bumped to the next page.

If you want to have the offset measurement honored regardless of how close the
text is to the bottom of the page, set the minimum offset to a large value (e.g.,
11" on an 11" long page).

Outside Border Space

The measurements in this option refer to the amount of space you want between
each border of your box and the text outside your box. Select this option (2),
then enter a setting for each border or press Enter to leave a setting as it is and
continue on to the next border setting.

If the box is aligned with any setting (left margin, right margin, etc.), the outside
border space on that side of the box is ignored.

Position of Caption
This option (7) lets you set the position of the caption Below (1) or Above (2)
the box, and Outside (1) or Inside (2) the border.

For Equation boxes, this option lets you position the caption Below (1) or Above
(2) the equation, or on the Left (3) or Right (4) side of the equation. All these
options are inside the Equation box.
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If you select Left or Right and the equation is too wide for the caption to fit
inside the box, the caption will be placed below the equation.

See Also: Graphics, Create; Graphics, Define a Box; Graphics, Edit

Graphics Screen Type
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Since WordPerfect can run on several different types of display cards with
several different types of monitors, it needs to know the type of display card and
monitor you have. It needs to know because the method for displaying graphics
and text on the screen differs from display card to display card and monitor to
monitor.

A graphics driver is one of the files WordPerfect uses to communicate with a
display card and monitor. This file, which ends with a .VRS (video resource
file) extension, is used to display images in graphics screens such as the
Graphics Editor, the Equation Editor, and the View Document screen.

If you are having trouble displaying images in any of these screens, it could be
that the correct graphics driver isn’t selected.

WordPerfect uses a feature called Graphics Screen Type to select the correct
graphics driver. When you enter a graphics screen, WordPerfect attempts to
automatically select the correct graphics driver for your system (unless you have
selected one manually).

The list of graphics drivers WordPerfect searches is a list of the most common
graphics drivers. These drivers reside in the STANDARD.VRS file which is
installed with the WordPerfect program files and should reside in the directory
where WP.EXE is located.

If your driver is not on the list or if you have a special situation (e.g., two
monitors run by the same computer), you will need to select the driver that is
designed for that monitor or situation.

To do so,

1 Press Setup (Shift-FI).

rfl Select Setup from the File menu.

2 Select Display (2), then select Graphics Screen Type (2).

3 Move the cursor to the type of display card and/or monitor you have, then
choose Select (1).

If you don't know the type of display card and monitor you have, consult the
documentation that accompanied them or ask the person who installed them.



Notes

4 Move the cursor to your specific display card and/or monitor, then choose
Select ().

5 Press Exit (F7) until you return to the normal editing screen.

This setting is stored in the WP{WP}.SET file and remains in effect each time
you start WordPerfect.

Auto-Select

WordPerfect initially selects your graphics driver automatically. If you selected
one yourself, but now wish to have WordPerfect select one automatically, go to
the Setup: Graphic Screen Driver menu (Shift-F 1,2,2), then choose Auto-Select
(2).

WordPerfect makes a “best guess” at the type of display card and monitor you
have.

Card or Monitor Not Shown

If your display card or monitor is not shown on either of the selection menus,
then the information for that monitor is not located in the directory where
WP.EXE resides.

If you have files ending with a .VRS extension in a directory other than where
WP.EXE resides, make sure you are in the Setup: Graphic Screen Driver menu
(Shift-FI,2,2), then select Other Disk (3). After you do so, enter the pathname
to where your .VRS files are kept. WordPerfect will display those files on the
Setup: Graphic Screen Driver menu.

If you do not have .VRS files in any directory other than the directory where
WP.EXE is located and your display card or monitor is not shown on either of
the selection menus, send the name of your display card and monitor, a brief
description of the problem you are having, your return address, and your phone
number to:

Graphics/Text Driver

Attn: WordPerfect Corporation Information Services
1555 N. Technology Way

Orem, UT 84057

At WordPerfect Corporation we are constantly updating our software and there is
a chance that we may have created a driver for your display card. In the
meantime, consult your display card and monitor manufacturers for a suitable
emulation and select that emulation from the list.

Graphic Driver Not Selected

If you get this error message in any of the graphics screens, it is because
WordPerfect cannot find your graphics driver or the incorrect driver is selected.
If this is the case, follow the numbered steps at the beginning of this reference
section and select the appropriate driver.
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If you still get the message, try using the Auto-Select option (see Auto-Select
above).

Name Search

The Name Search option on the Setup: Graphic Screen Driver menu
(Shift-F1,2,2) helps you easily move the cursor to the name of your display card
or monitor. To use the option, select Name Search (n), then begin typing the
name of your display card or monitor. As you type letters, the cursor moves to
the first name on the list that matches those letters. Press Enter or an arrow key
to exit Name Search.

Other Disk

The Other Disk option is used in case your display card or monitor is not
displayed on the Setup: Graphic Screen Driver menu. For more information, see
Card or Monitor Not Shown above.

STANDARD.VRS

STANDARD.VRS is a special graphics and text driver that comes with
WordPerfect, and it contains information for most common display cards and
monitors. This driver should reside in the directory where WP.EXE is located.

Text Screen Type

The Text Screen Type option is used to select a text driver. Text drivers also
end with a .VRS extension (and, in fact, can be contained in the same .VRS file
as graphics drivers), but they are different from graphics drivers in that they
determine display in text (non-graphics) screens.

Among other things, text drivers let WordPerfect use extended text modes (more
lines and columns on a screen) and text fonts that are available on many of the
newer display cards and monitors. If you have a display card that is capable of
these operations or are having trouble displaying text on the screen, see Text
Screen Type in Reference.

Wrong Driver
You must have the monitor and card for the graphics screen type you select. If
you don’t, WordPerfect may not be able to display graphics screens properly.

See Also: Display Setup; Text Screen Type



H Hard Space

Notes

A hard space holds the words on each side of it together on one line.

For example, you can use a hard space to keep dates (e.g., January 21, 1990) or
names (e.g., John Paul Jones, Jr.) from being split by a soft return.

To insert a hard space,
1 Press Hard Space (Home,Space Bar).

Codes
Pressing Hard Space (Home,Space Bar) inserts a Hard Space code []. You can
use Reveal Codes (Alt-F3) to display the Hard Space code on the screen.

Deleting a Hard Space
A hard space can be deleted either in the normal editing screen or in Reveal
Codes (Alt-F3). You are not asked to confirm the deletion.

Hyphenation

WordPerfect considers the words joined by hard spaces as one word.
Consequently, when Hyphenation is on, WordPerfect may ask if you want to
hyphenate the combined words. You can then press Cancel (FI) to wrap the
combined words to the next line (see Hyphenation in Reference).

See Also: Hyphenation

Headers and Footers

Often you may want certain things to appear on every page of a document. For
example, you might want to put a chapter title, a date, or the company name at
the top or bottom of each page (or on certain pages).
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Such repeated items are called headers when they appear at the top of a page,
and footers when they appear at the bottom.

N HEADER
FOOtER
In WordPerfect, you only need to create a header or footer once. You can then
have WordPerfect place it on the pages you want.
To create a header or footer,
1 Move the cursor to the top of the first page on which you want the header or
footer.
2 Press Format (Shift-F8), then select Page (2).
Select Page from the Layout menu.
Select Headers (3) or Footers (4).
4 Select a (1) or b (2) to create the first or second header or footer (see
Number of Headers/Footers Allowed below).
5 Select Every Page (2), Odd Pages (3), or Even Pages (4) (see Placement
Options below).
6 Type the text of the header or footer (see Creating a Header or Footer
below).
7 Press Exit (F7) twice to return to your document.
Notes Adding and Deleting Headers and Footers

You can add new headers and footers anywhere in a document by following the
above steps.
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You can delete an existing header or footer by deleting the code for it (see
Codes below). When you attempt to delete a header or footer code in the
normal editing screen using Delete (Del) or Backspace, you are asked to confirm
the deletion. When you use any other deletion feature, any headers or footers
within the deleted text are automatically deleted (see Delete Text in Reference).

If you accidentally delete a header or footer, you can use Cancel (FI) to restore
it, just as you would restore any other deletion (see Cancel in Reference).

Codes

Creating a header or footer inserts a code into your document. The format for
the code is [header/footer letter:location,text] where header/footer letter is the
letter of that header or footer (e.g., Header A or Footer A), location is the
placement of that header or footer (e.g., every page or odd pages), and text is the
text of the header or footer, up to the first fifty characters. If a header or footer
contains more than fifty characters, three dots appear at the end of the header or
footer text (e.g., . . .). You can view a Header or Footer code in Reveal Codes
(AU-F3).

Header and Footer codes only affect the text in your document from the point
where they are inserted forward. Consequently, if you want a header to start on
a certain page, you must define it at the very top of that page (i.e., before any
characters). Usually, it’s also a good practice to place Footer codes at the top of
the first page on which you want the footer to appear.

If you like, you can place headers and footers at the very beginning of your
document, then use Suppress on the Page Format menu (Shift-F8,2,8) to keep
them from appearing on the pages where you do not want them. For example,
when the first page of your document is a title page, you can still place the
header or footer at the beginning of page 1 and then suppress it on page 1so
that it won’t start appearing until page 2 (see Suppress Page Format in
Reference).

If a Header code is not on the first page of your document, it may move from
the top of the page as you add or delete text. As a result, it may not be printed
until the following page. If a header code is located on a page other than the
first page of a document, you will want to make sure the Header code remains at
the top of that page as you edit the document.

Creating a Header or Footer

Once you have selected the header/footer number and placement options, you are
placed in a special editing screen. The letter for the header or footer you are
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creating appears on the left end of the status line (e.g., Header A for first,
Header B for second).

f Press E*it when done Ln 1" POS 1"

A

r *  Press E»it when done Ln 1" Pos 1"

A

Enter text as you normally would, using the WordPerfect editing features (e.g.,
Bold, Underline, Center, Tab, Flush Right, etc.). Use Move, Block, and Cancel
to move, delete, and restore text within the header or footer. You can also use
the Speller, the Thesaurus, and the Date feature. If you do not want to use the
current margin settings of your document, you can use Line Format
(Shift-F8,1,7) to set new left and right margins for your header or footer.

A single header or footer can contain up to one page of text, as defined by the
format of the current document (e.g., top and bottom margins, font size). Unless
a Base Font code exists in the header or footer, it is printed in the font that is the
base font at the point where the Header or Footer code is located (see Codes
above and Font in Reference).

You can also use Move (Ctrl-F4) to move text from your document into a header
or footer and back again (see Move in Reference).

Remember to press Exit (F7) twice when you have finished typing the text to
save the header or footer and return to your document. Be sure to press Exit
(F7) and not Enter or Cancel (FI). Pressing Enter will only add an extra line of
space to the header or footer.

If you forget to exit the Header and Footer Editing screen, you may wind up
typing more than a page of information into this screen by mistake. If you
exceed the page limit, an error message is displayed and the cursor is placed at
the end of the header or footer when you try to exit the screen. You can then
use Block (Alt-F4) and Move (Ctrl-F4) to block the unwanted text and move it
back into your document (see Block and Move in Reference).



Editing an Existing Header or Footer

When you tell WordPerfect you want to edit a header or footer, WordPerfect
searches backward in your document for the first Header or Footer code it can
find. If it does not find one, it then searches forward. Consequently, before
starting to edit a header or footer, it is a good idea to place the cursor
immediately after the header or footer that you want to edit.

To edit an existing header or footer, press Format (Shift-F8), select Page (2),
select Headers (3) or Footers (4), select A or B. then select Edit (5).
WordPerfect searches for the header or footer as explained above. It then
displays an editing screen with the current text for the first header or footer that
it finds. Edit it, then press Exit (F7) twice to save your changes and return to
your document.

If you have several different headers and footers in one document, you can
search for a specific one by pressing a Search key and then pressing the Format
keystrokes necessary to insert that Header or Footer code into a search string
(see Search in Reference). Once you have used Search to find the header or
footer you want, you can then use the steps given in the above paragraph to
display and edit it.

Editing an existing header or footer changes that header or footer wherever it
appears in a document. For example, if you want Header A to be in one format
on pages 1 through 5 of your document, and then change format beginning on
page 5, you cannot just edit Header A on page 5. You need to redefine a new
Header A on that page (see Number of Headers/Footers Allowed below).

Number of Headers/Footers Allowed

WordPerfect lets you define two different headers or footers on each page (e.g.,
A and B). However, there is actually no practical limit to the number of
different headers and footers you can have in one document.

Each time you define a header or footer, the code that is placed in your
document takes effect from that point forward, until you insert a new code for
that same header or footer. While each new code does not affect any previous
code, it does change the header or footer definition from that point on.

For example, you can define Footer A to be one kind of footer on pages 1
through 7 of your document, then redefine it on page 8. The new definition will
affect only the footers from page 8 forward.

Page Numbers

Normally, you will want to use the Page Numbering feature (Shift-F8,2,6) to
have WordPerfect number the pages in a document for you. However, you can
include page numbering within the text of a header or footer by pressing ctri-b
to insert a AB code into the text (see Page Numbering in Reference).

If you use both the Page Numbering feature, and the Headers and Footers
features in the same document, the header or footer and page number may
overlap. You can avoid this by inserting an extra blank line at the top of the
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header whenever you are going to use the Page Numbering feature at the top of
the same document. In the same manner, insert an extra blank line at the end of
the footer to leave space for the Page Numbering feature whenever you are going
to use the Page Numbering feature at the bottom of the same document. If you
use a single line header or footer with the Page Numbering feature, you can also
avoid overlapping by leaving blank space in the header or footer where the page
number will print.

Placement Options

Each time you create a header or footer, you can have it placed on every page,
odd pages, or even pages. You can also discontinue existing headers and
footers.

WordPerfect places the header or footer on the pages you select, and inserts a
blank space (usually .33") between the header or footer and the existing text on
the page. WordPerfect considers the header or footer to be part of the text and
not part of the top or bottom margin of a page. A header or footer is never
printed in the top or bottom margin. If you are using headers and footers and
find that you need more space on a page, use Margins, Top and Bottom in Page
Format (Shift-F8,2,5) to change your top and bottom margins.

If you use two headers (or footers) on the same page, be sure that one is flush
right or printed on a different line. Otherwise, one may print on top of the other.
For example. Header A will print on top of Header B; Footer A will print on top
of Footer B, etc. If you need to add some space between two headers or two
footers that will be printed on the same page, place one or more hard returns
between them. You must add these hard returns in the Header or Footer Editing
screen, not in the document itself.

Turning Off a Header or Footer
You can have a header or footer print on several pages, then discontinue it at a
certain point in your document.

To discontinue an existing header or footer, press Format (Shift-F8), select Page
(2), select Headers (3) or Footers (4), select A or B, then select Discontinue (1).

You can also use Suppress on the Page Format menu (Shift-F8,2,8) to suppress a
header or footer on certain pages (see Suppress Page Format in Reference).

You should always place both Suppress and Discontinue codes at the top of the
page.

See Also: Suppress Page Format



Help

Notes

Help lets you quickly learn more about WordPerfect without having to turn to
the manual. You can use Help to find out what WordPerfect keystrokes do by
pressing them.

Of course, the on-screen information Help provides is often condensed. While
using Help, if you feel you need more detailed information about a feature, you
can always refer to the manual.

Use Help (F3) to display any of the following on your screen:
< An alphabetical listing of WordPerfect features and their keystrokes.

Descriptions of WordPerfect features and menu options.

Information about the current feature you are using.

A template listing the keystrokes and names of the WordPerfect function
keys.

To display on-screen Help while using WordPerfect,
1 Press Help (F3).
FB1 Select Help (see Mouse below).

The type of information displayed depends upon what you are currently doing in
WordPerfect (see Context-Sensitive Help and Normal Editing Screen below).

2 Press Enter or the Space Bar to return to the previous screen or menu.

Alternate Keyboard
The Alternate Keyboard option (Shift-FI,3,9) lets you assign Help to FI. For

more information, see Alternate Keyboard under Environment Setup in
Reference.

Context-Sensitive Help
WordPerfect offers you context-sensitive help. That means that while you are
using a certain feature, you can press Help (F3) to learn more about it.

For example, suppose you have pressed Format (Shift-F8) and displayed the
Format menu on-screen, but you are not certain which option you need to select.
You can press Help (F3) to display a screen which briefly describes the
available options.

Keep in mind that some of the help screens appear very similar to the actual
menus they describe. If you need to be sure you are in a help screen, look for
the “Press ENTER to Exit Help” prompt which appears at the lower right corner
of the status line on every help screen.

Context-sensitive help also works in pull-down menus. When you press Help (F3), a
menu of information for the highlighted item appears.
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Help File

The information necessary to display on-screen Help is contained in the file
WPHELP.FIL which is provided with WordPerfect. When you install
WordPerfect, you are asked if you want to use Help. If you type y, the Help file
is correctly installed for you.

If you did not install Help when you installed WordPerfect but you do want to
use it, you can run the Installation Program and answer Yes when you are asked
if you want to install the Help files.

Mouse

Using the mouse to select Help from the pull-down menu bar displays the pull-
down menu options for the Help feature. You can then select Help to display
the main Help menu. Index to display an alphabetical listing of WordPerfect
features, or Template to display an on-screen template.

While using Help, you can exit the Help feature at any time by clicking the right
mouse button.

Normal Editing Screen
Pressing Help (F3) from the normal editing screen displays the main Help menu.

Help License « WP9991234567 WP 5.1 U9/G1/89

Press any letter to get an alphabetical list of features.

The list will include the features that start with that letter.
along with the name of the key where the feature is found. You
can then press that key to get a description of how the feature

Press any function key to get information about the use of the key.

Some keys may let you choose from a menu to get more information
about various options. Press HELP again to display the template.

Selection: 0 (Press ENTER to exit Help)

At the upper right corner of the main Help menu, the version number of the
WordPerfect program that you are using is listed, along with the date when that
version was issued. If you are running WordPerfect on a network, your three-
letter file ID will also appear in the upper right corner of the menu.

The first time you start WordPerfect you are asked to enter your license number.
Thereafter, the number you have entered is displayed in the main Help screen so
that you can refer to it whenever you need it, such as each time you call
Customer Support.

The text on the main Help menu tells you how to use the Help feature.



Hyphenation

Whenever you are using Help, you can either display alphabetical lists of
WordPerfect features or on-screen help about certain features.

If you are just browsing or you are not certain of the keystroke for the feature
you want to learn about, you can press any letter of the alphabet to display a list
of features that start with that letter. Each list includes features by keystroke,
feature name, and keystroke name. You can then press a keystroke to learn
more about any feature on the list.

For example, suppose you want to learn more about how to make letters
uppercase or lowercase but you are not certain what that feature is called. You
might type u for Uppercase from the main Help menu. The list of features that
is then displayed tells you that the Uppercase/Lowercase feature is called Switch
and that the keystroke for that feature is Shift-F3. You can then press Switch
(Shift-F3) to display a screen filled with information about how to switch
existing text back and forth from uppercase to lowercase.

On the other hand, if you already know the keystroke and you just want to learn
more about how to use it, you can press the keystroke to display a screen filled
with information. This works both for function keys and cursor movement keys.

For example, while using Help, you can press Switch (Shift-F3) to learn about
Switch, Bold (F6) to learn about Bold, Setup (Shift-FI) to learn about Setup, or
Right Arrow (->) to learn about cursor movement.

Some WordPerfect features and their keystrokes are listed on your keyboard
template. You can also display an on-screen template by pressing Help (F3)
once again while in any Help screen. From the on-screen template, you can then
press a feature keystroke to learn more about a feature.

See Also: Getting Started

Normally, when a word extends beyond the right margin setting, WordPerfect
wraps the word to the next line on the page. If you want to hyphenate words at
the right margin to improve the look of the printed page, you may do so with the
WordPerfect Hyphenation feature. As you type text or scroll through existing
text, WordPerfect will hyphenate where necessary.

When Hyphenation is on, WordPerfect looks at three things before deciding
when and how to hyphenate: the hyphenation zone, the hyphenation dictionary,
and the Hyphenation Prompt option. These options come preset to meet a
variety of user needs, but if you would like to make changes to the way
WordPerfect is hyphenating your document, see Hyphenation Zone, Hyphenation
Dictionary, and Hyphenation Prompt below.
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To turn on Hyphenation,

1 Move the cursor to where you want to start hyphenation.

2 Press Format (Shift-F8), then select Line (I).

(13 Select Line from the Layout menu.

3 Select Hyphenation (2).

4 Type y to turn on Hyphenation.

5 Press Exit (F7) until you return to the normal editing screen.

If Hyphenation is on and you want to turn it off, follow the steps above but type
n in step 4.

Canceling Hyphenation

If you want to cancel hyphenation for a word that has already been hyphenated,
move to the first letter of the word, press Home, then type a slash (/). Next,
move to the hyphen and delete it. If you want to cancel hyphenation for a word
that is displayed at the *“Position Hyphen; Press ESC" prompt, press Cancel
(F1).

When you cancel hyphenation for a word, that word is wrapped to the next line.

You can search for the Cancel Hyphenation code by pressing Search (F2), then
pressing Shift-F8,1,3.

Hyphenation Alternatives

There are characters that you can type from the keyboard as well as codes that
WordPerfect itself can enter in a document to handle long words or words that
you need to keep together. These characters and codes are discussed below.

A Hyphen Character is the character that is placed in your document when you
type a dash (-). Displayed and printed as a dash, the Hyphen Character tells
WordPerfect where you want a word hyphenated when the word needs to be
hyphenated (even if Hyphenation is off). If WordPerfect hyphenates the word at
a Hyphen Character, it does not add a Soft Hyphen.

A Hard Hyphen is the character that is placed in your document when you press
Home, then type a dash. Displayed and printed as a dash, the Hard Hyphen tells
WordPerfect that a word should be treated as one word and should not
necessarily be hyphenated at the dash. WordPerfect will follow regular
hyphenation procedure (checking the dictionary, prompting for assistance if
appropriate) if it needs to hyphenate the word.

A Soft Hyphen is a code (-) that is placed in your document when WordPerfect
hyphenates a word or when you hold down Ctrl, then type a dash. This tells
WordPerfect where a word should be hyphenated when it needs to be
hyphenated. If the word does not need to be hyphenated, the Soft Hyphen code
remains in the document but has no effect.



An Invisible Soft Return is a code [ISRt] placed in your document when you
press Home, then press Enter. It tells WordPerfect where a word should be
broken when it needs to be hyphenated. In other words, it is like a Soft Hyphen
except it doesn’t produce a hyphen; it simply breaks the word. It is especially
useful for words separated by en dashes, em dashes, and slashes (e.g.,
Colors/[ISRt]Fonts/[ISRt]Attributes). If the word doesn't need to be hyphenated,
the Invisible Soft Return remains in the document but has no effect.

A Deletable Soft Return is a code [DSRt] inserted by WordPerfect when
WordPerfect needs to break a word that extends from left margin to right
margin. A frequent sight in extremely narrow columns where Hyphenation is
turned off, the Deletable Soft Return is deleted and the word it divides is pulled
back together when the code is not at the end of a line or page.

Hyphenation Dictionary

When Hyphenation is on and a word needs to be hyphenated, WordPerfect looks
at one of two dictionaries to determine where to hyphenate the word. One of the
dictionaries is an internal dictionary that is built into WordPerfect. The other is
an external dictionary which is contained in the WP{WP}US.LEX and
WP{WPJUS.HYC files.

The external dictionary is much larger than the internal dictionary. It contains
more words and thus, gives WordPerfect more hyphenating alternatives than the
internal dictionary, but it also takes up more disk space. You can choose which
hyphenation dictionary WordPerfect will use.

To do so, go to the normal editing screen and press Setup (Shift-FI). Then,
select Environment (3) and select Hyphenation (6). Select External
Dictionary/Rules (1) for the external dictionary or Internal Rules (2) for the
internal dictionary. Next, press Exit (F7) until you return to the normal editing
screen.

When you make your selection, that setting is stored in the WP{WP}.SET file
and remains in effect each time you start WordPerfect.

Important: Ifyou select External Dictionary/Rules, WP/WPjUS.LEX and
WPfWPjUS.HYC must be installed and located in the thesaurus/spell/hyphenation
directory. Thesefiles are installed when the Speller is installed, so if you chose not to
install the Speller when you installed WordPerfect or have not subsequently done so, you
must do so before you begin to hyphenate (see the Installation Instructions card).

If WordPerfect can’t find the WP{WPJUS.LEX or WP{WPJUS.HYC files and
you have selected External Dictionary/Rules, it prompts you with a message on
the status line that tells you which file it can’t find, then wraps the word to the
next line.

More information on the thesaurus/spell/nyphenation directory can be found
under Location of Files in Reference.
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If you want to add words to or change the hyphenation criteria for words in the
External Dictionary, you may do so with the Speller Utility. For more
information, see Speller Utility in Reference.

Hyphenation Prompt
When WordPerfect is hyphenating, it may ask you for assistance. You can
determine how often it will ask for assistance.

There are three Hyphenation Prompt options: Never, When Required, and
Always. These options determine what WordPerfect will do when Hyphenation
is on and a word needs to be hyphenated.

To set a prompt option, go to the normal editing screen and press Setup
(Shift-FI). Then, select Environment (3) and select Prompt for Hyphenation (7).
Select an option from the bottom of the screen, then press Exit (F7) until you
return to the normal editing screen.

Never (1) instructs WordPerfect to hyphenate the word according to the
instructions in the hyphenation dictionary you chose (see Hyphenation Dictionary
above). If the word doesn’t exist in the dictionary, WordPerfect will wrap the
entire word to the next line.

When Required (2) instructs WordPerfect to hyphenate the word according to the
instructions in the hyphenation dictionary you chose (see Hyphenation Dictionary
above). If the word doesn’t exist in the dictionary, WordPerfect will prompt you
with the “Position Hyphen; Press ESC” message (see Position Hyphen; Press
ESC below). You will also be prompted for confirmation when more than one
correct hyphenation can be made or if WordPerfect cannot determine a correct
hyphenation for a word.

Always (3) instructs WordPerfect to stop at each word that needs to be
hyphenated, then prompt you with the “Position Hyphen; Press ESC” message
(see Position Hyphen; Press ESC below).

This setting is stored in the WP{WP).SET file and is in effect each time you
start WordPerfect.

Hyphenation Zone

The hyphenation zone determines when a word needs to be hyphenated. It is a
feature that establishes a region (“zone”) across which a word must be located if
it is to be hyphenated. If the word is not located in that zone, it is either kept
intact on the current line of text or wrapped to the next line.

If you want more or less hyphenation in your document, you may want to
change the size of the hyphenation zone (see Hyphenation Zone in Reference).

Language
WordPerfect has created hyphenation/speller dictionaries in several different
languages. When Hyphenation is on and you are using the External Dictionary,



Hyphenation Zone

WordPerfect searches for the dictionary that matches the current language code
(see Language in Reference).

For more information about the hyphenation/speller dictionary, call (801) 225-
5000. This number is not toll free.

Position Hyphen; Press ESC

When this prompt appears on the status line, it means that WordPerfect needs
your help in hyphenating the displayed word. Use Left or Right Arrow (<-/->) to
position the hyphen where you like, then press Escape (Esc) to insert the hyphen
into your document.

You may notice that you can’t move the hyphen as far as you would like. This
is because the cursor must be located between the first letter of the word and the
right hyphenation zone setting (see Hyphenation Zone above).

If you press Cancel (FI), the entire word will be wrapped to the next line. The
space before the word is changed to a soft return and a Cancel Hyphenation code
[7] is inserted in front of the word.

You can choose to have a beep accompany the “Position Hyphen; Press ESC”
message (see Beep Options in Reference).

Turning Off Hyphenation

The process for turning off Hyphenation is described in the steps at the
beginning of this reference section. If you want to turn off Hyphenation
temporarily during spell-checking or any scrolling command (e.g.,
Home,Home,Down Arrow), you can do so by pressing Exit (F7) at the first
"Position Hyphen; Press ESC” prompt.

Two Disk Drives

If you have a two disk drive system (no hard disk) and want to use the External
Dictionary/Rules option, we suggest hyphenating the document after you have
finished writing the document. To do so, insert the Speller diskette into the B
drive, turn on Hyphenation at the beginning of the document, then press
Home,Home,Down Arrow ¢i) to hyphenate the document.

See Also: Lesson 25; Environment Setup; Hyphenation Zone

When you use the WordPerfect Hyphenation feature to hyphenate words, the
Hyphenation Zone setting is used to determine which words need to be
hyphenated. Increasing the size of the zone decreases the number of words that
need to be hyphenated, while decreasing the size of the zone increases the
number of words that need to be hyphenated.
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HYPHENATION ZONE

The hyphenation zone works this way:

RIGHT MARGIN

LEFT H-ZONE RIGHT H-ZONE

WORD WRAP

HYPHE JATION

There is a left hyphenation zone setting and a right hyphenation zone setting. If
Hyphenation is on and a word starts before the left hyphenation zone setting and
extends past the right hyphenation zone setting, the word needs to be
hyphenated. As you can see, if the hyphenation zone is small, more words will
meet these criteria.

The hyphenation zone uses a percentage measurement. The percentage is a
percentage of the line length. For example, if a line is 6.5" long and the
hyphenation zone is 10% and 4%, the left hyphenation zone setting is .65" (.10 x
6.5 = .65") to the left of the right margin, and the right hyphenation zone is .26"
(.04 x 6.5 = .26) to the right of the right margin.

The hyphenation zone is a percentage measurement rather than an absolute value
because it allows the size of the hyphenation zone to change with the line length.
This is especially useful in columns where the line length of a column may be
much smaller than the non-column line length.

To set the hyphenation zone,

1 Move the cursor to the line in the document where you want to change the
hyphenation zone.

2 Press Format (Shift-F8), then select Line (1).
CB Select Line from the Layout menu.
Select Hyphenation Zone (2).

3

4 Enter the left hyphenation zone setting.
5 Enter the right hyphenation zone setting.
6

Press Exit (F7) to return to the document.



Notes

Hyphen Position

When Hyphenation is on and a word falls in the hyphenation zone, WordPerfect
searches the specified hyphenation dictionary to see where the hyphen should be
placed (see Hyphenation in Reference).

If WordPerfect finds an appropriate location in the hyphenation zone, it positions
the hyphen there. If not, WordPerfect checks to the left of the hyphenation zone,
and if it finds an appropriate location there, it positions the hyphen. If
WordPerfect still can't find an appropriate location, it positions the hyphen at the
right margin.

In all of the cases in the paragraph above, WordPerfect may or may not prompt
you for hyphenation assistance depending on the setting for the Prompt for
Hyphenation option. If Prompt for Hyphenation is set to Never and WordPerfect
can’t find an appropriate hyphenation location, it wraps the entire word to the
next line. For information on the Prompt for Hyphenation option, see
Hyphenation Prompt under Hyphenation in Reference.

When WordPerfect does prompt you for hyphenation assistance, the message,
"Position Hyphen; Press ESC" is displayed on the status line along with the
word to be hyphenated. You can move the hyphen with the Left and Right
Arrow keys anywhere from between the first two letters of the word to just
before the letter that is located at the right hyphenation zone. Regardless of the
size of the hyphenation zone, it must contain a minimum of two characters to
allow you some flexibility in hyphenation.

Hyphenation and Full Justification
Like hyphenation, full justification is a way to keep lines of text more even at
the right margin.

For more information about Justification, see Justification in Reference.

See Also: Hyphenation
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| Indent

A LEFT INDENT
¢S DOUBLE INDENT
A HANGING INDENT

Indent lets you indent a complete paragraph without changing the current
margins.

When you use Indent, you don’t have to press Tab to indent each line of text
you type. Pressing Tab indents just one line of text to the next tab setting.
Pressing Indent sets up a temporary left margin at the next tab setting. All the
text you type is then indented to that tab stop until you press Enter to insert a
Hard Return code [HRt] (see Codes below).

There are three different indentation keystrokes. You can use them to do any of
the following:

 Indent all the lines in a paragraph from the left margin (left indent).
e Indent all the lines in a paragraph from both margins (double indent).

« Keep the first line in a paragraph flush with the left margin while indenting
the remaining lines (hanging indent).

The -Indent feature indents an entire paragraph one tab stop from
the left margin. Simply press -Indent (F4) and start typing.
> Notice that every line Is indented from the left margin. When
you are finished with the paragraph, press Enter and you are
returned to the left margin.
The -Indent- feature indents an entire paragraph one tab stop from
the left margin and an equal distance from the right margin. Simply
press -Indent- (Shift-F4) and start typing.
Notice that every line is indented one tab stop from the
left margin and an equal distance from the right margin.
When you are finished with the paragraph, press Enter
and you are returned to the left margin.

This filature is especially useful for formatting long quotes or
other items you want to set apart from the body of the text.

YOU can create a hanging indent by pressing -Indent (F4). then
pressing -Margin Release (Shift-Tab). The first line in the
paragraph starts at the left margin while the rest of the

n lines are indented.

To indent text,

1 Press the appropriate indentation keystroke (see Indentation Keystrokes
below).

(13 Select Align from the Layout menu, then select the indentation you want.
2 Type the text you want indented.

3 Press Enter to end the indentation and return the cursor to the left margin.
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Notes Indentation Keystrokes
The following table lists the keystrokes used to indent text.

Indentation Keystroke
Left—Left side of paragraph only (at ¢Indent (F4)
the next tab stop).

Double—Both sides of a paragraph an ¢Indent*
equal distance from the left and right (Shift-F4)

margins. (The left side is indented at
the next tab stop; the right side is
indented an equal distance in from the
right margin.)

Hanging Indent—First line of ¢Indent (F4),
paragraph remains at the left margin, +Margin Release
remaining lines are indented at the next (Shift-Tab)

tab stop.

Indentation Codes

A code is inserted at the cursor each time you press an indentation keystroke.
Pressing ¢Indent (F4) inserts the Indent code [-“Indent). Pressing ¢Indent*
(Shift-F4) inserts the Double Indent code (-2Indent*—}. Pressing *Indent (F4),
+Margin Release (Shift-Tab) inserts an Indent code [-“Indent] followed by a
Margin Release code [<-Mar Rel].

The Indent codes indent any text from that point forward until the appearance of
the next Hard Return code [HR{t],

Tab Stops

The indentations you get when you use the indentation keystrokes are based on
the existing tab stops. You can change the distances that text is indented by
changing the tab settings (see Tab in Reference). You can also press an
indentation key more than once to indent text by more than one tab stop.

See Also: Tab; Tab Set
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Index

You can have WordPerfect generate (create) an index for your document. Both
headings and subheadings are available, and you can choose one of five
numbering styles.

A HEADING
A SUBHEADING
A NUMBERING STYLE

There are three basic steps to creating an index:

» Designate the words or phrases you want included in the index by marking
them in the document or by creating a concordance file.
- Define the location and numbering Style for the index.

* Generate the index.

Each step is exclusive of the others. For example, you could mark text as you
write, define the index while formatting the document, and generate the index

just before your final edit. Later, you could edit the marked text or the index

definition, and then regenerate the index.

The instructions for these three steps are divided into separate sections in
Reference. To begin, see Index, Concordance and Mark Text, then see Index,
Define, and finally see Generate.

Notes Master Documents
If your document is extremely long, you may want to use the Master Documents
feature to break it into smaller pieces. You can still generate one index for the
master document and all subdocuments (see Master Documents in Reference).

See Also: Lesson 22; Generate; Index, Concordance and Mark Text; Index,
Define
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Index, Concordance and Mark Text

A HEADING
A SUBHEADING

The first step in creating an index is to designate the words and phrases you
want included. When the index is generated, these words and phrases (entries)
become the headings and subheadings of the index.

Advance (78)
To Line (156)
Append (22), <34)
Arrow Keys (11)
ASCI1
>Character (26), (135)
Files (68), (135), (136)
Automatic Reference (11)
Backup
Automatic (2), (33), <142)
Options (141)
Original (132)
Timed (143)
Backspace (14), (15), (23), (43)
BASIC 5136)
Block (21)
Key (21)
Protect (73)
Bold (2), (25)
Cancel (15), (16)
Page Top to Bottom (123)
]

Change
Directories (11)

ASCII (82)

Line Draw (82), (83)
Cades (25), (26), (41)

Hard Page (75)

There are two ways to designate the entries you want in an index:

e Create a concordance file.
e Manually mark entries throughout the document.

You create a concordance file by listing each index entry in a WordPerfect file
(see Concordance below). When you use a concordance file, WordPerfect
searches the document for each occurrence of an entry and inserts the
appropriate page numbers in the index. You manually mark entries by searching
through the document and marking each occurrence you want in the index (see
Mark Text below). When you mark entries in the document, WordPerfect
generates index page numbers for only those entries you have marked.

Using a concordance file saves you the time of manually searching for entries
throughout the document. However, marking text within the document lets you
select existing phrases instead of having to compose a master list of index
entries. Also, when you use a concordance file, WordPerfect only searches for
exact matches. For example, if “Bird” is an entry in the concordance file, an
occurrence of “Birds” in the document will not be included in the index.

You can use a combination of the two, marking some entries within the
document and using a concordance file for others. WordPerfect will generate the
index using entries from both the concordance file and the text marked in the
document.
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Notes

Once you have designated the index entries, you need to define the index
location and numbering style. See Index, Define in Reference for details.

Concordance
To create a concordance file,

1 Start with a blank document screen.

2 Type an entry for the index and press Enter. Repeat this step for each entry
you want to include.

3 Save the document (see Save in Reference).

Below is an example of what a concordance file might look like.

Advance

Append

Arrow Keys
ASCII

Automatic Reference
Backup
Backspace
BASIC

Block

Bold

Cancel

Center

Change
Characters
Cades

Colors

Columns
Comments
Conditional End of Page
Cursor Movement
Date

Document

Doc 1 Pg 1 Ln 4.5" Pos 1.8"

You can edit the list and resave the Hie as needed.

When you define the index (see Index, Define in Reference), you are asked for
the name of the concordance file. Then when you generate the index (see
Generate in Reference), WordPerfect searches the document for each occurrence
of the entries listed in the concordance file and includes the appropriate page
numbers in the index.

Each entry in the concordance file can be as long as you want but must end with
a hard return [HRt] (inserted in the Reveal Codes screen when you press Enter).
Don’t worry if the line automatically wraps; this inserts a soft return [SRt], not a
[HRt],

An index will generate faster if you sort the entries in the concordance file
alphabetically before using it (see Sort in Reference). Sorting a concordance file
is easiest if each entry is only one line long.

WordPerfect automatically makes each entry in the concordance file a heading in
the index. If you want an entry in the concordance file to be a subheading in the
index, mark it in the concordance file using steps 1 through 4 under the Mark
Text heading below. If you want a concordance entry to be both a heading and
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subheading, mark it twice—once as a heading and once as a subheading (see
Mark Text below).

The index heading has a size limit of 40 bytes.
Mark Text
To mark text for use in an index,

1 Move the cursor to the word you want in the index, or if it is more than one
word, block the phrase (Alt-F4).

2 Press Mark Text (Alt-F5), and select Index (3).
ESI Select Index from the Mark menu.
3 Press Enter to use the displayed text as an index heading.
or
Enter your own text for the heading.
4 Press Enter to use the displayed text (if any) for the subheading.
or
Enter your own text for the subheading.
You can also press Cancel (FI) in step 4 if you do not want a subheading.

The text you selected in step 1 appears as the index heading in step 3. If you
don't use the displayed text as the heading, it appears as the subheading in
step 4. if you use the displayed text as a heading, no text appears for the
subheading.

Mark all the entries you want in the index. If you want an entry to be both a
heading and a subheading, you must mark it twice—once as a heading and once
as a subheading.

If you have phrases that occur frequently throughout the document, you may
want to include them in a concordance file (see Concordance above). You can
mark entries within a concordance file using steps 1 through 4 above.

When you mark an entry, [Index.heading;subheading] (where heading is text of
the heading and subheading is the text of the subheading) is inserted in the
Reveal Codes screen next to the word or phrase. If you decide you don’t want
the entry in the index, delete [Index:].

Master Documents
If you are using the Master Documents feature, you can mark index entries
within the subdocuments. Then when you generate the index, these entries will
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Index, Define

Notes

be combined into one index. WordPerfect will also search each subdocument for
entries you have listed in a concordance file (see Master Documents in
Reference).

See Also: Lesson 22; Generate; Index; Index. Define

Once you have designated the entries you want (see Index, Concordance and
Mark Text), the next step in creating an index is to define the location and
numbering style for the index. The following instructions assume you want the
index at the end of the document. Although you can put an index anywhere in a
document, be aware that doing so may give you some unanticipated results. For
details, see [Def Mark:] below.

1 Move the cursor to the end of the document.

2 If you want the index to start on a separate page, press Hard Page
(Ctrl-Enter).

3 If you want a heading (title) for the index, type it now, then press Enter as
many times as you want to add extra spacing.

4 Press Mark Text (Alt-F5), select Define (5), then select Define Index (3).
01 Select Define from the Mark menu, then select Index.

5 Enter the concordance filename (include the full path if it is not in your
default directory), if you are using one (See Index, Concordance and Mark
Text in Reference).

or
Press Enter if you are not using a concordance file.
6 Select a numbering style (see Numbering Styles below).

Once you have defined the index numbering style, you are ready to generate the
index (see Generate in Reference).

[Def Mark:]

When you select a numbering style while defining an index,

[Def M'dtk:Index,# filename] (where # represents the numbering style you
selected and filename represents the concordance file, if you entered one) is
inserted into the Reveal Codes screen at the cursor position. The index will be
generated at this code. Please note that if you have marked index entries in a
document, they will only be included in the index if they occur before the
[Def Mark:] code. All concordance file entries will be included in the index,
regardless of where [Def Mark:] is located.
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INITIAL CODES

If you are using the Master Documents feature, you should place the [Def Mark:]
code at the end of the master document, not inside one of the subdocuments (see
Master Documents in Reference).

Numbering Styles

Numbering styles refer to the way the page numbers for headings and
subheadings will be displayed. You can choose from the following five
numbering styles while defining an index:

No page numbers

Page numbers following the entries (separated by a space)

Page numbers in parentheses following the entries (separated by a space)
Flush right page numbers

Flush right page numbers with dot leaders

These five options affect the placement of page numbers in an index. If you
want to change the actual type of number used (from Arabic to Roman, for
example), you can use the New Page Number feature (Shift-F8,2,6,1). Changing
the page number type with the New Page Number feature affects both page
numbers displayed in the document and those generated in a table, list, or index.
See Page Numbering in Reference for details.

See Also: Lesson 22; Generate; Index; Index, Concordance and Mark Text

If you create many similar documents, you may format them a particular way.
For example, your margins may always be set to 2", you may always have
Justification off, and you may always have a particular page numbering format.

WordPerfect gives you two places to put the codes you use to format a document
without having to actually enter them in the document. The benefit of this is
that the codes don't “clutter” your document. And depending on where they
were entered, you might not have to re-enter them each time you begin a new
document.

Initial Codes is an option on both the Setup: Initial Settings menu (Shift-F 1,4)
and the Format: Document menu (Shift-F8,3). For both options, the method for
entering the codes is the same. The difference is that the option on the Setup:
Initial Settings menu sets codes for all subsequently created documents, while the
option on the Format: Document menu sets codes for the document on the
screen. The option on the Format: Document menu overrides (takes precedence
over) the option on the Setup: Initial Settings menu.

For example, if most of your documents have 2" left and right margins, it is a
good idea to enter that setting in Initial Codes on the Setup: Initial Settings
menu. If you have one particular document that has 1" left and right margins,



you may want to make that setting in Initial Codes on the Format: Document
menu. For that one document, the left and right margins will be set to 1". For
the rest of the documents, the setting will be 2"

In Initial Settings in Reference, we tell you how to get to the Initial Codes option
on the Setup: Initial Settings menu (Shift-FI,4,5). Here, we will tell you how to
get to the Initial Codes option on the Format: Document menu. The method for
entering codes is exactly the same.

1 Press Format (Shift-F8), then select Document (3).
Select Document from the Layout menu.
2 Select Initial Codes (2).

3 Select a feature as you normally would, then enter the information. When
you select a feature, a code is inserted in the bottom half of the screen.

An example of a few settings is shown below.

The list of codes you can enter is discussed in Codes below. You should not
enter text in an Initial Codes screen.

4 Press Exit (F7) until you return to the normal editing screen.

When you save a document for the first time, the settings you make on both the
Setup: Initial Settings menu and Format: Document menu are saved with the
document. From that point on, the only way you can change the initial codes for
that document is by changing them in Initial Codes on the Format: Document
menu with the document on the screen. You must save the document for any
changes to be saved with the document.

Codes inserted in the document itself or in features such as headers and footnotes
take precedence over initial codes.
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Notes Codes
The following codes are allowed in the Initial Codes screen:

Base Font Line Numbering
Column Definition Line Spacing

Column On Margins, Left/Right
Decimal/Align Character Margins, Top/Bottom
Endnote Number Math Column Definition
Endnote Options Math On

Footnote Number New Page Number
Footnote Options Page Number Position
Graphics Box Number Page Number Style
Graphics Box Options Paper Size/Type
Hyphenation On/Off Print Color

Hyphenation Zone Suppress Page Format
Justification Tab Set

Kerning Underline Spaces and Tabs
Language Widow/Orphan On/Off
Line Height Word and Letter Spacing

You may be able to enter codes other than the ones listed above as well as text,
but they will have no effect.

A list of initial settings for these and other codes is shown in Appendix G: Initial
Settings.

Existing Documents
Any document retrieved into an existing document will not retain its initial
codes. Instead, it will use the initial codes for the existing document.

If you want to change initial codes for an existing document, you should retrieve
the document to the screen, edit the codes in the Initial Codes option on the
Format: Document menu, then save the document.

Initial Codes on the Format: Document Menu

Any codes in Initial Codes on the Setup: Initial Settings menu also appear in
Initial Codes on the Format: Document menu. You can then edit the Initial
Codes for an individual document in Initial Codes on the Format: Document
menu as you like.

Merge

If you are using one primary file and several records from a secondary file to
create a mass-mailing, it is a good idea to include initial codes for the primary
file in Initial Codes on the Format: Document menu. If you don’t, the codes at
the top of the document are repeated each time the primary file is repeated.
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Initial Settings

Notes

If you are using merge to create labels, the Paper Size/Type code must be placed
in Initial Codes. Otherwise, only one entry per page of labels will be printed.
For more information, see Labels in Reference.

See Also: Initial Settings; Appendix G

Setup: Initial Settings is a menu on the Setup key that allows you to make
default settings for WordPerfect features that will affect all subsequently created
WordPerfect documents.

Several of the options on the Setup: Initial Settings menu are repeated on other
keys throughout WordPerfect and are set similarly. The difference is that Initial
Settings sets options for all subsequently created WordPerfect documents. These
options can be temporarily overridden for a single document with similar options
on different keys.

Specific relationships between options on the Setup: Initial Settings menu and
similar options on other keys are discussed for each option under Notes below.

To change an option on the Setup: Initial Settings menu,

1 Press Setup (Shift-FI).

03 Select Setup from the File menu.

2 Select Initial Settings (4), then select the option of your choice.

3 Change the settings for the option. The options are discussed under Notes
below.

4 Press Exit (F7) until you return to the normal editing screen.

These settings are stored in the WP{WP} .SET file and are in effect each time
you start WordPerfect. In addition, these settings are saved with subsequently
created documents when you save the documents and are in effect when you
retrieve those documents.

Documents created before you change these settings retain their old settings.

Date Format

This option lets you change the format for dates that you enter in your
documents with the WordPerfect Date feature. A similar feature exists on the
Date Format menu (Shift-F5,3) and the method for creating a format is the same
(see Date in Reference).
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Settings made with the options on the Date Format menu insert a code into your
document and affect the document from the code forward. The code will
override the same settings made with the Date Format option in Initial Settings.

See Language in Reference to learn about other ways of changing the date format.

Equations

This option lets you determine printing and alignment options for equations. It
also lets you select a keyboard layout that will be used only when you are in the
Equation Editor.

Printing and alignment options made in the Equation Editor itself override
settings made with this option, but if you do not make settings in the Equation
Editor, the equations use the settings made with this option. Once an equation is
created, the only way you can change the printing and alignment options is in the
Equation Editor. Information about these printing and alignment options is found
in Equations in Reference.

The option for specifying the equations keyboard can only be set with this
option. To do so, select the Equations option from the Setup: Initial Settings
screen, then select Keyboard for Editing (5). Next, move the cursor to the
keyboard you want to select, then choose Select (1). Press Exit (F7) until you
return to the normal editing screen.

To learn how to create a keyboard layout (remap keys), see Keyboard Layout in
Reference. If you want to learn more about equations or the equation keyboard
in general, see Equations in Reference.

Format Retrieved Documents for Default Printer

When a document is saved, the printer selection for that document is also saved
with it. If you are retrieving a document that was saved for a printer that is not
the printer currently selected on the Printer, Select feature (Shift-F7,s),
WordPerfect needs to know if you want to reformat the document for the
currently selected printer or select the printer with which the document was
saved.

A Yes setting for this option instructs WordPerfect to reformat the document for
the currently selected printer. Keep in mind that among other things, this may
change the way certain fonts and attributes are printed.

A No setting for this option instructs WordPerfect to try to select the printer for
which the document was created. If that printer is not on your list of selectable
printers, and the ,PRS File is not found in the printer directory, WordPerfect
displays a message indicating that the document is not formatted for the currently
selected printer, then formats the document for the currently selected printer.

If you decide to change Format Retrieved Documents to Yes after a document
has been retrieved, the printer selection already attached to that document will
not change.



For more information on printer selection and the printing process, see
Printing—General Information and Printer, Select in Reference.

Initial Codes

This option lets you enter codes that will be in effect each time you begin
creating a document in WordPerfect. A feature similar to this option is located
on the Format: Document menu (Shift-F8,3), and the method for entering the
codes is the same (see Initial Codes in Reference).

Examples of codes you can enter in the Initial Codes options are margin,
justification, tab, and paper size/type settings.

Any settings made with the feature on the Format: Document menu override
settings made with this option. Any settings made in the document itself
override settings made with both options.

Merge

This option determines the field and record delimiters for a DOS text (or pre-
WordPerfect 4.0) secondary merge file. In other words, when you merge
information using a DOS text (or pre-WordPerfect 4.0) file as a secondary file,
this option tells WordPerfect how fields and records are divided in that
secondary file.

After you select this option, select Field Delimiters (1) or Record Delimiters (2).
Then, type the characters that determine where fields or records begin, press
Down Arrow (i), and type the characters that determine where fields or records
end. While you may not have beginning characters, you should definitely have
ending characters. Pressing Enter inserts a Line Feed code [LF], Pressing
Ctrl-m inserts a Carriage Return code [CR],

For more information on merge, see Merge in Reference.

Print Options

These options let you change the appearance of a printed document. Most of
them are also located on the Print menu (Shift-F7) and are discussed in detail
under Print Options in Reference.

Settings made on the Print menu override settings made with this option but are
only in effect until you exit the current document.

One of the two options that are located on this menu, but not on the Print menu,
is the Redline Method. It is also located on the Format: Document menu
(Shift-F8,3). The method for setting it is the same, but the setting on the
Format: Document menu overrides the setting on this menu (see
Redline/Strikeout in Reference).

The other option, Size Attribute Ratios, lets you determine the size ratio of text
with certain attributes as compared to the current base font. For example, if you
want to make text formatted as Large to be twice as large as normal text, enter
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200% next to the Large heading. WordPerfect will use this information to select
the correct font when the document is printed.

The Size Attribute Ratio option does not change your printer’s capabilities. In
other words, the fonts your printer has or what it can do with those fonts,
determines how much effect the Size Attribute Ratio has on your printed text. If
you have a printer with numerous fonts that can be scaled to size, the Size
Attribute Ratio will have a large effect. If you have a printer with one font or
print wheel, the Size Attribute Ratio will have no effect.

If you do not have a font that is the exact size you specified, WordPerfect will
usually pick the font closest to that size.

Changes to the Size Attribute Ratio option only affect printer definitions. In
order for the changes to take effect in the printer definition for a non-PostScript
printer, you must update the definition (see Update under Printer, Select in
Reference). After updating the definition, documents saved with that printer
selected will reflect the changes.

You do not have to update PostScript printer definitions.

For a discussion on how fonts are assigned to WordPerfect attributes, see Font in
Reference.

Repeat Value

This option determines the initial (default) value for the Repeat Value feature.
You can also set this value with the Repeat Value feature itself, and the setting
made with the Repeat Value feature overrides the setting made with this option
(See Repeat Value in Reference).

Table of Authorities

This option determines how entries in your table of authorities will be formatted.
The information is exactly the same as on the Definition for Table of Authorities
menu (Alt-F5,5,4). Settings made on the Definition for Table of Authorities
menu insert a code in your document and override settings made with this option
(see Table of Authorities in Reference).

See Also: Date; Equations; Initial Codes; Merge; Print Options; Repeat Value;
Table of Authorities



J Justification

A LEFT JUSTIFICATION
A RIGHT JUSTIFICATION

A FULL JUSTIFICATION
(BOTH LEFT AND RIGHT)

A CENTER JUSTIFICATION

The WordPerfect Justification feature is used to align text. Using the
Justification feature, you can align multiple lines of text on the right or left
margins, on both margins, or center it between margins.

The screen below shows the four types of justification you can use in
WordPerfect.

You can use the Flush Right (Alt-F6) and Center (Shift-F6) features to right-align or
center a single line of text.

To change justification in your document,

1 Move the cursor to the beginning of the line where you want to change
justification.

Ifyou don't change justification at the beginning of a line, WordPerfect inserts a
Deletable Soft Return [DSRt] in your document before the Justification code in order to
force the code to be placed at the beginning of a line.

2 Press Format (Shift-F8), then select Line (1).
03 Select Line from the Layout menu.
3 Select Justification (3).

4 Select the justification option of your choice (details about the options are
described below).

5 Press Exit (F7) until you return to the normal editing screen.
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The change remains in effect from the cursor forward in the document. If you
want to change the justification again, you must go through the steps above.

Center Justification

Center Justification centers lines of text between margins as you can see in the
example that accompanies this reference section. If you divide a center-justified
line of text in half, the same amount of text exists on both the left and right
sides of the line.

This setting is much like the Center (Shift-F6) feature except it is much better at
centering multiple lines of text. If you were to use the Center feature to center
multiple lines of text, you would need to turn on Center at the beginning of
every line. With Center Justification, all you need to do is turn it on and
subsequent lines of text are centered.

When Center Justification is active, you cannot use the Center, Flush Right, Tab,
and Tab Align features.

Full Justification

Full Justification aligns lines of text on both the left and right margins as you
can see in the example that accompanies this reference section. In order to do
so, spaces between words must be compressed or expanded as necessary (see
Word Spacing Justification Limits below). Full Justification will not show on the
normal editing screen but will display in the View Document screen correctly.

When Full Justification is active, you can use the Center, Flush Right, and Tab
Align features.

Left Justification

Left Justification is used to produce a “ragged right” margin as you can see in
the example that accompanies this reference section. Text is aligned at the left
margin, but not at the right margin. If Left Justification is active, you can still
use the Center, Tab Align, and Flush Right features.

Right Justification

Right Justification is used to produce a "ragged left” margin as you can see in
the example that accompanies this reference section. Text is aligned at the right
margin, but not at the left margin.

This setting is much like the Flush Right (Alt-F6) feature except it is much better
at right-aligning multiple lines of text. If you were to use the Flush Right
feature to right-align multiple lines of text, you would need to turn on Flush
Right at the beginning of every line. With Right Justification, all you need to do
is turn it on and subsequent lines of text are flushed right.

When Right Justification is active, you cannot use the Center, Flush Right, and
Tab Align features.



Notes

Existing Text

If you want to Center or Right Justify existing lines of text, block the text, press
the Center (Shift-F6) or Flush Right (AU-F6) keys, then type y. Even though
you are pressing those keys, a Justification code (rather than a Center or Flush
Right code) is placed in front of the block. At the end of the block, WordPerfect
inserts another Justification code which changes justification back to what it was
before the text you blocked.

Hyphenation

Like Justification, Hyphenation improves the look of the printed page. You
cannot, however, hyphenate right- or center-justified text. For more information
on hyphenation, see Hyphenation in Reference.

Search

If you enter a Justification code in the Search feature, you will notice that the
code is represented as [Just]. This is a generic Justification code that will find
any of the four types of Justification codes.

Tables

When WordPerfect encounters a table, the justification setting is turned off at the
beginning of the table, then turned back on at the end of the table. Within the
table, the Table Position option determines the alignment of the entire table
structure (see Position under Table. Edit Structure in Reference).

The Justification feature can be used within a table to determine text alignment
inside cells. When a justification setting is made with the Justification feature, it
only affects text in the cell where the justification setting is made.

You can also change the Justify settings under the Table Format options to make
jUStification settings for individual cells or entire columns of cells. Table JUStlfy

settings, however, are overridden by any settings you make with the Justification
feature inside of the table. The Table Justify settings allow for an additional
option, Decimal Align, which lets you align text on a decimal character. This is
useful if the table contains numbers.

For more information on justification in tables, see Table, Format Columns and
Cells in Reference.

Word Spacing Justification Limits

When Full Justification is active, WordPerfect expands or compresses spacing
between words as needed to justify the text on a line. The Word Spacing
Justification Limits option lets you set limits on this expansion and compression.
Once a limit is reached, WordPerfect then begins to adjust spacing between
characters.
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To adjust the Word Spacing Justification Limits,

1 Move the cursor to where you want to set the limits.
2 Press Format (Shift-F8), then select Other (4).

LB Select Other from the Layout menu.

3 Select Printer Functions (6), then select Word Spacing Justification Limits
(4).
4 Enter a compression percentage, then enter an expansion percentage.

The percentages you enter are percentages of an existing space. For example, if
you do not want WordPerfect to compress a space more than 60% (.6) of its
normal size, enter 60% for the compression percentage. If you do not want
WordPerfect to expand a space more than 120% (1.2) of its normal size, enter
120% for the expansion percentage.

For the expansion percentage, anything over 999% is considered unlimited.

5 Press Exit (F7) until you return to the normal editing screen.

If your printer cannot support this feature. Word and Letter Spacing will have no
effect.

See Also: Center; Flush Right; Tab Align



K Kerning

A UN-KERNED LETTER PAIRS
A KERNED LETTER PAIRS

Notes

On the printed page, certain letter pairs appear to have more space between them
than others because of the shape and slant of each letter. If you would like to
reduce the space between these letters. WordPerfect offers a feature called

Kerning.
VoV
WALTER
vV V
WALTER
Some fonts are defined with kerning tables while others are not. For example,

there is no mono spaced font with defined kerning tables. The printer resource
file (PRS file) determines which letter combinations are kerned.

1 Move the cursor to where you want kerning to begin.
2 Press Format (Shift-F8) to display the Format menu, then select Other (4).
C1 Select Other from the Layout menu.
Select Printer Functions (6).
4  Select Kerning ().
5 Type y to turn on kerning
or
Type n to turn off kerning.

6 Press EXit (F7) to return to the document.

Codes
Kerning starts at the [KermOn] code and affects text from that point forward in
the document until it reaches a [KermOff] code.

Manual Kerning
Depending on your needs, you can manually kern by inserting an Advance code
between the pair of characters to be kerned (see Advance in Reference).

Printers and Kerning

By using the Printer Program, it is possible to define kerning tables for specific
sets of characters by making adjustments to your .ALL file. For more
information, see Printer Program in Reference.

Test File

KERN.TST is a file containing the letter pairs which are most often kerned.
Retrieve this file, select the printer you are using, and change the base font to the
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font which you want to test. You may then print the file to see how the letter
pairs are kerned for the chosen font.

KERN.TST is installed with the Printer Program files. 1fyou did not install the Printer
Program files when you installed WordPerfect or have not subsequently done so. you
must do so ifyou wish to use KERN.TST (see the Installation Instructions card).

See Also: Printer Program; Word and Letter Spacing

When WordPerfect is shipped, certain WordPerfect features and operations are
assigned to certain keyboard keys. For example, Cancel is assigned to the FI
function key, Help is assigned to the F3 function key, and so on. Many of you
have learned how to use WordPerfect with these key assignments, and changing
the assignments might prove frustrating to those of you who like the key
assignments just the way they are.

But to keep the key assignments as they are and to prohibit you from changing
them can prove frustrating if you have switched to WordPerfect from another
word processing program, or if you would simply like to design a keyboard
layout of your own. To help those of you who would like to tailor key
assignments to your own needs, WordPerfect provides the Keyboard Layout
feature.

The Keyboard Layout feature lets you reassign or remap WordPerfect features
and operations to the keys on your keyboard. This includes the function keys
(FI through F10 or FI through F12, depending on your keyboard), the character
keys, and the Alt, Ctrl, and Shift states of the character and function keys.

This lets you assign features and operations to the keys of your choice. For
example, many software programs use Fl as the Help key. If you feel more
comfortable with FI as the Help key instead of F3, you can re-assign Help to the
FI key. Then, you can re-assign Cancel to another key. To do this, you can
create a keyboard layout from which you can modify some, or all, of the key
assignments.

There are two ways of assigning keys, and they are discussed in Keyboard
Layout. Edit and Keyboard Layout, Map in Reference. After you have created a
keyboard layout, the process for selecting it and putting it to use is very simple.

WordPerfect includes some keyboard layouts when it is shipped. For more detail on
these, see Appendix H: Keyboards.

1 Press Setup (Shift-FI).
(7TH Select Setup from the File menu.
2 Select Keyboard Layout (5).



Notes

3 Move the cursor to the keyboard of your choice, then choose Select (1) to
select it.

The keyboard names displayed on the Setup: Keyboard Layout menu are the
keyboard files (files with a .WPK extension) listed in the keyboard/macro
directory (see Location of Files in Reference). If the keyboard you want to use
is not listed, either you have not created it, or it is not located in the
keyboard/macro directory that you specified in Location of Files. If you have
not created it, see Create below. If it is not located in the keyboard/macro
directory, see Location of Files in Reference.

4 Press Exit (F7) to return to the normal editing screen.

The keyboard selection you make is stored in the WP{WP}.SET file and remains
in effect each time you start WordPerfect.

Copy

The Copy option on the Setup: Keyboard Layout menu lets you copy an existing
keyboard layout. Use this option if you want to create a keyboard layout using
an existing keyboard layout as a model.

To copy a keyboard layout, move the cursor to the name of the keyboard layout
you want to copy in the Setup: Keyboard Layout menu, select Copy (5), then
enter a name for the new keyboard.

You can enter up to eight characters for a keyboard name. If you try to name a
keyboard with the name of an existing keyboard, you will get an error message
and must try naming the keyboard with another name.

Create

The Create option on the Setup: Keyboard Layout menu lets you create and
name a keyboard layout. To do so, select Create (4) from the Setup: Keyboard
Layout menu, then enter a name (up to eight characters) for the keyboard. When
you give a keyboard a name, it is stored as a file in the keyboard/macro
directory and a .WPK extension is added to the name (see Location of Files in
Reference).

The new keyboard initially has the same key assignments as your original
keyboard. For information on editing the keyboards you create, see Keyboard
Layout. Edit in Reference.

Delete

The Delete option on the Setup: Keyboard Layout menu lets you delete a
keyboard on the menu. To delete a keyboard layout, move the cursor to the
name of the keyboard you want to delete in the Setup: Keyboard Layout menu,
select Delete (2), then type v.

The keyboard is deleted from the Setup: Keyboard Layout menu and its
associated .WPK file is deleted from your disk.
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Edit

The Edit option on the Setup: Keyboard Layout menu lets you edit key
assignments for a keyboard layout. Using this option, you can assign
WordPerfect features, macros, Compose characters, and keyboard characters to
the various keyboard keys. For more information, see Keyboard Layout, Edit in
Reference.

The Map option also lets you perform many of the same operations as the Edit
option. For more information on the Map option, see Keyboard Layout, Map in
Reference.

Keyboard Layouts and Macros

If you have defined an Alt-macro and execute it by pressing A It-letter,
WordPerfect first looks to see if a feature or operation has been assigned to that
Alt-letter key on the current keyboard layout. If it has, WordPerfect will use the
key assignment. If not, WordPerfect will search for the macro file, then execute
it.

For example, if you have an Alt-d macro that normally inserts the date in your
document, but are using a keyboard where Alt-d has been defined to turn on
Bold, pressing A1t-d will turn on Bold. If Alt-d is not assigned in the keyboard
layout you are using, pressing Alt-d will insert the date in your document.

If you want to make sure that the macro file is executed, you can press macro
(Alt-F10), then enter the name of the Alt-macro (e.g., altp).

Non-Alt-macros (macros invoked with Alt-FIO) will always be accessible no
matter which keyboard is active. Their operation, however, depends on several
factors (see Key Macro under Keyboard Layout, Edit and Keyboard Layout, Map
in Reference).

Keyboard Layouts vs. Alt-Macros
Keyboard layouts let you assign features and operations to Alt-character keys.
But so does the Macro feature. What’s the difference?

The obvious difference is that keyboard layouts give you more flexibility. If you
read through the information in this and the following keyboard sections, you
will learn that keyboard layouts let you assign more than macros to most keys on
the keyboard.

When you are deciding whether to create an Alt-macro or a keyboard layout,
however, you should be aware that an individual Alt-macro file takes up less
disk space than a keyboard layout file. In other words, you may not want to
create a keyboard layout that simply re-assigns one or two Alt keys. Try
creating an Alt-macro instead (see Macros, Define in Reference).

Map
The Map option on the Setup: Keyboard Layout menu gives you a “big picture”
or “map” of key assignments, while letting you assign WordPerfect features,



Compose characters, and keyboard characters to various keyboard keys. For
more information, see Keyboard Layout, Map in Reference.

The Edit option is similar to the Map option in that it can perform all of the
same operations and more, including making assignments for function keys and
assigning macros to a keyboard key. For more information on the Edit option,
see Keyboard Layout, Edit in Reference.

Name Search

The Name Search option on the Setup: Keyboard Layout menu lets you easily
move the cursor to the keyboard name you are looking for. Select Name Search
(n) in the Setup: Keyboard Layout menu, then begin typing the name of the
keyboard you are looking for. As you type letters, the cursor moves to the
keyboard name that matches those letters. To exit Name Search, press Enter or
one of the arrow keys.

Original

The Original option on the Setup: Keyboard Layout menu lets you re-select the
original keyboard. To do so, simply select Original (6) in the Setup: Keyboard
Layout menu.

You can also switch to the original keyboard from anywhere in WordPerfect by
pressing Ctrl-6. Unlike the Original option, Ctrl-6 temporarily disables the
selected soft keyboard. Press Ctrl-6 when you want to perform keystrokes that
have been disabled by the keyboard currently in use. If you don’t use the
Original option or select another keyboard on the Setup: Keyboard Layout menu,
the keyboard you selected prior to pressing Ctrl-6 will be in effect the next time
you start WordPerfect.

To switch back to the keyboard you temporarily disabled without using the Setup menus,
press Ctrl-6,Ctrl-6. The messaage, "Active keyboard-[keyboard name]" is displayed. To
disable the Ctrl-6 option, use the /no startup option (see Appendix N: Startup Options/

Rename

The Rename option on the Setup: Keyboard Layout menu lets you rename a
keyboard. To use this option, move the cursor to a keyboard on the menu, select
Rename (3), then enter the new name. When you select this option, the filename
for the keyboard layout is also changed to the new filename. The filename
maintains the .WPK extension and is stored in the keyboard/macro directory (see
Location of Files in Reference).

See Also: Lesson 26; Compose; Keyboard Layout, Edit; Keyboard Layout, Map
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The Edit option on the Setup: Keyboard Layout menu (Shift-FI,5,7) is one of the

two options (Map is the other) that lets you re-assign (or remap) WordPerfect
features to keys on your keyboard. These keys become part of a keyboard
layout.

If you want to learn more about keyboard layouts in general, see Keyboard
Layout in Reference.

To use the Edit option,
1 Press Setup (Shift-FlI).
LB Select Setup from the File menu.

2 Select Keyboard Layout (5), then move the cursor to the keyboard you want
to edit.

The keyboard names displayed on the Setup: Keyboard Layout menu are the
keyboard files (files with a ,WPK extension) listed in the keyboard/macro
directory (see Location of Files in Reference). If the keyboard you want to edit
is not listed, either you have not created it, or it is not located in the
keyboard/macro directory you specified in Location of Files. If you have not
created it, see Create under Keyboard Layout in Reference. If it is not located in
the keyboard/macro directory, see Location of Files in Reference.

3 Select Edit (7).

The Keyboard: Edit menu IS shown below.

Keyboard: Edit
Name : MACROS

Key Description

ilace an Wc with a di“rerent type

KEY MACRO 7) Transpose 2 visible characters
KEY MACRO 271 Insert a line.
KEY MACRO 3} Delete a line
Alt-F KEY MACRO 10} Find the Bookmark
Alt-G {KEY MACRO 4} Send GO to printer
Alt-C {KEY MACRO 8} Capitalize 1st letter of current word
Alt-B {KEY MACRO 6} Restore the previous block
Alt-N {KEY MACRO 5} Edit the Next or Previous Note.
Alt-M (KEY MACRO 9} Insert Bookmark
Ctrl-F8 KEY MACRO 17} Font Key
Alt-F9 KEY MACRO 1} List Files from Graphics Key
ctri-C {KEY MACRO 13} Calculator
ctrl-D {KEY MACRO 12} Generate Standard Documents
Ctrl-E {KEY MACRO 19} Print Name & Address on an Envelope
ctrl-G {KEY MACRO 18} Glossary Macro - Expand Abbreviations

1 Action; 2 Dscrptn; 3 Original; 4 Create; 5 Move; Macro: 6 Save; 7 Retrieve:



Notes

Notice the Name heading at the top of the screen. This reminds you which
keyboard layout you are editing.

4 Move the cursor to the key you want to edit.

If the key you want to edit is not displayed, its function is the same as on the original
keyboard (see Create below). You can move directly to a key on the list by selecting
Name Search (n), then pressing the key.

5 Select one of the options on the Keyboard: Edit screen and perform the
necessary operations (see the option headings under Notes below).

6 Press EXit (F7) to return to the Setup: Keyboard Layout menu.

At this point, you may select one of the options from the Setup: Keyboard
Layout menu, or you can press Exit (F7) to return to the normal editing screen.
If you wish to select the keyboard for use, move the cursor to the keyboard
name, then choose Select (1).

Action

This option on the Keyboard: Edit menu takes you directly into a macro editing
screen called the Key: Action screen, where you can assign a WordPerfect
feature or operation to the key.

Key: Action

Key Alt-H

Description Replace an AFC with a different type

1fIF% STATE)&4 {:}Ateedi tmacreen/no-block-
{ELSE

{RETURN}

[END IF)

{1 F}éSTATE %&128 -
Ir e Az
{RETURN)

{END 1F)

(DISPLAY OFF) {:)Check-foreconfirmation™
{CHAR)O*Confirm-Replace?=(Y/N)aNo[Left){Left}"
1(CASE) [VAR or

y~yes*“Y*yes*

(ASSIGN)O

ctri-Pgup for macro commands; Press Exit when done

Depending on what you want to do in this screen, your task can be as simple as
assigning a feature located on a function key to another key, or it can be as
intricate as creating the most powerful WordPerfect macro.

To use this option, move the cursor to the key on the Keyboard: Edit menu
whose assignment you want to change, select Action (1), then edit the key as
necessary. Press EXit (F7) when you are finished.

The procedure for editing in the Key: Action screen is the same as editing in the
WordPerfect Macro Editor. Before you decide to edit in the Key: Action screen,
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you may want to read Macros, Macro Editor in Reference to learn about the
things you can do in the Key: Action screen.

The following are some simple operations you can perform:

To assign a function key feature to the key. press the function key for that
feature. For example, press the function key for *Indent (F4) if you want to
assign the ~Indent feature to the key.

If you want to assign Cancel, Exit, Help, or many of the cursor movement keys (e.g.,
arrow keys), you must press Ctrl-v before pressing the key assigned to those features.

If you want to assign a Compose character, press Compose (Ctrl-2), type the
WordPerfect character set number, a comma, the character within the character
set. then press Enter (see Compose in Reference).

If you want to use the WordPerfect macro programming language, press Macro
Commands (Ctrl-PgUp) to display the programming commands, move the cursor
to the command you want, then press Enter.

Notice that commands such as Block Append/Copy/Move and Item Up/Down/Left/Right
are located on the list of programming commands. This is how you can assign these
functions to keys on keyboards without an enhanced BIOS.

Cancel

Pressing Cancel (FI) in the Keyboard: Edit menu displays the prompt “Cancel
Changes? No (Yes).” Typing n keeps you in the Keyboard: Edit menu while
typing y cancels all changes you made since you entered the Keyboard: Edit
menu and exits you to the Setup: Keyboard Layout menu. If you don’t want to
cancel the changes, press Exit (F7) instead of Cancel to exit the menu and save
the changes.

Create

This option on the Keyboard: Edit menu lets you assign a WordPerfect feature or
operation to a key that is not listed on the Keyboard: Edit menu. To use this
option, select Create (4) from the Keyboard: Edit menu, then press the key you
want to assign the feature or operation to.

After you press the key and enter a description for the key, you are placed in a
screen called the Key: Action screen, and the procedure is the same as if you
had selected the Action option for an existing key assignment. Read the
information under Action above to find out what your options are at this point.

Delete

If you want to delete a key and its assignment from the Keyboard: Edit menu,
move the cursor to the key you want to delete, press Delete (Del) or Backspace,
then type y to confirm the deletion. When you delete a key from the Keyboard:
Edit menu, its assignment is returned to what it was on the original keyboard.



Description

This option on the Keyboard: Edit menu lets you enter or add a description for a
key. The description is used to tell you what the key does and is displayed on
the Keyboard: Edit screen.

To use this option, move the cursor to a key on the Keyboard: Edit menu, select
Description (2), then enter a description for the key.

Key Macro

If you retrieve a macro file to a key (see Retrieve below) or if you create a
macro for a key (see Action above), the macro is represented as (Key Macro #}
under the Action heading on the Keyboard: Edit screen.

The Key Macro command is used in macros where you press the key associated
with the key macro. For example, suppose you assign a macro to the FI key in
a keyboard layout called TESTKEY, and suppose that macro becomes

(Key Macro 1}. If you are using TESTKEY while defining a macro called
MACRO, and then press FI, (Key Macro 1} is inserted into the macro (and can
be viewed in the Macro Editor).

When you execute MACRO and it comes time for WordPerfect to interpret the
{Key Macro 1} command, it will look in the keyboard layout you are currently
in, then execute the steps associated with the key assigned to {Key Macro 1}.
As long as everything is the same as when you defined the macro (the keyboard
layout, the key assigned to (Key Macro 1}, the operation that (Key Macro 1}
represents), the macro will work as expected. If any of those things have
changed by the time you execute the macro, the macro may not function as you
would like.

For this reason, we suggest that you create your macros with the original
keyboard in effect. With the original keyboard in effect, it is impossible to insert
(Key Macro} commands into a macro. Therefore, as long as the macro is
created correctly, it should execute as expected no matter which keyboard layout
you are in. The only exception to this is an Alt-macro which is discussed in
Keyboard Layouts and Macros under Keyboard Layout in Reference.

Keyboard Layout: Map

The Map option on the Setup: Keyboard Layout menu is similar to the Edit
option discussed in this section in that it lets you assign WordPerfect features
and operations to keys. It is another way to edit the same keyboard layout.

Unlike the Edit option, the Map option does not let you assign an existing macro
to a key, save a key assignment as a macro, or assign features and operations to
function keys. One advantage the Map option has over the Edit option, however,
is that it gives you a “big picture” of your keyboard layout. It shows most of
the keys on your keyboard and the features or operations assigned to them.

More information on this option can be found in Keyboard Layout, Map in
Reference.
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Move

This option on the Keyboard: Edit menu lets you move a key assignment from a
key existing on the Keyboard: Edit menu to a key that may or may not exist on
the menu. To use the option, move the cursor to the key on the Keyboard: Edit
menu whose assignment you want to move, select Move (5), then press the key
you want to move the feature or operation to.

For example, if you have retrieved a macro named TEST.WPM to F6 and you
want to change its assignment to F8, move the cursor to the F6 key assignment
on the Keyboard: Edit menu, select Move (5), then press F8.

If you are replacing a key assignment that previously existed on a key, you must
type y to confirm the replacement. The key from which an assignment was
moved is returned to its assignment on the original keyboard and is no longer
displayed on the Keyboard: Edit menu.

Original

This option on the Keyboard: Edit menu lets you return a key’s function to what
it was on the original keyboard. In effect, it deletes the “remapped” definition of
this key from the keyboard layout.

To use this option, move this cursor to the key on the Keyboard: Edit menu you
want to change, select Original (3), then type v.

Retrieve

This option on the Keyboard: Edit menu lets you assign an existing macro to a
key. To do so, select Retrieve (7) from the Keyboard: Edit menu, press the key
you want to assign the macro to, then enter the name of the macro. If you are

replacing a key assignment that previously existed on a key, you must type y to
confirm the replacement.

WordPerfect will look for the macro in the keyboard/macro directory unless you
enter a different pathname.

Once a macro is retrieved to a key, the association with the macro ends. In
other words, editing changes to the macro itself (not the key assignment), or the
macro assigned to the key do not affect each other.

More information about naming macros can be found in Macros, Define in
Reference. More information about the keyboard/macro directory can be found
in Location of Files in Reference.

Save

This option on the Keyboard: Edit menu lets you save a key assignment as a
macro. This enables you to use that assignment as a macro no matter which
keyboard is selected.

For example, suppose you have a key assignment that saves a document, then
clears the screen. If you want that assignment to be stored as a macro that can



be executed with the Macro feature regardless of the keyboard layout you are
using, use this option.

To do so, move the cursor to the key on the Keyboard: Edit menu whose
assignment you want to save as a macro, select Save (6) from the Keyboard:
Edit menu, then enter the name you want to call the macro. If you are replacing
a macro that previously existed under the same name, you must type y to replace
the macro. The macro will be saved to the keyboard/macro directory (unless you
enter a pathname to a different directory) and a .WPM extension will be added.

More information about naming macros can be found in Macros, Define in
Reference. More information about the keyboard/macro directory can be found
in Location of Files in Reference.

See Also: Lesson 26; Compose; Keyboard Layout; Keyboard Layout, Map;
Macros, Macro Editor

Keyboard Layout, Map

The Map option on the Setup: Keyboard Layout menu lets you see the key
assignments for most keys on a keyboard layout. In addition, you can assign
WordPerfect features and operations to keys on the Keyboard: Map menu.

If you like to assign WordPerfect characters to keys on a keyboard layout, this
option is especially useful for helping you determine which keys the characters
are assigned to.

To use the Map option,
1 Press Setup (Shift-FI).

.5 Select Setup from the File menu.

2 Select Keyboard Layout (5), then move the cursor to the keyboard whose
map you want to display.

The keyboard names displayed on the Setup: Keyboard Layout menu are the
keyboard files (files ending with a .WPK extension) listed in the keyboard/macro
directory (see Location of Files in Reference). If the keyboard whose map you
want to display is not listed, either you have not created it, or it is not located in
the keyboard/macro directory you specified in Location of Files. If you have not
created it, see Create under Keyboard Layout in Reference. If it is not located in
the keyboard/macro directory, see Location of Files in Reference.

3 Select Map (8).
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The Keyboard: Map menu is shown below. Notice that the name of the
keyboard is located near the top of the screen.

Keyboard: Map

Action CMMMCMMCMCCCMMCCCMCMCCCCCCCCCCCCCCCCCe

ABCDEFGH 1 JKLMNOPQRSTUVWXYZ [\] C * Command
CCMMMCMCCCCCCCCCCCCCCCCCCeeeee M = Keyboard Macro

1) >+, - . /0123456709 rB
Action 1 )*+.-./0123456769

Key ABCDEFGH I JKLMNOPQRSTUVWXYZ[\]" *
Action ABCDEFGH 1 JKLMNOPQRSTUVWXYZ[\j*_*

abcdefghi jkImnopgrstuvwnyzf1)*
Action abcdefghi jkImnopgrstuvwxyzf]}*

Key Action Description
AIt-A {ALT A

1 Key: 2 Macro; 3 Description; 4 Original; 5 Compose; N Key Name Search: 1

As you can see, the keyboard map menu shows all of the assignable or mappable
keys on your keyboard (minus the function keys and a few others). A non-
bolded letter or character on the Action row beneath the key means that letter or
character is assigned to that key. A bolded C on the Action row indicates a non-
macro feature or operation is assigned to the key, while a bolded M indicates a
macro is assigned to the key.

If you want to make assignmentsfor the function keys, you must do so with the Keyboard:
Edit option (see Keyboard Layout, Edit in Reference).

As you move the cursor from key to key on the Keyboard: Map menu, notice the
"Key,” “Action,” and “Description” headings at the bottom of the screen. “Key”
indicates the key on which the cursor is located, “Action” represents the feature
or operation assigned to the key, and “Description” is the description associated
with the action.

4 Move the cursor to the key whose assignment you want to change.

5 Select one of the options on the Keyboard: Map menu (see the option
headings under Notes below).

6 Press Exit (F7) to return to the Setup: Keyboard Layout menu.

At this point, you may select one of the options from the Setup: Keyboard
Layout menu, or you can press Exit (F7) to return to the normal editing screen.
If you wish to select the keyboard for use, move the cursor to the keyboard
name, then choose Select (1).



Notes

Cancel

Pressing Cancel (FI) in the Keyboard: Map menu displays the “Cancel
Changes?” prompt. Typing n keeps you in the Keyboard: Map menu, while
typing y cancels all changes you made since you entered the Keyboard: Map
menu and exits you to the Setup: Keyboard Layout menu. If you don’t want to
cancel the changes, press Exit (F7) instead of Cancel to exit the screen and save
the changes.

Compose

This option on the Keyboard: Map menu lets you enter a WordPerfect character
for a key. To use the option, move the cursor to the Action line under the key,
select Compose (5), type the WordPerfect character set number, a comma, the
character within the character set, then press Enter (see Compose in Reference).

Since the Keyboard: Map menu is in text mode, the number of characters
WordPerfect can display is limited by the computer, monitor, and display card.
If a character cannot be displayed, a box appears on the screen. Read the
Printing—General Information section in Reference to learn how WordPerfect
characters are printed.

Delete

If you want to delete a key assignment for a key, move to the Action line under
that key on the Keyboard: Map menu, press Delete (Del) or Backspace, then
type y (if necessary) to confirm the deletion. When you delete a key assignment,
the key is then assigned to its function on the original keyboard.

Description
This option on the Keyboard: Map menu lets you enter a description for the key.
The description is used to tell you what the key does.

To use this option, move the cursor to the Action line under the key on the
Keyboard: Map menu whose description you want to change, select Description
(3), then enter a description for the key.

Key

This option on the Keyboard: Map menu lets you assign a feature or operation
that exists on one key to the key on which the cursor is resting. To use this
option, move the cursor to the Action line under a key on the Keyboard: Map
menu, select Key (1), then press the key whose feature or operation you want to
assign.

For example, move the cursor to Alt-c, select Key (1), then press Cancel (FI) to
assign Cancel to Alt-c.

If you are replacing an existing macro, WordPerfect will display the “Replace
KEY MACRO?” message before letting you replace the macro. Type y to
confirm.
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If the key you press after selecting this option already has a function or operation
assigned to it in the current keyboard, it will execute that function. For this
reason, we suggest you use Ctrl-6 or the Original option on the Setup: Keyboard
Layout screen to make sure the original keyboard is in effect before you make
assignments with this feature (see Original under Keyboard Layout, Edit in
Reference).

Key Macro
If you create a macro for a key (see Macro below), the macro is represented as
(Key Macro #) under the Action heading on the Keyboard: Map screen.

The Key Macro command is used in macros where you press the key associated
with the key macro. For example, suppose you assign a macro to the FI key in
a keyboard layout called TESTKEY, and suppose that macro becomes

{Key Macro 1}. If you are using TESTKEY while defining a macro called
MACRO, and then press FI, (Key Macro 1} is inserted into the macro (and can
be viewed in the Macro Editor).

When you execute MACRO and it comes time for WordPerfect to interpret the
(Key Macro 1} command, it will look in the keyboard layout you are currently
in, then execute the steps associated with the key assigned to (Key Macro 1).
As long as everything is the same as when you defined the macro (the keyboard
layout, the key assigned to {Key Macro 1}, the operation that (Key Macro 1}
represents), the macro will work as expected. If any of those things have
changed by the time you execute the macro, the macro may not function as you
would like.

FOI‘ thIS reason, we suggest that you create your macros with the original
keyboard in effect. With the original keyboard in effect, it is impossible to insert
(Key Macro) commands into a macro. Therefore, as long as the macro is
created correctly, it should execute as expected no matter which keyboard layout
you are in. The only exception to this is an Alt-macro which is discussed in
Keyboard Layouts and Macros under Keyboard Layout in Reference.

Keyboard Layout: Edit

The Edit option on the Setup: Keyboard Layout menu is similar to the Map
option discussed in this section in that it lets you assign WordPerfect features
and operations to keys. It is another way to edit the same keyboard layout.

The Edit option doesn't give you the “big picture” that Map gives you. The
advantages to using the Edit option, however, are that it lets you retrieve an
existing macro to a key, save a key assignment as a macro, and assign features
and operations to function keys and other keys such as Escape, Backspace, and
the arrow keys that are not located on the Keyboard: Map menu.

More information on this option can be found in Keyboard Layout, Edit in
Reference.



Macro

This option on the Keyboard: Map menu lets you use the Key: Action screen to
create a macro for a key. To do so, move the cursor to the Action line under a
key on the Keyboard: Map menu, select Macro (2), then edit the key as
necessary. Press Exit (F7) when you are finished.

The procedure for editing in the Key: Action screen is the same as editing in the
WordPerfect Macro Editor. Before you decide to edit in the Key: Action screen,
you may want to read Macros, Macro Editor in Reference to learn about the
things you can do in the Key: Action screen.

The following are some simple operations you can perform:

To assign a function key feature to the key, press the function key for that
feature. For example, press the function key for ~Indent (F4) if you want to
assign the Undent feature to the key.

Ifyou want to assign Cancel, Exit, Help, or many of the cursor movement keys (e.g.,
arrow keys), you must press Ctrl-v before pressing the key assigned to those features.

If you want to assign a Compose character, press Compose (Ctrl-2), type the
WordPerfect character set number, a comma, the character within the character
set, then press Enter (see Compose in Reference).

If you want to use the WordPerfect macro programming language, press Macro
Commands (Ctrl-PgUp) to display the programming commands, move the cursor
to the command you want, then press Enter.

Notice that commands such as Block Append/Copy/Move and Item Up/Down/Left/Right
are located on the list of programming commands. This is how you can assign these
functions to keys on keyboards without an enhanced BIOS.

Name Search

The Key Name Search option on the Keyboard: Map menu lets you easily move
the cursor to the key you are looking for. To use this option, select Key Name
Search (n) in the Keyboard: Map menu, then press the key you are looking for.

Original

This option on the Keyboard: Map menu lets you return a key’s function to what
it was on the original keyboard layout. To use this option, move to the Action
line under a key on the Keyboard: Map menu, select Original (4), then type y (if
asked to confirm).

You will be asked to confirm ifyou are deleting a key macro.

See Also: Lesson 26; Compose; Keyboard Layout; Keyboard Layout, Edit;
Macros, Macro Editor
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WordPerfect is commonly used to produce mailing labels. This process is as
simple as providing WordPerfect with the information it needs to know about
your labels, then inserting that information in your document where you want to
begin creating mailing labels.

Once you have done so, you can type the labels individually or merge one or
more labels from a secondary file into a primary file.

Since the Labels feature is actually an option on the Paper Size/Type menu and
can be used for more than labels (e.g., program covers, side-by-side landscape
pages), it is a good idea to become familiar with the Paper Size/Type feature
(see Paper Size/Type in Reference). Also, Lesson 28: Envelopes and Labels in
the WordPerfect Workbook talks about using Merge to create mailing labels.

The steps below take you through creating paper size and type information for
labels. If you have already created this information, skip to the notes at the
bottom of the steps to see what your options are at that point.

1 Press Format (Shift-F8), then select Page (2).
Select Page from the Layout menu.

2 Select Paper Size/Type (7).

3 Select Add (2).

4 Select a paper type. We suggest you select Labels (4) to make the paper
type easily recognizable, but you have the option of selecting any of the
other types listed or creating one of your own.

5 At this point, you can select and change any of the Format: Edit Paper
Definition options. These options tell WordPerfect the size of the page you
are using, the font orientation, where the form is located in your printer and
more. These options are explained in Paper Size/Type in Reference.

Of particular importance is the size. If you are printing an entire sheet of
labels, enter the dimensions of the entire sheet. If you are using tractor-fed
labels, see Tractor-Fed Labels under Notes below.

6 Select Labels (8), then type y to move to the Format: Labels screen.

7 Change your label settings as necessary. For more information about the
options on the Format: Labels menu, see the option headings below.

8 Press Exit (F7) twice to return to the Paper Size/Type menu.

After you have created a Paper Size/Type for your labels, you can select it
immediately by choosing Select (1), then pressing Exit (F7) until you return to
the normal editing screen. You can also select it at any other time by moving
the cursor to where you want to start using labels, going to the Paper Size/Type

LABELS 319



menu (Shift-F8,2,7), highlighting the correct Paper Type, choosing Select (1),
and pressing Exit (F7).

If you are not merging information (see Merge in Reference), place the code at
the top of the page where you want it to take effect. If you don't place it at the
top of the page, it will go into effect starting with the next page.

Important: Ifyou are creating a primary file preparatory to merging name and address
information from a secondary file (see Merge in ReferenceJ, you should place the Paper
Size/Type information in Document Initial Codes (Shift-F8,3,2) (see Initial Codes in
Reference).

Also, if WordPerfect will not allow you to enter the Paper Size/Type code, try setting the
left and right (Shift-F8,1,7) and top and bottom (Shift-F8,2,5) page margins (not the label
margins) to 0" before entering the Paper Size/Type code.

Once you have selected the labels paper size and type, you can begin typing the
text for your labels if you aren’t merging information from a secondary file. If
you are merging information from a secondary file, you can begin creating your
primary file.

After a Paper Size and Type code is entered, any editing changes you make to
the information on the Paper Size/Type menu do not affect the existing code. If
you want to have your editing changes reflected in the document, you must
delete the existing code, then re-enter the paper size/type information after you
make the changes.

When you are satisfied with your label text, insert the labels into your printer
and print them as you would any other document (see Printing Labels under
Notes below).

Label Size

This option on the Format: Labels menu lets you enter the width and height of
an individual label. If your labels are 2.75" wide by 1" high, these are the
measurements you should enter.

Number of Labels
This option on the Format: Labels menu lets you enter the number of columns
and rows you have on your sheet of labels. Columns run vertically, while rows
run horizontally.

Top Left Corner

This option on the Format: Labels menu lets you enter the location of the top left
comer of the first label on the sheet of labels. The top measurement is measured
from the top edge of the page to the top edge of the first label, while the left
measurement is measured from the left edge of the page to the left edge of the
first label.

If your first label starts .5" from the top of the page and .5" from the left edge of
the page, these are the measurements you should enter for this option. If your



A COLUMN DISTANCE
' ROW DISTANCE

labels start at the top left edge of the page, 0" and 0" are the measurements you
should enter.

If you are using tractor-fed labels, the top left comer measurements should be 0",
0", and the label(s) should be positioned in the printer so that the printer will
print on the first line of the top left-most label (see Tractor-Fed Labels under
Notes below).

Distance Between Labels

This option on the Format: Labels menu lets you enter the distance between
labels on your sheet of labels. There are two measurements, one for distance
between columns and one for distance between rows.

When you measure the distance, measure the distance between two labels. The
illustration below shows you an example of a sheet of labels and where you
should measure the distance between columns and rows.

v

If there is no space between labels on the page, enter 0" and 0" for the
measurements.

Label Margins

This option on the Format: Labels menu lets you enter the left, right, top, and
bottom margins you want for each individual label. In other words, this option
does not set margins for the entire sheet of labels; it sets them for the individual
labels themselves.
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Centering Text on Labels

You can vertically center text on a label by entering a Center Page code
(Shift-F8,2,1)y) at the top of each label. If you are merging information and
want to vertically center text on every label, place the Center Page code at the
top of the primary file (not in Document Initial Codes).

Code

The labels Paper Size/Type code (which you can see in Reveal Codes (Alt-F3))
will display like other Paper Size/Type codes except that the label size will also
be displayed (e.g., [Paper Sz/Type:8.5"x 11",Labels,2"x3"]).

WordPerfect ignores any duplicate Paper Size/Type codes for labels. When
WordPerfect encounters a second Paper Size/Type code for the same label form,
the second Paper Size/Type code is ignored.

Entering Measurements
This feature, like other WordPerfect features that call for measurements, allows
you to enter fractions (see Units of Measure in Reference).

Label Information Needs to be Updated for Paper Size

If you get this message when you exit the Format: Paper Size/Type menu, it is
because you have changed the paper size for a paper type that is set to print
labels. This message means that the current label information cannot be correct
for the new paper size. You must update the label information to make it match
the paper size.

Check information such as the label size, the number of rows and columns you
have on the page, the lahel margins, and the location of the top left label. Then

make the necessary corrections.

Label Margins Increased Due to Printer’s Minimum Margin
This message means that at least one of the label margins (left, right, top, or
bottom) had to be increased due to an unprintable region for your printer.

An unprintable region is an area measured from the edge of the page in which
your printer cannot print. If one or more of your label margins is less than the
unprintable region, WordPerfect increases the margin(s). This increase takes
effect for all labels on the page.

Check your printer manual or consult your printer manufacturer to see if your
printer has an unprintable region.

Labels Macro

A macro called LABELS.WPM has been included with WordPerfect. This
macro allows you to create and insert a label Paper Size/Type code into
Document Initial Codes. Using the Labels macro can greatly simplify the
process of creating labels. If you want to use this macro, press Macro
(Alt-F10), then enter labels.



WordPerfect will search the keyboard/macro directory for the Labels macro (see
Location of Files in Reference). If the macro is elsewhere, you must enter the
full pathname (including the filename) to the macro after pressing Macro.

Important: The Labels macro is installed with the macro and keyboard files. 1fyou
chose not to install the macro and keyboardfiles when you installed WordPerfect or have
not subsequently done so, you must do so before executing the macro (see the Installation
Instructions card).

When you retrieve the Labels macro, a list of preset label definitions for laser
printers appears. Press Switch (Shift-F3) to see a list of label definitions for
tractor-fed (dot matrix) printers.

You can scroll through either list by pressing the arrow keys or Page Up (PgUp)
and Page Down (PgDn). You can also move the cursor to a particular definition
by typing the name of that definition. With the definition highlighted, press
Enter to begin building the label.

WordPerfect prompts you to specify how paper is fed into your printer. For
information on these location options, see Editing a Definition under Paper
Size/Type in Reference.

When you select an option, a message on the status line asks whether you want
to insert the label definition into Document Initial Codes. Even if you choose
not to insert the label definition into Document Initial Codes, the definition will
be added to your Format: Paper Size/Type menu.

If you have already created a labels Paper Size/Type and then run the Labels
macro, the “Error: Labels Previously Defined” message will appear. You are
then taken to the Format: Paper Size/Type menu where the specified labels paper
size is highlighted.

Labels Will Not Fit on Paper Size

If you get this error message, the information you have entered on the Format:
Labels menu or the Format: Edit Paper Definition is incorrect. WordPerfect
gives you this message because it calculates the information you have given it
and knows that the labels you defined cannot fit on the page.

Check information such as the size of the page of labels, the number of rows and
columns you have on the page, the label margins, and the location of the top left
label. Then make the necessary corrections.

Merging Labels

If you are creating several labels, it is probably best to merge the information
from a secondary file into a primary file. The secondary file should contain your
mailing list, while the primary file contains the merge codes that represent the
information you want to extract from the secondary file (see Merge in Reference
and Lesson 28: Envelopes and Labels in the WordPerfect Workbook).
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An example of a primary file that would extract the first three fields of each
record in your secondary file is shown below.

(FIELD}I"
(FIELD)2"
{FIELD}3"

An example of two records in a secondary file is shown below.

Robin PiercefEND FIELD)

Interchange, Inc.

544 Westminster Circle NW{END FIELD}
Atlanta, GA 30327{END FIELD)

{END RECORD}

Jayna Wilder-Smith(END FIELD)

6611 Market St.(END FIELD}

San Francisco, CA 94102{END FIELD}
(END RECORD)

Field: 1 Doc 1 Pg 1 Ln 1" Pos 1*

If you are merging records, go to Document Initial Codes (Shift-F8,3,2), select
Paper Size/Type (Shift-F8,2,7), highlight the labels paper size/type, choose Select
(1), then press Exit (F7) to insert the labels Paper Size/Type code into the
Document Initial Codes of the primary file. If you do not and are printing
multiple labels, the labels may not be printed where you expect them to be.

Physical Page vs. Logical Page

WordPerfect considers the entire sheet of labels as a physical page and each
individual label as a logical page. It gets the size information for the physical
page under Paper Size on the Format: Edit Paper Definition menu and the size
information for logical page on the Format: Labels menu. It numbers the logical



A LABEL ONE
A LABEL TWO
A LABEL FOUR
A LABEL SEVEN
A LABEL NINE

pages from left to right, then top to bottom from the top left label to the bottom
right label. For example,
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After you have selected the label paper size/type, the “Pg” heading on the status
line in the normal editing screen reflects the logical page the cursor is on. So,
even though you may be working on one sheet (physical page) of labels, you
will notice that the sheet has several logical pages. This is very useful in letting
you know which label the cursor is resting on and helping you move from one
label to another. You can see the entire physical page of labels in View
Document (Shift-F7,6).

Page Down (PgDn) will move you to the next label. Page Up (PgUp) will move
you to the previous label. Go To (Ctrl-Home), then a page number will send
you to a specific label.

Since labels are considered as separate “pages,” formatting features that affect
subsequent pages, such as Page Numbering, Headers, and Footers, will be in
effect for each label. Thus, if you have a header for every page defined at the
top of the document, each label will have the header.

Also, if you print a single page, only one label (rather than the entire sheet) will
be printed. Likewise, if you print selected pages, only those labels will be
printed.

Printing Labels

There are several measurements you need to enter when you create labels, and a
mistake on one of these measurements will give WordPerfect incorrect
information. We suggest you look at your final document in View Document
(Shift-F7,6) to make sure everything is correct.
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Ifyou think all of your measurements are set correctly, yet you only see one label on an
entire sheet of labels in the View Document screen, make sure that your Paper Size/Type
code is in Document Initial Codes (see the note marked as “Important™ under the steps
of this reference section).

Since sheets of labels are more expensive than regular sheets of paper, you may
want to print some sample labels on a sheet of paper to make sure that
everything is positioned properly. If you are merging a very large number of
labels, just merge a few at first to make sure. This may save you the frustration
of wasting several sheets of labels because a measurement was entered
improperly.

If labels do not print the way you like or expect, re-check your measurements.

Ifyou receive a beep from your computer or a message from your printer when you try to
print labels, check the Control Printer menu (Shift-F7,4). If it instructs you to insert your
label sheets, do so, then press g to continue. Ifyou want to avoid this prompt, try setting
the Prompt to Load setting for the labels Paper Size/Type to No (see Paper Size/Type in
Reference/.

If you are printing selected logical pages of labels, the labels will be printed on a
single physical page of labels until that page is full. For example, if you are
printing labels 1, 15, 40, and 75 on a 30-label sheet of labels, all four of the
labels will be printed on the same sheet.

Program Covers
You can also use the Labels feature to create program covers or print two pages
of information side-by-side as shown below.



A TRACTOR-FED LABELS

To do so, specify the physical page as a landscape form, then treat each half of
the page as a “label” and enter the appropriate measurements. For example, you
may have an 11" x 8.5" page with two 5.5" x 8.5" "labels.”

Tractor-Fed Labels

Tractor-fed labels are labels on a sheet that has holes along its side to guide the
labels through the printer. Tractor-fed labels are commonly used on dot-matrix
and daisy-wheel printers.

Probably the most time-consuming part of printing tractor-fed labels is
positioning the labels in the printer so that the first line of text will print on the

first line of a label. To position the labels, set your label margins (not your page
margins; see Label Margins above) to 0", print a test label and calculate how far
and in which direction you need to move the labels in the printer to have the
first character in the label print at the top left corner of the row of labels.

Once the labels are positioned correctly, they should print correctly as long as
you have entered the paper size/type and label information correctly.

When you enter label information for tractor-fed labels, we suggest you treat
each row of labels as a “sheet” of labels.

When you treat each row of labels as a sheet of labels, the number of rows is
always 1, and the distance between rows is always 0. However, the paper size
should account for the distance between labels.

For example, if you have two-across labels that are 4" wide with a .5" space
between columns, the paper width is 8.5" (4" + .5" + 4"). If you have labels
that are 15/16" long with 1/16" between rows of labels, your paper height is 1"
(15/16" + 1/16").
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This does not change the information you enter for the label size or the distance
between columns (if you have multiple columns). Those measurements should
accurately reflect the actual label size. Using the example in the paragraph
above, your labels are still 4" wide and 15/16" high.

Typing Label Text

As you type label text, you can end the information for one label and move on
to the next by pressing Hard Page (Ctrl-Enter). If you want to leave a label
blank (maybe you already peeled it off and don’t want to waste the rest of the
sheet), press Hard Page (Ctrl-Enter) without entering text for the label.

If you exceed the number of lines WordPerfect can fit on a label, you can try
changing the base font to a smaller font or change the top and bottom label
margins (see Font in Reference and Label Margins above). Once you exceed the
number of lines, WordPerfect inserts a soft page break (represented by a row of
dashes), and the remaining text is moved to the next label.

Similarly, you can end a line of text by pressing Enter. Once you exceed the
amount of text WordPerfect can fit on one line of a label, WordPerfect wraps the
text to the next line.

Use View Document (Shift-F7,6) to see how labels will appear when they are
printed.

See Also: Lesson 28; Merge; Paper Size/Type

Versions of WordPerfect are available in several languages. When you write or
edit in any of these languages, you can have WordPerfect help you use them
correctly.

You can change the language being used as a reference for your document at any
time by entering a language code.

1 Press Format (Shift-F8), then select Other (4).
Select Otherfrom the Layout menu.

2 Select Language (4), then enter letters which represent the language you
want to use (see Language Codes below).

3 Press Exit (F7) to return to your document.

If you want the language code to affect all text in a document (including
substructures such as footnotes), place the code in Document; Initial Codes.
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Keyboard Layout

If a language which you often use contains extended characters, you can create a

keyboard for that language by mapping those special characters to the keys of

your choice (see Keyboard Layout in Reference).

Language Codes

The following list details the languages in which WordPerfect is available.

Language

Afrikaans

Catalan

Croatian
Czechoslovakian
Danish

Dutch
English—Australia

English—United Kingdom

English—United States
Finnish
French—Canada
French—France
Galician
German—Germany
German—Switzerland
Greek

Hungarian

Icelandic

Italian

Norwegian
Portuguese—Brazil
Portuguese—Portugal
Russian

Slovak

Spanish

Swedish

Turkish

Ukranian

Language Code

AF
CA
HR
(074
DK
NL
0z
UK
us
SuU
CF
FR
GA
DE
SD
GR
MA
IS
IT
NO
BR
PO
RU
SL
ES
SV
TK
YK

You can also display the most current list of language codes on-screen by
pressing Help (F3) while the cursor is on the Language entry in the Format:

Other menu in step 2 above.

When you select a reference language using steps 1 through 3 above,
WordPerfect inserts a language code [Lang:xx| into your document, where xx

represents the two-letter code denoting that language (e.g., CA for Catalan, DK

for Danish).

At any point following the code, WordPerfect then uses that language as a
reference for the Sort and Date features. When you sort the document,

LANGUAGE

329



330

JAGt

WordPerfect uses the guidelines of that language’s alphabet, and when you insert
a date, WordPerfect inserts the date in the way dates are written in that language
(e.g., 12 decembre 1990 for French).

Inserting a language code does not change the language in which WordPerfect
menus are being displayed.

Also, inserting a language code within the text of a document does not change
the way the “(continued)” message is displayed in footnotes. If you want the
“(continued)” message printed in a different language, you need to enter the
language code for that language in the Initial Codes for that document
(Shift-F8,3,2) (see Initial Codes in Reference). You must also set the Print
Continued Message entry in Footnote Options to Yes (Ctrl-F7,1,4,8) (see
Footnote and Endnote. Options in Reference). This affects only how the
“(continued)” message is printed and not how it is displayed in the normal
editing screen. You can view the change on-screen by using View Document
(Shift-F7,6) to preview the printed document.

In order to know how to format dates and write the “(continued)” message in a
given language, WordPerfect refers to the WP.LRS file. When you install
WordPerfect, a WP.LRS file is stored in the same directory where the WP.EXE
file is found. If you want to change the information concerning a language, you
can do so by editing the WP.LRS file (see Language Resource File in
Reference).

While each copy of WordPerfect normally comes with only one copy of the
Speller, Thesaurus, and Hyphenation dictionaries, you can buy additional copies
in many of these languages. For information on purchasing dictionaries, you can
call WordPerfect Inform ation Services at (801) 225-5000. This number iS nOt

toll-free.

For WordPerfect to find and use a Speller, Thesaurus, or Hyphenation dictionary,
that dictionary either needs to be stored in the same directory where the
WP.EXE file is found, or the path to the directory where the dictionary is stored
needs to be listed on the Location of Files entry in Setup (Shift-FI,6,3).

If a dictionary is correctly installed, then at any point following the language
code, WordPerfect uses that language’s Speller for spell-checking, its Thesaurus
for displaying synonyms and antonyms, and its Speller, hyphenation dictionary,
or hyphenation guidelines as a reference for hyphenation.

When WordPerfect cannot find a dictionary for a certain language, it displays an
error message, “WP{WPJxx.LEX Not Found” where xr is the language code for
that language.

See Also: Language Resource File
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Notes

When you install WordPerfect, a WP.LRS file is stored in the same directory
where the WP.EXE file is found. The WP.LRS file is the WordPerfect language
resource file. WordPerfect refers to it when you use the date feature, print the
“(continued)” message in footnotes, print the Document Summary menu, and
display the date and time for each file in List Files. You can change the
language information by editing the WP.LRS file.

For example, you may want to use different abbreviations for the months and
days than those contained in the WP.LRS file. You can modify any of the
information in the WP.LRS file to suit your specific language needs, or you can
change the entries being used at all times for the language in which you
purchased WordPerfect (see Package Language below).

The WP.LRS file is a WordPerfect 5.0 secondary merge file. It is also saved in
a format that can be used in the Notebook program which is a part of the
WordPerfect Library and WordPerfect Office packages.

You can edit the WP.LRS file in the normal editing screen just as you would
edit any secondary merge file.

1 Press Retrieve (Shift-FIO), then enter wp.lIrs. If the file is not found in your
default directory, you need to enter the full pathname (e.g.,
C:\WP51\WP.LRS).

The WP.LRS file is retrieved and displayed on the normal editing screen.

2 Make any changes you want (see Editing the Language Resource File
below).

Press Exit (F7), then type y to indicate that you want to save the new file.

4 Press Enter and type y to replace the old WP.LRS, then type n to remain in
WordPerfect and return to the normal editing screen.

Certain changes made to the WP.LRSfile do not take effect until you exit WordPerfect
and then enter again.

Editing the Language Resource File
When a WP.LRS file is retrieved into WordPerfect, the first thing that appears
on-screen is the Notebook header which formats the file so that it can be
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retrieved into the Notebook in the WordPerfect Library or WordPerfect Office
packages.

01 FO1 1,1

.1.3,
02 FO2 1,5,1,37,
03 FO3 2,1,13,26,
04 F04 2.30,13,35

05 FO5 15,1,21,26,
06 Fo6 15,30,21,35,
o7 Fo7 1,39,1,57,

08 FO3 1.59,1,77
09 F09 2,39,2,77
10 F10 3,39,3,77
11 FIl 4,39,4,77
12 F12 5,39,5,77,
13 F13 6,39,6,77
14 F14 7,39,7,77
15 FI5 8,39.8.77.
16 F16 9,39,9.77

17 F17 10,39,10, 77,
18 FI8 11,39,11,77,
19 F19 12.39,12,77,
20 F20 13,39,13,77,
21 F21 15,39,15,39,
22 F22 15,42,15,45,
23 F23 15,55.15,56,

C:\WP51\WP.LRS Doc 1 Pg 1 Ln 1" Pos )"

When editing a WP.LRS file in WordPerfect, you need to be careful not to
change or alter this header. Instead, you want to quickly move to the records
which contain the language information. You can do this using eSearch (F2).

A secondary merge file is made up of records which are divided into fields. The
merge codes in the WP.LRS secondary merge file are in WordPerfect 5.0 and
WordPerfect Office 2.0 Notebook format. In this format, each record ends with
a A (Ctrl-e) code and the fields in each record end with a AR (Ctrl-r) code.

You can move from record to record by searching for the AE codes, or from
field to field by searching for the AR codes.

You can convert the merge codes in the WP.LRS file into WordPerfect 5.1
merge code format (see Previous Versions under Merge in Reference). However,
if you do so, you can no longer use the WP.LRS file with WordPerfect 5.0 or
WordPerfect Office 2.0 Notebook.



A END OF HEADER
A FIRST LANGUAGE CODE

A FIELDS FOR THAT
LANGUAGE

A US LANGUAGE CODE

A DATE FORMAT
A MONTHS OF THE YEAR

A MONTHS, ABBREVIATED

Each record in the WP.LRS secondary merge hie begins with a held containing

the language code for the language referenced by that field.

pm°R
Janeiro
fevereiro

sunha
julho
agosto
setembro
outubro
navembro
dezembro*R

C:\WP51\WP.LRS Doc 1 Pg 3 Ln 3.83" Pos 0.5”

You can move to the record for a specific language by searching for the field
which contains that language code. For a list of the language codes, see
Language Codes under Language in Reference.

For example, you can press #Search (F2), type US and press Enter to insert
US[HRt] as the search string, then press #Search to begin the search.

The cursor then moves to the record for the English—United States language.

p» »
January
February
March
April

May

Jun*

July
August
September
October
November
December ‘R

Mar ~

Jun
C:\WP51\WP.LRS Doc 1 pg 41 Ln 4.67" POS 0.5"

Each field in the record is separated by a AR code.

While you need to be careful not to change the number of fields within the
record or the number of lines within each field, you can edit the information
contained within each field.
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The first field in each record contains the language code.

Fields 2 through 6 apply to the Date feature. They determine the information
that is inserted concerning a date whenever the language code for that language
appears in your document.

Field 2 contains the information which controls the way a date is written when
you insert Date Text (Shift-F5,I) or Date Code (Shift-F5,2). The first line of
field 2 contains the format in which the date is written (see Date Format under
Date in Reference). The second line of field 2 determines the way a.m. is
written when it follows a time. The default is a.m. The third line determines
the way p.m. is written. The default is p.m.

Field 3 contains the complete names of the months of the year. Each name is on
a separate line so that the different names are separated by Hard Return codes
[HRt]. You can display these Hard Return codes on-screen in Reveal Codes
(AIt-F3).

Field 4 contains the abbreviated names of the months of the year, separated by
Hard Return codes [HRt].

Field 5 contains the complete names of the days of the week, separated by Hard
Return codes [HRt],

Field 6 contains the abbreviated names of the days of the week, separated by
Hard Return codes [HRt].

Fields 7 and 8 contain the footnote “(continued)” messages. When you insert the
language code for a language into the Initial Codes of the document, these fields
determine the way the continued messages appear in the footnotes for that
document.

As explained above, you can move to the record for any language in the
WP.LRS file by searching for the field which contains that language code. You
can then edit any of the items in the fields in that record to suit your current
needs.

For fields 1 through 8, any changes you make to the fields for a certain language
will determine how those items appear when WordPerfect inserts them into your
document after you have placed the language code in your document (see
Language in Reference).

Package Language
The package language is the language which your version of WordPerfect comes
in.

For example, if you bought an English version of WordPerfect for the United
States, your package language is English—United States and your package
language code is US. If you bought an English version of WordPerfect for
England or Canada, your package language is English—United Kingdom and
your package language code is UK.



A DOCUMENT SUMMARY
MENU ITEMS

Your package language determines which record in the WP.LRS file that your
version of WordPerfect uses to obtain the default settings when you use the date
feature, print the “(continued)” message in footnotes, print the Document
Summary menu, and display the date and time for each file in List Files.

For example, if your package language is English—United States, WordPerfect
searches for the US Language code and the US record in WP.LRS to determine
the default entries for these items. If your package language is English—United
Kingdom, WordPerfect searches for the UK Language code and the UK record
to determine the default entries.

Consequently, if you want to change your default settings, you need to edit the
record for your package language. You can even change the fields in this record
to another language if you want that language to be used as the default.

System Namei R
System Filetype: R
Document Name:*R
Document Type:“R
Creation DateUR

> Revision Date:-R

Subject: "R
Account: R
Keywords:*R
Author:“R

Typist:*R
Abstract:~R
2°R

12°R

p*P

LR
Figure"R
Table"R

E.
C:\WP51\WP.LRS Doc 1 Pg 42 Ln 3* POS 0.4"

Fields 9 through 20 contain the prompts that appear on the different entries in
the Document Summary menu. These entries do not change the way the menu
appears on the screen. They appear only when you print the document summary.
You can do this either while in the Document Summary menu (see Document
Summary in Reference) or while viewing a document summary using Look in
List Files (see List Files in Reference).

Please note that the Document Summary fields will only print in a given
language when the language code for that language is placed in Setup Initial
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Codes (Shift-FI,4,5). Placing the language code in the document or in
Document Initial Codes is not sufficient.

System Name: 'R
System Filetype: ‘R
Document Name:*R
Document Type: ‘R
Creation Date: ‘R
Revision Date:"R
Subject: R
Account:R
Keywords:"R
Author:"R

Typist: R
Abstract:"R

-"R
12'P

pH

-°R
Figure'R
TableR

C:\WP51\WP.LRS Doc 1 Pg 42 Ln 2.67" Pos 0.36"

Fields 21 through 25 in the records in the WP.LRS file are referenced only for
the package language for your version of WordPerfect. If you want to change
the entries for these fields, you need to edit the record for your package
language.

Fields 21 through 25 contain information that determines how the file attributes
are displayed on the List Files screen. These file attributes include the date and
time for each file and the thousands separator which can appear in the file size

for each file (see List Files in Reference).

Field 21 contains a number which determines the order in which the items in the
date are displayed for each file on the List Files screen, as detailed in the
following list.

Number Order of Display

1 Day Month Year
2 Month Day Year
3 Year Month Day

Field 22 contains the two characters being used to separate each of these items in
the date. These two characters are separated by a Hard Return code [HRt].

Field 23 contains either the number 12 or the number 24. This determines
whether the time on the List Files screen is displayed according to a 12 or 24
hour clock.

Field 24 contains the character used to separate hours from minutes, followed by
the letters used to indicate a.m. and p.m. when a 12 hour clock is used. Each of
these entries is separated by a Hard Return code [HRt],

Field 25 contains the thousands separator that is used when a file size is
displayed for each file on the list files screen.



Line Draw

Fields 26 and 27 contain information to be used with other operating systems
(e.g., UNIX and VAX). They are not applicable to the IBM PC versions of
WordPerfect.

Fields 28-31 contain symbols that are used when you import spreadsheets. For
more information, see Currency Symbols under Spreadsheet, Import and Link in
Reference.

Field 28 contains the character used to separate decimal numbers from whole
numbers. Field 29 contains the currency symbol. Fields 30 and 31 contain the
credit and debit symbols.

Please note that the spreadsheet import fields will only print in a given language
when the language code for that language is placed in Document Initial Codes
(Shift-F8,3,2) or Setup Initial Codes (Shift-FI,4,5). Merely placing the language
code in the document is not sufficient.

See Also: Language

With the Line Draw feature, you can draw boxes, graphs, borders, and other
illustrations using special line draw characters. Using the arrow keys, you can
draw on a clear screen or around and over existing text. WordPerfect inserts
comers automatically as you draw, and fills blank areas with spaces and/or hard
returns. Any codes in front of the cursor are pushed forward.

You need to select a mono-spaced font that has a line draw automatic font
change or a line draw font in order to print correctly. Most proportionally-
spaced fonts cannot be used for Line Draw.

1 Press Screen (Ctrl-F3) to display the Screen menu, then select Line Draw (2)
to display the Line Draw menu.

CB Select Line Draw from the Tools menu.

2 Type 1 and move the cursor with the arrow keys to begin drawing with a
single line.

or
Type 2 and move the cursor with the arrow keys to draw with a double line.
To choose one of the remaining Line Draw options, refer to Notes below.

3 Press exit (F7) when you finish drawing to return to normal editing.
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Arrows and Lines

The arrows that appear on the screen as you draw are used to represent two
things. First, they represent a line that does not connect to another line. They
also represent half-space lines, which means if printed or seen in the View
Document screen, these arrows will appear as a line exactly one half-space long.

It is possible to erase these arrows and remove the half-lines (see Erase below).
If you want, you can also extend the half-line into a full-space line simply by
pressing the End key. These arrows will not show on a printed document at any
time.

When you have one space representing a single line directly adjacent to a space
representing a double line, WordPerfect inserts a character (| ) to represent the
intersection of the two lines. This character will not show on your printed
document. To preview how the intersection will look when printed, look in the
View Document screen.

Broken Lines

If you have broken lines in Line Draw, there are three things you should check.
First, make sure Justification is set to Left. Second, make sure you are using a
fixed pitch font. Third, make sure you have a hard return at the end of every
line.

Character Options

The third option on the Line Draw menu lets you draw with an optional
character. The third character is preset as an asterisk, but you can change that
character with the Change option.

For example, if you select Change (4) from the Line Draw menu, you can select
one of the menu characters by typing the corresponding number. You can, if
you want, select Other (9) and enter the character of your choice. Once you do
this, the chosen character will then appear on the menu, and you can select it by
typing 3. You can use Compose to create any of the characters in the
WordPerfect character sets (see Compose in Reference).

Dot-Matrix Lines

If you have a dot-matrix printer, vertical lines can sometimes appear on the
printed page as broken or separated lines. This is because the initial setting for
Line Height is Automatic, and in certain fonts the lines aren’t tall enough at that
setting to touch the lines above them. If you have this problem, set your Line
Height to .125" (8 lines per inch) (see Line Height in Reference).

Erase

When you want to delete a line, select Erase (5) from the Line Draw menu. As
you move the cursor, lines are erased from the screen. Spaces and hard returns

may be left or added by WordPerfect to keep the unerased part of the illustration
intact.



Line Format

Graphics Lines and Tables

Lines and boxes can also be created by using Graphics Lines and Tables. It
would be a good idea to experiment with these features to find out which method
would best suit your needs (see Graphics Lines and Table, Create in Reference).

Justification

Using Full Justification with Line Draw can create problems with the borders of
any illustration you might create. While using Line Draw, use Left Justification
only (see Justification in Reference).

Move

When you want to move through lines or illustrations without disturbing any
characters, select Move (6) from the Line Draw menu. As you move the cursor,
WordPerfect may add spaces and hard returns to allow the cursor to move freely.

Repeat

You can use the Escape key to repeat a line of a specific length. For example, if
you press Escape (Esc), type 54, and then press Right Arrow (-»), you will
draw a horizontal line 54 characters long. The line is drawn in the direction of
the arrow key that you press. Since WordPerfect will not draw lines past your
right or left margin, it presents no problem to enter an Escape number that is
larger than necessary.

Another way to repeat the value of your line is to use the Home key. For
example, if you were to press Home and then Right Arrow your line would
extend to the right margin of your screen. The exception to this is when you
have a previously drawn line acting as a border, in which case your new line
would extend only as far as the border line. If you would like to move through
the border line to the right margin, press Home,Home,Right Arrow
(Home,Home,->).

Text in a Line Draw Box

The area inside a Line Draw box is filled with spaces and hard returns. If you
would like to keep your structure intact while including text, you must use
Typeover (see Typeover in Reference).

See Also: Graphics Lines; Table, Create

The Line Format options determine the way text is formatted horizontally on a
line, between the left and right margins.

WordPerfect not only wraps the text at the end of each line, but it will also
handle hyphenation, justification, and line numbering.
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To change a line format setting,
1 Move the cursor to where you want the setting changed.

2 Press Format (Shift-F8), select Line (), then select an option and make the
necessary adjustments (see the options described in Notes below).

CB Select Line from the Layout menu.

3 Press Exit (F7) to return to your document.

Codes

Changing any of the Line Format options inserts a code into your text which
changes that setting from that point forward in your document. However, if the
code is not placed at the beginning of a line, it doesn’t take effect until the next
line.

Hyphenation

The Hyphenation options let you determine whether you want WordPerfect to
hyphenate the words that fall at the end of a line, as well as the region (“zone”)
in which a word must be located if it is to be hyphenated (see Hyphenation and
Hyphenation Zone in Reference).

Initial Codes

If you want different line format settings than those that come with WordPerfect,
you can enter your own settings using Initial Codes in Setup (Shift-FI,4,5) (see
Initial Codes in Reference). They will then be in place each time you create a
document.

Justification

WordPerfect lets you determine whether you want text centered, aligned at the
left margin, at the right margin, or at both the left and right margins (i.e., full
justification). Full justification is the default setting (see Justification in
Reference).

Line Height

WordPerfect uses the Line Height option to calculate the space allotted to each
line of text. This determines the number of lines on a page. You can set your
own line height or have WordPerfect calculate it for you (see Line Height in
Reference).

Line Numbering

Line Numbering lets you have WordPerfect number the lines in your text and
print a number for each line at a specified position (see Line Numbering in
Reference).



Line Height

Line Spacing

Line Spacing lets you select single spacing, double spacing, etc. This determines
how many lines of space will be given to each Soft Return code [SRt] and Hard
Return code [HRt] in your document (see Line Spacing in Reference).

Margins
This option lets you set new left and right margins for your document (see
Margins, Left and Right in Reference).

Tabs

Initially, standard tabs are set at every one-half inch. You can use this option to
change the tab settings and to select several different types of tabs (see Tab Set
in Reference).

Widow/Orphan Protection

A widow is the last line of a paragraph appearing alone at the top of a page. An
orphan is the first line of a paragraph appearing alone at the bottom of a page.

If this option is set to Yes, WordPerfect does not allow widows or orphans in
your text (see Widow/Orphan in Reference).

See Also: Hyphenation; Hyphenation Zone; Justification; Line Height; Line
Numbering; Line Spacing; Tab Set; Widow/Orphan

Line Height lets you enter an exact amount of space to be used for each line on
a page. You can adjust the line height to create documents that need to meet
exact publishing specifications.

Normally, WordPerfect assigns a line height measurement to each different font
or attribute you use. WordPerfect calculates line height to be the height of a
font plus any additional leading which WordPerfect automatically includes with
that font (see Leading Adjustment below).

When you are using single spacing and WordPerfect calculates the line height for
you, you can usually measure line height from the baseline of one line to the
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baseline of the next. The baseline is the line on which the characters in a line
are placed. Each letter sits immediately on the baseline. For letters with
descenders (i.e., g, j, p, and y) the descenders drop below the baseline.

N BASELINE

N BaskLne .
L LINE HEIGHT baseline to the next. L*

Line Height is measured from oneV

Normally, the line height entry on the Format: Line menu is set to Automatic.
This means that as you change fonts and attributes, WordPerfect automatically
adjusts the line height to match the space required for the largest font on a line.

When only a few of the letters on a line are in a large font, you may not want
your lines of text to be spaced according to the largest font on a line. You can
then assign a line height measurement of your own.

A fixed line height measurement fixes the value of each Line Return code in
your document (see Return, Soft and Hard in Reference). This causes the lines
in your document to be of equal height, regardless of the font.

To set a fixed line height,

1 Press Format (Shift-F8), then select Line (1).
CB Select Line from the Layout menu.

2 Select Line Height (4), then select Fixed (2).

3 Enter a line height measurement (e.g.. 1/5").
4 Press Exit (F7) to return to the normal editing screen.

Notes Baseline Placement for Typesetters
One WordPerfect option requires you to set a fixed line height using steps 1
through 4 at the beginning of this section. When you set the Baseline Placement
for Typesetters entry on the Format: Printer Functions menu to Yes, you must
also set a fixed line height.

This places the baseline for the first line of text on the top margin of your page,
keeping it constant. It is like placing a grid over your page, where all the
measurements on the page are measured from the top margin and every line
height has a constant value (see Printer Functions in Reference).

Codes

Changing the line height inserts a Line Height code [Ln Height:#] into your
document, where # is the current line height. This code can be seen in Reveal
Codes (Alt-F3). Adjustment takes effect from the line containing the code and
continues until another Line Height code is encountered.

You can delete the line height setting by deleting the code.
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You can also return the line height setting back to Automatic by pressing
Format (Shift-F8), selecting Line (1), selecting Line Height (4), selecting Auto
(1), then pressing EXit (F7) to return to your document. This inserts a Line
Height code [Ln Height:Auto] so that WordPerfect will resume adjusting the line
height automatically.

Exceptions
If your printer can only print 6 lines per inch, adjusting the line height will not
have any effect on printed text.

Initial Codes

If you want a certain line height to be in place each time you create a document,
you can enter it in Initial Codes in Setup (Shift-FI,4,5) (see Initial Codes in
Reference).

Leading Adjustment

Leading is the extra space which is added to the height of the fonts you use in
order to place white space between the lines in your text. The term leading
refers to the long strips of lead that typesetters once placed between lines of text
when they prepared a page for printing.

The height for a font is not merely the height of the largest characters in a line.
It also includes any leading which is built into that font.

The fonts you use can be classed in two different types: mono-spaced fonts, and
proportionally-spaced fonts. For a definition of these font types, and also of font
sizes (points), see the Glossary.

For mono-spaced fonts, the extra leading is built into the font size by the
manufacturer WordPerfect does not add any additional leading when it
calculates the line height. For example, if the font size for a mono-spaced font

is 10 points, then the line height is 10 points. With single spacing, that makes
the distance from baseline to baseline 10 points (see Spacing below).

For proportionally-spaced fonts, WordPerfect always adds an extra two points of
leading to the height of a font, in addition to any leading built into the font size
by the manufacturer. For example, if the font size of a proportionally-spaced
font is 10 points, then WordPerfect adds 2 points, making the actual line height
12 points. With single spacing, that makes the distance from baseline to baseline
12 points (see Spacing below).

The default line height which WordPerfect calculates for you always includes the
leading value which WordPerfect adds. This is the line height WordPerfect
displays in the Line Height entry on the Format: Line menu. For example, a 12
point mono-spaced font has a line height of 12 points. A 12 point
proportionally-spaced font has a line height of 14 points (i.e., 12 points plus 2
points of leading).

WordPerfect also provides you with an option that lets you add or subtract
leading values of your own. You can add or subtract leading from line heights
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by using the Leading Adjustment option on the Format: Printer Functions menu
(Shift-F8,4,6,6) (see Printer Functions in Reference). This changes the distance
from the baseline of one line of text to the baseline of the next line of text. You
can also change the distance from baseline to baseline by changing the current
line spacing (see Spacing below).

However, changing the Leading Adjustment or changing the line spacing does
not change the line height which WordPerfect assigns to a line of text.
Consequently, any leading value you have entered in the Leading Adjustment
option on the Format: Printer Functions menu is not reflected on the Line Height
entry on the Format: Line menu.

Spacing

With single spacing, the distance from baseline to baseline is one line height.
This is the default setting in WordPerfect. You can change the line spacing at
any time by entering a different number in the Line Spacing entry on the Format:
Line menu (Shift-F8,1,6). The number you enter is multiplied by the current line
height, changing the distance from the baseline of one line of text to the baseline
of the next line of text (see Line Spacing in Reference).

However, keep in mind that changing the spacing does not change the distance
which WordPerfect calculates as a line height.

Total Lines
WordPerfect uses the line height, page length, and top and bottom margins to
calculate the total number of lines on a page.

See Also: Line Format; Line Spacing; Printer Functions

You can have WordPerfect number the lines in a document and print the number
of each line at a specified position on the page. The actual numbers appear only
when the document is printed or when you preview the document to be printed
using View Document (Shift-F7,6).

To turn on Line Numbering,

1 Move the cursor to the place in your document where you want line
numbering to begin.

2 Press Format (Shift-F8), then select Line (1).
o3 Select Line from the Layout menu.

3 Select Line Numbering (5), then type y to display the Format: Line
Numbering menu.



Notes

4 Select and change any option you want (see Notes below).

5 Press Exit (F7) to return to your document.

Codes

You can start and stop numbering anywhere in a document. When you turn on
Line Numbering using the above steps, you place a Line Numbering On code
[Ln NurmOn] in your document. If the code is not at the beginning of the line,
line numbering starts on the next line. Lines will be numbered until you turn off
Line Numbering again. You can do so by pressing Format (Shift-F8), selecting
Line (1), selecting Line Numbering (5), then typing n.

Line numbers are printed in the base font that is in effect where the Line
Numbering On code is found (see Font in Reference).

Footnotes and endnotes are included in line numbering; headers and footers are
not included.

Count Blank Lines
If this option is set to No, any lines that contain only a Hard Return code [HR{]
will not be counted.

Number Every n Lines
This option lets you print the line numbers every n number of lines, where n is
the number you specify.

Position of Number from Left Edge
In this option, you can enter the distance from the left edge of the page you want
the line numbers to appear (e.g,, 1 1/8" for 1.13" inches).

Restart Number on Each Page

Selecting No for this option, gives you continued consecutive line numbering
throughout the document. If this option is set to Yes, numbers restart with each
new page either from 1 or from a starting number you have selected (see
Starting Number below).

When you preview the printed page in View Document (Shift-F7,6), numbers
always restart with every page regardless of how this option is set. Nevertheless,
if this option is set to No, the numbers will still be numbered consecutively
throughout the document when it is printed.

Starting Number
Unless you change this option and enter a number, WordPerfect will start

numbering lines from 1 If you enter a number, the lines in your document will
begin being numbered from that number.

See Also: Line Format
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Line Spacing determines the number of lines that will be inserted for each Soft
Return code [SRt] and Hard Return code [HRt] in your document. WordPerfect
single spaces your documents unless you change the line spacing.

To change the line spacing in your document,

1 Press Format (Shift-F8), then select Line (1).

LB Select Line from the Layout menu.

2 Select Line Spacing (6), then enter a number (see Spacing below).

3 Press Exit (F7) to return to your document.

Codes

Changing the line spacing inserts a Line Spacing code [Ln Spacing:#] into your
document where # represents the current line spacing. WordPerfect only changes
the line spacing after the Line Spacing code. Any text before the code uses the

previous setting.

This makes it easy to change the spacing at any point in the document. To
change the line spacing of existing text, use steps 1 through 3 above to insert a
Line Spacing code immediately before the text.

When you attempt to delete a Line Spacing code in the normal editing screen,
you are asked to confirm the deletion.

Initial Codes

If you want different line spacing settings than those that come with
WordPerfect, you can enter your own settings using Initial Codes in Setup
(Shift-FI ,4,5) (see Initial Codes in Reference). They will then be in place each
time you create a document.

Leading Adjustments
Leading is the amount of space which is added to the height of the characters in
a line of text (see Leading under Line Height in Reference).

You can change line spacing by changing the amount of leading added to the
Soft Return codes [SRt] or Hard Return codes [HRt] in your document (see
Return, Soft and Hard and Printer Functions in Reference).

Spacing

Line Spacing lets you increase the line spacing by multiplying. For example,
entering 2 for the line spacing doubles the current setting and creates double
spacing. You can also enter any fraction (e.g., 1.5", 1.33", 2 1/3", or 3 1/10") to

more accurately adjust the line spacing.
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Notes

The number you enter is multiplied by the current line height in order to create
the new line spacing (see Line Height in Reference).

See Also: Lesson 13; Line Format; Line Height; Return, Soft and Hard

Files are stored in directories (see Directories in Reference). The directory can
be the name of a disk drive (e.g., A:\, B:\) or a subdirectory on a floppy or hard
disk (e.g., C:\LETTERS). The full name (pathname) of a file includes the drive
letter, directory, and filename (e.g., B:CLIENT.I, CALETTERS\CLIENT.1).

The List Files feature lets you change the default directory (see Directories in
Reference), as well as display the names of the files in a directory. It is an
important feature for organizing and working with files.

Using List Files, you can retrieve, delete, rename, print, or copy a file. You can
also change the default directory, look into a file or directory, or display all files
that contain the same word(s).

1 Press List (F5) to display the name of the default directory at the bottom left
of your screen.

CB Select List Files from the File menu.
2 Press Enter to display the names of the files in the default directory.
or

Enter the name of another directory to display the names of the files in that
directory.

Ifyou want to see thefile list of a diskette in an external drive, you must type the drive
letter and a colon before pressing Enter. For example, if you want to see the file list of
a diskette in drive A, press List Files (F5) and enter a:.

3 Move the cursor to the name of a file, select an option from the List Files
menu at the bottom of the file list, then enter any requested information (see
the options listed under List Files Menu below).

Some options on the List Files menu do not need afile highlighted first. These options
are explained under List Files Menu below.

4 Press Exit (F7) to return to the normal editing screen.

Current and Parent Directories

At the top of the list on the List Files screen are the words “Current” and
“Parent.” The “<Dir>" on the same line indicates that these are directories. The
Current directory is the one currently being displayed. It is listed in the header
at the top of the screen. If there is more than one directory in the name, the
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parent directory is the one listed just before the current directory (e.g., in the
path CA\WPS5I\LETTER, LETTER is the current directory and WP51 is the
parent directory).

File List

The major portion of the List Files screen consists of the file list. Certain
aspects of this list (e.g., the thousands’ separator, the date display) are displayed
according to the ,LRS file. To make changes to the file list display, see
Language Resource File in Reference.

When you display the List Files screen, you have the option of displaying the
file list with “short” or “long” filenames. Use Short/Long Display (5) on the
List Files menu to choose the type of display (see Short/Long Display under List
Files Menu below). The appearance of the file list is one of the major
differences between short and long display.

Another option affecting the file list is the Sort List Files option (see Sort List
Files below for details). This option allows you to choose whether you want
your subdirectories and files sorted alphabetically (default) or in the order that
they reside on your disk.

If the Sort List Files option is set to No, subdirectories and files are displayed
according to where they reside on disk for both short display and long display.

If the Sort List Files option is set to Yes, the subdirectories are listed first in
alphabetical order, followed by an alphabetical listing of files for both short
display and long display. Sorting takes place according to the package language.
Flowever, when long display is on, only files created in WordPerfect version 5.x
(no DOS, PlanPerfect, macro files, WordPerfect program files, etc.) appear on
the screen, and the files are alphabetized by descriptive name rather than by
filename.

Long Display
When you have long display on, the information for each filename takes up
one line of the list rather than having two filenames per line (as in the short



A HEADER
A FILE LST
A MENU

display). Additionally, the header at the top of the screen increases by one
row to display several column headings.

ACCPAID .SSS 4,130 12-15-88 08:1la
Letter to President Letter CORP -LET 12,549 09-28-B9 01:30p
List of Employees. June Work EMPLIST .JUN 3,128 09-28-89 01:35p
Mailing Label Lesson Lesson LESS-24 . 19,048 09-28-89 01:32p
Math Lesson Lesson LESS-25 . 11,620 09-28-89 01:33p
MEMOFORM .NEW 6,916 01-11-B9 01:48a
PLFILES .APP 6,153 06-12-69 10:16a
September Birthday List Work SEPT-OCT.B6W 1,298 09-28-89 01:36p
SHOKTORD .NEW 2,643 12-15-68 07;38a
SIGDATES .DSL 3,500 12-15-00 07:39a

* 1 Retrieve: 2 Delete; 3 Hove/Rersame; 4 Print; 5 Short/Long Display;
6 Look; 7 Other Directory; 8 Copy; 9 Find; N Name Search: 6

This feature lets you add another level of organization to your files. For
example, you can give the same “Type” name to a group of similar files,
then use the Find option (9) on the List Files menu to display just the files
with that document type (see Find in Reference).

The Descriptive Name column lists the long document name rather than the
shorter DOS (8 characters plus 3 characters extension) filename (see
Environment Setup in Reference for an explanation of long document names).
If you have not entered a long document name, nothing is displayed in this
column.

Ifyou have a locked document in your directory. “[Locked]” is displayed in this
column rather than the long document name.

If you created an alias name for a subdirectory of the current directory (see
Directory Alias under Directories in Reference), that name is displayed in
this column. If you have not created an alias for a subdirectory, nothing is
displayed in this column.

The Type column lists the long document type you entered (if any) when
you saved the file with a long document name (see Environment Setup and
Document Summary in Reference).

The Filename column lists the DOS filename or directory name.

The Size column lists the size of the file or “<Dir>" if referring to a
directory.

The Revision Date column lists the date and time the file or directory was
most recently revised.
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Short Display

When you have short display on, the file list is displayed with two filenames
on each line. Each file or directory is identified by filename and the date
and time the file or directory was last revised. In addition, the size of the
file is displayed. An arrow at the bottom or top of the vertical line that
divides the filenames indicates more files in that directory that can be
scrolled onto the screen.

in <bir*

WORK Cl:za 8514A -VRS 4,797 09-07-89 03:04p
ADDRESS  TUT 978 09-07-8y 03:U4p ADDRESS .WKB 642 09-07-89 03;04p
ADVANCED TUT 3 09-07-89 03:04p ARROW-22.WPG 116 09-07-89 03:04p
BALLOONS WPG 2,806 09-07-89 03;04p BANNER  .TUT 631 09-07-89 03:04p
BANNER-3 WPG 648 09-07-89 03:04p BEGIN =TuT 11 09-07-89 03:04p
BICYCLE WPG 607 09-07-89 03:04p BKGRND-1.WPG 11,391 09-07-89 03:Q4p
BORDER-8 WPG 144 09-07-89 03:04p BRIEF -WKB 6,640 09-07-89 03:04p
BULB WPG 2,030 09-07-89 03:04p  BURST-1 .WPG =48 0OV-o0"-ov 03:04p
8UTTRFLY WPG 5,276 09-07-89 03:04p  CALENDAR.WPG 300 09-07-09 03;04p
CERTIF WPG 608 09-07-89 03:04p CHARACTR.DOC 42,522 09-07-89 03:04p
CHARMAF  TST 15,216 09-07-B9 03:04p CHART Wi 4,218 09-07-09 03:04p
CHKBOX-1 WPG 582 09-07-89 03:04p  CLIENTS .WKB 1,357 09-07-89 03:04p

CLOCK WPG 1,811 09-07-89 03:04p  CNTRCT-2.WPG 2,678 09-07-89 03:Q4p
COMPASS  WKB 2,924 09-07-89 03:04p CONVERT .EXE L03,043 09-21-89 08:5la
CURSOR Ccom 1,452 09-07-89 03:04p CUSTOMER . WKB 1,729 09-07-89 03:04p
DEVICE-2 WPG 657 09-07-89 03:04p DIPLOMA .WPG 2,342 09-07-89 03:04p
EGAS12 FRS 3,584 09-07-89 03:04p EGAITAL .FRS 3,584 09-07-89 03:04p
EGASMC FFS 3,584 09-07-09 03:04p EGAUND  .FRS 3,584 09-07-89 03:04p

1 Retrieve; 2 Delete; 3 Move/Rename; 4 te 5 Short/Long Display;
6 Look; 7 Other Directory; 8 Copy; 9 Find; N Name Search: 6

Filename Patterns
While entering a directory name after pressing List (F5) in step 2 above, you can

include a filename pattern to display selected files. For example, b:\*.Itr would
list all files with a .LTR extension on the R drive (see Search Patterns under

Find in Reference).

Header

The header (the bar at the very top of the List Files screen) includes the current
date, time of day, name of the directory being displayed, the size of the
document on your screen, the amount of available space on the disk (or in your
hard drive), the amount of used space on the disk (or in the current directory),
and the number of files listed. In addition, the “long"” display has several
column headings on the bottom line of the header (see Long Display above).

List Files Menu
The options on the List Files menu are described below. Before using an option,
highlight the desired file or directory by using the cursor keys (if necessary).

Copy
Use Copy (8) to copy the highlighted file to another file or directory.

When copying to another file, you can enter a new filename to create a file
or enter an existing filename, then type y to replace a file. When copying to
another directory, enter a directory name, then use the same filename or
include a new or existing filename with the directory.



When entering afilename, be sure to use the DOS filename.

If you mark files (see Marking Files below) before selecting this option, you
will be asked if you want to copy the marked files. Type y, then enter the
drive or directory where you want them copied, or type n and you can copy
just the currently highlighted file.

Delete

Select Delete (2) to delete a filename or directory. (A directory must be
empty before it can be deleted.) A prompt appears asking if you want to
delete the file or directory. Type y to delete it; type any other key if you
decide not to delete. Once deleted, a file cannot be retrieved.

If you mark files (see Marking Files below) before selecting this option, you
will be asked twice if you want to delete the files. Type y twice to delete
the marked files. If you type n with either prompt displayed, you will be
asked if you want to delete the currently highlighted file. Type y to delete
this file only or type n to return to the List Files menu.

Find
Use Find (9) to search for files in the current directory that meet certain
conditions (see Find in Reference).

Look

If you highlight a directory on the List Files screen, you can select Look (6),
then press Enter to display the names of the files in that directory on the
List Files screen. With a file highlighted, select Look to display the text or
document summary of that file in a special Look screen (see Look in
Reference).

Move/Rename

Select Move/Rename (3). then enter a new filename to move or rename the
highlighted file. If you enter the same filename, but specify a different path,
the file is moved to another directory. If you enter a new filename, the file
is renamed. If you specify a different path and enter a new filename, the file
is moved and renamed. If you enter a filename that already exists, you will
be asked if you want to replace that file. Type y to replace it or type n to
return to the List Files menu.

If you mark files (see Marking Files below) before selecting this option, you
will be asked if you want to move the marked files. Type y, then enter the
drive or directory where you want them moved, or type n and you can move
or rename the currently highlighted file.

Name Search

Besides using the cursor keys to move through the list of filenames, you can
also move the cursor to a specific file by selecting Name Search (n), then
typing the filename.

You can also use ¢Search (F2) to move the cursor to a specific file (see Search under
WordPerfect Features in List Files below).
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When you use this option, a “Name Search” message appears at the bottom
right of the screen. When you type the first letter of the filename (or
descriptive name if long display is on), the cursor moves to the first file that
begins with that letter. As you continue to add letters to the name, the
cursor moves to the first filename that matches the displayed letters.

You may only need to type part of the filename (or descriptive hame) to
move the cursor to that file. You can erase characters with Backspace.
Press Enter, Exit (F7), or an arrow key to exit Name Search and redisplay
the List Files menu.

You can also use this option to move the cursor to a subdirectory. After
typing n, type a slash (/) or backslash (\), then start typing the subdirectory
name.

Other Directory
Use Other Directory (7) to change the default directory or create a new
directory (see Directories in Reference).

Print

Use Print (4) to send a file to the printer. After selecting Print, you are asked
for the pages you want printed. You can print all of the file or selected pages,
including the document summary (see Print, Document on Disk in Reference
for details).

If you mark files (see Marking Files below) before selecting this option, you
will be asked if you want to print the marked files. Type y to print all the
marked files, then enter selected pages; the same pages in each file will be
printed. Type n to print the currently highlighted file.

When printing a document from List Files or from disk that is fast saved,
that needs to be generated, or that is formatted for a different printer,
WordPerfect attempts to reformat the document. To reformat a document,
WordPerfect must associate a printer definition (,PRS file) to the document.

WordPerfect uses a .PRS file if a printer selection exists in the setup file
(WP(WP).SET) for that .PRS file. If the .PRS file exists, but its printer
definition is not found in the setup file, WordPerfect reformats the document
using the currently-selected printer.

Retrieve

Use Retrieve (1) to retrieve a copy of the file to your screen at the cursor
position. If there is already text in the normal editing screen, a message
appears asking if you want to retrieve the file into the current document.
Type y to place the contents of the retrieved file at the cursor position in the
document on the screen. Text below the cursor is pushed down to make
room for the incoming file. (See Retrieve in Reference for details on
retrieving.)

You can select this option with a DOS text file highlighted, and the file will
automatically be converted to WordPerfect format and retrieved to the
screen. Be aware, however, that if you then save this document using the



same filename, it will replace the DOS text file and be saved as a
WordPerfect document. If you want to keep the DOS text file on disk, enter
a different filename when you save the document on the screen (see Save in
Reference).

If you select this option with a locked document highlighted, you will be
asked to enter the password (see Locked Documents in Reference).

Short/Long Display

Select Short/Long Display (5) to display a menu that lets you switch between
the short and long display of the List Files screen (see Long Display and
Short Display under File List above). If you are currently in short display,
Long Display (2) is the default option. If you are currently in long display,
Short Display (1) is the default option. After you select an option, the
current directory name is displayed in the bottom left corner of the screen.
Press Enter to display that directory, or enter another directory name.

This option can be selected with either afile or directory highlighted.

Marking Files

You can copy, delete, find, move, or print a group of files by “marking” each
file with an asterisk (*). Move the cursor to a file in the list and type an
asterisk. Once the files are marked, select a menu option and enter any
requested information.

You can “unmark” a file by moving the cursor to a marked file and typing
another asterisk. To mark (or unmark) every file on the List Files screen, press
Mark Text (Alt-F5) or Home,*. This method of unmarking files works even if
only one file is marked.

As you mark files (whether in short or long display), the asterisk (*) appears to
the left of the filename, and the Files amount in the header changes to the

number of files marked. The Used amount changes from the amount of disk or
directory space used to the total amount of bytes in the marked files.

Redisplaying List Files

If you have been displaying files or directories from your hard drive, you can
press List (F5) twice in a row to redisplay the most recently displayed List Files
screen. This is especially helpful if you changed your List Files screen the last
time it was displayed (e.g., marked files or used Find to display selected files).

This feature will not work to display the files on a diskette drive nor will it work
if you have changed the default setting for the Long Document Name feature
(Shift-FI,3,4,3). You can rewrite the currently displayed List Files screen by
pressing Screen (Ctrl-F3).

Sort List Files

Sort List Files (5) is an option on the Setup: Document Management/Summary
menu (Shift-F1,3,4,5). This option determines whether you want subdirectories and
files in List Files to display in alphabetical order or in the order that they reside on
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disk. If you set this option to Yes, List Files displays subdirectories in alphabetical
order followed by an alphabetical listing of files. If you set this option to No, List
Files displays subdirectories and files in the order they reside on the disk. This will

speed display of the file list (especially for very large directories).

When the file list in List Files is not sorted, Name Search is not allowed. Pressing
“n” for Name Search will display the "ERROR: Name Search not allowed on
unsorted list, use F2” message. Also, pressing List Files twice (F5,F5) will bring up
the previous file list, but if the sort mode has been changed (from sorted to unsorted
or vice versa), the file list will not be in the same order.

WordPerfect Features in List Files
There are a number of WordPerfect features you can use with the List Files
screen displayed. These are described as follows.

List

You can press List (F5) from anywhere in the List Files screen to display
the current directory name at the bottom left of the screen. At this point,
you can enter a different directory name or just press Enter to display the
names of the files in that directory.

Print

You can print a list of all the filenames in the current directory list by
pressing Print (Shift-F7) with the List Files screen displayed. (The current
directory is the one currently being displayed on the List Files screen.) The
long display is printed if that is currently on the screen; the short display is
printed if that is on the screen.

This list is automatically sent to the currently selected printer (see Printer,
Select in Reference).

Search

You can move the cursor forward or backward through the file list using
#Search (F2) or #Search (Shift-F2). With long display on, Search will look
through the Descriptive Name, Type, and Filename columns. With short
display on, Search will look through the filenames and subdirectory names.
You can use patterns when searching (see Search Patterns under Find in
Reference).

Text In/Out
You can use Text In/Out (Ctrl-F5) with the List Files screen displayed to
import a DOS text file into WordPerfect (see Text In/Out in Reference).

This feature only works when short display is on: no DOSfiles appear in long
display (see Long Display under File List above).

See Also: Directories; Find; Find, Conditions; Look
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A NUMBERING STYLE

Notes

In many documents you may want to include lists of figures, illustrations, tables,
maps, etc. WordPerfect can help you create up to ten lists within a document.
You also choose one of five numbering styles for each list. When a list is
generated, the entries will be listed in the order in which they appear in the
document.

Tables
Import/Export Firms -Total (23)
HALVA Sales (27)
Merchandising Results (31)
Net Profit (33)
Quarterly Results (33)
Market Share (34)
Major Distribution Centers (40)
Non-HALVA Quarterly Results (43) -
Non-HALVA Market Share (44)
Non-HALVA Major Distribution Centers (50)
Individual Sales (57)
Music Box Sales (58)
Price Differential (60)
Overhead (62)
Number of Employees (80)
Number of Branches (88)

There are three basic steps to follow when creating a list:

¢ Mark the text you want included in the list.
¢ Define the location and numbering style for the list.
¢ Generate the list.

Each step is exclusive of the others. For example, you could mark text as you
write, define the list while formatting the document, and generate the list just
before your final edit. Later, you could edit the marked text or the list
definition, and then regenerate the list.

The instructions for these three steps are divided into separate sections in
Reference. To begin, see Lists, Mark Text, then see Lists, Define, and finally see
Generate.

Graphics

If you want a list of captions from figure, table, text, equation, or user-defined
boxes, you do not have to mark text. You can simply define a list to include
one of these caption types, and WordPerfect will include the appropriate captions
when the list is generated (see Lists, Define in Reference).
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Master Documents

If your document is extremely long, you may want to use the Master Documents
feature to break it into smaller pieces. You can still generate a list which will
include any text marked in subdocuments (see Master Documents in Reference).

See Also: Generate; Lists, Define; Lists, Mark Text

Once you have marked the text you want (see Lists, Mark Text in Reference),
you need to define the location and numbering style for each list.

1 Move the cursor to the place in your document where you want the list to
appear.

2 If you want the list on a separate page, press Hard Page (Ctrl-Enter), then
move the cursor to the page where you want the list generated.

3 If you want a heading (title) for the list, type it now, then press Enter as
many times as you want to add extra spacing.

4 Press Mark Text (AU-F5), select Define (5), then select Define List (2).
CB Select Define from the Mark menu, then select List.

5 Enter the number of the list you want to define (1 through 10).
Lists 6-10 are preset to assemble captions (see Graphics below).

6 Select a numbering style for the list (see Numbering Styles below).

Repeat steps 1 through 6 for each list you want to define. Once you have
defined and marked text for the list, you are ready to generate it (see Generate in
Reference).

[Def Mark:]

When you select a numbering style, [Def Mark:List,list#:numbering style#]
(where list# and numbering style# represent the numbers you entered for the list
number and numbering style) is inserted into the Reveal Codes screen at the
cursor position. The list will be generated at this code. If you are using the
Master Documents feature, [Def Mark:] should be in the master document and
not in one of the subdocuments (see Master Documents in Reference).

Graphics

Lists 6 through 10 are pre-assigned to automatically assemble captions. For
example, you can follow the steps above and type 6 in step 5 to define list 6.
When you generate the list, all captions for figure boxes will be included in the
list automatically. You don’t have to mark any text.
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Likewise, captions of table boxes are included in list 7, captions of text boxes
are included in list 8, captions of user-defined boxes are included in list 9, and
captions of equation boxes are included in list 10 (see Graphics, Create in
Reference).

You can include other text or phrases in lists 6 through 10 by marking text for

them (see Lists, Mark Text in Reference). When you mark text for one of these
lists, the text will be included with the captions pre-assigned to the list. If you
have no captions for any one of lists 6 through 10, you can use the list just as

you would lists 1 through 5 by marking text for it and defining it.

Numbering Styles

Numbering styles refer to the way the page numbers for each list entry are
displayed. You can choose from the following five numbering styles while
defining a list:

* No page numbers

« Page numbers following the entries (separated by a space)

« Page numbers in parentheses following the entries (separated by a space)
« Flush right page numbers

* Flush right page numbers with dot leaders

These five options affect the placement of page numbers in a list. If you want to
change the actual type of number used (from Arabic to Roman, for example),
you can use the New Page Number feature (Shift-F8,2,6,1). Changing the page
number type with the New Page Number feature affects both page numbers
displayed in the document and those generated in a table, list, or index. See
Page Numbering in Reference for details.

See Also: Generate; Lists; Lists, Mark Text

If you want to create a list of captions from figure, table, text, equation, or user-
defined boxes, you do not have to mark the text of the captions. WordPerfect
will generate a list of them for you once you define the list (see Lists, Define in
Reference).

The table boxes referred to in this section are created using Graphics (AU-F9) and should
not be confused with Tables created using the Tables feature (Alt-F7).
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The first step in creating any other lists is to mark the text you want in the list.
If you want to create multiple lists, you should mentally assign each a number
before marking text. You will be asked for this list number in step 3 below.

1 Block the word or phrase you want included (Alt-F4).
2 Press Mark Text (Alt-F5) and select List (2).

03 Select Listfrom the Mark menu.

3 Enter the list number (1 through 10).

Repeat the steps above for each item you want included in the list. Once you
have marked all the entries you want, you should define the list(s) (see Lists,
Define in Reference).

Graphics

If you want a list of captions from graphic, table, text, equation, or user-defined
boxes, you do not have to mark text. You can simply define a list to include
one of these caption types, and WordPerfect will include the appropriate captions
when the list is generated (see Lists, Define in Reference).

[Mark:] and [End Mark:]

When you mark text, [Mark:List,#] (where # represents the list number you
entered for the marked item) is inserted in the Reveal Codes screen before the
text, and [End Mark:] is inserted after. Any codes included in the block of text
(Bold, Underline, Center) are included with the text when the list is generated.

If you decide you do not want a marked word or phrase included in a list, delete
[Mark:] before generating.

See Also: Generate; Lists; Lists, Define

To help you more efficiently organize all of the files you may use or create,
WordPerfect has included the Location of Files feature.

Location of Files tells WordPerfect where certain files are located. For example,
when you spell-check a document, WordPerfect looks for the dictionary file in
the thesaurus/spell/hyphenation directory. If no location is specified, the Speller
may not work.

When you install WordPerfect, the Installation Program organizes your files for
you. If you want to change the way the files are organized, you may do so with

one of several features, including Location of Files.
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Before you use Location of Files, you should have created the directory or
directories you want to use. You may do so with the DOS MD (make directory)
command (e.g., MD C:\WP51\SPELL) or the Other Directory option on the
WordPerfect List Files feature (see List Files in Reference).

You should also copy the proper files to the appropriate directory (see the
information pertaining to each option under Notes below to determine which files
should be copied to each directory).

1 Press Setup (Shift-FI) to display the Setup menu.
CH Select Setup from the File menu.
2 Select Location of Files (6).

3 Select the option of your choice (see the information pertaining to each
option under Notes below).

4 Enter the directory or full pathname for the option (again, see the
information pertaining to each option under Notes below).

5 Press Exit (F7) to exit the Setup menu.

Backup Files

Enter the directory where you want your timed backup files (WP(WP).BKI and
WP{WP).BK2) to be stored. If you are using Timed Backup, WordPerfect
creates timed backup files for you in the directory you specify. If you do not
specify a directory, the backup files are stored in the directory where WP.EXE is
located (see Backup, Timed in Reference).

Documents
Enter the name of the directory where you want your docLiments to he stored.

Once you enter a directory for this option, that directory becomes the default
directory.

If you want to save a document to or retrieve a document from this directory,
there is no need to enter a full pathname for the document. In addition, you may
wish to move (or copy) previously existing documents to the directory specified
for this option.

You can change the default directory with the List Filesfeature. Ifyou do so, documents
will be saved to the new default directory (see List Files in Reference). Also, the
documents directory overrides (takes precedence over) any default directory you may
enter in the WordPerfect Shell Program.

Of course, if you want to save a document to or retrieve a document from a
directory other than the one specified as the documents directory, you may do so
by entering a complete pathname.
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Graphic Files

Enter the directory where your graphics files are kept. These graphics files
(several of which come with WordPerfect) are used when you are retrieving a
file to a graphics box.

Once you enter a directory for this option, all subsequent graphics files you
retrieve are retrieved from that directory. Simply enter the name of the graphics
file when you are retrieving the graphics file in the Graphics feature, and the file
will be retrieved from the graphics files directory. There is no need to enter a
full pathname for the graphics file.

You may want to move (or copy) previously existing graphics files to this
directory. If you want to retrieve a graphic file from a directory other than the
one specified as the graphic files directory, however, you may do so by entering
a complete pathname.

For more information about using the Graphics feature, see Graphics, Create in
Reference.

Invalid Drive/Path Specification

If you enter a directory that has not yet been created, you will receive the
"Invalid Drive/Path Specification” error message. The cursor will be
repositioned at the beginning of the pathname, and WordPerfect will let you try
again.

The maximum path length you can enter in Location of Files is 66 characters (or less if
extended characters are used).

You can press Cancel (FI) to back out of an option and restore the previous
setting.

Keyboard/Macro Files
Enter the directory where your keyboard files (files ending in .WPK) and macro
files (files ending in .WPM) are located.

Keyboard files contain information for the various keyboard layouts you can use
with WordPerfect, while macro files contain information for WordPerfect
macros. Some keyboard and macro files come with WordPerfect, and you can
also create many more.

Once you enter a directory for this option, all subsequent keyboard and macro
files you define or execute are saved to or executed from that directory. Simply
enter the name of the keyboard or macro when you are defining a keyboard or
executing a macro and the file will be saved to or executed from the
keyboard/macro directory. There is no need to enter a full pathname for the
keyboard or macro.

You may want to move (or copy) previously existing macros to the directory
specified for this option. If you want to invoke a macro from, create a macro in,
or save a macro to a directory other than the one specified as the
keyboard/macro directory, however, you may do so by entering a complete



pathname. When you edit or execute a macro, WordPerfect will look in the
default directory in addition to the directory listed in Location of Files.

Important: You should move all previously existing keyboard files to the keyboard/macro
directory. Only keyboard files that exist in the keyboard/macro directory can be
displayed on the Setup: Keyboard Layout screen.

For more information on the Keyboard Layout and Macro features, see Keyboard
Layout and Macros in Reference.

Printer Files

Enter the directory where your printer files (files ending in .ALL and .PRS) are
kept. These files are used to help WordPerfect communicate with a specific
printer. They are created when you go through the printer selection process.

Once you enter a directory for this option, all subsequent printer files you define
are saved in that directory. You may want to move (or copy) previously existing
printer files into the printer files directory.

All printers that you have selected are listed on the Print: Select Printer List, but
only the printer files in the printer files directory are shown when you select List
Printer (PRS) Files (Shift-F7,s,2,4).

If you want to display printer files that exist in another directory, you should use
the Other Disk option (Shift-F7,s,2,2). (See Printer, Select in Reference.)

For more information on printer files, see Printer, Select in Reference.

Unless you enter a directory for downloadable fonts and printer command files
on the Select Printer: Edit menu, WordPerfect searches for downloadable fonts
and printer command files in the Printer Files menu (see Printer, Edit in
Reference).

Spreadsheet Files

Enter the directory where your spreadsheet files are located. WordPerfect uses
this directory when you import or link to a spreadsheet. For more information,
see Spreadsheet, Import and Link in Reference.

Style Files
For the Style Files heading, enter the directory where your style files are located.
These files are used when you use the Style or Outline Style feature.

Once you enter a directory for this option, all subsequent style files you create,
save, or retrieve are created in, saved to, or retrieved from that directory.
Simply enter the name of the style file when you are saving or retrieving a style
on the Style or Outline Style menus, and the file will be saved to or retrieved
from the style files directory. There is no need to enter a full pathname for the
style file.

When you retrieve a style file, both outline and non-outline styles appear on the
Style menu. Only outline styles appear on the Outline Style menu.
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You may want to move (or copy) previously existing style files to the style files
directory. If you want to retrieve a style file from or save a style file to a
directory other than the one specified as the style files directory, however, you
may do so by entering a complete pathname.

For the Style Library Filename heading, enter the filename (or the complete
pathname if the library is not in the style files directory) of the file you want to
use for your style library. The style library is your default list of styles and is
retrieved when you enter the Style or Outline Style menu in a document that has
no previously defined styles.

For more information on the Style and Outline Style features and the Style
Library, see Style, Create and Outline, Style in Reference.

Thesaurus/Spell/Hyphenation Files

For the Main option, enter the directory where the thesaurus (WP{WPJUS.THS)
as well as the hyphenation and speller dictionary files (WP{WP}US.HYC and
WP{WP)US.LEX) are located. These dictionaries are the files WordPerfect uses
when you use the Thesaurus, Spell, and Flyphenation features.

For the Supplementary heading, enter the directory where your supplementary
speller dictionary files are located. They include the WP{WP}US.SUP file as
well as any other supplementary dictionaries you may create with the Speller
Utility or in WordPerfect.

For more information on the Thesaurus, Spell, and Hyphenation features see
Thesaurus; Speller, Check Spelling; and Hyphenation in Reference. For more
information on the Speller Utility, see Speller Utility in Reference.

See Also: Directories; List Files

If you create a personal document or any document that you would prefer to
remain confidential, WordPerfect allows you to lock the document with a
password. Once it has been locked, you cannot retrieve or print the file without
knowing the password. It is not possible to lock directories in WordPerfect.

In most situations, the password will provide the security you need. The password is not,
however, intended to meet U.S. Department of Defense or other high-level security
standards. WordPerfect Corporation will not unlock a documentfor you.
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1 Press Text In/Out (Ctrl-F5) to display the Text In/Out menu, then select
Password (2).

a Select Password from the File menu.
2 Select Add/Change (1).

3 Enter a password twice.

Since the password does not appear on the screen, you must enter the same password
twice to ensure that the correct password is used for the file. The password can contain
no more than 23 characters, and you can use Compose (see Compose in Reference).

4  Save the document for the lock to take effect.

Associated Files

When you lock a document, all files associated with the current editing of the
document (backup files, undelete files, move files, temporary buffer files, virtual
files, and the original file on disk) are also locked.

Document Protection

Though locking a document can prevent others from accessing it, you cannot
protect that document from being deleted. If you have a need to protect a
document, it would be best to make sure you have a copy of the document on
disk and store it in a safe place.

Find
If you are using the Find feature to search through a directory, and WordPerfect
encounters a locked document, you must enter a password to have the locked

document searched. You will also be asked for a password when you merge
locked documents or use Look to look at a document.

Retrieve

Once a document has been locked, you are asked for the password each time you
retrieve the document. If a “File is Locked” message appears after you try to
retrieve the document, you entered the wrong password.

Text Out
When you use Text In/Out to save a document as a 5.0 document, the file
remains locked. If you save the document as a 4.2 file, the file is unlocked.

Unlock

To unlock a document, you must remove the password. Follow the same steps
as listed above, but instead of selecting Add/Change, select Remove (2). Be
sure to save the document so the change can take effect.

See Also: Retrieve; Save
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The List Files menu includes a Look option that lets you view the text or
document summary of a WordPerfect 5.1 or 5.0 file, the text of a WordPerfect
4.2 or DOS text file, a WordPerfect 5.1 macro description, or a list of the files in
a directory.

1 With the List Files screen displayed, move the cursor to the file you want to
look at.

If you want to display the names of the files in a directory, move the cursor to
that directory in step 1 (see Directories below).

2 Select Look (6) or press Enter to display the file in the Look screen.

If the file is a WordPerfect 5.0 or 5.1 document and contains a document summary, the
summary is displayed (see Document Summary below).

3 Use the cursor keys to scroll through the text.

4 Select Next Document (1) or Previous Document (2) to display the next or
previous file from the List Files screen in the Look screen.

5 Press Exit (F7) or the Space Bar to return to the List Files screen.

Clipboard

With the Look screen displayed, you can use Block (Alt-F4) with Shell (Ctrl-FI)
(if you are running WordPerfect under the WordPerfect Shell) to block a portion
of the document and save or append it to the Clipboard.

1 Move to one end of the block of text you want saved to the Clipboard.

2 Press Block (Alt-F4), then move the cursor to the other end of the text you
want saved.

3 Press Shell (Ctrl-Fl), then select Save (1) or Append (2) to save or append
the blocked text to the Clipboard.

You can then retrieve the contents of the Clipboard into WordPerfect or any
other WPCorp product (see Shell Clipboard under Go to Shell in Reference).

This feature will work only ifyou are running WordPerfect under the WordPerfect Shell.

Cursor Movement

When you first enter the Look screen, the cursor is at the bottom of the screen.
You can use the arrow keys to move through the document in the Look screen.
Press Right or Left Arrow (->/<-) to display all of the document if it is wider
than the screen. Screen Up (-) and Screen Down (+) and Page Up (PgUp) and
Page Down (PgDn) move the cursor up or down through the document one
screen at a time. Home,Home,arrow keys will move the cursor to the far edges
of the document.



If your document is too wide to be displayed completely on the screen, press
End to alternate between showing the right and left ends of the document.

You can scroll backward or forward, left or right in a Look screen, but because
you have not actually retrieved the file, you cannot edit the file. Type s to
continuously scroll forward through the document. Press any other key to stop
scrolling.

Directories

You can use Look (6) to display the files in a subdirectory of the current
directory. Move the cursor to a directory (“<Dir>" appears in the Size column),
then select Look or press Enter. The name of that directory appears in the
lower left comer of the screen. Press Enter again or enter another directory
name to display the names of all the files in that directory (see Filename
Patterns below for details on entering a pattern at this point).

You can select Look with the Parent directory highlighted, then press Enter to
move back through the path one directory. The path includes the root directory
and all other subdirectories listed after the root directory (see Directories in
Reference).

For example, if the directory currently being displayed in the List Files screen is
C:\WP51\WORK, selecting Look with Parent highlighted, then pressing Enter
will display the names of the files and subdirectories of C:\WP51 in the List
Files screen. The cursor will be placed on the WORK subdirectory. If you
highlight Parent, select Look, then press Enter again, the names of the files and
subdirectories of C:\ will be displayed in the List Files screen.

Filename Patterns

When you select Look (6) or press Enter with a directory on the List Files
screen highlighted, the name of the directory is displayed at the bottom of
the screen with a filename pattern that includes all files in the directory (e.g.,
CAWPS51\WORK\*.*),

You can press Enter to display the names of all the files, or type another
pattern to display the names of all the files that match that pattern. For

example, entering *.Itr in place of *.* displays only those filenames that
have a .LTR extension (see Search Patterns under Find in Reference for
details on filename patterns).

Document Summary

The Look screen changes slightly if you are looking at a WordPerfect 5.0 or 5.1
document that contains a document summary (see Document Summary in
Reference). If the document summary only contains the document name (and
type if you are looking at a 5.1 document), the Look screen looks the same as
when there is no document summary, except that the header increases to two
lines to include the long document name, document type, and date of creation.

If you have created a document summary with more than just the name and type,
the document summary, instead of the text of the document, is displayed in the
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Look screen. A new menu appears at the bottom of the screen when the
document summary is displayed (see Look Menu below for details on the menu
displayed when there is no document summary or just the long document name
and type in the summary). These options are explained as follows.

Look at Text

Select this option (3) or press Down Arrow (1) to display the text of the
document in the Look screen. If you want to return to looking at the
document summary, select Look at Document Summary (3).

Next
This option (1) does the same thing as Next Document on the regular Look

screen (see Look Menu below).

Previous
This option (2) does the same thing as Previous Document on the regular
Look screen (see Look Menu below).

Print Summary
Select this option (4) to send the document summary to the currently selected
printer.

Save to File

Select this option (5), then enter a filename to save the document summary
to a file. The entire summary is included in the file, plus the DOS filename
(including the path) and type of system that created the document (e.g.,
WordPerfect 5.1).

If you enter a filename that already exists, you can choose to Replace (1) the
existing file or Append (2) the document summary to the existing file.

Header

The Look screen has a header at the top of the screen. It contains information
about the file currently being displayed (i.e., filename, revision date and time,
and if it is a WordPerfect 5.0 or 5.1 file).

If you select Look (6) on a file containing a document summary, the header
changes slightly. A second line is added that includes the long document name
and type, and the date the file was created.

Locked Documents

If you select Look (6) with a locked file highlighted (see Locked Documents in
Reference), you will be asked to enter the password of that file. If you cannot
remember the password, you will not be able to look at the contents or document
summary of the file.

Look Menu
When you select Look (6) with a file highlighted (and that file has no document
summary or just the document name and type in the summary), the text of the



file appears in the Look screen, and a menu appears below the text. The options
on this menu are described as follows.

Next Document

This option (1) displays the text or document summary of the next file from
the List Files screen in the Look screen. You can continue selecting this
option until the end of the file list is reached.

Previous Document

This option (2) displays the text or document summary of the previous file
from the List Files screen in the Look screen. You can continue selecting
this option until you reach the beginning of the files on the file list. As soon
as you come to a directory, you are returned to the List Files screen.

Search in the Look Screen

You can search forward or backward for characters or words while in the Look
screen using #Search (F2) or eSearch (Shift-F2). You cannot search while in the
document summary; you must have the text of the file displayed in the Look
screen (see Search in Reference).

When you first display the Look screen, the cursor is at the bottom of the screen.
You will have to use #Search, or move the cursor to the top of the screen and
use #Search to search through the text displayed in that screen.

See Also: Directories; List Files
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The Macro feature records keystrokes and plays them back just as they were
recorded, much like the re-dial feature on a telephone. For example, you may
perform one of the following tasks several times a day:

e Type a closing to a letter.

e Back up a directory of files.

* Replace several different items in a document.
* Print and save a file.

e Send a “Go” to your printer.

e Print several copies of a document.

Instead of repeating keystrokes manually each time you need to perform the task,
you can define (create) a macro to do it for you.

While the WordPerfect Macro feature can be as simple as saving a few
keystrokes from the keyboard, it also includes a flexible programming language
for more complex uses (see Macros, Macro Editor in Reference). For most
circumstances, you will only need the fundamental macro features. For example,
each of the tasks listed above could be included in a macro without using the
macro programming language.

There are two steps to using the fundamental macro features. First, you need to
define the macro (create it), and then you can execute the macro (run it). For
details on these two steps, see Macros, Define and Macros, Execute in Reference.

If your macro needs are more sophisticated, and you have a fundamental
understanding of logical structures and variables, you may want to explore the

macro editor and macro programming language (see Macros, Macro Editor in
Reference}. The language includes such features as the following:

« External condition handling

« Logical structures (e.g., if/then, case)
 Subroutine calls

e User-defined prompts and menus

« Variable assignment, storage, and retrieval

The macro language is quite flexible and can be used to create very sophisticated
macros. However, if you are new to the macro feature, we recommend that you
start with some fundamental macros before jumping into the macro language.

Keyboard Layout

You can also create macros using the Keyboard Layout feature. These macros
are assigned to specific keys on the keyboard and can be executed by simply
pressing the assigned key (see Keyboard Layout in Reference for details).

One advantage to using keyboard layout macros is that you can have multiple
keyboard layout definitions, each with different macros assigned to the same
keys. For example, you might have one keyboard layout where Alt-m marks
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items for an index and another keyboard layout where Alt-m moves paragraphs
to document 2. Then depending on the task you need, you can change the
keyboard layout for the appropriate macro.

Another advantage to using keyboard layout macros is that they are stored
together in one keyboard definition file. If you define multiple macros using the
Macro feature, each macro is its own file. And multiple macros in individual
files will take up more disk space than the same macros in one keyboard file.

Macro Support Policy
Although Macro support operators can assist you in troubleshooting existing
macros, they cannot design and write customized macros for you.

See Also: Lesson 15; Keyboard Layout; Macros, Define; Macros, Execute
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The Macro Conversion Program helps you convert macros written with
WordPerfect 4.x (4.0, 4.1, or 4.2) to WordPerfect 5.x (5.0 or 5.1) macros. You
can also use the Macro Conversion Program to break and chain WordPerfect 5.0
or 5.1 macros that you define at the normal editing screen that are then too large
to edit in the Macro Editor (see /m under Startup Options, and Large Macro
Files below).

WordPerfect 50 macros do not require conversion through the Macro (Conversion
Program to run with WordPerfect 5.1. However, since the keystrokes to accomplish
certain tasks may have changed with WordPerfect 5.1, you may need to edit the macro in
the Macro Editor (see Macros, Macro Editor in Reference).

When converting a 4.x macro, the portions of the 4.x macro containing text,
cursor keystrokes, and functions that haven’t been changed for WordPerfect 5.x
are converted directly to the new format. Those that have changed with 5.x are
converted to comments (see /;Jcomment- in Appendix K: Macros and Merge,
Programming Commands). Once you have converted the macro, you can
retrieve it in the Macro Editor (see Macros, Macro Editor in Reference) and
make any additional changes.

Important: The Macro Conversion Program file (MACROCNV.EXE) needs to be
installed properly before using the program. Ifyou chose not to install the WordPerfect
utility programs when you installed WordPerfect, or have not subsequently installed them,
you must do so now to use the Macro Conversion Program (see the Installation
Instructions card).

To use the Macro Conversion Program to convert a 4.x macro to a 5.x macro,
1 Go to DOS.
2 Change to the directory where MACROCNV.EXE is located.
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The Installation Program copies thisfile to the directory where WordPerfect (WP.EXE) is

located (usually C:\WP51) ifyou are using a hard disk, or to the diskette you labeled
"Utilities” if you are using a two disk drive system.

3 Enter macrocnv macroname (where macroname is the name of the macro to
be converted) to start the program and the macro conversion. If you do not
specify a macro name when you start the program, you are prompted to enter
one. (Be sure to enter the full pathname of the macro if it is not in the
current directory. You need not enter the .MAC extension.)

When the conversion is finished, you will see “Done” appear on the screen,
along with a report on the conversion of the macro. Portions of the macro that
could not be converted (or which require additional modification to replicate its
function in 5.v) are described. To make further modifications to the macro, use
the Macro Editor in WordPerfect (see Macros, Macro Editor in Reference).

The output file generated in the conversion has the same name as the original
macro file, except with an extension of \WPM. It is stored in the same directory
as the original file, which remains intact in the directory.

If a file already exists in the directory with the same name as the new output
file, you will be asked before the conversion starts whether you want to replace
the file. You may either replace it or enter a new name for the output file.

5.0 vs. 5.1

WordPerfect 5.0 macros do not require conversion through the Macro
Conversion Program to run with WordPerfect 5.1. However, since the
keystrokes to accomplish certain tasks have changed with WordPerfect 5.1, you
may need to edit the macro in the Macro Editor (see Macros, Macro Editor in
Reference) to make it function properly in WordPerfect 5.1.

WordPerfect 4.x macros that you convert with the Macro Conversion Program
can be run in either WordPerfect 5.0 or 5.1. (You will still have to edit the
portions of the macro that were not converted in the Macro Editor.)

It is possible to run macros created in WordPerfect 5.1 in WordPerfect 5.0;
however, commands that are specific to 5.1 and keystroke processes which
changed from 5.0 to 5.1 will not function correctly.

Large Macro Files

If you defined a macro in WordPerfect 4.x that was very large, it may not fit in
the Macro Editor in WordPerfect 5.1 The Macro Conversion Program checks
the size of the macro it is converting, and if it is too large for the Macro Editor,
it automatically breaks it into smaller files (about 4.5K in size) which are
chained together. (For an explanation of chained macros, see Chaining Macros
under Macros. Define in Reference, and Chaining, Nesting, and Substituting
under Notes in Appendix K: Macros and Merge. Programming Commands.)

The resulting 5.x macro files are named with the same filename as the input file,
except a number is appended to the end of the filename. For example, if you
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converted a very large WordPerfect 4.2 macro called DOIT.MAC, the resulting
WordPerfect 5.x macro files would be named DOIT1.WPM, DO1T2.WPM,
DOIT3.WPM, etc. Since the Macro Conversion Program chains the macros
together, executing DOIT1.WPM in WordPerfect 5.x would automatically
execute DOIT2.WPM, then DOIT3.WPM, etc.

If the Macro Conversion Program must break and chain a macro whose name already
contains 8 characters, you will receive a warning message, and it will try to alter the
name so that it can still append the number(s) and maintain unique filenames.

WordPerfect 5.x macros you define at the normal editing screen can also become
too large to fit in the Macro Editor. You can use the Macro Conversion
Program with the /m startup option to break and chain them. See An under
Startup Options below.

Multiple Files

If you want to convert several macro files at once, use wildcard characters (“?”
to represent a single character, “*” to represent zero or more characters) in the
name of the macro file to be converted. For example:

search? Would convert all the macros in the directory named
“SEARCH?” followed by a single character.

search* Would convert all the macros in the directory named
“SEARCH" followed by zero or more characters.

* Would convert all the macros in the directory.

Startup Options
There are several startup options you can use with the Macro Conversion
Program.

/h
This option displays helpful information about the Macro Conversion
Program. To use the option, enter macrocnv/h at the DOS prompt.

/m

If you define a macro at the normal editing screen of WordPerfect 5.0 or 5.1,
it may be so large that it will not fit in the Macro Editor. If you want to edit
the macro in the Macro Editor, use the Macro Conversion Program with this
startup option to break the macro into smaller files which are then chained
together. See Large Macro Files above for more information on breaking
and chaining large macro files.

Important: You should not use this startup option for 4.x macro files since the
Macro Conversion Program breaks and chains 4.x macros automatically. This option
isfor 5.x macros only.

WARNING: Do not use the /m startup option with the Macro Conversion
Program to try to break and chain macros that use subroutines (see
Subroutines in Appendix K: Macros and Merge, Programming Commands) or
any other control direction commands (such as (IF), (CASE), {WHILE},
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etc.). The Macro Conversion Program breaks and chains macros using a
sequential order of commands. Macros whose commands are not meant to
be executed in the same order they occur in the file are likely to be non-
functional after the Macro Conversion Program breaks and chains them.

/o
This option causes existing .WPM files to be overwritten by newly generated
macro files of the same name without a warning prompt.

/P
When you run the Macro Conversion Program, a report of the conversion of

the macro is written to the screen. This startup option lets you write the
report to the printer or to a file instead of to the screen. In addition, the
report sent to a file or the printer contains a representation of the original 4.x
macro, with notations of the commands that did not convert or that will need
modification.

If you want the report written to a file, enter the following at the DOS
prompt:

macrocnv/p macroname >filename

where macroname is the name of the macro to be converted, and filename is
the name of the file where you want the report written.

If you want the report written to the printer, enter the following at the DOS
prompt:

macrocnv/p macroname >PRN:

where macroname is the name of the macro to be converted. “>PRN:” is the

standard DOS redirect command to send output to the printer. It defaults to
LPT1. If you want more specific information about this command, see your

DOS manual.

See Also: Lesson 15; Macros; Macros, Define; Macros, Execute; Macros, Macro
Editor; Appendix K

The following instructions describe defining (creating) a macro from a normal
editing screen. You can also define a macro from the macro editing screen (see
Macros. Macro Editor in Reference). If you are new to defining macros, we
recommend that you start by following the steps below.

To define a macro,
1 Press Macro Define (Ctrl-FIO) to begin defining the macro.

[B Select Macrofrom the Tools menu, then select Define.
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2 Enter the name for the macro (eight characters or fewer).

You can also hold down Alt and type any single letter, or you can just press
Enter to name a macro (see Naming Macros below).

3 Enter a brief description of the macro (see Macro Descriptions below).
or
Press Enter to define the macro without a description.

At this point you are returned to the normal editing screen with “Macro Def’
displayed on the status line.

4 Type the keystrokes you want recorded.
5 Press Macro Define (Ctrl-FIO) again to end defining the macro.
CB Select Macro from the Tools menu, then select Define.

The keystrokes are saved in a file in the keyboard/macro directory (unless you
specified a full path when naming the macro). The default setting for the
keyboard/macro directory is the current default directory, unless you have
changed the pathname using the Location of Files option on the Setup menu
(Shift-FI ,6,2). See Location of Files in Reference.

A macro file is automatically given a .WPM extension by WordPerfect.

If you try to name a macro with a name that you have already used, WordPerfect
gives you the opportunity to replace or edit the original macro. If you select
Replace (1) and type y for Yes, the original macro definition is deleted, and you
can enter a description for the new macro (or just press Enter), then begin
entering keystrokes for the new definition. If you select Edit (2), you are placed
in the macro editing window. If you select Description (3), you can edit the
macro description before entering the macro editing window (see Editing Macros
below).

When you create macros that select fonts, printers, paper sizes, etc., use Name Search,
not arrow keys, to select the desired item. Ifyou use arrow keys to select an item and
later add an item to or delete an item from the list (thus changing the position of the
desired item in the list), your macro may not select the correct item.

Chaining Macros

Chaining macros means that when one macro ends, the next macro starts. You
can chain macros both with and without using the macro language. The
following example describes how to chain macro B to macro A without using the
macro editor.

1 Press Macro Define (Ctrl-FIO) to begin defining macro A.
Le Select Macro from the Tools menu, then select Define.

2 Enter a for the macro name, then enter a macro description (or just press
Enter).



3 Type the keystrokes for macro A.

4 Press Macro (Alt-FIO) to begin chaining macro B to macro A.
CB Select Macro from the Tools menu, then select Execute.

5 Enter b for the macro name.

6 Press Macro Define (Ctrl-FIO) to end defining macro A.

CB Select Macro from the Tools menu, then select Define.

7 If you have not already done so, define macro B.

Pressing Macro (Alt-FIO) while defining macro A (or any macro), records the
keystrokes for starting the macro, but does not start macro B. Only when you
actually run macro A does WordPerfect start macro B.

When you start macro A, WordPerfect runs through all the keystrokes in macro
A before starting macro B.

You can expand a simple chain to include several macros by continuing to start
one macro while recording another. This takes some careful planning to make
sure the macros are chained in the correct order. Start macro B while recording
macro A, start macro C while recording macro B, etc.

If you want to chain an Alt-letter macro (see Naming Macros below), you must
first press Macro (Alt-FIO), then the Mt-letter macro keystroke.

You can also nest macros (execute a macro anywhere within another macro).
See Nesting Macros below.

Converting Macros

Portions of WordPerfect 4.2 macros containing text, cursor keystrokes, and
functions that haven’t changed in WordPerfect 5.1 can be converted to
WordPerfect 5.1 with the MACROCNV.EXE program (see Macros, Conversion
Program in Reference). Macros created in version 5.0 will work in version 5.1
if the keystrokes required to accomplish the task are the same in both versions.
Macros created in version 5.1 will only work in version 5.0 if no new 5.1
features have been included in the macro, and if the keystrokes required to
accomplish the task are the same in both versions.

If you create a 5.1 macro using features that are not available in 5.0, these
features will be represented by a box character (|) in the 5.0 Macro Editor
window.

Editing Macros

WordPerfect provides a Macro Editor that can be used to edit WordPerfect
macros, whether the macros are simple or complex. However, with some
fundamental macros it may be easier to re-create the macro rather than go
through the steps of editing it.
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If you want to edit a macro, press Macro Define (Ctr]-F10), enter the macro
name (you don’t need to type the .WPM extension), then select Edit (2). You
are placed in the macro editing window. You can now edit the macro by
deleting codes as desired and pressing function keys to enter function codes.
You can also enter programming commands with the Macro Commands key
(Ctrl-PgUp). See Macros, Macro Editor in Reference and Appendix K: Macros
and Merge, Programming Commands for details.

You can edit a macro description by pressing Macro Define (Ctrl-FIO), entering
the macro name, then selecting Description (3). Edit the description, then press
Enter and you are placed in the macro editing window. To exit the macro
editing window, press EXxit (F7).

If you want to go directly to the macro editing window to create a macro, press
Home,Define Macro (Ctrl-FIO), enter a new macro name, then enter a
description (or just press Enter).

Ending a Macro Definition

You can press Macro Define (Ctrl-FIO) to stop defining a macro—even at a
message or in a menu. Please note that starting a merge while defining a macro
also ends a macro definition.

Macro Commands

The Macro Commands key (Ctrl-PgUp) displays a different menu depending
upon the state of WordPerfect when you press it. If you press it while in the
Macro Editor, it displays a list of the macro language commands (see Appendix

K: Macros and Merge, Programming Commands for details). If you press it
whnile at a document screen, it allows you to enter a variable for macro

programming. If you press it while Block is on, it assigns the contents of the
block to a variable you specify. And if you press it while defining a macro, the
following four options become available.

Pause

You can insert a pause that will let you enter text from the keyboard while
the macro is running. Select Pause (1). At this point, you can type any
keystrokes (except Enter), and these keystrokes will not be included in the
macro. Then press Enter to insert the pause. Once you have inserted the
pause, you can continue defining the rest of the macro.

When the macro is running, WordPerfect pauses for an entry from the
keyboard. You can then type any text and press Enter to continue running
the macro.

Display

A macro usually executes a task without displaying the various prompts and
screens that are included in the task. If you want to see the screen change as
the macro executes, you must turn on the display while defining the macro.

To do so, press Macro Commands (Ctrl-PgUp), select Display (2), then
type Y (or type N to turn off the display).



Assign

The macro language lets you assign values to variables. The Macro
Commands key lets you assign variables without being in the Macro Editor.
Select Assign (3), enter the variable name or number, then enter the value
you are assigning to the variable.

If you highlight a block of text before selecting Assign, you are asked for the
variable name. When you enter the variable name, the contents of the block
are assigned to the variable (most codes included in the block will not be
included in the variable).

For details on variables, see Appendix L: Macros and Merge, Variables.

Comment

The macro language lets you insert comments to document your macro.
These comments can be seen in the macro editing window but do not disturb
macro execution. You can insert a comment while defining a macro using
the Macro Commands key. Select Comment (4), type the text of the
comment, then press Enter. The comment is inserted into the macro but can
only be seen in the macro editing window. For details on macro comments,
see Appendix K: Macros and Merge, Programming Commands.

Macro Descriptions

A macro description can be used to describe the contents of a macro. It is
displayed at the top of the macro editing screen (see Macros, Macro Editor in
Reference). It is also displayed if you select Look in List (F5,Enter,6) to view
the contents of a macro (see List Files in Reference). The description can be up
to 39 characters long.

You do not have to enter a description for a macro.

Mouse

You can use the mouse to access pull-down menus while defining a macro.
However, you cannot use the mouse to move the cursor while defining a macro.
Use the cursor keys instead.

Naming Macros
Before you define a macro, you are asked to enter a name. There are three ways
to name a macro:

« Enter one to eight characters.
+ Hold down Alt and type a letter from A to Z.
 Press Enter.

WordPerfect adds a .WPM extension to all macro names.

The advantage to using an Alt-letter macro name is that to execute the macro,
you simply press the Alt-letter keystroke without pressing the Macro key.

If you named a macro with the Enter key, WordPerfect names the macro
WP(WP).WPM. However, you do not have to enter this name when you

execute the macro. Just press Macro (Alt-FIO), then Enter.
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If you want to edit a macro named with the Enter key, press Macro Define
(Ctrl-F10), then enter wp{wp}. If you just press Enter after pressing Ctrl-FIO,
the existing Enter macro will be replaced without confirmation.

Macros are saved as files in the keyboard/macro directory and can be copied like
other files (see List Files in Reference). If no directory is specified using the
Location of Files feature, then the macro is saved in the default directory. When
you execute a macro (see Macros, Execute in Reference), WordPerfect looks for
the macro in the keyboard/macro directory first (or default directory) and then
the system directory (where WP.EXE is located) next.

You can define macros using full pathnames (e.g., BAMEMO,
C:\JULIE\MEMO). This is useful if you want to store macros in directories
other than the keyboard/macro directory. Remember, if you give a macro a full
pathname when you create it, you will most likely have to use that full pathname
when you execute the macro.

Nesting Macros

You can use Alt-letter macros to nest one macro inside another macro. You do
this by pressing Alt, then the letter of the macro while you are defining another
macro. Unlike chained macros, WordPerfect does not wait until it completes the
first macro before executing the nested macro. Rather, it executes the nested
macro at the point it is inserted, and then returns to the original macro after
executing the nested macro.

See Also: Lesson 15; Macros; Macros, Execute; Macros, Macro Editor

The instructions for executing (running) a macro depend on the way you named
the macro when you defined it. If you named a macro using the Alt key (see
Macros, Define in Reference), you can execute it by holding down Alt and
typing the letter you used to name the macro. You do not have to press the
Macro key.

If you named the macro any other way,
1 Press Macro (Alt-FI10).
CB select Macro from the Tools menu, then select Execute.

2 Enter the macro name, or press Enter (if you named the macro with the
Enter key).

When you enter the macro name, you do not have to include the WPM
extension that WordPerfect automatically adds to macro names.



Notes /m Startup Option
You can have a macro execute automatically each time you start WordPerfect
using the /m startup option (see Appendix N: Startup Options).

Pathnames

You can execute macros using full pathnames (e.g., BAMEMO,
C:\JULIE\MEMO). This is useful if you want to execute macros from
directories other than the keyboard/macro directory (see Location of Files in
Reference for details on the keyboard/macro directory). When you edit or
execute a macro, WordPerfect will look in the default directory in addition to the
directory listed in Location of Files.

Repeating a Macro
You can use the Repeat feature to repeat a macro a specific number of times.

1 Press Repeat (Esc), and type the number of times you want the macro
repeated.

2 Press Macro (Alt-F10).
or

If you named the macro with the Alt key, press the Mi-letter combination
you gave it, then skip step 3 below.

3 Enter the macro name.

The macro executes the specified number of times.

Stopping a Macro

You can press Cancel (F1) to stop a macro while it is running. If you include a
search in a macro, the macro stops when it can no longer find the searched-for
item. A macro also stops if an error is detected.

You can change these three conditions using advanced macro commands. For
details, see Appendix K: Macros and Merge. Programming Commands.

See Also: Lesson 15; Macros; Macros, Define; Macros, Macro Editor

Macros, International Interface

Some menus have options that are chosen by mnemonic letter only and not by
number. This can create problems for macros written in one language and
running in another because the mnemonics will not always coincide. For
example, the mnemonic for Number of Copies on the Print menu (F7) is N in
English and Italian (Numero di Copie), but A (Aantal Exemplaren) in Dutch. To
help you avoid this difficulty, WordPerfect provides an optional international
interface for mnemonics used in macros.
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As a general rule, treat mnemonic options in international macros as though they
were numbered in sequence with the numbered options. For example, the
English WordPerfect Print menu contains seven numbered options followed by
six mnemonic-only options. Select 8 for the first mnemonic-only option (Select
Printer) and 9 for the next (Binding offset). Instead of using two-digit numbers
for the international macro interface, use the following characters which have
been chosen to represent the numbers 10 through 15.

/=10,\= 11, := 12, *=13,?7=14,+=15

For any YES/NO menu option, you can use a plus (+) for yes and a minus (-)
for no.

Name Search is on several menus in different positions. It is the tenth menu
item on the List Files menu, but sixth on the Format Paper Size/Type menu

(Shift-F8, 2, 7). To maintain consistency in macros, Name Search is always
represented by the equal sign (=).

When you specify sort keys in an international macro, Alphanumeric (a) is 1 and
Numeric (n) is 2.

In the Tab Set feature, there are only mnemonic choices for Type, Left, Center,
Right, and Decimal. These can be accessed by pressing / for Type, Tab for
Left, Shift-F6 for Center, Alt-F6 for Right, and Ctrl-F6 for Decimal.

When entering numbers with a unit of measurement (e.g., 2"), you can use these
character equivalents to represent the units wanted.

Unit Character Equivalent

i \
c :
. .
w ?
u +

So, for example, you would enter 2" as 2\.

Macros, Macro Editor

380

MACROS. MACRO EDITOR

The Macros feature lets you create and edit macros using a programming
language. Macro programming is done in the Macro Editor.

The Macro Editor is a special editing window that shows you the individual
commands (keystrokes) of your macro. You can insert macro programming
commands, keystroke commands, editing keys, and text into your macro. Each
command is displayed in braces ({}). Characters and numbers appear without
braces.

Below you are shown how to define a new macro (see Defining a Macro) and
how to edit an existing macro (see Editing an Existing Macro).



A MACRO NAME
A MACRO DESCRIPTION
A EDITING WINDOW

Defining a Macro

There are two ways to define a new macro. You can define the macro from the
keyboard (see Macros, Define in Reference) or you can define it in the Macro
Editor.

To use the Macro Editor when defining a new macro,

1 Press Home, then press Macro Define (Ctrl-FIO) to begin defining the
macro.

2  Enter the name of your macro. (You can enter a pathname if you want the
macro in a directory other than the default.)

3 Enter a macro description (up to 39 characters).
or
Press Enter if you do not want a description.

You are now in the Macro Editor. The Macro Editor screen displays the name
of the macro, its description (your explanation of its function), and the
keystrokes and commands that you insert.

Macro: Action
File YOURMAC .WPM «

Description This is a net

{DISPLAY OFF}

Ctrl-V to Insert next key as command;
Ctrl-PgUp for macro commands; Press Exit when done

4 Create the macro (see Inserting Text, Inserting Macro Programming
Commands, and Inserting Editing Keys and Keystroke Commands below).

5 Press Exit (F7) to end macro definition and save the macro.
You cannot use the pull-down menu for rapid entry into a macro (i.e., Home,Ctrl-FI10).

If you do not want to save your macro, press Cancel (FI) instead of Exit.
WordPerfect asks if you want to cancel changes. If you choose No (the default),
you remain in the Macro Editor. If you choose Yes, your changes are not saved
and you are taken back to the normal editing screen.

When you cancel a new macro, any editing that you may have done is disregarded.
However, a macro with the name you gave it will exist, containing nothing but a
(DISPLAY OFF) command.
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The {DISPLAY OFF} command is inserted at the beginning of all macros. (For
information on the {DISPLAY OFF} command, see Appendix K: Macros and
Merge, Programming Commands.)

Ffowever, if a macro that you define from the normal editing screen ends at a
menu (e.g.. Print) or contains a {Pause}, the {DISPLAY OFF} command is
deleted to let you see the menu.

If you define a macro from the normal editing screen, some commands that you
insert from the menu bar are treated specially. If the command displays a menu
(e.g., Font), the Macro Editor inserts a {MENU OFF) before the command and a
{MENU ON) after the command (e.g., {MENU OFF} {Font}{MENU ON}F).
Turning the menu off prevents any menus from flashing on the screen when you
run the macro. See the descriptions for the {MENU OFF} and (MENU ON)
commands in Appendix K: Macros and Merge, Programming Commands.

Editing an Existing Macro

There are two ways to enter the Macro Editor when editing an existing macro.
To go directly into an existing macro,

1 Press Home, then press Macro Define (Ctrl-FIO).

WordPerfect prompts you for a macro name and a macro description, then places
you in the Macro Editor.

If you have already entered a description, the existing description appears at the
Description: prompt, where you can edit it or delete it, or you can accept it as it
is by pressing Enter.

To edit an existing macro without using the rapid entry,
1 Press Macro Define (Ctrl-FIO).
EH Select Macro from the Tools menu, then select Define.
2 Enter the name of your macro.
You are given the option of replacing the old macro:
YOURMAC.WPM Already Exists: 1 Replace; 2 Edit; 3 Description: 0

If you choose Replace (1), you are asked to confirm that you really want to
replace your macro.

Replace YOURMAC.WPM? No (Yes)

If you choose No (default), you are returned to the normal editing screen. If
you choose Yes, your old macro is deleted, you are prompted to enter a
description, then you are placed in the normal editing screen where you can
begin defining the new macro.

If you choose Edit (2), WordPerfect brings up your macro and puts it in the
Macro Editor where you can edit it.



If you choose Description (3), you are prompted for your description, then placed
in the Macro Editor.

Inserting Text
Once you are in the Macro Editor, you can insert and delete text, keystroke
commands, and macro commands, and format your macro.

You can insert text by simply typing it at the desired location. To move your
cursor through the macro, use the cursor control keys as you would in the
normal editing screen. The cursor keys, as well as Enter, Tab, Page Up (PgUp),
Page Down (PgDn), Delete, Backspace, and End, perform their normal functions.

Spaces that you type appear as centered dots in the macro editing screen.

You can use Tab and Enter to make your macro more readable. The tabs and
hard returns do not affect the execution of your macro. (For details, see
Inserting Editing Keys and Keystroke Commands below.)

Comments can also help make a macro easier to read and edit. See the
(;{comment- command description in Appendix K: Macros and Merge,
Programming Commands.

Typeover cannot be used in the Macro Editor.

Inserting Macro Programming Commands

You can insert both macro programming commands (e.g., {DISPLAY ON},
{IF}) as well as WordPerfect keystroke commands (e.g., {Spell}, {Tab}) into
your macro.

All commands are bolded and enclosed in braces. However, those commands that are
assigned to a keystroke are shown in initial capital letters ((Spellj), while the macro
programming commands (those commands not assigned to a keystroke) are shown in all
capital letters ({DISPLAY ONj).

To insert macro programming commands into your macro,
1 Move the cursor to where you want to insert the command.

2 Press Macro Commands (Ctrl-PgUp or Alt-=) to display the Macro
Commands menu. You can scroll to your desired command or you can use
Name Search.

3 When you have highlighted the command you want, press Enter to insert it
into your macro.

Press Cancel (FI), Escape, or Exit (F7) to exit the Macro Commands menu
without inserting a command.

You can use the cursor keys to move around in the Macro Commands menu. In
addition to the cursor keys, pressing the Space Bar moves the cursor to the top
of the menu.
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Name Search is active while you are in the Macro Commands menu. To use
Name Search, start typing the name of the command you want to insert. (You
do not need to type the opening brace ({), just the letters.) The letters you type
appear in the lower left comer of your screen, and the cursor moves to the
command that most closely matches those characters. You can press Enter to
insert the command, or you can press one of the arrow keys to reset Name
Search (so that you can type characters for another command) and to move the
cursor.

You cannot simply type a macro command surrounded by braces—it must be
retrieved from the Macro Commands menu. Each macro command that you
insert into your macro is treated as a single unit by the Macro Editor. Each

command is deleted with a single delete.

Most commands require a specific syntax. For more information, see Appendix
K: Macros and Merge, Programming Commands.

Inserting Editing Keys and Keystroke Commands

Besides using the editing keys (e.g.. Enter, arrows. Home, Backspace, PgUp) for
editing your macro, you may want to insert editing key commands into your
macro.

You must enter the Command Insert mode before pressing the key to insert the
following commands: macro commands (Ctrl-PgUp), variables, certain control
characters, keyboard macro names, and cursor keys.

To enter Command Insert mode, either press Ctrl-v, which places you in
Command Insert mode for the following keystroke, or press Ctrl-FIO, which
places you in Command Insert mode until you press Ctrl-FIO again.

Command Insert mode tells WordPerfect to insert the command for any key you
press into the macro. For example, to insert the (Enter) command into your
macro, press Ctrl-v, then press Enter.

If you only need to insert one Tab, cursor key, etc., into your macro, press
Ctrl-v. A prompt “Press Command Key” appears. Press the desired key.

If you will be inserting many of these commands, enter the Command Insert
mode by pressing Macro Define (Ctrl-FIO). While in this mode, all keys you
press will insert the key command. When you want to use the editing keys to
edit, press Macro Define again to return to edit mode.

You can insert most of the function key commands simply by pressing the
corresponding feature key. For example, press Spell (Ctrl-F2) to insert the
(Spell) command into your macro.

If you want to have your macro view a document, press Print (Shift-F7), then
type v. Your macro should then look like this: (Print)v

However, there are four functions which are executed when you press the
corresponding keys: Macro Define (Ctrl-FIO) (toggles Command Insert mode as
described above), Cancel (FI), Help (F3), and Exit (F7). You can insert these



Notes

corresponding keystroke commands into your macro by entering Command Insert
mode, then pressing the function key. You can only insert {Macro Define} into
your macro by first pressing Ctrl-v, then pressing Macro Define (Ctrl-FIO).

If you want to insert the commands associated with a macro assigned to a key on
the current keyboard layout, press Ctrl-v, then press the key.

When you create macros that selectfonts, printers, paper sizes, etc., use Name Search,
not arrow keys, to select the desired item. 1fyou use arrow keys to select an item and
later add an item to or delete an item from the list (thus changing the position of the
desired item in the list), your macro may not select the correct item.

Combining Macros

You can insert the contents of a macro into other macros by assigning it to a key
(see Action under Keyboard Layout, Edit in Reference). The commands of the
macro are inserted into the Macro Editor when you press Ctrl-v, key.

Macro Size Limit

The Macro Editor has a limit on the size of macro that it can hold (at least 5K).
If you are editing a macro, the Macro Editor simply stops inserting your
commands or text when you reach this limit. You can use {CHAIN} or
{NEST} to overcome this limitation (see Appendix K: Macros and Merge,
Programming Commands).

If you have created a macro (e.g., in the normal editing screen) that is larger
than can fit in the Macro Editor, an error message appears, “Not enough
memory,” and then you are returned to the normal editing screen. In order to
edit such large macros, use the /m option of the Macro Conversion Program.
This option breaks your large macro into smaller macros and then chains them
together. See /m under Macros, Conversion Program in Reference for details.

Message Display
You can position your cursor and text on the screen, as well as change attributes of
the text that you display. See Macros, Message Display in Reference for details.

Programming Commands

There is a wide range of programming commands that you can use in your
macro. See Appendix K: Macros and Merge, Programming Commands for
details.

Variables and Expressions

You can assign values to variables and store text in variables. See Appendix J:
Macros and Merge, Expressions and Appendix L: Macros and Merge, Variables
for details.

See Also: Macros; Macros, Conversion Program; Macros, Define; Macros,

Execute; Macros, Message Display; Appendix I; Appendix J; Appendix K;
Appendix L
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You can use control characters to affect the way the messages in the {CHAR},
{INPUT}, {PROMPT), (STATUS PROMPT}, and {TEXT} commands are
displayed on the screen. (See Appendix K: Macros and Merge, Programming
Commands for details of the above commands.) For example, you can use
control characters to determine the attributes of text in the message (such as
bolding or underlining), or to place messages at different locations on the screen.

The following screen shows an example of how you might display a message
using these control characters.

ft= select document type;

1. Report
- Letter

Enter selection:

The characters are divided into three categories: Attribute On/Off Characters,
Attribute Characters, and Cursor Positioning Characters. Some of the characters
have different functions depending on where they appear in the message string
(e.g., which character precedes them). The tables below describe how each
control character functions.

In all of the tables below, the Character column lists the control characters you should
press to insert the commands listed in the second column (the Shown As column). In the
Character column, Netter means to hold down the Ctrl key, then press the letter. You
may also press the key which corresponds to the command. For example, to display the
jHome] command, you can press either Av followed by Ah (Ctrl-v, Ctrl-h), or Ctrl-v
followed by Home.

In order to insert certain commands into your macro, you must be in Command Insert
mode (see Inserting Editing Keys and Keystroke Commands under Macros, Macro Editor
in Reference). The appropriate commands are listed following each table.



Attribute On/Off Characters
The following characters are used to control attribute display:

Character
AN

3

2e& 3333

Al
A

Shown As

(AN}

ro}

1))
m

(M)
fAT}
(A)
IA)

H}
1AV

Action

Turn on display attribute (followed by
attribute character) (see Attribute Characters
below).

Turn off display attribute (see Attribute
Characters below).

Turn off all display attributes.
Turn on reverse video.

Turn off reverse video.

Turn on underline.

Turn off underline.

Turn on mnemonic attribute (the attribute
selected with the Display menu of the Setup
key). Turn off with AQ.

Turn on bold.
Turn off bold.

Important: To insert (AV) into your macro, you must be in Command Insert mode (Ctrl-v

or Ctrl-FIO).

Attribute Characters

The following control characters turn a display attribute on or off when they are
preceded by jAN) or {0 }. To turn on an attribute, precede the appropriate
control character with {AN}. To turn off the attribute, precede the control

The attribute is displayed with the settings you have
selected on the Screen Attributes menu on the Setup key (see Colors/Fonts/
Attributes in Reference).

character with (A0).

Attribute

Blink
Bold

Double Underline

Fine Print
Italics

Large

Outline
Redline
Reverse Video
Shadow

Small

Character Shown As

»
A
AK
D
AH
»
G
A

Yo}
A

C

?E)el to EOP)
{Del to EOL)
{ro}
{Home}
(AB)

(AG)

(Enter)

1/Q)
{Tab}
(AC)
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Attribute Character Shown As

Small Caps A ro)

Strikeout AV {AVi}
Subscript A {A}
Superscript A {rE}
Underline AN {A\}
Very Large AA {AA}

Important: To insert {Del to EOL), [Home), [Enter), or [Tab), you must be in
Command Insert mode (Ctrl-v or Ctrl-FIO).

The following example illustrates one use of underlining.

{ASSIGN Jname'Hemingway'
{CHAR}I'ls-the-Author- {AN H{AN H{VARIABLE}ame'faO }{AN }?-(Y/N):~

The word “Hemingway” is assigned to the variable name. The {CHAR}
command then displays the following message at the bottom of the screen:

la the author Heatnovav? (Y/N)!

Thefirst nN signals that an attribute characterfollows. The second AN turns on
underline. Notice that the contents of the variable name are displayed next. The aO
signals that the attribute associated with the next character should be turned off. Since
AN represents underline, underlining is turned off.

The following example illustrates one use of bold.

{CHAR} r
(AYH{AQ H AV}M{AQ}emo;-
{AR{AQ AV IL{AQ Jetter;
{AR{AQ HAV J{AQ }tinerary

The {CHAR} command displays this message at the bottom of the screen:

1 Memo; 2 Letter; 3 Itinerary:



The A] codes turn on bold, the AQ codes turn off all attributes (including bold). The AV
codes turn on the mnemonic attribute (in this case, bold). (Remember, you must press
Ctrl-v twice to get JAVJ.) Again, AQ is used to turn off the mnemonic attribute.

Cursor Positioning Characters

The following control characters affect the location of text in a message on the
screen. When a control character is inserted, the cursor is moved to the location
indicated, and any text that follows the control character is displayed beginning
at that location. You can use as many display position control characters in a

message as you need to position and format the message.

Character Shown As Action

AH {Home} Position cursor at upper-left comer of
screen.

Al (Enter) Position cursor at beginning of next line.

AK {Del to EOL} Clear text to end of line. Cursor
remains.

Al {Del to EOP} Clear the screen, position cursor at
upper-left corner of screen.

AV {AV1} Position cursor at beginning of line.

AP {AP} Position cursor (followed by two
characters: column, then row). See Ctrl-
P below.

AN {Up} Position cursor up one line.

AX {Right} Position cursor right one character.

AY {Left} Position cursor left one character.

A {Down} Position cursor down one line.

Important: To insert any of the above codes except /Del to EOPj, jAMj, or fAPj, you
must be in Command Insert mode (Ctrl-v or Ctrl-FIO).

The following example illustrates the use of the AY control character (displayed
as {Left}) for repositioning the cursor.
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{ASSIGName'Hemingway'
{CHAR) Ils the-Author- {AN }{AN {VARIABLE}ame'{A0 }{AN}?
(Y/N):-Yes{Left) {Left} {Left}'

la the author Heainouay? (*/N): Ves

The three fLeftj commands position the cursor three characters to the left. When the
message is displayed, the cursor is on the “Y" of Yes.

Conversion Chart, Alphabetic
Use the following chart to determine row and column positions using
alphabetical control characters:

Screen Control Screen Control
Position Character Position Character
1 1MA) 14 (AN)

2 1AB) 15 1a0)

3 m 16 m

4 AD 17

5 e s (3

6 m 19 (AS)

7 1AG1 20 1AT)

8 1AH} 21 (AJ)

9 (A) 22 1AV}

10 (AL 23 {AN}
i m 24 1AX)

12 m 25 (AY)

13 (AV) 26 (A2)

If you want to use ASCII characters for your row and column positions, the
ASCII Conversion Chart is in Appendix A.

Ctrl-P

You can use the Ctrl-P character (AP) to position the cursor (and hence, the
message) on the screen. Ctrl-P is a shortcut to positioning the cursor. Moving
the cursor can also be accomplished by using the other control characters as
listed in the table under Cursor Positioning Characters above.

The two characters following Ctrl-P should be the coordinates for the position on
the screen. The screen is divided into columns and rows. Each position that can
be occupied by a character on the screen has a column and row coordinate. The



column coordinate is listed first, then the row coordinate. For example, the
upper left corner of the screen has the coordinates 0,0. The position directly
below 0,0 is 0,1. One position to the right of 0,1 is 1,1.

Within the {CHAR}, {INPUT}, {PROMPT}, (STATUS PROMPT}, and
{TEXT} commands, the coordinates that follow {A} must be entered as either
control characters or ASCII character equivalents. If you use control characters,
{AA} corresponds to coordinate 1, {AB} corresponds to coordinate 2, and so on.
If you use ASCII character equivalents, coordinate 1=©, 2=®, 3=v, and so on.

Refer to Conversion Chart. Alphabetic above and Appendix A: ASCII Conversion Chart
to translate all the row and column positions.

The first row and column of the screen are at position zero. Since there is no
letter of the alphabet for zero (A=I), the top row and left-most column are
inaccessible using the {AP}w? positioning feature with control characters. Also,
you cannot use the ASCII equivalent of 0 since this is a null character.

However, you can reach row 0 or column 0 using ASCII 254. For example, to
position at column 0, row 0, insert a prompt command ({CHAR}, {INPUT},
etc.), press Ctrl-P, then press Alt-254 twice.

Since there are only 26 letters of the alphabet (Z=26), to position a message
starting at a row or column position greater than 26 you must use the ASCII
equivalents.

To produce the menu shown at the beginning of this section, the command you
would enter in the macro would be the following:

{CHAR}3-{*Q}{Del to EOF)
{‘P}{'U}{Home}

g'PjCo Tabl wlease-select -document -type:

PH 'U}{Enter}

{*P}{ _u}{Del to EOL} -{"])1-<“\>-Report*
to EOP} «(*132. r\}-Letter*

P Memo ===

£ P USL N) Othere-

{*P}{UH 0>

{*P}{"A}{Right)Enter-Se€lection:a

Notice that this is all one fCHARj command. fAQj turns off all attributes (see Attribute
On/Off Characters above), fDel to EOPI clears the screen and positions the cursor at
the upper left corner. The first {APH"UHHome) positions the cursor at column 21, row 8
(U=21. H=8-see Conversion Chart, Alphabetic above). The rest of the line is simply
characters written to the screen as part of the message string. (You can enter these
characters like any other ASCII character. See Appendix A: ASCII Conversion Chart.)
When the next jAP) is encountered, the cursor is repositioned to the next row at the 21st
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column position. PP}(AA)(Right) positions the cursor at column 1, row 24 (the last row
on the screen) for the prompt. Finally, the tilde (~) ends the fCHARj command.

Using only ASCII equivalents, you would enter this to produce the screen:

{CHAR}3=(“Q){Del to EOP}

("P}so wleasee=selecte=documentstype:

{-P]8s

{"P)&d «{“1}1-{*\}-Report-
{“P)8Q «{“1}2.{"\}-Letter-
{'PIS* n{*]1}3.{*\}-Memo-me
{'P3s1 “{ IM -{ \}Other*=

{*P}oTEntereselection:*

Display On/Off, Effect on Messages

The messages of the {CHAR}, {INPUT}, {PROMPT}, (STATUS PROMPT),
and {TEXT} commands display on the screen whether Display is on or off (see
{DISPLAY ON} and (DISPLAY OFF} under Appendix K: Macros and Merge,
Programming Commands).

The message stays on the screen until the screen is rewritten. If Display is on,
the screen is rewritten very frequently (at each vertical cursor movement, change
of menu, etc.). If Display is off, the screen is not rewritten unless a {DISPLAY
ON} code is encountered and a subsequent action rewrites the screen.

However, when Display is off, a new message will overwrite a previous
message. If you use cursor positioning, only the part of the screen occupied by
the new message is overwritten. You can use this feature to create a stacking

effect with messages.

4. Othe



If you don’t want messages stacked, use the AL ({Del to EOP}) positioning
command to clear the screen, as in the example under Ctrl-P above. You can
also rewrite the screen to clear a previous message by pressing Screen,Screen
(Ctrl-F3,Ctrl-F3).

Even if Display is off in your macro, your document may still be visible under a
message, as in this example:

The two characters following Control P should be the
coordinates for the position on the screen. The
screen is divided into columns and rows. Each
position that can be occupied by a character <

screen has a column and coordinate. The column
coordinate is liste e row coordinate,
For example, the up Select type: rner of the screen
has the coordinates ion directly below
0.0 Is 0.1. One po 1. Screen ght of 0.1 is 1,1.
2. H Screen
Within the {CHAR}, 3. Page 3. {STATUS PROMPT},
and (TEXT] commands 4. = Page s that follow { P)
must be entered as 5. Ulus haractera or ASCI1
character oquivalen 6. Photo control characters,
{"A) corresponds to 7. Graph B) corresponds to
coordinate 2, and i 18 Menu e ASCII character

equivalents, coord: *«, and so on.

Refer to Conversion Chart. Alphabetic below and
Appendix A: ASCII Conversion Chart to translate all
the row and column positions.

The first row and column of the screen are at position
Enter Selection: 1

Using the AL ({Del to EOP}) positioning command in the {CFIAR}, {INPUT},
{PROMPT}, {STATUS PROMPT}, or {TEXT} command will also clear the
screen in this case.

If Display is on and you use cursor positioning for messages, a message may
remain on the screen when the macro has finished. (This may make it look like
the macro got “stuck.") You can cause the screen to rewrite by pressing Down
Arrow (1). However, if you put {PROMPT}{Del to EOP}~ (inserted using
Ctrl-L) somewhere after the last message command in the macro, the screen will
be clear when the macro finishes.

Reappearing {PROMPT) Messages

After executing a {CHAR} or (TEXT) command, WordPerfect restores the
contents of the status line, even if the contents are the message of a previously
executed {PROMPT} command. If you do not want a {PROMPT} message to
reappear after the {CHAR} or {TEXT} command, use {PROMPT}' before the
{CHAR} or {TEXT} command to clear the status line.

Reveal Codes, Effect on Messages

If Reveal Codes is on when you execute a macro using Ctrl-P cursor positioning
(see Ctrl-P above), the message may not display correctly. You can use the
following commands at the beginning of the macro to turn off Reveal Codes (if
it is on):

{ASSIGN}RevealCodes~~
{;}Clear RevealCodesvariable'
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{IF} (STATE}&512~
{;}If Reveal Codes on'

(Reveal Codes}
{;[Turn-RevealCodesofr

{ASSIGN}RevealCodes'was on'
{;} Set-flag’
(END IF}

If you want Reveal Codes turned back on when the macro finishes (if it was on
when the above codes were encountered by the macro), insert the following
commands at the end of the macro:

{IF}" {VARIABLE}RevealCodes"'="was-on"~

{}1f flagwasset(RC-was-turned-off)by-above-commands'

(Reveal Codes}

{;}Turn Reveal Codes back on’
(END IF}
If you frequently write macros where you need these commands, we recommend
that you save each set of commands as a separate macro and then use {NEST}
(see Appendix K: Macros and Merge, Programming Commands) to nest them in
macros that need them.

See Also: Macros; Macros, Define; Macros, Execute; Macros, Macro Editor;
Appendix A; Appendix I; Appendix J; Appendix K; Appendix L
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In WordPerfect, the left and right margins are measured from the left and right
edges of the page. They remain constant regardless of the font size you are
using. WordPerfect adjusts the text you type to fit within the current margins.
The default setting is for a 1" margin on each side of the page.

To change the left or right margin setting,
1 Press Format (Shift-F8), then select Line (1).
13 Select Line from the Layout menu.

2 Select Margins (7).

3 Enter a left margin measurement, then enter a right margin measurement (see
Measurements below).

4 Press Exit (F7) to return to your document.
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Codes

Changing the margins inserts a Left and Right Margin code [L/R Mar:###] into
your document where # represents the left margin and ## represents the right
margin. The code takes effect from that point in your document forward, until
you change the margins again. WordPerfect only changes the margins after the
Left and Right Margin code. Any text before the code uses the previous setting.

This makes it easy to change the margins at any point in the document. To
change the margins of existing text, follow steps 1 through 4 above to insert a
Left and Right Margin code immediately before the text.

If the cursor is not at the left margin when you change margins, a Hard Return
code [HRt] is inserted just before the new Left and Right Margin code and the
cursor moves to the left margin on the next full line of text.

In Reveal Codes (Alt-F3), the ruler across the center of the screen displays the left
margin as a left bracket ([) and the right margin as a right bracket (]). If a margin
falls on a tab setting, it is displayed as a left brace ({) or a right brace (}).

When you attempt to delete a Left and Right Margin code in the normal editing
screen, you are asked to confirm the deletion.

Initial Codes

If you want margin settings different from those that come with WordPerfect,
you can enter your own margin settings using Initial Codes in Setup

(Shift-F 1,4,5) (see Initial Codes in Reference). They will then be in place each
time you create a document.

Measurements
When entering a measurement, you can enter fractions (e.g., 1 1/2). The
measuremeiil you enter will be converted to @ decimal number in the current unit

of measure. For example, if inches are the current unit of measure, 1 1/2 is
converted to 1.5". The default unit of measure is selected in Units of Measure in
Setup (Shift-F 1,3,8) (see Units of Measure in Reference). WordPerfect allows
ten input characters for margins.

If you enter margins that overlap the current paper width, an error message is
displayed and you are given the chance to enter new settings (see steps 2 through
4 above).

You must make margin changes within WordPerfect. WordPerfect overrides any margin
settings you set on your printer.

Most laser printers have a minimum margin setting to allow for an unprintable
region. If you enter a margin setting that is less than the minimum margin
setting, WordPerfect resets the margins to equal the minimum margin setting.
For example, if your left unprintable region is .25" and you enter 0 for your left
margin setting, WordPerfect will set your left margin at .25".

See Also: Margins, Top and Bottom; Units of Measure
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MARGINS, TOP AND BOTTOM

In WordPerfect, the top and bottom margins are measured from the top and bottom
edges of the page. They remain constant regardless of the font or paper size you
are using. WordPerfect places the text on the page within the current margins.

The default setting is for a 1" margin at the top and bottom of the page.

To change the top or bottom margin setting,

1 Press Format (Shift-F8), then select Page (2).

(2B Select Page from the Layout menu.

2 Select Margins (5).

3 Enter a top margin measurement, then enter a bottom margin measurement.

4 Press Exit (F7) to return to your document.

Baseline Placement
Normally, text is never printed within the top or bottom margin of a page.
WordPerfect prints the first line of text immediately below the top margin.

You can have WordPerfect place the first line of text inside the top margin by
setting the Baseline Placement option on the Format: Printer Functions menu to
Yes (Shift-F8,4,6,5,y). WordPerfect will then print the first line of text within
the top margin, and place the baseline of that line on the top margin (see Printer
Functions in Reference). This measurement will not vary, regardless of the fonts
you use in that first line of text.

Codes

Changing the top and bottom margins inserts a Top and Bottom Margin code
[T/B Mar:###] into your document, where # represents the top margin and ##
represents the bottom margin. The code takes effect from that point in your
document forward, until you change the margins again. However, keep in mind
that a top and bottom margin code should always be placed at the top of a page,
with any codes used to format that page. Otherwise it does not take effect until
the next page.

Although the top and bottom margins are not displayed in the normal editing
screen, the top margin is always taken into account in calculating the position
number which is displayed on the right end of the status line (unless you are
using 4.2 units of measure). You can also view the current top and bottom
margins on-screen by using View Document to preview the printed page
(Shift-F7,6) (see View Document in Reference).

Headers, Footers, and Footnotes

WordPerfect does not print headers, footers, and footnotes within the top and
bottom margins of a page. It places headers immediately below the top margin.
It places footers and footnotes immediately above the bottom margin.
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Measurements

When entering a measurement, you can enter fractions (e.g., 1 1/2). The
measurement you enter will be converted to a decimal number in the current
default measurement, as selected in Units of Measure in Setup (Shift-F1,3,8) (see
Units of Measure in Reference). WordPerfect allows ten input characters for
margins.

If the measurements that you enter are greater than the overall length of the
page, they will return to the default settings.

You must make margin changes within WordPerfect. WordPerfect overrides any margin
settings you set on your printer.

Most laser printers have a minimum margin setting to allow for an unprintable
region. If you enter a margin setting that is less than the minimum margin
setting, WordPerfect resets the margins to equal the minimum margin setting.
For example, if your top unprintable region is .25" and you enter 0 for your top
margin setting, WordPerfect will set your top margin at .25".

Text Adjustment

If you find that text on the printed page is not located where you expect it
should be (according to the margins you have set), you may need to change your
text adjustment. See Text Adjustment under Paper Size/Type in Reference for
more information.

Note that your top margin setting should not be smaller than your text adjustment. If it
is, text at the top of the page may be overprinted.

See Also: Line Height; Margins, Left and Right; Printer Functions

A master document is a WordPerfect document that contains one or more
subdocuments as well as intermixed text and codes. Subdocuments are other
WordPerfect documents.

For example, a master document could be a book with several chapters. Each
chapter could be a subdocument that exists as an individual file.

The benefit of using a master document is that it is very manageable and easy to
edit. This is because the subdocuments can easily be removed from or retrieved
to the master document. This lets you edit your individual subdocument files
without having to scroll through a very large document to do so. It also lets you
easily combine several subdocuments to create, among other things, a table of
contents, a list, or an index for a large document.

Subdocuments can be easily retrieved or removed from a master document
because the master document contains subdocument links. These links, which
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you insert in a master document, are used to tell WordPerfect where a
subdocument should be located in the master document. When you are ready to
retrieve the subdocuments to the link locations, you can expand the master
document. When you want to remove the subdocuments from the link locations,
you can condense the master document.

Subdocument links are represented on the screen as comments. In the screen
below, you can see two subdocument links.

Subdoc: C :\MAYREPRT

£V Subdoc: C:\MAYCHART

These links tell you and WordPerfect the name of the file that is to be retrieved
to the link location. You can see the filename after the “Subdoc:” heading.

The process of creating a master document is as simple as typing text and
inserting codes as you would in a normal document, then inserting the links
where you want to include subdocuments.

To insert a subdocument link,
1 Move the cursor to where you want to insert the link.

You may want to insert a hard page break before the location of the
subdocument link to make sure that the subdocument starts on a separate page.
WordPerfect will not insert a hard page break for you when you expand the
master document.

2 Press Mark Text (Alt-F5), then select Subdocument (2).
CB Select Subdocument from the Murk menu.

3 Enter the filename (include the pathname if necessary) of the subdocument
you want to link to.

WordPerfect will let you enter a filename to a subdocument that does not yet
exist. If the subdocument does not exist when you expand the master document,
however, WordPerfect will display a prompt that tells you that subdocument does
not exist (see Expanding a Master Document below).



Notes

You can create as many subdocument links as you like in a master document.
You can also save the master document, give it a filename, and use it as a
subdocument in other master documents.

Codes

One of the best things about using a master document is that codes in the master
document function just like codes in a normal WordPerfect document. In other
words, a code remains in effect until it is replaced by another code of the same

type.

For example, if you set a code such as a margin setting anywhere in a master
document, including in the subdocuments, that code remains in effect until
WordPerfect reaches the next code of the same type. The same holds true for
any type of numbering (e.g., page numbering, footnote numbering, line
numbering) that you may have in your document.

One thing you should realize, however, is that a master document must be
expanded for any of the subdocument codes to take effect.

Condensing a Master Document

Condensing a master document removes the subdocuments from the master
document. It does not remove the links to the subdocuments, just the
subdocuments themselves. |If a master document is not expanded, it does not
need to be condensed.

To condense a master document, press Mark Text (Alt-F5), select Generate (6),
then select Condense Master Document (4).

When a master document is condensed, you are given the opportunity to save
any editing changes you may have made to the subdocuments while they were in
the master document. When WordPerfect displays the “Save Subdocs?" message
on the status line, type y to save the subdocuments or type n to continue
condensing the document without saving the subdocuments.

If you type y, WordPerfect displays the "Replace filename” message, then gives
you three choices. Yes (1) tells WordPerfect to replace the old subdocument
with the newly edited subdocument, No (2) lets you enter a new filename for the
newly edited subdocument, and Replace All Remaining (3) tells WordPerfect to
replace the old subdocument with the newly edited subdocument and to do the
same for the rest of the subdocuments in the master document.

If a subdocument by the same name as the subdocument you are saving doesn 't exist,
WordPerfect saves the newly edited subdocument without further prompt.

Cross-References, Tables, Lists, and Indexes

A master document is especially useful for generating cross-references, endnotes,
indexes, lists, tables of contents, and tables of authorities for a document. As
long as the proper codes for those features are located in the master document,
the Generate feature (Alt-F5,6,5) will work as it does in a normal document.
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For most of the features listed in the paragraph above, you should mark the
entries in the subdocuments. Then, you should include the definition code in the
master document. For example, if you are compiling an index, you should mark
the index entries in the subdocuments. Then, you should move to the bottom of
the master document, insert a hard page break, and insert an Index Definition
code.

If you are generating a condensed master document, WordPerfect expands the
document during generation, then condenses the document after generation.
During the generation, WordPerfect prompts you with the “Update Subdocs?”
message. Type n to delete the subdocuments without saving them, or type y to
save all subdocuments before deleting them from the master document.

As mentioned in Codes above, numbering in a master document functions just as
it does in a normal document. Unless WordPerfect encounters a code calling for
a numbering change somewhere in the master document (including the
subdocuments), numbering starts at one and continues throughout the document.
If WordPerfect does encounter a code calling for a numbering change, it changes
numbering at that point, then continues from the specified number.

Unless you have a hard page break at the top of your subdocuments (a rare
occurrence), you should insert a hard page break (Ctrl-Enter) before the link to
the subdocument. Otherwise, WordPerfect will not start the subdocument on a
separate page.

Expanding a Master Document

Expanding a master document retrieves the subdocuments to the master
document. If you plan to print a master document, you must expand the
document. If you don’t expand the master document, the condensed version is
printed.

When a master document is expanded, subdocuments are formatted for the
currently selected printer. This means that if the subdocuments were saved with
a different printer definition, fonts and other printer-specific formatting changes
may not appear as they did in the subdocument.

To expand a master document, press Mark Text (Alt-F5), select Generate (6),
then select Expand Master Document (3).

As the master document is being expanded, prompts appear on the status line
letting you know which subdocuments are being expanded. If a subdocument
doesn't exist, WordPerfect displays the “Subdoc Not Found (Press Enter to
Skip)” message along with the filename of the subdocument that doesn’t exist.
You can press Enter to have WordPerfect skip over that subdocument and
continue, or you can re-enter the filename.

When the master document is expanded, the “Subdoc: filename” comments are
replaced with a “Subdoc Start: filename” comment at the beginning of the
subdocument and a “Subdoc End: filename” comment at the end of the
subdocument. These comments let you know which text in the master document
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is in a subdocument. Like all WordPerfect comments, these comments are not
printed.

You can edit any text in a master document, including text in a subdocument. If
you save or condense the document, WordPerfect will give you the opportunity
to save the editing changes in the subdocuments (see Condensing a Master
Document above and Saving a Master Document below).

Saving a Master Document
You can save a master document just as you can any other document. This
includes saving a document with either the Save or Exit features.

If you are saving an expanded master document, however, WordPerfect displays
the “Document is Expanded, Condense it?” prompt. If you type n, WordPerfect
will save the document in its expanded form and will not display this prompt on
subsequent saves. If you type y, WordPerfect begins to condense the master
document.

As WordPerfect begins to condense the master document, it gives you the
opportunity to save any editing changes you may have made to the
subdocuments while they were in the master document. This process is
described under Condensing a Master Document above.

See Also: Cross-Reference; Generate; Index; Lists; Table of Authorities; Table
of Contents

There are two ways to perform fundamental math calculations in a document:
Tables and Math. The Tables feature approaches math operations much like a
spreadsheet program, and may be easier for those familiar with such programs.
The Math feature takes a different approach to math operations which avoids the
formatting of Table lines and boxes.

If you have not used the Math features in WordPerfect, we recommend that you
try Tables math first (see Table, Math in Reference).
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The Math feature uses tab stops to designate columns. Both numbers and text
can be typed into columns, and numbers can be calculated down or across
columns.

The simplest way to use Math is to calculate subtotals, totals, and grand totals
down the tab columns. This process eliminates the need to define Math columns
(step 2 below). The headings under Notes below guide you through the process
of performing such fundamental math calculations (down columns).

If you want to use Math for more sophisticated applications, the instructions
under Notes refer you to three other sections in Reference: Math, Define
Columns; Math—Row Titles, Numbers, and Functions; and Math, Formulas.

There are six basic steps to creating a math document. For details on each step,
see the individual headings under Notes below.

1 Move the cursor to where you want to use Math, then set a tab stop for each
math column (see Tab Set in Reference for details).

2 Define the math columns (Alt-F7,3,3)—only if you need to do more than just
calculate down columns.

Turn on Math (Alt-F7,3,1).

Enter row titles, numbers, functions, and formulas into the math document.

w

Calculate the operators, functions, and formulas in the math document.
Turn off Math (Alt-F7,3,2).

o o1 b

The following headings are listed in the order they should be performed (in most
cases) when using Math, rather than alphabetically as in other sections.



Set Tab Stops
You designate math columns by setting tab stops. You can use the default tab
stops, but they will likely provide too narrow of columns.

You can adjust the space between columns by resetting the tab stops
(Shift-F8,1,8). If the numbers in one column overlap into the next column, the
calculations will not be correct, and you will need to reset the tab stops to make
more room (see Tab Set in Reference).

Please note that it is the tab stops that represent columns in Math—not the space
between tab stops. When you insert numbers into most math columns, they are
aligned at the tab stops. Numbers are preset to align on a decimal character (see
Other Format in Reference).

Both absolute and relative tabs work with Math.

Since numbers align at the tab stops, the space between the left margin and the
first tab stop is not counted as a math column. It can be used for row titles or
any text that labels the math document.

Define the Math Columns

There are four types of Math columns: Text, Numeric, Total, and Calculation.
All Math columns are preset to be numeric. In numeric columns, you can type
numbers and then calculate subtotals, totals, and grand totals down the columns.
If that is all you need, you can skip Define the Math Columns and proceed to
Turn On Math below.

If your needs are more sophisticated (e.g., calculating across columns), you will
need to display the Math Definition menu by pressing Columns/Table (Alt-F7),
selecting Math (3), then selecting Define (3).

From the Math Definition menu, you can change numeric columns into text.
total, and calculation columns. For details, see Math. Define Columns in
Reference.

To exit the Math Definition menu, press Exit (F7).

Turn On Math

When you define Math columns from the Math Definition menu, you are
returned to the Math menu. From the Math menu you can turn on Math by
selecting On (1).

If you do not need to define your Math columns, you can use the following steps
to turn on Math. These steps also apply if you are using Math in multiple
locations in a document (with the same definition) and want to turn on Math at
any of those locations.

1 Move the cursor to the place in the document where you want Math to start
(if you defined math columns, the cursor should be positioned after the Math
Definition code).
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2 Press Columns/Table (Alt-F7), select Math (3), then select On (1).
CB Select Math from the Layout menu, then select On.

Turning on the Math feature inserts [Math On] into the Reveal Codes screen at
the cursor position. Whenever the cursor moves to the right of the code, the
message “Math" appears at the bottom left of the screen.

Enter Row Titles, Numbers, Functions

Since the space between the left margin and the first tab stop is not used by the
Math feature, you can type any row titles or labels using this space. Once you
have typed a title or label, press Tab to move to the first column. Unless you
have changed it, the first column is a numeric column, and you can type a
number into it. In numeric columns, numbers shift left until you type the
alignment character (usually a decimal point), and then they allow normal entry
to the right (see Other Format in Reference). For decimal numbers, WordPerfect
will calculate up to four digits to the right of the decimal.

Once you have typed a number, press Tab again to move to the next Math
column, then type another number. Repeat this process until your first row of
numbers is complete. Then press Enter to move to the next line where you can
begin inserting the next row of information.

When you reach the bottom of a column of numbers, you can type afunction
instead of a number to designate where a calculation should occur. Functions
are abbreviated formulas. They tell WordPerfect what to do with a column of
numbers. For simple calculations type any of the following functions (just type
the character +. =, or *) to perform the following calculations:

+ Subtotals numbers above it.
Totals all subtotals above it.
Gives a grand total of all totals above it.

* 1l

When you type the function, the character appears on the screen (+, =, *), but a
code is inserted into the Reveal Codes screen (e.g., [+]). The result of the
function does not appear until you calculate the Math document. The function
characters appear on the screen but do not print.

The Math feature includes several other functions in addition to those mentioned
above and allows for more sophisticated calculations and formatting. For details,
see Math—Row Titles. Numbers, and Functions in Reference.

Calculate
When you finish creating the math document, you are ready to calculate the
results.

1 Press Columns/Table (Alt-F7), select Math (3), then select Calculate (4).
CB Select Mathfrom the Layout menu, then select Calculate.

Any function characters you have entered in the document now display the
appropriate calculation results.



If numbers overlap into other columns, calculations may not be accurate, and you

will need to reset your tab stops to allow more space, and then calculate again
(see Tab Set in Reference).

If you have more than one math section in a document, WordPerfect starts at the
cursor position and searches backward for the closest math section and calculates
it. 1f no math section is found in the backward search, then WordPerfect
searches forward from the cursor and calculates the closest math section in that
direction. You need to calculate each section separately.

Turn Off Math
When you finish working on a math section of the document, you can return to
regular WordPerfect editing by turning off Math.

1 Move the cursor to the end of the math section of the document.
2 Press Columns/Table (Alt-F7), select Math (3), then select Off (2).

O3 select Math from the Layout menu, then select Off.

[Math Off] is inserted into the Reveal Codes screen at the cursor position.
[Math On] and [Math Off] codes define the limits of the math section of a
document. When you move the cursor to the right of [Math Off], the “Math”
message disappears from your screen.

By turning on and off Math at different locations, you can have multiple math
sections in a document. You can also create distinct math definitions at different
locations in a document by moving the cursor to a new position, then defining
math columns (see Math, Define Columns in Reference).

If an entire document includes only math, you do not have to turn off Math.

See Also: Math, Define Columns; Math, Formulas; Math—Row Titles,
Numbers, and Functions

Math, Define Columns

Once you have set the tab stops for the columns you want to use in Math, you
are ready to define the Math columns. If you only want to add numbers down a
math column (or if you have previously defined math columns in your document
and want to use the same definition again), you can skip this step and turn on
Math to start using the feature (see Math in Reference). You can define each
column to be one of four different types (see Types of Columns below), and you
can specify the way numbers will be displayed.
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To define math columns,

1 Press Columns/Table (Alt-F7), select Math (3), then select Define (3) to
display the Math Definition menu.

[3 Select Math from the Layout menu, then select Define.

2 Move through the Math Definition menu with the arrow keys, then edit any
of the column settings you want changed (see the headings under Notes
below).

3 Press Exit (F7) to save the definition and return to the Columns/Table menu.

[Math Defj is inserted into the Reveal Codes screen at the cursor position. If
you want these changes to affect your math section, the cursor must be
positioned after [Math Def] when you turn on Math.

Calculation Formulas

If you define a calculation column, you can enter a formula which will be used
to calculate numbers across columns. You can define up to four calculation
columns per Math definition.

For information on calculation formulas, see Math, Formulas in Reference.

Decimal/Align Character/Thousands’ Separator

Though not listed on the Math Definition menu, the Decimal/Align
Character/Thousands’ Separator feature also affects the way math results are
displayed.

The deciinal/align character is the character that is used to separate decimal
fractions from whole numbers and is preset to a period (.). The thousands'
separator character is the character used to separate hundreds from thousands and
is preset to a comma (,).

To change these settings,

1 Move the cursor to the place where you want to change the settings (usually
before the Math Definition code).

2 Press Format (Shift-F8), then select Other (4).
QO select Other from the Layout menu.
3 Select Decimal/Align Character/Thousands’ Separator (3).

4 Type a decimal character or press Enter, then type a thousands’ separator
character or press Enter.

5 Press Exit (F7) to return to the document.

The settings change from that point forward in the document. The decimal
character also serves as the alignment character in number, total, and calculation
columns (see Other Format in Reference).



Ifyou are using an international version of WordPerfect, you can use a period (.) as the
decimal/align character regardless of the primary decimal/align character of the package
language. However, you cannot use a period (.) as the decimal/align character when you
are using the Math feature, where both the decimal/align character and the thousands’
separator are used together. (This applies to international versions only.)

Math Definition Menu

The Math Definition menu includes 24 columns (A through X), all of which are
available for performing math operations. Column A is at the first tab stop to
the right of the margin; column B is at the second tab stop to the right, etc.

Math Definition Use arrow keys to position cursor

Columns ABCDEFGHIJKLMNOPORSTUVWX
Type 222222222222222222222222
e wmers <(CCCCCCCSCOS<CCC<<((C
Number of Digits to 222222222222222222222222

the Right (0-4)

Calculation 1
Formulas 2
3

Type of Column:
0 - Calculation 1 - Text 2 = Numeric 3 = Total

Negative Numbers
( - Parentheses (50.00) - - Minus Sign -50.00

Press Exit when done

To change the definition of a column, move the cursor underneath the column
letter using Left Arrow (<-) or Right Arrow (->), then select the number

corresponding to the column type you want (0-3). If you select Calculation (0),
the cursor moves to a calculation formula line where you can enter the formula

to be used in the calculation column (see Math, Formulas in Reference).

With the cursor directly under a column letter, you can also press Down Arrow
(i) once and change the way negative numbers will be displayed in results by
typing ( or - (see Negative Numbers below). Press Down Arrow again, and you
can change the number of digits that will be displayed to the right of the decimal
in results by typing a number (see Number of Digits to the Right below).

Negative Numbers

You can choose how you want WordPerfect to display negative results by typing
( for parentheses or - for the minus sign in the Math Definition menu. The
default setting for displaying negative numbers is with parentheses.

Number of Digits to the Right

You can choose how many digits (up to 4) you want WordPerfect to display to
the right of the decimal character (in calculated results) by entering a number
from 0 to 4 in the Math Definition menu. WordPerfect rounds a trailing digit up
if it is greater than or equal to 5.
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Types of Columns
There are four types of column definitions available in the Math Definition
menu. The initial setting for each column is numeric.

Math Definition Use arrow keys to position cursor
Columns ABCDEFGHIJKLMNOPQRSTUVWX
Type 230222222222222222222222
Negative Numbers e r
Numtier of Digits to 222222222222222222222222
the Right (0-4)
Calculation 1 C 05*A
Formulas 2

Type of Column:

0 = Calculation 1 - Text 2 - Numeric 3 - Total
Negative Numbers
( - Parentheses (50.00) - - Minus Sign -50.00
Press Exit when done
Calculation

Select this type when you want to create and calculate a formula using the
four Math operators. These formulas are calculated across columns and can
use numbers from the same row (see Math, Formulas in Reference).

Numeric

Select this type when you want to add positive and negative numbers down a
column to create subtotals, totals, and grand totals. All columns are preset to
numeric unless you define them otherwise.

Text
Select this type when you want to include descriptions, row titles or labels,
etc., in a column of your math document.

Total
Select this type when you want to display only the totals from the column to
the left.

See Also: Math; Math, Formulas; Math—Row Titles, Numbers, and Functions

If you are using the Math feature, you can use math operators, numbers, and
column letters to create formulas. Formulas are useful if you want to do more
than just add positive and negative numbers down a column. Formulas calculate
results across columns.
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You can also create formulas if you are using the Tables feature (see Table,
Math in Reference).
This section is devoted to a description of formulas used with the Math feature.

The steps below indicate how to insert formulas into a document. For
instruction on creating formulas, see Creating Formulas below.

Formulas can only be inserted into calculation columns. You can define up to
four calculation columns in your math definition. When you define a calculation
column, you must also define the formula to be used in that column.

The following steps show you how to enter a formula starting from the normal
editing screen. If you are already at the Math Definition menu, skip to step 3
below.

1 If you have already turned on Math, move the cursor immediately to the left
of the [Math On] code (in the Reveal Codes screen).

or

Move the cursor to where you want the math definition inserted into the
document.

2 Press Columns/Table (Alt-F7), select Math (3), then select Define (3).

CB Select Math from the Layout menu, then select Define.

3 Move the cursor directly below the letter of the column you want to define
as a calculation column.

Each column has a letter associated with it. The first tab stop is column A. the second is
column B, etc.

4 Select Calculation (0) to define the column as a calculation column.
5 Enter the formula you want calculated for the column.

6 Press Exit (F7) twice to return to the normal editing screen.

You can create up to four formulas for each Math section in a document (one
per calculation column).

As you press Tab to move into a calculation column, an exclamation mark (1)
appears on the screen, and a [!] code is inserted into the Reveal Codes screen.
This is a symbol inserted by WordPerfect indicating that the formula for the
column will be calculated on the current line. Delete the “!” if you do not want
WordPerfect to calculate the formula for that line.

Calculating Formulas

To calculate formulas, press Columns/Table (Alt-F7), select Math (3), then
select Calculate (4). WordPerfect calculates the formula across the columns of
your math document.

MATH, FORMULAS 409



410

MATH. FORMULAS

Calculation Order
When there are two or more operators, they are calculated from left to right.

Formulas Result
2*3-1/2 2.5
2-3*1/2 (.50)

In the first example, 2*3=6, 6-1=5, and 5/2=2.5. In the second example, 2-3=-
1-*1=-1, and -1/2=-5.

If you want to change the order of calculation, use parentheses. The operator(s)
in parentheses are calculated first.

formula Result

2*(3-1)/2 2.00
In this example, 3-1=2 is calculated first, then 2*2=4, and 4/2=2.

You can nest parentheses within parentheses up to seven levels—for example,
2*((a-1)/2)+b.

Great ng Formulas

Once you have selected a calculation column from the Math Definition menu
(see the steps above), you can create a formula for the designated column using
operators, numbers, and math column letters, or you can use four special
functions.

There are four operators you can use to create a formula.

+ Add
Subtract
Multiply

/ Divide

You use these operators in combination with numbers and the math column
letters to create a formula. For example:

Formula Result
2*3-1 5.00
2*3-A 6.00-the number in column A



In the second example, the number in column A (on the same line as the
formula) is subtracted from 6.00.

The formula might appear as follows:

A FORMULA
Math Definition Use arrou keys to position cursor
Columns ABCDEFGHIJKLMNOPQRSTUVWX
Type 202222222222222222222222
Negative Nunbers (<((=<(<=<<< (<< C==(1
Number of Digits to 222222222222222222222222
the Right (0-4)
2%3-A 4~

Type of Column:

0 =calculation 1 - Text 2 * Numeric 3 = Total
Negative Numbers

( - Parentheses (50-00) - = Minus Sign -50.00

Press Exit when dune

A formula can use numbers from the left and right of the formula (on the same
row).

If you use decimal numbers in a formula, WordPerfect will calculate up to 4
digits to the right of the decimal.

When you want to indicate anegative number in a formula, use a minus sign.
Formula Result

—2*3-1/2 (3.50)
-2*3-A (b.00)-the number in columnA

Results displayed in parentheses are negative numbers. You can change the way
WordPerfect displays negative numbers by changing the math definition (see
Math, Define Columns in Reference).

There are also four special functions you can use while defining a formula in

Math:
+ Add numbers across numeric columns.
+/ Average numbers across numeric columns.
= Add numbers across totals columns.
=/ Average numbers across totals columns.

These functions cannot be combined or used with other functions, operators, or
numbers.

Editing Formulas

If you want to edit a formula, you must first move the cursor immediately to the
right of the [Math Def] code you want to edit (in the Reveal Codes screen).
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Then, display the Math Definition menu (Alt-F7,3,3), move the cursor directly
below the column you want to edit, type 0, make any changes, and press Enter.
Pressing Enter without making any changes erases the formula.

Fractions
When you want to use a fraction in a formula, place it in parentheses or use its
decimal equivalent (e.g., (1/2), .5).

See Also: Math; Math, Define Columns; Math—Row Titles, Numbers, and
Functions

Numbers, and Functions

The Math feature (not Tables math) lets you define four math column types:
Text, Numeric, Total, and Calculation. Each type is designed for entering row
titles, numbers, functions, and/or formulas. Row titles can only be entered in
text columns; functions can only be entered in numeric, total, or calculation
columns. Numbers can be entered in all four types of columns but are not
calculated when entered in text columns. And formulas can only be entered in
calcu ation columns (for details on formulas, see Math, Formulas in Reference).

If you want column titles, you should enter them before turning on Math (see
Math in Reference).

Functions

A function is a symbol that determines the way WordPerfect calculates numbers.
In numeric, calculation, or total columns, you can use one of six functions (+, =,
* 1, T, and N). You can also use four special functions when creating a formula
(see Math, Formulas in Reference).

A calculated answer is called a result. Results do not appear until they are
calculated (see Math in Reference).

Functions used in numeric and calculation columns calculate numbers above
them, within the same column. Functions used in totals columns calculate
numbers in the column to the left above them.
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Z5 NUMERIC COLUMN
<= SUBTOTAL

A NUMERIC COLUMN
A TOTALS COLUMN
A ToTAL

When you type a plus sign (+) as the function, the numbers above the function
(the column to the left if a totals column) will be added when you calculate.

The result is a subtotal.

Monthly Revenues -- February
Item Revenues Year to Date Sales Tax
Appliances
Stereos 3510.00 175.50!1-
Televisions 5300.00 265.00!
Total 8.810.00+<j3
Art
Paintings 3060.00 153.00!
Sculptures 1450.00 72.50!
Total 4,510.00+
Lamps
Small 5000.00 250.00!
Large 3500.00 175.00!
Total 8,500.00+
February Total 21,820.00- 1,091.00+
January Total T22,230.00 t1,023.00
Year to Date 44,050.00* 2,114.00=
Math

Status

up
Up

Up

Up

Doc 1 Pg 1 Ln 4

When you type an equal sign (=) as the function, only the subtotals above the
function are added (the column to the left if a totals column). The result is a

total.
Monthly Revenues - February
Item Revenues Year to Date Sales Tax
Appliances
Stereos 3510.00 175.50!
5300.00 265.00!
Total B.810.00+
Paintings 3060.00 153.00!
Sculptures 1450.00 72.50!
Total 4,510.00+
Lamps
small 5000.00 250.00!
3500.00 175.00!
Total 8,500.00+
February Total 21,820.00- -3  1,091.00+
January Total T22,230.00 ~ t1,023.00
Year to Date 44,050.00* 2,114.00=

Math

Status
Up
Up
Up

Y
Dg—n

Up

Doc 1 Pg 1Ln 4
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NUMERIC COLUMN
TOTALS COLUMN
CALCULATION COLUMN
GRAND TOTAL

>>>>

A suBTOTAL
A TOTAL

When you type an asterisk (*) as the function, only the totals above the function
are added (the column to the left if a totals column). The result is a grand total.

Monthly Revenues -- February
Item Revenues Year to Date Sales Tax Status
Appl: ances y V y
Stereos 3540.00 175.50! Up
Te.evisions 5300.00 265.00! Up
Total 8,810.00*
Art
Padntings 3060.00 153.00! Down
Seelptures 1450.00 72.50! Up
Total 4.51U.no=
Lamps
Smell 5000.00 250.00! Up
Large 3500.00 175.00! Down
Total 8,500-00*
February Total 21,820.00- 1,091.00* Up
January Total T22,230.00 t1,023.00
N
Year to Date 44.050.00* 2,114.00=
Math Doc 1 Pg 1 Ln 4.

Two additional functions let you insert your own subtotals and totals into a
column. Type tin front of a number you want to be calculated as a subtotal and
T in front of a number you want calculated as a total.

Monthly Revenues

Item Revenues Year to Date Sales Tax Status
Appli ances
Steceos 3510.00 175.501 Up
Telavisions 5300.00 265.00! up
b,ela.oo*
Art
Paintings ° o 153.00! Down
Scu .ptures a o 72.501 Up
A
Lamps
Sma-. 1 5000.00 250.00! Up
Large 3500.00 175.00! Okwn
Votal 8,500.00*
February Total 21.820.00- 1,091.00* Up
Janusiy Total T22,230.00 cl,023.00
Year to Date 44,050.00* 2,114.00= ~
Math Doc 1 Pg 1 Ln 4.

When you type N in front of a number, the number is negative when calculated.
N can be combined with other functions. It is especially useful in a Net Worth
situation where assets and liabilities are both added up as positive numbers, and
then liabilities are subtracted from assets.

For functions to work correctly, they should be entered in the order below (top
to bottom).

+t (Subtotal, Extra Subtotal)
f’T (Total, Extra Total)
(Grand Total)
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Functions and results both appear on the screen, but the function characters (e.g.,
+, =, T) are not printed when the document is sent to the printer. The functions
appear as codes in the Reveal Codes screen (e.g., [+]).

Numbers

Numbers can be entered in any column, but are not calculated when entered in a
text column. They can be positive or negative. If you want to indicate a
negative number, you can use a minus sign or parentheses (e.g., -3.45, (3.45)).

The Negative Number option on the Math Definition menu indicates how you
want WordPerfect to display negative results. You can enter a negative number
with the minus sign or parentheses regardless of the negative number setting.

Numbers are preset to align on tab stops at the decimal point. You can change
the tab stops or the character preset for decimal alignment (.) to change the way
numbers align (see Tab Set or Other Format in Reference).

Row Titles

Row titles can be entered in text columns only. The space between the left
margin and the first tab stop is not considered a math column and can be used
for row titles that label the rows in the math document.

If you want column titles, you should create them outside of the math document
(before the [Math On] code).

See Also: Math; Math, Define Columns; Math, Formulas

When running, WordPerfect requires that memory be used to store information.
The document(s) being edited, the program file, and several other files must be
in memory in order for WordPerfect to operate.

There are two types of memory WordPerfect can use—conventional memory
(known as RAM or cache) and expanded memory. All computers have
conventional memory, but not all computers have expanded memory. Unless
you specify otherwise, WordPerfect first uses all available conventional memory,
then available expanded memory. When no more memory is available,
additional information is stored on disk.

Many people want to run other programs at the same time as they run
WordPerfect. Since WordPerfect uses all available conventional memory, no
memory is available for other programs. However, if your computer is equipped
with expanded memory, you can use the /w=cm,em startup option to limit the
amount of conventional memory and increase the amount of expanded memory
WordPerfect uses, providing conventional memory space for other programs.

See Appendix N: Startup Options for more information on this option.
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If you have expanded memory but do not want WordPerfect to use it, use the /ne
starti.p option (see Appendix N: Startup Options).

For additional information on expanded memory, see Expanded Memory below.

it Startup Option

If you have at least 592K of unused expanded memory (LIM Spec 3.2 or 4.0),
the WP.FIL file portion of the WordPerfect program can be loaded into memory
by starting WordPerfect with the /r and /w startup options (e.g., wp/w=>**/r).
The Iw=** instructs WordPerfect to use all available conventional memory and
expanded memory, while the /r sends the WP.FIL portion to expanded memory
(see Appendix N: Startup Options).

Expanded Memory

Expanded memory is treated as an extension to conventional memory. The
maximum amount of expanded memory WordPerfect can use is 16M. The
following WordPerfect features and modules can use expanded memory if there
is sufficient expanded memory available: File caching, Generate, Hyphenation,
overflow (virtual) files, Printing Graphics, Spell, and View Document. However,
only L.IM expanded memory versions 3.2 or 4.0 are supported. If you have a
version previous to 3.2 installed on your system, expanded memory is ignored.
For more information, see /32 in Appendix N: Startup Options.

Ifyou are running WordPerfect under Shell (an optional program by WordPerfect
Corporation), 50% of the available expanded memory is used by WordPerfect, when
needed. If not, nearly 90% of available expanded memory can be used by WordPerfect.

Extended Memory
WordPerfect does not use or support extended memory.

Freeing Up Memory
If you frequently receive the “Not enough memory” error message, try one or
more cf the following to free up some memory:

* Remove any Terminate and Stay Resident (TSR) programs, including Shell
(an optional WordPerfect Corporation product).

e If you are running WordPerfect on a 286 or 386 machine, use a memory
remapping program (like QEMM) to make more conventional memory
available.

e If you have a soft keyboard selected, deselect it (press Ctrl-6) (see Keyboard
Layout in Reference).

e Turn off Hyphenation, or select Internal Rules as the hyphenation type (see
Hyphenation in Reference).

« While editing a document, have a printer selected that uses a .PRS file that
has a limited number of fonts (see Printer, Select in Reference).



e Do not print in the background (see Printing—General Information in
Reference).

« Use fewer graphics boxes in your document (see Graphics, Define a Box in
Reference).

e Use only Document 1 while editing (see Switch in Reference). This will also
increase the speed of generating, sorting, or printing from disk.

WordPerfect has a startup option. M2, that disables the Document 2 screen to save
memory <see Appendix N: Startup Options).

« Rather than executing one large macro, chain or nest several small macros
together (see Chaining, Nesting, and Substituting under Notes in Appendix K:
Macros and Merge, Programming Commands). The series of small macros
will execute faster than a large one.

« Don’t select a mouse type in Setup (see Mouse Type in Reference).

e Use the default drivers for text and graphics (see Text Screen Type and
Graphics Screen Type in Reference).

e Use WPSMALL.DRS rather than WP.DRS for editing equations (see
Appendix Q: WordPerfect Files). To do so, rename or delete WP.DRS.
Then make sure WPSMALL.DRS s in the graphic files directory specified
in Location of Files (Shift-F 1,6), or if no directory is specified in Location of
Files, make sure it is in the directory where WP.EXE is located.

e If you used the /w startup option (see Appendix N: Startup Options), restart
WordPerfect and increase the workspace specified in the /w option.

¢ Reduce the FILES= and/or BUFFERS= commands in your CONFIG.SYS file
(see your DOS manual). Flowever, do not reduce FILES= to less than 20.
« Exit WordPerfect and start it again.

e See your dealer about increasing the memory in your computer.

Memory Requirements
WordPerfect requires 384K of the available conventional memory in your
computer to run WordPerfect.

Overflow Files

The part of the document which does not fit into memory is spilled into
“overflow” files on disk until all available disk space is used. This means that
you can increase potential editing space by increasing memory and/or disk space.

The overflow files are named WPI}WP(.TV1 for overflow above the cursor in
Document 1 and WP}WP{.BV1 for overflow below the cursor in Document 1
The overflow files for Document 2 are WP}WP{.TV2 and WP}WP{.BV2.

Unless otherwise specified, overflow files are directed to the directory where
WP.EXE is located. The overflow files can be directed into a different
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drive'directory by entering wp/d-drive\directory when you start WordPerfect (see
Appendix N: Startup Options) or by using the SET command. These commands
can be included in an AUTOEXEC.BAT file.

If you do not have a hard disk, you can redirect the overflow files to another
drive (RAM, drive B, etc.) with the /d option (see Appendix N: Startup Options).

FIAM Drives

There is little to be gained by using a RAM drive with WordPerfect. If you
must have a RAM drive, direct the overflow files, Speller, or Thesaurus to that
drive (depending on how much room you have), thereby utilizing memory that is
otherwise lost to WordPerfect. If you do load the Speller or Thesaurus into a
RAM drive, you must inform WordPerfect of its location through the Location of
Files feature (see Location of Files in Reference).

See Also: Appendix N

You can select an option from most WordPerfect menus with a number, a
mnemonic letter, or by clicking on it with a mouse. The Menu Options feature
lets you change the appearance of WordPerfect menus to make option selection
easier.

For example, you can make your mnemonic letters “stand out” by assigning
them c.n attribute.

1 Press Setup (Shift-Fl).
CEi

Select Setup from the File menu.
2 Seect Display (2), then select Menu Options (4).

3 Select the menu option of your choice (see the option headings under Notes
below).

4 Select Size (1) or Appearance (2), then select the attribute of your choice.
or
Select Normal (3) to have the option appear as normal text.

Ifyou are changing the setting for Alt Key Selects Pull-Down Menu (4) Menu Bar
Separator Line (7), or Menu Bar Remains Visible (8). the only choices arey for Yes and
» for No.

5 Press Exit (F7) until you return to the normal editing screen.

Settings for all of these options are stored in the WP{WP].SET file and remain
in effect each time you start WordPerfect.



Notes

Alt Key Selects Pull-Down Menu

This option determines whether the left Alt key will display the pull-down menu
bar. Setting this option to Yes causes the Alt key (if pressed and released
without pressing any other key) to display the pull-down menu bar at the top of
the screen. Setting this option to No prevents the Alt key from displaying the
pull-down menu bar. No matter what you set this option to, Alt-= (equal sign)
will display the pull-down menu bar.

Ifyou set this option to Tcs, Alt also “hides™ the menu bar if it is displayed. This option
is overriden by the Menu Bar Remains Visible option (see Menu Bar Remains Visible
Below).

You may want to set this option to No if you have another program that can be
accessed from WordPerfect with the Alt key. If you have such a program and
do not set this option to No, the Alt key (when pressed and released without
pressing any other key) will display the pull-down menu bar when you are in
WordPerfect.

Assigning Attributes

To assign an attribute to one of the menu options, select the option, select Size
(1) or Appearance (2), then select the attribute. The attribute will appear as it is
defined in the Colors/Fonts/Attributes feature (see Colors/Fonts/Attributes in
Reference).

Menu Bar Remains Visible

This option determines whether the pull-down menu bar is always displayed at
the top of the screen (in screens where you can use the pull-down menus). Once
you set this option to Yes, the only way to “hide" the menu bar is to set this
option to No.

Menu Bar Letter Display
This option determines how the mnemonic letter on the pull-down menu bar will
appear.

Menu Bar Separator Line
This option determines whether you want a double line separating the pull-down
menu bar from the rest of the screen.

Menu Bar Text
This option determines how the text (other than the mnemonic letter) on the pull-
down menu bar will appear.

Menu Letter Display
This option determines how the mnemonic selection letter in menus (other than
pull-down menus) will appear.
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Pull-Down Letter Display
This option determines how the mnemonic selection letter in pull-down menus
will appear. It does not affect the mnemonic letter on the pull-down menu bar.

Pull-Down Text
This option determines how text (other than the mnemonic selection letter) in pull-
down menus will appear. It does not affect the text on the pull-down menu bar.

See Also: Colors/Fonts/Attributes

Somelimes referred to as mail-merge because it can be used to mass-produce
personalized form letters and mailing labels, the WordPerfect Merge feature can
be used for these purposes and much more. Contracts, boilerplates, phone lists,
and memos are just a few of the documents that WordPerfect helps people create
every day.

Important: For more information about merging, along with some examples of merges, it
is strongly recommended that you work through lessons 23, 24, and 25 (Merge
Fundamentals, Mass Mailings, and Special Techniques) in the WordPerfect Workbook.

Merging is the process of combining information from two or more sources into
a single document. One source is always a primary file, which is also the file
that controls the merge. The other sources of information may be secondary
files, the keyboard (information you enter at the time of the merge), specially
designed WordPerfect document files, DOS textfiles, or the Shell Clipboard (if
you own WordPerfect Shell). See Primary Files, Secondary Files, Keyboard,
Docun<ent Assembly, and Shell Clipboard below for an explanation of these
information sources.

Primary Files

Every merge requires a primaryfile. This file directs the merge, inserting a
name here, an address there, a date some place else, and even a selected
paragraph in the middle. Text may come from secondary merge files, the
keyboard, document files, DOS textfiles, or the Shell Clipboard.



A primary file contains text and merge commands. The text and format can be
whatever you want, while merge commands must be chosen and inserted with
care. Whenever possible, formatting codes should be placed in the primary file,
either in the document itself or in Initial Codes (see Initial Codes below).
However, you can use attribute codes such as Bold and Italics in a secondary
file. Codes that affect an entire page, such as Paper Sizes and Top/Bottom
Margins, should only be used with primary files.

If you want certain formatting codes to always affect a certain field (e.g., bolding
a state in an address field), you can enter these codes once in a primary file
rather than entering them for each record in a secondary file.

N TEXT
&> MERGE COMMANDS samson Air Freighters
222 Seal Drive, Suite a, Newport Beach, CA 92663
A

June 12, 1991

{FIELD}Name™
{FIELD}Company~
{FIELD)Address*

Dear {FIELD}Salutation“:

BeFOTe finalizing our agreement, 1 want to advise you of our shipping
limitations. Unlike aea transport, we ore bound by certain packaging
regulations which determine what we can 3hip,

Packaging: To maximize safe transport of your shipment, we suggest
that the items be contained in palletized crates. Our largest carrier, the
B747F. is limited to crates that are 350 x 260 x 260 cm. in size with a
maximum payload of 750 kilograms. As an alternative, you can ship each
piece os an indivisible item which requires no packaging. However, we
strongly discourage this for fragile items.

Doc 1 Pg 1 Ln 1" Pos 1"

WordPerfect gives you many different merge commands to automate your most

demanding applications. In addition, you can combine merges with macros to
increase the capacity of WordPerfect to create the documents you need. For a

complete description of both macro and merge programming commands, see
Appendix K: Macros and Merge, Programming Commands.

Secondary Files

Sometimes called an address file, the secondary merge file may contain many
records (a record is a collection of related information). The number of records
in a secondary file is limited only by disk space, and each record can contain as
much information as you like. Records are separated by the (END RECORD}
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merge command followed by a hard page, and can be sorted (see Sort in
Reference).

{FIEL 3 NAVES)

Compa ly

Addre3s"

Salutation®

Phone*

“{END RECORD)

Robin PlercefEND FIELD}

Interchange, Inc.{END FIELD}"
P 544 Westminster Circle NW

Atlanta, CA 30327{END FIELD)

Robin END FIELD)

(404) 555-2828{END FIELD)

{END” RECORD}

Anna Lee Pierce(END FIELD)
Tradeuinds, Inc.{END FIELD)
P.0. Uax 1392
Centriil Park Station
Buffalo, NY 14215{END FIELD)
Anna{lIND FIELD)
(716) S55-5678[END FIELD}
{END" 11ECORD)
Doc 1 Pg 1 Ln 1" Pos 1%

The information in each record is divided into fields. One field may contain a
name, another field may contain a company name, and another field may contain
an address. It is these fields that are merged into a primary file. During a
merge, only those fields that have been requested by the primary file are merged.

Fields within each record are separated by the {END FIELD) merge command
followed by a hard return.

Important: Never separate fields or records with an extra hard return or insert spaces
between the lust word in afield and the {END FIELD} command. If you do, your

merged documents may not look as you expect them to.

Fields may be referenced by number or by name. Fields are numbered from top
to botlom in a record. You can assign names to the fields by using the

{FIELD NAMES} command that includes the names of the fields (in order) at
the beginning of the secondary file. For more information on the {FIELD
NAMES) command, see Appendix K: Macros and Merge, Programming
Commands.

As you move the cursor to each field, the number or name of the field at the
curren cursor position appears on the status line. You can clear the name or
number from the status line by pressing Home,Home,Up Arrow.

While there is no limit to the number of fields allowed in a record, each record
should contain the same number of fields, and each field should contain the same
type or information or remain empty. If field 3 of one record contains a phone
number, then field 3 of every other record in that file should also contain a
phone number—or nothing at all. (Even if empty, the field still needs an

(END FIELD) command.) Records using the {NEXT RECORD) or

{FIELD NAMES) commands (see Appendix K: Macros and Merge,
Programming Commands) are the only exceptions to this rule.



You do not have to keep the same number of lines or words within each field.
For example, you might have two lines in the address field of one record and
five lines in the address field of another record.

We recommend that you consider how information is organized into fields. For
example, if the city, state, and ZIP Code are in the same field, it is impossible to
merge anything but the whole field (city, state, and ZIP Code) into a primary
file. This problem is remedied by reducing the information to smaller categories,
(i.e., the city in one field, the state and ZIP Code in another).

Secondary files can grow to include many thousands of records. If you are

merging with a large secondary file, the merge stops if you run out of disk
space. You can break the secondary file into two or more smaller files, or
merge to the printer using the {PRINT} command (see Appendix K: Macros and
Merge, Programming Commands).

Once the primary file and other information sources are set up properly, you can
merge them together. To perform a merge,

1 Press Merge/Sort (Ctrl-F9) to display the Merge/Sort menu, then select
Merge (1).

(H select Merge from the Tools menu.

2 Enter the name of the primary file.

3 Enter the name of the secondary file if you are using one.
or
Press Enter if you are not using a secondary file.

When you are prompted to enter the primary or secondary file, you can use the List (F5)
key to list the files in a directory. When you have found the file you want, select Retrieve

(1) to select the file and continue the merge. For more information on listing files, see
List Files in Reference.

When you perform the merge, a document is created with the combined
information from the sources used in the merge. For example, if you merged a
letter (primary file) with an address list (secondary file), a document would be
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created with a copy of the letter for each record in the secondary file.

letter would be separated by a hard page [HPg].

Samson Air Freighters
222 Seal Drive. Suite A, Newport Beach. CA 92663

{F13LD)Name~
(FIELD)Company*“
(FIELD)Address™

Dear (FIELDJSalutatiorT:

Packagiiing:
that: the it
B747F, is limi
maximum payload of 750

piece as an indivisible item

stmngly discourage

544 W«(ti»inm»«r Circle W
Atlanta. OA 305i7(ENO FIELD)
10bIN{END FIELD}

(404) 555-2828{END HELD)

'
RST!Srth»i”

Cant**: Park Station
Buffalo VY 14215{END FIELO"i
Anna(END FIELD)

(716) 555-5670{END FIELD)

June 12, 1991

out (hipping

tc*aging
crates. Our IargeslUSEome
1260 x 260 in size with a

Doc 1 Pg 1 Ln 1" »0*

:1 Fg 1Ln 1" Po? 1"

Each
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Canceling a Merge

You can press Cancel (FI) to stop a merge. If Cancel has been turned off (see
(CANCEL OFF} in Appendix K: Macros and Merge, Programming Commands),
press Ctrl-Break to cancel the merge. See also Inserting Merge Commands
During Execution in Appendix K: Macros and Merge, Programming Commands.

Document Assembly

A primary file can merge with other document files by using the
{DOCUMENT?} command (see Appendix K: Macros and Merge, Programming
Commands). These files are usually short paragraphs that can be chosen and
inserted into preselected places in the primary file during a merge. This process
is sometimes called document assembly.

DOS Delimited Text Files

Delimiters are the characters in the exported file that determine the beginning
and end of each field and record. An exported file may have both beginning and
end delimiters for fields and records, or it may have combinations of beginning
and/or end delimiters. It must have at least an end delimiter for both fields and
records.

You can merge a primary file with spreadsheet or database files if the
spreadsheet or database program can export files in a delimited DOS text format.
In order for WordPerfect to perform the merge, you must tell WordPerfect what
the delimiters are. You can declare the delimiters using the Setup feature, or at
the time of the merge. To declare the delimiters through the Setup feature,

1 Press Setup (Shift-FI).

LS

Select Setup from the File menu
2 Select Initial Settings (4).
3 Select Merge ().

4 Select Field Delimiters (1), enter the field delimiters of the exported DOS
text file, then press Exit (F7).

5 Select Record Delimiters (2), enter the record delimiters, then press Exit
(F7).

To enter a Line Feed command [LF] as a delimiter, press Enter. To enter a Carriage
Return [CR] as a delimiter, press Ctrl-m. To enter a Form Feed command [FF], press
Ctrl-1.

You cannot specify AC, AD, AE, AF, AG, AN, A0, A, AQ, AR, AS, AT, AU, or AV
as a delimiter.

If you do not specify the delimiters through Setup, or if you want to change the
delimiter specification at the time of the merge,

1 Press Merge/Sort (Ctrl-F9) to begin the merge.

LB Select Merge on the Tools menu.
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2 Enter the name of the primary file.
When the prompt for the secondary file appears,

3 Press Text In/Out (Ctrl-F5) to change the prompt to “DOS Text Delimited
File:”.

Important: Text In/Out (Ctrl-F5) must be the first key pressed at the prompt. Ifyou
begin typing, then use Backspace to delete the characters, pressing Text In/Out will not
bring up the DOS Text Files menu. You should cancel the merge and begin again.

4 Enter the name of the delimited DOS text file (include a full pathname if
necessary).

You can also use List (F5) to list and select the DOS textfile at the prompt.

5 Select Field Delimiters (1) or Record Delimiters (2), enter the delimiters, and
press Exit (F7). Press Enter when all the delimiters are specified correctly.

The merge continues as usual.

The DOS Text Files menu also appears if you enter the name of a secondary file
that is not in WordPerfect secondary file format. If you have made a mistake,
press Cancel (FI) to stop the merge. If the file is in delimited DOS text format,
enter the delimiters and proceed with the merge.

Graphics

If you are using graphics in your merge files, it is a good idea to use the Graphic
on Disk feature (see Graphic on Disk under Graphics, Define a Box in
Reference). Using graphics on disk (rather than in the document) saves a great
deal of disk space and considerably speeds up merge execution.

Initial Codes

When creating a primary file, some formatting codes are better placed in Initial
Codes, rather than in the document portion of the primary file. Keep in mind
that everything in the document portion of the primary file will be repeated for
each record in the secondary file, even formatting codes. So, for example, if you
have a Tab Set code, it will be inserted at the top of each copy of the merged
document. Inserting the tab setting in Initial Codes, however, sets the tabs only
once for the entire file. Placing codes you want to appear only once in the
merged document in Initial Codes saves disk space and speeds up merge
execution.

Important: Merge commands cannot be used in Initial Codes.
lInserling Merge Commands
To insert any merge command in a document,
1 Fress Merge Codes (Shift-F9), then select More (6).
or
Press Merge Codes (Shift-F9) twice.



CB Select Merge from the Tools menu, then select Merge Codes.

am
(BELL)
{BREAK}
ECALL}IabeI -
CANCEL OFF]
{CANCEL ON)
{CASEYexpr-CBI* Ibl~. ..CSN" IbN-—
{CASE CALL}eKpr-cfil“Ibl"...caN"IbN

{CHAIN MACRO)macroname*
{CHAIN PRIMARY}filename”

)

A Dbox appears in the upper right corner of the screen, with a list of merge
commands.

2 Use Up Arrow (1) and Down Arrow (1) to scroll to the command you want
to insert.

or

Begin typing the name of the command you want until it is highlighted (you
need not type the brace ({)).

3 Press Enter to insert the command in the document.

Some commands require arguments, such as a variable name, a field name, or
other information. (The arguments and syntax required by the command are
displayed in the command access box. For more information on arguments and
command syntax, see Appendix K: Macros and Merge, Programming
Commands.)

4  Enter each argument as requested.
Once the command is entered, you can edit the arguments as regular text.

Some of the most common commands can be entered without going to the
command access box. To enter the {FIELD}, {END RECORD}, {INPUT},
{PAGE OFF}, and (NEXT RECORD} commands,

1 Press Merge Codes (Shift-F9) to display the merge codes menu.
2 Select the command you want from the menu.
Selecting the More option (6) on the menu displays the command access box.

3 Enter any arguments as requested.
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To enter the [END FIELD) command,
1 Press End Field (F9).

Merge commands may be placed in the regular document portion of a file, in
graphics boxes that are either empty or designated for text, and in headers,
footers, footnotes, and endnotes. Merge codes are not permitted in styles or
graphics box captions.

If you want to insert the merge codes that were used in previous versions of
WordPerfect (such as AF, AQ, AR, etc.), press Ctrl-letter, where letter is the letter
corresponding to the code. For example, to insert AQ, press Ctrl-q. If the code
requires arguments or a terminating A you must type them in manually. For
more information on these codes, see Previous Versions below and Previous
Merge Commands under Notes in Appendix K: Macros and Merge, Programming
Commands.

Keybnard

A primary or secondary file can merge with the keyboard by inserting the
{KEYBOARD} or {INPUT} command (see Appendix K: Macros and Merge,
Programming Commands). The merge pauses at the {KEYBOARD} or
{INPUT} command to let you enter information.

Merge Commands Display

You may choose whether you want to display the merge commands in a
document in the normal editing screen. When you are creating a document (e.g.,
a primary file), it is helpful to see the commands. However, since these
commands do not actually affect the format of the other text and codes in the
document, you may want to turn off Merge Commands Display to have a better
idea of how the text will fall on the page when the merge is performed.

Merge Support Policy
Although Merge support operators can assist you in troubleshooting existing
merges, they cannot design and write customized merges for you.



The following illustrations show how the screen looks with Merge Commands
Display on, then with Merge Commands Display off.

Samson Air Freighters
222 seal Drive, Suite A, Newport Beach, CA 92663

June 12. 1991

(FIELD)Name"
(FIELD)Company*
(FIELD)AOdreefi

Dear {FIELD)Salutation*s

HrPt]

[MrgF1ELD]Flame* [HHL]
MrgFI1ELD]Company " [HRt]
MrgFIELD]Address® [HRt]

HRt]

Dear [MrgFIELD]Salutation®: [HRt]

[HRE]

Press Reveal Codes to restore screen

Samson Air Freighters
222 Seal Drive, Suite A, Newport Beach, CA 92663

October 2, 1989

Company*
Address*

[MrgFIELD] Flame” [HRt]
[MrgFIELD]Company” [HHt]
[MrgFIELD]Address " [HRt]

Dear [MrgFIELD]SalutationHRrt]
[HPt]

press neveai codes to restore screen

To turn Merge Commands Display on or off,

1 Press Setup (Shift-FI).

CB Select Setup from the File menu.

2 Select Display (2).

3 Select Edit-Screen Options (6), then select Merge Codes Display (5).
4 Type y to turn on Merge Commands Display or n to turn it off.
5

Press Exit (F7) to return to the normal editing screen.

MERGE



430

MERGE

Previous Versions

Secondary merge files you may have created with previous versions of
WordPerfect require no conversion to be run with WordPerfect 5.1. Primary
merge files created with WordPerfect 5.0 also require no conversion. If you
prefer, however, you may convert the merge codes in these files to the new
merge command format. Primary files created with WordPerfect 4.2 or earlier
versions do need to be converted to function with WordPerfect 5.1.

To convert the merge codes in a file to the new command format,

' Retrieve the document containing the old format merge codes.

2 Press Merge/Sort (Ctrl-F9), then select Convert Old Merge Codes (3).
3 Save the file.

If you want to convert the commands back to the control codes format, use the
Text Out feature to save the file as either a WordPerfect 4.2 or 5.0 document
(see Text In/Out in Reference). You will lose any merge commands unique to
5.1 in the conversion.

If you save a merge file in WordPerfect 5.1, then retrieve it in WordPerfect 5.0,
5.1 merge commands will appear as [Unknown] codes in WordPerfect 5.0. If
you retrieve the file again in WordPerfect 5.1, the original 5.1 merge commands
will be restored.

Previous version equivalents to the WordPerfect 5.1 merge commands are listed
to the right of the command in the command access box (Shift-F9,Shift-F9) (see
Inserting Merge Commands above). A list is also included under Previous
Merge Commands under Notes in Appendix K: Macros and Merge. Programming
Commands. For information on inserting these commands, see Inserting Merge
Commands above.

For an example of how to create a primary file, see Lesson 23: Merge
Fundamentals in the WordPerfect Workbook.

Programming Commands

There are many merge programming commands you can use in both primary and
secondary files to control and add flexibility to your merges. You can also use
macros to add even more versatility to your merges. See Appendix K: Macros
and Merge, Programming Commands for information on programming
commands for both Macros and Merge.

Shell Clipboard

If you own WordPerfect Shell, the Shell Clipboard may be used as the source for
either the primary or secondary merge file, as long as its contents are in the
appropriate format. To use the Clipboard as a file source when executing a
merge,

1 Begin executing the merge (see steps above).

2 Press Shell (Ctrl-FI) at the Primary File: or Secondary File: prompt.



Mouse Setup

Important: Shell (Ctrl-FI) must he thefirst key pressed at the prompt. 1fyou begin
typing, then use Backspace to delete the characters, pressing Shell will not access the
contents of the Clipboard. You should cancel the merge and begin again.

The Setup: Merge DOS Text File screen will appear. For more information
about this screen, see DOS Delimited Text Files above.

3 Continue executing the merge as described in the steps at the beginning of
this section.

See Also: Lessons 23 through 25; Labels; Appendix I; Appendix J; Appendix
K; Appendix L

You can use a mouse with WordPerfect to position the cursor, block text, and
select WordPerfect features and options. Before you do so, however, you need
to install your mouse according to the instructions in your mouse documentation.
Then you should check the Mouse Setup menu in WordPerfect to ready your
mouse for use with WordPerfect.

The Mouse Setup menu is used to tell WordPerfect the type of mouse you are
using and where it is plugged into the computer. Since WordPerfect supports
several different kinds of mice, it is important for WordPerfect to know which
mouse you have and where it is located.

The Mouse Setup menu is also used to tailor mouse operation to your level of

mouse experience. Settings on the menu let you change mouse responsiveness,
select a submenu display time, and tell WordPerfect if you are using the mouse

with your left hand.
To change a setting on the Mouse Setup menu,
1 Press Setup (Shift-FI).

Select Setup from the File menu.

2 Select Mouse (1) to display the Mouse Setup menu.

Select a setup option and make the necessary changes (see the option
headings under Notes below).

4 Press Exit (F7) to return to the normal editing screen.

The settings on the Mouse Setup menu are stored in the WP{WP}.SET file and
are in effect each time you start WordPerfect.
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Acceleration Factor

The mouse pointer is controlled by moving the mouse and is shown on the
screen below. While the exact appearance of the mouse pointer may vary from
monitor to monitor, this should give you an idea of what the mouse pointer looks
like.

Fitness in Your BO"a

Aler:: Retirement may be hazardous to your health. A recent study
conducted by the Institute of Health and Wellness shows that older
adul :s who engage in an exercise program during their 60"s and 70"*
fair better in their SO .

This is significant because more and more alder adults are living
to S"je their 85th and 86th birthdays. By 1995, 10 % of all
Americans will be octogenarians | 4*

Also by chat date, expenses for hospital care are expected to
doubte. This is an important consideration since many insurance
compinies are limited in the amount of medical coverage they can
exteid to older adults-

Doc 1 Pg 1 Ln 2" Pas 3.6"

Depending on your experience using a mouse and the mouse acceleration factor,
you may feel that the mouse pointer is more or less responsive than it should be
to mouse movement. Using WordPerfect, you can adjust the mouse acceleration
factor.

The acceleration factor determines how responsive the mouse pointer is to actual
mouse movement. The smaller the acceleration factor, the less responsive the

mouse pointer is. For example, if you set the acceleration factor to 30, the
pointer will be less responsive to mouse movement than if you set the
acceleration factor to 200. You may want to experiment with different settings
to find which is most comfortable for you.

You can set the acceleration factor to any humber between and including 1 and 1200.

Assisted Mouse Pointer Movement
This option determines whether WordPerfect moves the mouse pointer to the first
selectable item when the menu bar or a WordPerfect menu is displayed.

Double-Click Interval

As you use the mouse in WordPerfect, and read the mouse instructions under
Mouse Support in Reference, you will learn that pressing a mouse button, then
releasing it is called “clicking” and clicking the mouse button twice in rapid
succession is called “double-clicking.” You will also learn that the difference is
important to WordPerfect since the mouse functions differently depending on
whether you are clicking or double-clicking.

The double-click interval determines the difference between a click and a double-
click. If you don’t click the mouse button twice within the double-click interval,



you are clicking the mouse twice rather than double-clicking. The double-click
interval is measured in 100ths of a second, so you can enter 50, for example, to
make the double-click time one-half of a second.

Left-Handed Mouse

This option lets you tell WordPerfect whether you are using the mouse with your
left hand. If you set this option to Yes, the operations that are normally
performed with the left-most mouse button are performed with the right-most
mouse button and vice versa. If you set this option to Yes, keep in mind that the
documentation is written for the default setting, which is No. Thus, instructions
pertaining to the left-most mouse button will apply to the right-most mouse
button and vice versa.

Port

The port is where your mouse is plugged into your computer. If you have a
serial mouse, you must select the proper location. If you have a bus mouse, you
don’t need to use this option. If you don’t know the proper location, there are
four choices, and you can try each one until your mouse works properly. Or,
you can try asking the person who installed your mouse.

Submenu Delay Time

The Submenu Delay Time setting determines how long the cursor must rest on a
pull-down menu item that has a submenu before the submenu is displayed. It
also determines how long you have to move the mouse pointer to a submenu
item if you are dragging the mouse and are “short cutting” to the submenu
through the main menu to the submenu.

The submenu delay time is measured in I00ths of a second, so you can enter 50,
for example, to make the submenu delay time one-half of a second.

Pull-down menu items with submenus are displayed with a »at the immediate
right of the item. The mouse pointer is shown on the screen under Acceleration
Factor above.

Type

A mouse driver is a set of information that helps WordPerfect communicate with
your mouse. Without this information, your mouse cannot work properly in
WordPerfect. The Type option is used to help WordPerfect select the correct
mouse driver.

For information on using this option, see Mouse Type in Reference.

See Also: Mouse Support; Mouse Type; Pull-Down Menus
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A “mouse” is a piece of hardware that connects to your computer to perform
different operations. While you don't need a mouse to run WordPerfect,
WordPerfect supports most common mice. Mice can be used for three
operations in WordPerfect:

« Blocking Text
e Cursor Movement

e Feature and Option Selection
Information on performing these operations is listed below.

Before you begin using the mouse, you should have installed the mouse
according to the instructions in the documentation that came with your mouse.
You should also have used the Mouse Setup menu to give WordPerfect
information about your mouse (see Mouse Setup in Reference).

Before you read more about the mouse and WordPerfect, you should know that
in the normal editing screen and some WordPerfect menus, the mouse pointer is
usually represented by a reverse-video box ( | ). This pointer exists separately

from the WordPerfect cursor (usually a dash) and should not be mistaken as the
WordPerfect cursor. It appears when you move the mouse and disappears when
you press a key.

A mcuse pointer is shown in the screen below. While its appearance may vary
from monitor to monitor, the example below should give you a good idea of
what the mouse pointer looks like.

\%

Fitness for the 801s

Alert: Retirement may be hazardous to your health. A recent study
conducted by the Institute of Health and Wellness shows that older
adults who engage in an exercise program during their 60°S and 70"s

fare Tetter in their 80"s. |

When talking about the mouse, “click” means to press a button, then release it.
“Double-click” means to click a button twice in rapid succession. “Drag” means
to press the button, hold it down, then move the mouse.

Blocking Text

To block text with the mouse, position the mouse pointer on one end of the text
you want to block. Next, press the left mouse button and drag the mouse until
the mouse pointer is at the immediate right of the other end of the text you want
to block. Then release the left mouse button. The text you blocked is
highlighted.

Once you have blocked the text, you can use any of the features you can if you
had used the Block feature (Alt-F4) to block the text (see Block, Define in



Reference). The same codes are inserted and the document is formatted the
same. The only thing that is different is the method of blocking the text.

Once a block is defined and you have released the left button, you can change its size

without canceling the block and starting over by using the arrow keys, #Search (F2) or
#Search (Shift-F2). (See Search in Reference.)

Cursor Movement
Using the mouse pointer, you can "point” to a specific location, then click the
left button on your mouse to move the WordPerfect cursor to that location.

Like the cursor keys, the mouse cannot be used to position the cursor where
there is no text or codes. If you position your mouse pointer where there is no
text or codes, then click the left mouse button, the cursor will be positioned at
the nearest text.

As you are positioning the cursor with the mouse, remember that double-clicking
the left button or pressing the left button, then dragging the mouse mean
different things to WordPerfect (see Blocking Text above and Clicking and
Double-Clicking below).

If you have split the screen with the Window feature (Ctrl-F3,1), the mouse can
be used to position the cursor in either document screen. Also, the mouse can be
used to position the cursor in WordPerfect prompts that ask for some type of
input such as a filename (e.g.. Document to be Saved: C:\WP51\LETTER.DOC).

If you want to scroll to parts of the document that are not displayed on the
screen, press the right mouse button, then drag the mouse to the edge of the
screen in the direction you want to scroll. When you release the right mouse
button, scrolling stops. If you want to scroll and block text as you scroll, use
the left mouse button instead of the right mouse button.

If you are scrolling left or right, scrolling stops when you reach the beginning or
end of the current line of text. If you are scrolling up or down, scrolling stops
when you reach the top or bottom of the document.

Feature and Option Selection

The mouse can be used to select any WordPerfect feature or option. You can
use the mouse to select features and options in combination with WordPerfect
keystrokes, or you can use the mouse exclusively.

To display the pull-down menu bar, you should click the right mouse button. To
hide the menu bar once it is displayed, you can click the right button again
(unless you have chosen to have the menu bar always visible).

To select an option from any WordPerfect menu (pull-down or other), you can

do one of two things. You can move the mouse pointer to that item, then click
the left mouse button. Or, you can press the left button, drag the mouse to the
item you want to select, then release the left button.

You can also click on prompts such as “Press List” to select the key to which
the prompt refers.
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As >ou use the mouse to select features and options, be aware that the right

mouse button serves the same function as Exit (F7). In other words, it will exit
you out of a menu.

Also, be aware that double-clicking the left button acts the same as pressing the
left button, then pressing Enter. This is especially useful in menus such as List
Files, Base Font, and Printer Selection where a list of items is displayed.

Double-clicking in List Files, Base Font, and Printer Selection is useful because
the first click highlights the item you want to select, then the second click acts as
the Enter key. In List Files, this lets you quickly view a document. In Base
Font and Printer Selection, this lets you quickly select a base font or a printer.

Double-clicking is also useful when a Status line prompt is displayed because it
tells WordPerfect to accept the default value.

Canceling

Clicking the middle mouse button on a three-button mouse performs the same
function as pressing the Cancel key (FI). Among other things, this includes
canceling Block, backing out of a menu without making changes, and restoring
deleted text (see Cancel in Reference).

To cancel with a two-button mouse, press and hold either mouse button, click the
other button, then release the first button.

Center Button
The center button on a three-button mouse performs the same function as the

Cancel key (F1). If you have a two-button mouse, press and hold either mouse
button, click the other button, then release the first button.

Clicking and Double-Clicking

Pressing a mouse button, then releasing it is called clicking. Clicking the mouse
button twice in rapid succession is called double-clicking. If you read the
information under Feature and Option Selection above, you will see that clicking
and double-clicking cause WordPerfect to act in different ways.

For example, a click, then another click in the List Files menu simply highlights
a file. A double-click in the List Files menu highlights a file and lets you look
into the file’s contents.

How does WordPerfect tell the difference between two separate clicks and a
double-click? It checks the Double-Click Interval setting.

If you click a mouse button twice within the double-click interval, WordPerfect
considers it a double-click. If you exceed the double-click interval in clicking
the mouse button twice, WordPerfect considers it as two separate clicks.

Information on setting the double-click interval can be found in Double-Click
Interval under Mouse Setup in Reference.



Exiting

When you click the right mouse button, it performs the same function as if you
had pressed Exit (F7). In many WordPerfect menus, this exits you out of the
menu.

The right button does not exit you out of a document. If you want to do so with
the mouse, you must select Exit from the File menu.

Left Button

The left button on your mouse performs several functions. When you are in
normal text, clicking the left button moves the cursor to where the mouse pointer
is located. Pressing the left button, dragging the mouse, and releasing the left
button blocks text.

In a WordPerfect menu, clicking the left button highlights the menu item where
the mouse pointer is located. Pressing the left mouse button, dragging the mouse
pointer to a menu item, then releasing the left mouse button also selects the item.
If the mouse pointer is not located on an item, clicking the left button cancels
you out of that menu.

Double-clicking the left mouse button performs the same function as pressing the
left button, then pressing Enter. If the “Move Cursor; Press Enter to Retrieve”
message is on the screen, however, double-clicking the left mouse button
retrieves the text that is in the temporary move buffer to the location of the
mouse pointer.

Macros

Menu selections with the mouse are stored as the equivalent keystrokes in
macros. This provides you with a clearer idea of what you did in the macro
should you need to edit the macro in the Macro Editor.

When you are defining a macro, you cannot use the mouse to position the cursor.

Mouse and Keystrokes

You can use the mouse and WordPerfect keystrokes in combination with one
another or exclusively. For example, you can use the mouse to move the cursor
or select a menu option, then in the next operation, use the keystrokes. You can
use the mouse in one step of an instruction in the WordPerfect Workbook or this
manual, then use the keystrokes in the next step.

With few exceptions, WordPerfect is designed to let the mouse work anywhere
that keystrokes work. Notable exceptions include typing keyboard characters,
moving the cursor in the Reveal Codes screen, and entering the text and codes to
be searched for after selecting the Search or Replace features.

Mouse Responsiveness

If you want the mouse pointer to be more or less responsive to your mouse
movements, change the Acceleration Factor setting on the Mouse Setup menu
(see Acceleration Factor under Mouse Setup in Reference).
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Pull-Down Menus

WordPerfect lets you select features from pull-down menus. This is especially
useful if you are using the mouse, although you can select features from the pull-
down menus with both the mouse and the keyboard.

More information on how the mouse works in pull-down menus can be found
under Feature and Option Selection above. More information on the pull-down
menus themselves can be found in Pull-Down Menus in Reference.

Right Button

In the normal editing screen, clicking the right button on your mouse does one of
Iwo things. If the pull-down menu bar (located at the top of the screen) is not
displayed, clicking the right button displays the menu bar. If the menu bar is
displayed, clicking the right button “hides” the menu bar (unless you have
chosen to have the menu bar always visible).

In WordPerfect menus, clicking the right mouse button performs the same
function as Exit (F7). This means that it exits you from the menu.

Press ng the right mouse button, then dragging the mouse pointer to the edges of
the normal editing screen, lets you scroll through a document.

Yes/Nn Options

When an option gives you two choices. Yes and No, the default response is
shown without parentheses. Clicking on Yes sets the option to Yes, while
clicking on No sets the option to No.

see Also: Mouse Setup: Mouse Type; Pull-Down Menus

Since WordPerfect can support several different types of mice, it needs to know
the tyoe of mouse you have. The method for supporting mouse functions differs
from mouse to mouse.

A mouse driver is the file WordPerfect uses to communicate with a mouse. This
file, which ends with a .IRS (input resource file) extension, is used to support
mouse functions such as cursor movement, blocking text, and selecting
WordPerfect features and options.

If you are having trouble performing any of these functions with the mouse, see
Mouse Support in Reference to make sure you are using the mouse correctly. If
you are, it could be that the correct mouse driver isn't selected.

WordPerfect uses a feature called Mouse Type to select the correct mouse driver.
When you install WordPerfect, it selects a generic mouse driver called



Notes

MOUSE.COM which works with most mice. However, you should check the
Mouse Type screen to see if your mouse is one of the supported types.

The list of mouse drivers on the Setup: Mouse Type menu comes from a file
called STANDARD.IRS. This file is installed with the WordPerfect program
files and should reside in the directory where WP.EXE is located.

To select your mouse driver from the Mouse Type screen,
1 Press Setup (Shift-FI).

03 Select Setup from the File menu.

2 Select Mouse (1), then select Type (1).

3 Move the cursor to the type of mouse you are using, then press Enter to
select it.

Notice that the same mouse may have two or more options such as serial and bus. These
options refer to how your mouse is connected to your computer. You should be able to
tell which option to choose from the documentation that came with your mouse. You can
also check the underside of your mouse, which often has a sticker giving you information
about the mouse.

4 Press Exit (F7) until you return to the normal editing screen.

This setting is stored in the WP{WP}.SET file and remains in effect each time
you start WordPerfect.

Auto-Select

WordPerfect initially selects the generic “Mouse Driver” (see MOUSE.COM
below). If you selected a mouse driver yourself, but now wish to have
WordPerfect deselect the driver you selected, go to the Setup: Mouse Type menu
(Shift-F1,1,1), then choose Auto-Select (2).

Deselecting the Mouse

If you wish to deselect a mouse driver, go to the Setup: Mouse Type menu
(Shift-Fl, 1,1), move the cursor to the mouse driver you want to deselect, then
type an asterisk (*).

Mouse Not Shown

If your mouse is not shown on the Setup: Mouse Type menu, then the
information for that mouse is not located in the directory where WP.EXE
resides.

If you have files ending with a .IRS extension in a directory other than where
WP.EXE resides, make sure you are in the Setup: Mouse Type menu
(Shift-FI1,1.1), then select Other Disk (3). After you do so, enter the pathname
to where your .IRS files are kept. WordPerfect will display those files on the
Setup: Mouse Type menu.
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If you do not have .IRS files in any directory other than the directory where
WP.EXE is located and your mouse is not shown on the Setup: Mouse Type
menu, send the name of your mouse, your return address, and your phone
number to:

Mouse Driver

Attn: WordPerfect Corporation Information Services
1555 N. Technology Way

Orem, UT 84057 '

At WordPerfect Corporation, we are constantly updating our software and there
is a chance that we may have created a driver for your mouse. In the meantime,
select the generic “Mouse Driver” from the Setup: Mouse Type menu (see
MOUSE.COM below).

MOUSE.COM

If the name of your mouse is not listed on the Setup: Mouse Type menu, select
the generic “Mouse Driver.” This instructs WordPerfect to use a mouse driver
called MOUSE.COM.

MOUSE.COM is a program that comes with your mouse. You must run
MOUSE.COM before starting WordPerfect if you plan to select “Mouse Driver.”
Information on running MOUSE.COM should be found in the documentation that
came with your mouse.

On the other hand, if the name of your mouse is listed on the Setup: Mouse
Type menu, and if you don’t use your mouse with any other program on your

computer, you don’t need to run MOUSE.COM. The WordPerfect mouse driver
will be all that you need to support your mouse.

Name Search

The Name Search option on the Setup: Mouse Type menu (Shift-FI,1,1) helps
you easily move the cursor to the name of your mouse. To use the option, select
Name Search (n), then begin typing the name of your mouse. As you type
letters, the cursor moves to the first name on the list that matches those letters.
Press Enter or an arrow key to exit Name Search.

llther Disk
The Other Disk option is used in case your mouse is not displayed on the Setup:
Mouse Type menu. For more information, see Mouse Not Shown above.

STANDARD.IRS

STANDARD.IRS is a special mouse driver that comes with WordPerfect, and it
contains information for most common mice. This driver should reside in the
directory where WP.EXE is located.



Move
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Wrong Driver
You must have the mouse for the mouse type you select. If you don’t,
WordPerfect may not be able to properly support your mouse.

See Also: Mouse Setup; Mouse Support

You can use Move to highlight a sentence, paragraph, or page of text, and then
move, copy, or delete it.

1 Place the cursor on the text you want to move.

2 Press move (Ctrl-F4), then select Sentence (1), Paragraph (2), or Page (3) to
highlight the sentence, paragraph, or page on which the cursor is resting (see
Text Delimiters below).

CB Choose Selectfrom the Edit menu, then select Sentence, Paragraph, or Page.
3 Select a Move option (see Move Options below) and move the text.
or

Select Delete (3) to delete the text. The text is then removed from the
screen. It can be retrieved as deleted text (see Undelete in Reference).

Move Options

When you use Move, the Move options appear the same as when you are using
Move with Block. They ale move. COPY. pelete, OF Append. Move and Copy
are explained in the following paragraphs. The Delete option is explained in step

3 above. To learn about Append, see Append in Reference.

Selecting either Move (1) or Copy (2) stores text in a temporary buffer. With
Move, the text is removed from your document. With Copy, the text remains on
the screen but is also held in a temporary buffer. In both cases, a prompt
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appears on the status line informing you that pressing Enter will retrieve the text
you have just moved or copied.

society or any economic systems, they are interesting to think
about. I found myself wondering if some of these ideas might not
work or be true. Time may have the only answers.

This man implemented ideas that were not very common in his
day. His philosophy was that man is no better than his environment.
He bought a group of textile mills in Scotland. In accordance with
this new philosophy he tried to eliminate the typical social evils
of tlie factory system and make his factories Into the model
worker*s community. He raised wages and improved factory
sanitation. He reduced the hours worked, and even helped rebuild

the workers® homes and provided schools for their Children.

~»Wove cursor; press Enter to retrieve. Doc 1 Pg 1 Ln 4.25" Pos 1"

You can then move the cursor to any other place in your document and press
Elnter to retrieve the text. If you switch to another document, you can still press
Enter to retrieve the text (see Switch in Reference). Even if you retrieve another
document into the second screen, pressing Enter will still retrieve the text. The
text will not be removed from the temporary buffer until you exit WordPerfect,
or use Move again to store new text in the buffer.

As long as the Move prompt appears on the status line, the text in the temporary
buffer will be retrieved when you press Enter. You can use the cursor
movement and deletion keys to move through text in your document, but you
cannol press Enter without retrieving the text at the point on which the cursor is

resting.

While the Move prompt is on the screen, if you decide you do not want to
retrieve the text, you can press cancel (FI) to make the prompt disappear.
However, the text will still remain in the temporary buffer until you move new
text into it or exit WordPerfect. As long as the text is in the buffer, you can
retrieve it by pressing move (Ctrl-F4), selecting Retrieve (4), then selecting
Block (1). You can also retrieve it by pressing Retrieve (Shift-FIO), then
pressirg Enter.

When the Move prompt is displayed and you then create a table, the Move
prompi: is suppressed while you are in table editing mode. As soon as you exit
Table Edit, the prompt should reappear, unless the temporary buffer is destroyed
while you are in Table Edit.

If the Edit pulldown is used and Paste is selected, the text reappears.



Move, Block

Text Delimiters
Move lets you move a sentence, paragraph, or page.

The Sentence option is designed to move a sentence from the capital letter that
begins the sentence, up to and including the punctuation that ends the sentence,
along with as many as three spaces following it. The sentence you move can
end with a period (.), question mark (?), or exclamation point (). However, a
Hard Return code [HRtJ is always considered to be a definite end of a sentence.
Consequently, if a Hard Return code [HRt] occurs before the end of a sentence,
WordPerfect highlights only up to the Hard Return code.

You can place the cursor anywhere on a sentence before highlighting it. When
the sentence is retrieved, any existing ending spaces are inserted after the end of
the sentence. Consequently, if the sentence you move is followed by two spaces,
and you move the cursor to the first letter in a sentence before retrieving it, your
text will continue to be spaced correctly.

Since paragraphs are normally separated by Hard Return codes [HRt] in
WordPerfect, the Paragraph option is designed to move a paragraph from the last
Hard Return code in your text up to, and including, the next Hard Return code.
Any spacing at the beginning of the paragraph (e.g., a tab or indentation code or
a series of spaces, etc.) is included. When the paragraph is moved, the Hard
Return code at the end of the paragraph is moved with it. Consequently, if you
move the cursor to the start of a paragraph before retrieving it (and not to any
extra line above a paragraph), your text will continue to be spaced correctly.

In WordPerfect, pages can be separated by both a Soft Page code [SPg]
(represented in the normal editing screen by a single-dashed line) or a Hard Page
code [HPg] (represented in the normal editing screen by a double-dashed line).
The Page option is designed to move text from one page break to the next.

W hen a page of text is moved, soft page breaks are not moved with it.

However, if the bottom of the page is indicated by a hard page break, that page
break is moved with the text. Unless every page in your document is separated
by hard page breaks, using the Page option usually changes where the page
breaks occur in your document.

see Also: Append; Move, Block

You can use Move to move a block of highlighted text.
1 Block the text (Alt-F4).
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2 Press Move (Ctrl-F4), then select Block (1), Tabular Column (2), or
Rectangle (3). These options indicate the type of block you are moving (see
Block, Tabular Column, and Rectangle below).

(B) Choose Select from the Edit menu, then select Tabular Column or Rectangle.

The Move options appear.

3 Select Move (1), Copy (2), or Append (4) to move, copy, or append the text.
or

Select Delete (3) to delete the text. The text is then removed from the
screen. It can be retrieved as deleted text (see Undelete in Reference).

Block

Most often, you will probably select Block (1) when you use Move (Ctrl-F4) to
move text. The Block option lets you block any part of your document by
placing the cursor on the first character you want to move, pressing Block
(Alt-F4) to turn on Block, then moving the cursor to the last character you want
to move. You can block a heading, a part of a sentence or a paragraph, or any
part of a line (see Block in Reference).

Once you have defined a block of text, selecting Block (1) from the Move menu
displays the move options: Move, Copy, Delete, and Append. You can then
select any option. For a description of the Move options, see Move in Reference.

When you use Block to move text, any codes within the blocked text are moved
with tie block. However, WordPerfect is designed to keep the attributes of
blocked text the same whenever it is moved. Consequently, if you block only
part o:'a line, WordPerfect inserts the necessary codes to keep the bolded text
bolded, the underlined text underlined, etc.

Rectangle

The Rectangle option lets you move a rectangular-shaped block without
disturbing other parts of the text on a page. Each of the lines of text must end
with Hard Returns (see Return, Soft and Hard in Reference).

Suppose, for example, you have imported an ASCII text file into WordPerfect
which contains several vertical columns of numbers and that these columns of



A COLUMN TO BE MOVED
A SPACES
A HARD RETURNS

A RREGULAR BLOCK
A BEGINNING OF BLOCK
A END OF BLOCK

numbers are separated by spaces and not by tabs. You can use the

option to re-arrange the columns

Extension Last Name First Name
2345 ..ntn Jean
2389 Jensen Jack
4534 Richards Shawn
3412 Hawkins Larry
4564 Mui rbrook Wendy
9876 Knudsen Steven
7865 Forest Richard
7034 Larsen David
7898 Long Frank
let»n« a-
[HRt]
2345 Hansen Jean
2389 Jensen Jack
Shawn
3412 Hawkins A Larry
4564 Muirbrook Wendy
9876 Knudsen Steven
7865 Forest Richard
7834 Larsen David

Press Reveal Codes to restore screen

and also keep them intact.

Employee Number

234123
234567
234987
345642
342543
123433
342567
573893
129876
Oac 1 Pg i "

i»plnyee Humber]

234123 [HRt]
234567 [HRt]
23498; [HRt]
345642 [HRt]
342543[HRt] VA
123433[HRt] ~
342567 (Hittl
573893[hRt]

Rectangle

To move a rectangular-shaped block, place the cursor at one corner of the
rectangle you want to move (e.g., upper left or lower right), then press Block
(Alt-F4). A “Block On” message appears at the left corner of the status line.
Move the cursor to the opposite comer of the rectangle. As you do so,
WordPerfect highlights an irregular-shaped block of text on-screen.

Jack

Shawn

Larry

wendy
9876 Steven
7865 Forest™ Richard
7834 LarsenX David
7898 Long \ Frank

> 6756 Stewart \ Stan

6758 Chapel \ Bob
5555 Cox Stan
1112 Cooper \ Rachell
5544 Fullmer  \ Charles
4321 Gardner . Hank
3415 Fowler Kevin
8767 Gibb Gary
9878 Chamberlain Brian
4599 Giles Greg
7765 Marsh Lisa
T Mann

2341231
23456/
M-ijV
345642
3.12643
1734

789900

754992

MOVE, BLOCK
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Keep in mind that this irregular-shaped block is no indication of the actual text
that you are going to move. Once you have diagonally spanned the rectangle
you want to move, press Move (Ctrl-F4), then select Rectangle (3).

Employee Number
2345 iJean 234123
2389 Lack 234567
4534 234987
3412 345642
4564 342543
9076 Cnudsen 123433
7065 342567
7834 573893
7690 129876
6756 348293
6758 234728
5555 455643
1112 324343
5544 112233
4321 445566
3415 990800
8767 112234
9870 456123
4599 600980
7765 789900

677777

754992
1 Move; 2 copy;

The on-screen block changes to highlight only the rectangle which will be
moved, and the Move options are displayed on the status line. You can then
select Move (1) or Copy (2), move the cursor to the place where you want the
rectangle inserted, and press Enter to insert it.

While the Move options are displayed, selecting Delete (3) deletes the
highlighted text. You can also select Append (4). For more information, see
Append in Reference.

Short Cuts

On keyboards with an enhanced BIOS, you can also move a block of text by
blocking the text, then pressing Block Move (Ctrl-Del) to move the block, or
Block Copy (Ctrl-Ins) to copy it. A prompt appears on the status line informing
you that pressing Enter will retrieve the text you have just moved. You can
then move the cursor to the place where you want the text and press Enter to
insert the text.

If you do not have a keyboard with an enhanced BIOS, you can re-assign or map
these same keystrokes to different keys. You can also map Block Append to a
key on your keyboard (see action under Keyboard Layout, Edit in Reference).

Tabular Column

When you press Tab. Undent (F4), or Tab Align (Ctrl-F6) to create a series of
columns across a page, you may sometimes decide that you want to re-arrange
those columns without typing them in again. For example, if you have typed



A COLUMN TO BE MOVED

A NEW LOCATION FOR
COLUMN

A IRREGULAR BLOCK
A BEGINNING OF BLOCK

four tabbed columns across a page, you might want to move the first tabbed
column to the right of the page.

Ex Last Mama Employee Numhpr
2345 Hansen Jean 234123
2389 Jensen 234567
Richards 234967
3412 345642
4564 Mui rbrook Wendy 342543
9876 Knudsen Steven 123433
7065 Forest Richard 342567
7034 573693
698 129876
\HP51RF.schnmovehlok.i Doc 1 Pg 1 Ln 1" Pos 2."

[Tah SetwRet - -1".-0.5,,,0". *1.7" .+3.4" .*5.1" ][B
ifiTljpi [HOLD 1Last Name [Tab] First Name [Tab]Em
[KRt]

2345[Tab]Hansen[Tab]Jean [Tab]234123[HRt]
2389[Tab]Jensen [TablJack [Tab]234567[HRt]

4534[Tab]Richards [Tab]Shawn [Tah]234987[HRt]
3412[Tab]Hawkins[TablLarry [Tab]345642[HRt]

4564[Tab]Muirbrook [Tab]Wendy[Tab]342543[HRt]
9876[Tab]Knudsen [Tab]Steven [Tab]123433[HRt]
7865[Tab]Forest [Tab]Richard [Tab]342567[HRt]

Press Reveal Codes * mrestore screen

You can do this by using the Tabular Columns option.

To move any of the tabbed columns on a page, place the cursor on the first
character following the Tab code [Tab] in the first line of the left-most column
you want to move, then press Block (Alt-F4). A “Block On” message begins
blinking at the left corner of the status line. You then need to move the cursor
through any of the columns you want to move. As you do so, WordPerfect
highlights an irregular-shaped block of text on-screen.

As with the Rectangle option, this irregular on-screen block is no indication of
the actual text that you are going to move.

Once you have moved the cursor through all the columns you want to move,
move down to a character in the last line of the right-most column you want to
move, press Move (Ctrl-F4), then select Tabular Column (2).
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The block changes to highlight only the columns which will be moved, and the
Move: options are displayed at the status line.

A BLOCK TO BE MOVED
A |10VE OPTIONS frudlovee Number

234123
234567
234987
345642
342543
123433
342567
573893
129076
348293
234726
455643
324343
112233
445566
998800
112234
456123
600980
789900
677777
754992

You can then select Move (1) or Copy (2), move the cursor to the place where
you want the column inserted, and press Enter to insert it.

Using Tabular Column to move text moves the Tab code preceding the column,
along with the text in the column (e.g., [Tab|text).

When the Move options are displayed, selecting Delete (3) deletes the column.
You can also select Append (4). For more information, see Append in
Reference.

The Tabular Column option can be used to move columns that you create using
Tab, "Indent (F4), or Tab Align (Ctrl-F6). Do not use it to move text within
Newspaper Columns, Parallel Columns, or Tables. For information on moving
text in Newspaper Columns, Parallel Columns, or Tables, see Columns,
Newspaper, Columns, Parallel; and Table, Create in Reference.

See Also: Append; Move
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0 Other Format

Notes

The Other Format menu contains several specialized formatting and printing
functions, such as changing the language code or selecting whether or not spaces
are underlined when you use Underline (F8).

To change an Other Format setting,
1 Move the cursor to where you want the setting changed.

2 Press Format (Shift-F8), select Other (4), then select an option and make the
necessary adjustments (see the option headings under Notes below).

CB Select Otherfrom the Layout menu.

3 Press Exit (F7) to return to your document.

Advance
Advance lets you position text at a specific point on a printed page, for example,
in a graphics image or in a pre-printed form (see Advance in Reference).

Border Options
This menu determines the appearance of the border types you can select for both
graphics boxes and tables.

Conditional End of Page

This feature protects a specified number of lines from being split between two
pages. It is most often used to keep titles with the paragraphs which follow
them (see Conditional End of Page in Reference).

Decimal/Align Character and Thousands’ Separator

The decimal/align character is preset to a period (.). It is used as the alignment
character when you use Tab Align (Ctrl-F6) to align text vertically on a character
(see Tab Align in Reference).

The decimal/align character is also the character that is used in Math. It
separates decimal fractions from whole numbers and serves as the alignment
character in number, total, and calculation columns (see Math, Define Columns
in Reference).

The thousands’ separator character is the character used to separate hundreds
from thousands and is preset to a comma (,).

If you want to select other characters for these functions, you can do so using
the Decimal/Align Character and Thousands’ Separator options (see Tab Align
and Math, Define Columns in Reference).
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lind Centering/Alignment

You can use this option to place an End Centering/Alignment code [End C/A] in
your document. This code will turn off a Center code [Center], a Hard Decimal
Align Tab code [DEC TAB], or a Flush Right code [Fish Rgt] at the cursor
position. The cursor remains on the same line when the alignment ends. For
more information, see Center Text, Flush Right, and Tab Align in Reference.

Language

You can use this option to place a language code \Lang:language\ in your
document. At any point following the code, WordPerfect then uses that language
as a reference for the Sort and Date features. When you sort the document,
WordPerfect uses the guidelines of that language’s alphabet, and when you insert
a date, WordPerfect inserts the date in the way dates are written in that language
(e.g., 12 decembre 1990 for French).

WordPerfect Corporation also offers versions of the Speller, Thesaurus, and
Hyphenation dictionaries in several languages. If you have purchased and
installed a dictionary for a certain language then, at any point following the
language code for that language, WordPerfect uses that language's Speller for
spell-checking, its Thesaurus for displaying synonyms and antonyms, and its
hyphenation dictionary as a reference for hyphenation. For more information,
S€e Language IN Reference.

Overstiike
This option lets you print two or more characters in the same location such as
combining the / and the 0 to create O (see Overstrike in Reference).

Printer Functions

This option presents a submenu used for handling such specialized printer
functions as kerning, leading, and the placement of the baseline (see Printer
Functions in Reference). Your ability to use these functions depends upon your
printer’s capabilities.

Underline Spaces/Tabs

Underline and Double Underline are attributes. For information on adding these
attribu'es to text, see Attributes in Reference. WordPerfect is initially set to
underline spaces but not tabs when you underline or double underline text.

To change the current settings, select Underline (7) from the Format: Other menu
to move the cursor to the Spaces entry. Type y to underline spaces or type n if
you do not want spaces underlined. The cursor moves to the Tabs entry. Type
y to underline tabs or type n if you do not want tabs underlined. Press Exit (F7)
to return to your document.

See Also: Advance; Conditional End of Page; Language; Math, Define
Columns; Overstrike; Printer Functions; Tab Align



Outline, Create

There are times when part or all of the document you are creating is actually an

outline such as the one shown in the screen below.

A:\OUTLINE

Economics in Education

Perspective
A. Why Economics Education?

Case Study
ft PS 4
B. Summit Community College
C. Carter State University
1. Graduate School
2. Undergraduate College

Moving Toward Discipline-Based Economics

Doc 1 Pg 1 Ln 1" Pos 1"

Using the WordPerfect Outline feature, you can easily create and number several
different types of outlines. Once you turn on Outline, inserting the next outline
number is as easy as pressing Enter.

Before you learn more about outlines, you should know that outlines consist of
paragraph numbers. These numbers are differentiated by levels, then by
numbers, letters, keyboard characters, WordPerfect characters, or styles within a
level. You can have up to eight levels of paragraph numbering within a
document, and this differentiation lets you organize text in a hierarchical manner.

OUTLINE, CREATE
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A LEVEL ONE
A LEVEL TWO
A LEVEL THREE
A LEVEL FOUR
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Four outline levels are shown below.

Economics in Education

tv, Pea
~ Wiy Economics Education?
- iral Education
High School
College
2. Vocational Training
a. College Degrees
b. Post-Graduate Degrees
». Basic Principles
Ilm  Government

t
3. OMIIKi#
IX. Case Study
AL PS 4
B. Summit Community College
C. Carter State University
111, Moving Toward Discipline-Based Ecortom

V- Conclusion

While you can use numbers, letters, keyboard characters. WordPerfect characters, or
styles to “number” paragraph numbers, we use “numbers"” in the rest of this reference
section to describe all of the possibilities.

The following instructions explain how to create an outline with the Outline
feature. They are written to conform to the default settings for the Outline
feature. If you have changed any of these settings with the Paragraph Number
Definition menu, you should read Outline, Define in Reference to see how these

changes affect outlining.

1 Press Date/Outline (Shift-F5), then select Outline (4).

CB Select Outline from the Tools menu.

2 Select On (1) to turn on Outline.

3 Press Enter to insert a first level paragraph number.

4  Type the text for the first outline level (see Typing Text below).

It is a good idea to always use ¢Indent (F4) when you want to move text to a tab
stop in Outline.

5 Press Enter to insert another first level paragraph number.

or

Press Enter, then press Tab to insert a second level paragraph number.
6 Type the text for that outline level.

7 Continue pressing Enter to insert a new paragraph number, then press Tab
to change the paragraph number to the next level or ¢Margin Release



Notes

(Shift-Tab) to change the paragraph number to the previous level (see Levels
below).

8 When you are finished with your outline, press Date/Outline (Shift-F5), then
select Outline (4).

I'a Select Outline from the Tools menu.
9 Select Off (2) to turn off Outline.

If the cursor is not at the left margin when you select Off, WordPerfect inserts a
hard return before inserting the Outline Off code.

To learn more about outlines, see Lesson 18: Corporate Report—OQutline in the
WordPerfect Workbook.

Codes

When you insert a paragraph number in an outline, WordPerfect represents that
number as an Automatic Paragraph Number code [Par Num:Auto]. This code is
no different from the code inserted with the Paragraph Numbering feature, but
there is a difference between the two features (see Paragraph Numbering wv
Outline below).

If you delete an Automatic Paragraph Number code, you can reinsert it by
pressing Date/Outline (Shift-F5), selecting Paragraph Numbering (5), and
pressing Enter.

Cursor Control

WordPerfect includes a few cursor movement commands specifically designed
for use in outlines. When Outline is on, the following cursor commands can be
used:

Alt-Left Arrow (<-) Moves the cursor backward to the first paragraph
number or outline style it can find.

Alt-Right Arrow (->) Moves the cursor forward to the first paragraph
number or outline style it can find.

Alt-Up Arrow (T) Moves the cursor backward to the first paragraph
number of the same (or preceding) level it can
find. For example, if the cursor is resting on a
third level paragraph number, Alt-Up Arrow will
move the cursor backward to the first third,
second, or first level paragraph number it can
find.
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Alt-Down Arrow (4) Moves the cursorforward to the first paragraph
number of the same (or preceding) level it can
find. For example, if the cursor is resting on a
third level paragraph number, Alt-Down Arrow
will move the cursor forward to the first third,
second, or first level paragraph number it can
find.

The A't-arrow functions only work on keyboards with an enhanced BIOS. Ifyou don't
have ¢ keyboard with an enhanced BIOS, you can map the Alt-arrow keys to keys on your
keyboard with the Item Left/Right/ Up/Down commands (see Action under Keyboard
Layout in Reference).

Enter

If you are in an outline and press Enter immediately after inserting a paragraph
number (or after placing the cursor to the immediate right of the Paragraph
Number code), Enter inserts a hard return in front of the paragraph number. If
you press Enter at any other time in an outline, it is preset to insert a hard
return, the tabs that are necessary to place a paragraph number at the correct
level, then a paragraph number.

You can change this setting on the Paragraph Number Definition menu (see
Outline, Define in Reference).

Level numbering
In an outline, WordPerfect automatically updates the paragraph numbers as

necessary to keep numbering current. This is also true even when you make
editing changes such as inserting new paragraph numbers anyWhere in the

outline. See Levels below for more information.

Levels

The concept of levels is explained at the beginning of this section, and you can
have up to eight levels of numbering in an outline. Enter is preset to insert a
paragraph number into an outline (see Enter above).

Pressing Enter inserts a paragraph number at the same level as the current level.
In other words, if the current level is the second level, pressing Enter inserts
another second level paragraph number.



For example, in the outline below, the current level is the third level.

Economics in Education

A. why Economics Education?
1. General Education

Doc 1 Pg 1 Ln 2.17" Pos 2.2"

After you press Enter, another third level paragraph number is inserted.

Economics in Education

Perspective
A. Why Economics Education?
General Education
2. Vocational Training

Doc 1 Pg 1 Ln 2.33"1 Pos 2.2"

Again, this is preset. If you want WordPerfect to always insert a first level
paragraph number when you press Enter, or if you do not want Enter to insert a
paragraph number at all, you may make the changes on the Paragraph Number
Definition menu (see Outline, Define in Reference).

If you want to change the paragraph number to the next level (e.g., first level to
second level), press Tab immediately after inserting the number. If you want to
change the paragraph number to the previous level (e.g., second level to first
level), press #Margin Release (Shift-Tab) immediately after inserting the
number.
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If you want to return to an existing paragraph number and change its level, you
must make sure the cursor is positioned to the immediate right of the Paragraph
Number code you want to change before pressing #Margin Release or Tab.
Use Reveal Codes (Alt-F3) to make sure.

If the paragraph number is not in an outline, the cursor must be positioned to the
immediate left of the code to have Tab change the paragraph number to the next level
and have #Margin Release change the paragraph number to the previous level.

Move/Copy/Delete Family

An outline “family” is the paragraph number on the line where the cursor is
located, plus any paragraph numbers of subordinate levels. The family also
includes any text associated with those levels.

In the example below, the cursor is located on the line where the number Il has
been inserted. The outline family in this example includes all paragraph
numbers and text from the number Il to the number III.

1. I*erspective
h why Economics Education?
1. General Education
a.  High School
b.  College
2. Vocational Training
0. College Degrees
b- Post Graduate Degrees
r. Basic Principles
1. Government
2. Money
3. Control
11. _ Case Study
*. PS4
Im Main Concepts
2. Why it ia important
E.  Summit Community College
C. Carter State University
111. Moving Toward Discipline-Based Economics

IV.  Conclusion
Outline Doc 1 Pg 1 Ln 3.67" Poa 1.3*

Using the Move, Copy, and Delete Family options, you can move, copy, and
delete entire outline families. This is an excellent way to edit your outline since
paragraph numbers are automatically updated to reflect your changes.

To use the options, move to the family, press Date/Outline (Shift-F5), select
Outline (4), then select the option of your choice.

If you select Move Family (3), the family is highlighted, and you can use the
arrow keys to reposition the family in the outline. When you are satisfied with
the location, press Enter and the family will be inserted in that location.

If you select Copy Family (4), a copy of the family is highlighted, and you can
use the arrow keys to position the new copy in the outline. When you are
satisfied with the location, press Enter, and the family will be inserted in that
location. The original family will not be moved.



When you are moving or copying a family, Home,Up Arrow (T) moves the
family to the top of the outline, while Home,Down Arrow (i) moves the family
to the bottom. The Left and Right Arrows move the family in or out a level. If
you use the Left and Right Arrows, however, you cannot move the family more
than one level past the level of the line preceding the family.

If you select Delete Family (5), then press y to confirm, the family is deleted
from the outline and is stored in a temporary file. You can retrieve this file by
moving the cursor to where you want to retrieve it, pressing Cancel (FI), then
pressing Restore (1). Once the family is moved out of the delete buffer or you
exit WordPerfect, however, you cannot restore the family (see Undelete in
Reference).

You can use the Block feature (Alt-F4) to block afamily, then use the Move feature
(Ctrl-F4) to move, copy, or delete the block (see Move in Reference).

Outline On/Off

When you turn on Outline, an Outline On code is inserted into the document.
When you turn off Outline, an Outline Off code is inserted into the document.
This facilitates easy movement of an entire outline from one document to
another. Anytime the cursor is located between Outline On and Off codes,
“Outline” is displayed on the status line.

Also, when WordPerfect encounters an Outline On code, it uses the settings for
the closest Paragraph Number Definition code preceding the Outline On code.
This includes starting the outline with the specified Starting Paragraph Number.

If no Paragraph Number Definition code exists, the outline is formatted
according to the default settings (see Outline, Define in Reference).

Paragraph Number Definition Menu

The Paragraph Number Definition menu has several options which will help you
create the kind of outline you need. If you change any of these options, the
steps shown above may need some modifications. For more information on the
Paragraph Number Definition menu, see Outline, Define in Reference.

Paragraph Numbering vs. Outline

When you use the Outline feature to create an outline, you are simply inserting
automatic paragraph numbers between outline codes. Why does WordPerfect
have both an Outline feature and a Paragraph Numbering feature? Versatility.

If you are using Outline, you can insert paragraph numbers by simply pressing
Enter. You can move entire “families” of paragraph numbers and
accompanying text to different locations in an outline, and you can keep
paragraph numbering intact as you move an entire outline from one document to
another.

If you are using Paragraph Numbering, you can insert single paragraph numbers
anywhere in a document without having to turn Outline on or off. And, you can
“fix” paragraph numbers at a specific level.

OUTLINE. CREATE 457



Outline, Define

458

OUTLINE, DEFINE

If you want to insert fixed paragraph numbers in an outline, you can do so with
the Paragraph Numbering feature.

For more information on the Paragraph Numbering feature, see Paragraph
Numbering in Reference.

Styles

You can include an Outline On code in a style. More importantly, however, you
can define an outline style of your own with a combination of the Outline and
Style features (see Outline, Style in Reference).

Substiuctures

The Outline feature in the normal editing screen is independent of the Outline
feature in document substructures such as graphics boxes, footnotes, endnotes,
headers, and footers. If you want to turn on Outline in one of the above
mentioned features, you must do so in the editing screen for that feature.

Typing Text

After you insert a paragraph number, you may begin typing text. As you type
text, however, you should be aware that pressing Tab when the cursor is at the
immediate right of a Paragraph Number code changes the paragraph number to
the next level (see Levels above).

It is a good idea to always use Undent (F4) when you want to move text to a tab
stop in Outline. For example, press Tab until the paragraph number is at the
correct level, then press ¢Indent (F4) before typing text. If you must use a tab,
press Home, then Tab to insert a hard tab after the Paragraph Number code.

See Also: Lesson 18; Outline, Define; Outline, Style; Paragraph Numbering

Several options on the Paragraph Number Definition menu let you tailor the
Outline feature and paragraph numbers to your needs. Among the things you
can do with the options on this menu are select a style of paragraph numbering,
start paragraph numbering at a number other than one, and redefine the function
of the Enter key in an outline.

These options (with the exception of Automatically Adjust to Current Level)
affect paragraph numbers outside of outlines as well as paragraph numbers
within outlines. If you do not know how to use the Outline feature, see Outline,
Create in Reference and Lesson 18: Corporate Report—Outline in the
WordPerfect Workbook.
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The Paragraph Number Definition menu is shown below.

Paragraph Number Definition

1 - Starting Paragraph Number 1
(in legal style)

1M

2 3. 4 _S_  _6_ 2
2 - Paragraph 1. a. i @ @ ] D
3 - Outline - A.
4 - Legal (1.1.1) 1 1 1 1 1 1
5 - Bullets - 0 - -
6 - User-defined
Cur:rent Definition 1. A 1. <U @ D) -
Attigch Previoub Lavol No No No No No NoO' No
7 - Enter Inserts Paragraph Number Yes
0 - Automatically Adjust to Current Level Yea

9 - Outline Style Name

Selection: 0

1 Move the cursor to a location preceding the spot where you want the changes
to take effect.

2 Press Date/Outline (Shift-F5), then select Define (6).
US Select Define from the Tools menu.

3 Select the option of your choice and make the appropriate changes (see the
option headings under Notes below).

4 Press Exit (F7) until you return to the normal editing screen.

WordPerfect inserts a Paragraph Number Definition code at that location. From
that point forward (or until WordPerfect finds another Paragraph Number
Definition code), WordPerfect formats all outlines and paragraph numbers
according to the settings you entered.

You can press Cancel (FI) while in the Paragraph Number Definition menu to
exit the menu without inserting a code into your document.

Attach Previous Level

This heading on the Paragraph Number Definition menu tells WordPerfect
whether to connect the previous level paragraph number to the current level
paragraph number. For example, if you want the first three levels of an outline
format connected (e.g., 1.A.3) at the third level, you would type y for Yes under
the second and third level paragraph numbers.

WordPerfect presets the answers under this heading to No for all nhumbering
formats except the legal numbering format. The settings for the established
formats cannot be changed.

The only way for you to change the Attach setting is to create a user-defined
numbering format. After selecting User-Defined (6), you can move to the Attach
setting by pressing Down Arrow (i). Type y if you want to attach the previous

OUTLINE, DEFINE 459



460

OUTLINE, DEFINE

level number or type n if you don’t want to attach the previous level number.
Press ~“Margin Release to move backward through the settings or Tab to move
forwiird.

For more information on creating a user-defined numbering format, see
Numbering Formats below.

Automatically Adjust to Current Level

This option tells WordPerfect the level an automatic paragraph number in an
outline should have when it is inserted. If this option is set to Yes, WordPerfect
will insert the number at the last level that was inserted.

For example, if the last number that was inserted was a second level paragraph
number in the outline numbering format (e.g., A., B., C.), the next automatic
paragraph number will also be a second level number. If this option is set to
No, WordPerfect will always insert a first level automatic paragraph number

€g. 1., I, 1L).

Of course, you can still use Tab to move the number to the next level or
+Margin Release (Shift-Tab) to move the number to the previous level no matter
what the setting is for this option (see Levels under Outline, Create and
Changing Levels under Paragraph Numbering in Reference).

Enter Inserts Paragraph Number

This option defines the function of the Enter key when Outline is on. Yes
means that Enter will insert a paragraph number as it normally does. No means
that Enter will end a line of text and nothing more.

if this option is set to No, the only way you can insert a paragraph number is
with the Paragraph Numbering feature (Shift-F5,5,). You may want to define a
macro to perform this task (see Macros in Reference).

If this option is set to Yes and Outline is on, you can insert a hard return without
inserting a paragraph number by pressing Ctrl-v before pressing Enter.
Similarly, pressing Ctrl-v before pressing Ctrl-Enter will insert a hard page
break.

For more information on the Paragraph Numbering feature, see Paragraph
Numbering in Reference.

Existing Numbers

If you insert a Paragraph Number Definition code prior to an existing outline or
paragraph number, the outline and paragraph numbers will be converted to
conform to the new definition.

Initial Codes/Settings
You can insert a Paragraph Number Definition code in Initial Codes.

For more information on the Initial Codes features, see Initial Codes in
Reference.



A NUMBERING FORMATS

Numbering Formats

You can choose one of four WordPerfect paragraph numbering formats or create
your own. The formats and examples of each are displayed under options two
through six on the Paragraph Number Definition menu.

paragraph Number Definition

1 - Starting Paragraph Number 1

2 3 4 5. 6 7 8 N
2 - paragraph 1 1 1 @ u b) a

3 Zoutiine 1 A 1 (a). @ @ 3 a)
4 - Legal (1.1.1) 1 1 1 1 1 1 K 1

5 - Bullets - [¢]

6 - User-defined

Current Definition |8 A. 1. a @ @ D) a)
Attach Previous Level NO No No No’ No NO No

7 - Enter Inserts Paragraph Number Yes

0 - Automatically Adjust to Current Level Yes

9 - Outline Style Name

Selectiis» 0

Once you select a format, it is displayed next to the Current Definition heading.

To define your own format, select User-Defined (6), then select the option of
your choice from the menu at the bottom of the screen. If you want an
uppercase Roman numeral for that level, select Uppercase Roman (I). If you
want a lowercase letter, select Lowercase Letters (a). If you want a paragraph
number to be a Roman numeral at its own level and an Arabic numeral when
attached to subsequent levels (e.g., I., 1.1, 1.11), select Uppercase Roman/Digits
if attached (X) or Lowercase Roman/Digits if attached (x).

If you want a WordPerfect character, press Compose (Ctrl-2). Next, type the
character set number, a comma, the character within the character set, then press
Enter (see Compose in Reference). If you want a keyboard character, type the
keyboard character. If you don’t want any number, letter, or character displayed
at that level, delete the displayed number, and leave it blank.

Your choices are displayed under the Current Definition heading. Press Enter or
Tab to move from one level to the next. Press #Margin Release (Shift-Tab) to
move backward through the settings.

After you choose the numbers, letters, or characters for all eight levels, you must
type y for Yes or n for No in the Attach Previous Level heading. Press Exit
(F7) at any time when you are satisfied with the displayed settings. For more
information on the Attach Previous Level heading, see Attach Previous Level
above.
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Outline Style Name

Select this option to go into the Outline Style menu and select an outline style.
For more information on the Outline Style feature, see Outline, Style in
Reference.

Starting Paragraph Number

Editing this option lets you start outline numbering at any level with any number.
Some situations where this might be helpful are discussed in the following
paragraphs.

When you enter a number for this option, you must enter it in a numeric format. This
means you should use arabic numerals separated by commas, spaces, or periods. Ifyou
want to start at VI.B.3 in the outline numbering format, enter 6.2.3 for the Starting
Paragraph Number option.

One situation where the Starting Paragraph Number option is useful is in a
document where you turn off Outline, then turn it on again later in the document.
For example, you may have one outline at the beginning of your document that
stops with a first level paragraph number of IlI.

Later in the same document, you may want to turn on Outline again but start
with a first level paragraph number of IV (rather than I). To do so, you can
make the change with the Starting Paragraph Number option.

To make the change, move the cursor to a location after the first outline but
before: the second outline. Next, select Starting Paragraph Number

(Shift F5,6,1), delete the default value, and enter 4. Then press Exit (F7) until
you return to the normal editing screen.

When you move the cursor past the second Outline On code, you will notice that
the outline numbers change.

Another thing you could have done in the example above was to delete the
starting paragraph number and leave it blank. When you leave the option blank,
WordPerfect continues numbering from any previous paragraph numbers in the
document.

In the example above, WordPerfect would have searched for the first paragraph
number preceding the numbering change (Il1), then would have continued
paragraph numbering from that point on. This is especially helpful when you
add or delete paragraph numbers prior to the location of the numbering change.

Another situation where changing the Starting Paragraph Number option may be
useful is when you want to start numbering over on a level without starting the
entire outline over.



For example, your cursor may be located at a third level paragraph number as
shown below.

Economics in Education

A. Why Economics Education?
General Education
a- High School
b. College
2. Vocational Training
a. College Degrees
b. Post Graduate Degrees
B. Basic Principles
1. Governinent
2. Money
3.

Doc 2 Pg 1 Ln 3.67" Pos 2.2%

To start numbering over at this level without starting numbering for the entire
outline over, move the cursor to where you want to make the change. Next,
select Starting Paragraph Number (Shift-F5,6,1) and enter the numbers that
represent the level and the number at which you want to restart numbering (1.2.1

for the example above). Then press Exit (F7) until you return to the normal
editing screen.

As you finish your outline, you will notice that numbering started over at that
level, but continued on in the rest of the outline.

1. Perspectlve
Why Economics Education?
1. General Education
a. High School
b. College

2. Vocatuonal Training
College Degrees
b. Post-Graduate Degrees

b. Basic Principles

1. Government

2. Money

3. Control

1. Supply

Demand
C. Appllcatlons

Doc 1 Pg 1 bn 3.83” Pos 3.2"
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Another thing you could have done in the example above was to enter the
starting paragraph number as ?.?. 1L The question mark (?) tells WordPerfect to
leave a paragraph number at that level as it is.

In the example above, it could have been used to tell WordPerfect not to do
anything to first and second level paragraph numbers. This is especially useful if
you add or delete paragraph numbers prior to the location of the numbering
change or if you don’t know what the numbers for previous levels were (such as
in subdocuments for a master document).

See Also: Outline, Create; Outline, Style; Paragraph Numbering

The Outline Style feature uses the power of the WordPerfect Style feature to let
you create styles for your paragraph numbers. This lets you go beyond the
simple numbering formats found in the Paragraph Number Definition menu.

Styles consist of codes and text and can be used to format text. Styles are easily
created and edited and make editing a document easier. If you are not familiar
with the Style feature, we highly recommend that you read Style and Style,
Create in Reference before reading this section.

Once you have selected an outline style, it then becomes the numbering format
for paragraph numbers (both within and without outlines). To learn more about
the besics of the Outline feature, you should read Outline, Create in Reference
and Lesson 18: Corporate Report-Outline in the WordPerfect Workbook. To
learn more about Paragraph Numbering, see Paragraph Numbering in Reference.

To select an outline style,

1 Move the cursor to the location in your document where you want to begin
using outline styles for your paragraph numbers.

2 Press Date/Outline (Shift-F5), then select Define (6).

O3 Select Define from the Tools menu.

3 Select Outline Style Name (9).

4 Move the cursor to the style you want to select, then choose Select (1).

From that point forward in your document, paragraph numbers will be formatted
accord ing to that outline style.

If you have not created an outline style or cannot find the style you want to use,
you can create or retrieve an outline style (see Creating an Outline Style and
Retrieving an Outline Style below). After you do so, be sure to select it.
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Changing Non-Outline Styles to Outline Styles

To change a non-outline style to an outline style, press Style (Alt-F8) from the
normal editing screen, move the cursor to the style you want to change, then
press Edit (4).

Next, select Type (2), select Outline (3), then enter the necessary information to
change the style. The necessary information includes the name of the outline
style you want to include the style under and the number of the level at which
you want to include the style.

For example, if you want to change the style to a third level number under an
outline style named “Outline,” you would enter Outline for the style name and 3
for the level.

If the name you enter does not match an existing outline style, an outline style with that
name will be created.

After entering the information, you can select the outline style from the Outline
Styles menu at any time as you normally would.

Creating an Outline Style

Creating an outline style is similar to creating a style on the Styles menu. To do
so, select Create (Shift-F5,6,9,2) from the Outline Styles menu, then enter the
necessary information. Press Exit (F7) until you return to the Outline Styles
menu. The Outline Styles menu is shown below.

Outline Styles
Description

-- NONE -- Use paragraph numbers only
Outline 1

1 Select; 2 Create; 3 Edit; 4 Delete; 5 Save; 6 Retrieve; 7 Update; 1

You may notice that there are several other options (Edit, Save, Retrieve, etc.) on the
Outline Styles menu. These options function the same way they do in the Style feature
(see Style in Reference).
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You create outline styles in the Outline Styles: Edit menu. This menu is shown
below.

outline Styles: Edit
Nane: Outline 2

Description:

Level Type Enter

1 Nams; 2 Description; 3 Type: 4 Enter; 5 Codes: 0

The Name is the name you want to call an outline style. You don’t name the
styles for each paragraph numbering level, rather, you use one name for the style
that incorporates all of the level styles. Select Name (1), then enter a name for
the outline styles.

You can enter up to 12 characters or spaces for an outline style name.
Characters entered with Compose may take up more space than regular keyboard
characters, so if you decide to enter characters with Compose, you may not be
able to use all 12 characters or spaces for the outline style name.

The Description is something you can label the style with to help you remember
its contents. Select Description (2), then enter a description for the outline style.

You can enter up to 54 characters or spaces for an outline style description.
Characters entered with Compose may take up more space than regular keyboard
characters, so if you decide to enter characters with Compose, you may not be
able to use all 54 characters or spaces for the outline style description.

Creating a style for each paragraph numbering level is very similar to creating a
style in the Styles menu. Move the cursor to the level for which you want to
create a style, then enter the Type, Enter, and Codes information.

Type tells WordPerfect whether the style is paired or open. See Style, Create in
Reference for a discussion on paired and open styles. Select Type (3), then
Paired (1) or Open (2).

Enter lets you define the function of the Enter key with regard to a particular
style. Once again, this procedure is discussed under Style, Create in Reference.
This option is only in effect for paired styles. Select Enter (4), then select the
option of your choice.

You may wonder how this Enter option works in conjunction with the setting for
the Enter key on the Paragraph Number Definition menu. When you are inside



Style On and Off codes, the Enter key setting for the style is in effect. Once
you are outside of the Style codes, the Paragraph Number Definition menu
setting is in effect.

Codes lets you enter the codes for the style. Again, a discussion on this
procedure is found under Style, Create in Reference. Select Codes (5), then
enter the codes you want to include in the style. Press Exit (F7) to return to the
Outline Styles: Edit screen.

If you don't enter codes for a level in an outline style, WordPerfect inserts a
fixed paragraph number for that level (see Paragraph Numbering in Reference).

Nesting Styles

You cannot nest outline styles (include one paired outline style completely within
another). If you try to do so, WordPerfect will turn the first style off before
inserting the second style.

Non-Existing Styles

If WordPerfect encounters an Outline Style code in a document that doesn't have
a corresponding style on the Styles or Outline Styles menus, it re-creates the
outline style on both the Styles and Outline Styles menus. All codes in the style
are preserved.

This will most likely happen because a style was created, used, then deleted from
either the Styles or Outline Styles menu. This will also happen when a style is
renamed on the Styles or Outline Styles menu but not in the document.

Retrieving a Style

If you want to retrieve a previously saved list of outline styles to the Outline
Styles menu, select Retrieve (6) from the Outline Styles menu, then enter the
name of the style hie. If you don't enter a complete pathname, WordPerfect will
search the style directory (see Location of Files in Reference). If no style
directory exists, WordPerfect searches the default directory.

After you select Retrieve (6), you can press List (F5). then enter a directory name to
display thefiles in that directory. Wfth the directory displayed on the screen, select
Retrieve (1) to retrieve the highlightedfile.

When you retrieve a list of outline styles, WordPerfect checks your current list
of outline styles for style names that match the incoming styles. If WordPerfect
finds a match, it displays the “Style(s) Already Exist, Replace?” message. If you
type n for No, WordPerfect only retrieves the styles whose names do not match
current style names. If you type y for Yes, WordPerfect retrieves all of the
styles, replacing current styles with the incoming files of the same name.

When you retrieve the style file, all styles (both outline and non-outline) in the
file are retrieved to the Styles menu.
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Savinti a Style

If you want to save all of the outline styles on the Outline Styles menu to a
separate file that can be used from document to document, select Save (5), then
enter a name for the style. WordPerfect will save the outline styles to the style
directory (see Location of Files in Reference). If no style directory exists,
WordPerfect will save the outline styles to the default directory.

Keep in mind that this option is only for saving outline styles as a separate file
that can be used from document to document. When you save a document, you
save the outline styles associated with it, so there is no need to use this option if
you p an on using the outline styles in the current document only.

Important: We suggest you create a style directory, specify it in Location of Files
(Shift-F1,6,5), and name style files with some type of descriptive extension (e.g,, .STY)

when you save them. This may help you remember that a style file is a style file and not
a document.

When you save outline styles, the styles on the Styles menu are also saved to the
file.

Style vs. Outline Style

Outline Style is very similar to the Style feature. In fact, you may notice that
Outline Style contains all of the options that Style contains with the exception of
On and Off.

Outline Style replaces On and Off with Select which is used to tell WordPerfect
that you want to use a particular outline style. Once you have selected an
outline style, paragraph numbers are formatted according to the style from that
point forward in the document The style for each numbering level is turned on
when you insert a new level number and is turned off when you use the Right
Arrow key (or Enter, if it is so set) to move past the Style Off code.

If the style is an open style, you can't turn it off.

As you work with the Style feature, you may notice that your outline styles are
also shown on the Styles menu. They are there to remind you that they are part
of the document and will be saved with the document when you save the
document. You can only turn outline styles on and off from the Styles menu,
however, when you are in an outline.

You can change a non-outline style to an outline style (see Changing Non-
Outline Styles to Outline Styles above). One advantage outline styles have over
styles is that outline styles can be changed to a previous or following level with
+Margin Release (Shift-Tab) or Tab just like other paragraph numbers.

See Also: Outline, Create; Outline, Define; Style; Style, Create



Overstrike

Notes

You may want to combine the characters found on your keyboard to create new
characters. For example, if the printer font you are using does not clearly
differentiate a zero (0) from a capital O (O), you may want to combine the zero
with a slash (e.g., 0). You can do this using Overstrike.

If your printer has the capability, overstrike lets you combine characters and
attributes to create mathematical symbols, chemical symbols, and other character
combinations which are not included in the WordPerfect character sets.

To create an overstrike,

1 Move the cursor to where you want to create the overstrike.
2 Press Format (Shift-F8), then select Other (4).

CB Select Other from the Layout menu.

3 Select Overstrike (5), then select Create (1).

4 Type the characters that you want printed as an overstrike. For example, to
get the O overstrike you would type /0. You can also use Font (Ctrl-F8) to
select the attributes you want those characters to have. When you are ready
to save the overstrike, press Enter.

5 Press Exit (F7) to return to your document.

Codes

When you select Overstrike (5) from the Format: Other menu, then select Create
(1), an Overstrike code [Ovrstk] appears on the status line. Any characters you
then type appear side-by-side on the screen. You can type up to 30 characters,
discounting the space taken up by the attributes you select.

When the document is printed, all the characters you type will be printed on top
of one another. However, only the last character you type appears in the normal
editing screen. To see all the characters in the overstrike, you can press Reveal
Codes (Alt-F3). In the Reveal Codes part of the screen, all the characters in an
overstrike are included as part of the Overstrike code (e.g., [Ovrstk:0/]).

Editing an Overstrike

To edit an existing Overstrike, select Edit (2) rather than Create (1) in step 3 of
the steps given at the beginning of this reference section. WordPerfect searches
through text backward, from the cursor position and displays the first overstrike
it encounters. If it can't find an overstrike searching backward it then searches
forward.

Once an existing overstrike is displayed on the screen, you can edit it. Typing a
character key erases the existing overstrike and you have to start over. However,
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before you press a character key, you can use Left Arrow (<-) and Right Arrow
(->) to move through the characters and edit them. When you are ready to save
the overstrike, press Enter, then press Exit (F7) to return to your document.

Overstrike vs. Compose

Man)' overstrike character combinations are already provided in the WordPerfect
character sets (see Appendix P: WordPerfect Characters). This includes
international characters. You can enter these characters into your text using
Compose (Ctrl-2). You can also use Compose to create many of the most
common character combinations (e.g., e, i. ii) (see Compose in Reference).

Whenever possible, it is preferable to use Compose rather than Overstrike to
enter characters into your text. If the elements of those characters are available,
WordPerfect will then compose the characters for you, even if the total character
is not available on a printer.

Short Cuts

If there is an overstrike that you use often, you might want to define a macro
that creates an overstrike and then map that macro to a certain key on your
keyboard using the Keyboard Layout feature in Setup (Shift-FI,3). That would
spare you from having to re-create the overstrike each time you want to insert it
in yoir document (see Keyboard Layout in Reference).

See Also: Compose; Keyboard Layout



P Page, Soft and Hard

A SOFT PAGE BFEAK
&Y oURRENT PAGE NVBRR

You do not need to divide the text you type into pages. WordPerfect does that
for you. Just as WordPerfect automatically wraps the text you type each time
you come to the end of a line, it also inserts a page divider each time you reach
the end of a page.

The page dividers which WordPerfect inserts for you are called soft page breaks.
They are represented in the normal editing screen by a line of dashes which
extends across the width of the screen.

carrier, the B747F, is limited to crates that are 350 x 260 XZGD
cm. in size with a maximum payload of 750 kilograms. The only
alternative is to ship the statues as indivisible items which
require no packaging However, we strongly discourage this due to
the statuary's fragile nature.

You should be aware that Samson Air Freighters can only insure
each piece for £1,000,000, which is included in the £9.60 (per 100
miles X 50 kilograms) price we quoted. Any Increase in the

Insurance will affect the shipping cost To make it cost effective

for you, you may want to seek an independent insurer to supplement
our schedule.

ur final concern is Customs. When the plane arrives at Los
Angeles customs officials will randomly select cargo and unpack
it. If any damage results from this procedure, our underwriter
cannot be held responsible for coverage. The crate dismantling
must be done by The Great Gem Company. As a precaution, SAF will
designate Los Angeles os a final destination. At that time, a Great
Gem Company representative must accept delivery of the statuary
Once that transaction has been completed, we will draw up a new
Invoice to continue delivery to Houston._

Doc 1 Pg 2 Ln 3" Pos 5"

A

Such page breaks are called soft because their location is likely to change as you
add and delete text from your document. They reformat your text so you don’t
have to. Even as you add or delete footnotes, endnotes, headers, or footers in
your document, WordPerfect continually reformats your document from page to
page, displaying on the status line the page number on which the cursor is found.

However, there are times when you may want to insert a page break of your

own. For example, if the document you are creating contains two sections, you

might want to be sure that the second section always begins on a new page.

You can do this by inserting a hard page break. The location of a hard page

break will not change regardless of the changes you make to your document.
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To insert a hard page break at the cursor.
1 Fress Hard Page (Ctrl-Enter).

According to Dr. Dan Maryon, the best way to prepare for the age
of 30 is to exercise now. "It doesn't really matter what kind of
exercise program older adults choose.” he states, "just as long as

the” are active.”

] Chapter Three

The key to sticking with an exercise program is finding one that
Is snjoyable. For older adults, this means developing a program

that la not only fun, but also safe. In order to avoid Injury, the
Doc 1 Pg 19 Ln 2.33" Pos 1"

A hard page break is represented in the normal editing screen by a line of double
dashes which extends across the width of the screen.

Alternate Keystroke

On keyboards with an enhanced BIOS, you can also insert a hard page break by
pressing Ctrl-Insert. If you do not have a keyboard with an enhanced BIOS,
you can re-assign or map this alternate keystroke to a different key (see
Keyboard Layout in Reference’).

Codes

In the Reveal Codes (Alt-F3) portion of the screen, a hard page is represented by
a Hard Page code [HPg] and a soft page is represented by a Soft Page code
[SPg]. If the Soft Page code [SPg] was originally a Hard Return code [HRt], it
is displayed as [HRt-SPg],

Deleting Page Breaks

You can delete a hard page break in either the normal editing screen or in
Reveal Codes (Alt-F3). Since the on-screen change is evident, you are not asked
to cor firm the deletion.

You cannot add or delete soft page breaks. WordPerfect adds and removes them
for you as you make changes to a document.

Other Features

Although hard page breaks can be used to separate sections or chapters within a
document, it is preferable to create documents in small, manageable sizes and
then combine them together using the Master Document feature (see Master
Documents in Reference).



Page Format

Notes

WordPerfect also offers several methods of keeping text together on a page.
These include the Block Protect, Conditional End of Page, and Widow/Orphan
features.

See Also: Block Protect; Conditional End of Page; Headers and Footers; Master
Documents; Widow/Orphan

The Page Format menu deals with the way text is formatted on the page. For
example, you can use Page Format options to set the top and bottom margins of
a page and to select the paper size and type. Page Format options also let you
center text vertically on a page, add headers or footers, and have WordPerfect
handle page numbering. You can have an option take effect on every page in a
document, or you can turn off an option for any given page.

Some of the changes you make to text using Page Format options are not
apparent in the normal editing screen. They only appear on the printed page or
when you preview the printed page using View Document (Shift-F7,6).

To change a Page Format option,

1 Move the cursor to the top of the page on which you want the setting
changed.

2 Press Format (Shift-F8), then select Page (2).
CB select Page from the Layout menu.

3 Select an option and make the necessary adjustments (see the option
headings under Notes below).

4 Press Exit (F7) to return to your document.

Center Page Top to Bottom
Center Page lets you center the entire page of text vertically, between the top
and bottom margins on the page (see Center Page in Reference).

Codes

Changing any of the Page Format options inserts a code into your text which
determines that setting from that point forward in your document. In general,
these codes should be placed at the top of the page before any Column On
Codes.

Force Odd/Even Page
Sometimes you may want to make sure that certain pages in a document always
have an odd, or an even, page number. For example, it is customary to begin
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each chapter in a book on an odd-numbered page. You can do this using the
Force Odd/Even Page option (see Force Odd/Even Page in Reference).

Headers and Footers

Often you may want certain information (a chapter title, the date, or the company
name) to appear on every page in a document. Such items are called headers
when they appear at the top of a page and footers when they appear at the
bottom of the page. WordPerfect offers you considerable latitude in creating and
alternating headers and footers (see Headers and Footers in Reference).

Margins, Top and Bottom
This option lets you set new top and bottom margins for the pages in your
document (see Margins, Top and Bottom in Reference).

Page numbering

You can use this feature to have WordPerfect number the pages in your
document. WordPerfect gives you eight choices as to where it will place the
numbers on each page. It also lets you insert text with page numbers (e.g., Page
10) and begin renumbering pages at any point in a document (see Page
Numbering in Reference).

Paper ISize/Type

In versions of WordPerfect sold in the United States, WordPerfect is set to print
on 8 1/2" x 11" paper, with the text running parallel to the narrow edge of the
page.

The Paper Size/Type options let you select from several common paper Sizes and
positions. You can even create a new Paper Size/Type definition of your own
(see Paper Size/Type in Reference).

Suppress Page Format
This option lets you turn off page numbering and headers and footers for the
current page only (see Suppress Page Format in Reference).

See Also: Center Page; Force Odd/Even Page; Headers and Footers; Margins,
Top and Bottom; Page Numbering; Paper Size/Type; Suppress Page Format

The Page Numbering feature is designed to let you quickly select the kind of
numbers you want and where you want them to be on the page.

You can choose Arabic (e.g., 1 2, 3) or two different kinds of Roman numerals
(e.g., i, ii, iii, or I, I, 1) and have them placed at any one of eight possible
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locations. You can also have WordPerfect accompany your page numbers with a
word or phrase (e.g.. Page Number 1 or Economics—Page 1).

Once you’ve made your selections, WordPerfect numbers the pages in your
document for you and keeps them numbered correctly no matter how much you
edit the document. The actual numbers do not appear on the normal editing
screen, only on the printed page. However, you can preview how they will look
using View Document (Shift-F7,6).

To have WordPerfect number your pages,

1 Move to the top of the page where you want numbering to begin.

2 Press Format (Shift-F8), then select Page (2).

I7B select Page from the Layout menu.

3 Select Page Numbering (6) to display the Format: Page Numbering menu.

4 Select Page Number Position (4), then select a number indicating where you
want the numbers placed (see Page Number Position below).

The location you have selected is displayed on the screen in entry number 4
(e.g., Top Alternating). At this point, you can also have words included with the
page number (see Page Number Sty'le below) or change the type of number being
used (see New Page Number below).

5 Press Exit (F7) to return to your document.

Codes

Selecting Page Numbering as explained in steps 1through 4 above inserts a Page
Numbering code [Pg Numbering:/oc«//o/i] into your document, where location
indicates where the page numbers will appear on the page (e.g.. Bottom Center
or Top Alternating). From that point forward, page numbers will appear at that
location. Generally, this code should always be placed at the top of the page on
which you want the page numbering to start.

Selecting New Page Number (1) from the Format: Page Numbering menu, then
typing a number and pressing Exit (F7) inserts a New Page Number code

[Pg Num:#l into your document, where # is the current number. You can also
use this option to change the type of number being used by entering another
numbering type (e.g., i or IV). From that point forward, pages will be numbered
consecutively starting with that number and in that type. If no New Page
Number code appears, Arabic numerals are used (see New Page Number below).

Selecting Page Number Style (2) from the Format: Page Numbering menu, then
changing the text being used with numbers, inserts a Page Numbering Style code
[Pg Num Style:sf\7e] into your document, where style is the current Style being
used (e.g., [Pg Num Style:Page AB]. From that point forward, page numbers
will be accompanied by that additional text (see Page Number Style below).

Any changes made by the Page Numbering, New Page Number, and Page
Number Style codes are also reflected in the numbers which appear in the lists
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and tables you generate (e.g., Indexes, Tables of Contents, Tables of Authorities,
Cross-References).

Initial Settings

Page numbers are not initially included in the documents you create in
WordPerfect. However, you may always want to use page numbers in your
documents. You can have a page number format automatically inserted at the
beginning of the documents you create by inserting the page numbering codes
into i:he Initial Codes you enter in Setup (Shift-FI ,4,5) (see Initial Codes in
Reference).

Inserting a Page Number

Sometimes you may want to include the current page number in text which
appears elsewhere on a page. You can do this by pressing Ctrl-b to insert a AB
code into your text. This also works in headers, footers, footnotes, and endnotes.

If you want to insert the complete current page numbering style into your text
(e.g., Page AB), select Insert Page Number (3) from the Page Numbering menu.
This xturns you to your document, inserting the complete current page
numbering style at the cursor.

New Page Number
This option lets you begin renumbering pages at any point in your document. It
also lets you change the type of numbers being used.

To change the page number, select New Page Number (1) from the Format: Page
Numbering menu, enter the new starting number, and press Exit (F7) to return to
your document.

The new number is displayed on the status line, and the pages which follow are
numbered consecutively starting with that number.

Three different kinds of numbering are possible: Arabic (e.g., 1, 2, 3),
Lowercase Roman (e.g., i, ii, iii), or Uppercase Roman (e.g., I, II, lll). Unless
you make a change in this entry, Arabic numerals are used. You can change to
Roman by entering a Roman numeral (e.g., i or I) as the new page number. If
you want all the numbers in your document to appear as Roman numerals, you
must do this on the first page of your document.

Page Number Position
Page rumbers are not included in a document unless you select them.

Selecting Page Number Position (4) from the Format: Page Numbering menu
display s the possible page number selections graphically on the screen.



The possible selections are:
Selection Page Number Location
Top left corner, every page
Top center, every page
Top right corner, every page
Top left corner for even pages, top right corner for odd pages
Bottom left corner, every page
Bottom center, every page

Bottom right corner, every page

N o O B~ W N

Bottom left corner for even pages, bottom right corner for odd
pages

9 No page numbers

Selecting any of these locations returns you to the Format: Page Numbering
menu and displays that selection in the Page Number Position entry. You can
then press Exit (F7) to return to the normal editing screen. This inserts a Page
Numbering code into your document (e g., [Page Numbering:Bottom Center]) as
explained in Codes above. The code takes effect from that point forward, until a
new one is inserted.

Page Number Style

Normally, page numbers include only numerals (e.g., 1 2, 3). This is
represented by a Ctrl-B code (AB) in the Page Number Style entry on the
Format: Page Numbering menu.

You may sometimes want to accompany page numbers with text (e.g., Page 2, or
Economics, Page 6). You can do this by adding text to the Page Number Style
entry.

When you select Page Number Style (2) from the Page Numbering menu, the
cursor moves to the current style. You can then type any character to erase the
current style or use the arrow keys to move through the current style and edit it.
You can type characters from the keyboard or use Compose (Ctrl-2) to insert any
character in the WordPerfect character sets (see Compose in Reference). Up to
28 characters are possible, excluding the extra space required to display extended
characters.

Once you have completed the style you want, press Enter to save it.

A page number style must always include the Ctrl-B code (AB). If you forget to
include the Ctrl-B code in this entry, WordPerfect inserts it for you at the end of
the Page Numbering Style entry.
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Page Numbers with Headers and Footers

WordPerfect inserts page numbers on either the top or bottom line of text on
each page. It also inserts a blank line between the page numbers and the
remaining text.

Since headers are also printed on the top line of every page, and footers on the
bottom line, this can cause problems when you use both the Page Number
feature and the Header and Footer feature in the same document. You can avoid
this by inserting an extra line at the top of a header or at the bottom of a footer
whenever you are going to use these features along with page numbers (see
Headers and Footers in Reference).

Suppressing Page Numbering

To suppress page numbering for one page, press Format (Shift-F8), select Page
(2), select Suppress (this page only) (8), select Suppress Page Numbering (4),
type v, then press Exit (F7) to return to your document (see Suppress Page
Format in Reference).

To suppress page numbering for several pages, move to the top of the page
where you want to begin suppressing numbers, press Format (Shift-F8). select
Page (2), select Page Numbering (6), select Page Number Position (4), select No
Page Numbers (9), then press Exit (F7) to return to your document.

You can then move to the page where you want page numbers to reappear, and
turn on page numbering again by following the steps given at the beginning of
this reference section. WordPerfect will take the intervening pages into account
as it numbers your pages, but it will not print numbers on them when you print
your document.

See Also: Headers and Footers; Initial Codes

When printing in WordPerfect, you need a way of selecting and creating
different kinds and sizes of paper (forms) to print on. In addition, you need to
be able to tell WordPerfect which form you are printing on at a particular time.
The Paper Size/Type feature lets you do this.

This feature lets you define any kind of form (letterhead, labels, envelopes, etc.),
then print on that form. Since there are so many possible types of paper you can
print on, WordPerfect needs information about each type you use. For example,
it needs to know the size of the paper, how the paper is inserted into the printer
(e.g., bin number), and whether or not you want WordPerfect to prompt you to
insert the paper.

In addition to directing WordPerfect to the proper form, this information helps
WordPerfect format text on both the screen and the printed page. For example,



word wrap and soft page breaks are directly related to the size of the current
page.

The Paper Size/Type feature displays a list of all the paper sizes and types
dehned for the currently selected printer. Each printer you select will have
different paper sizes and types already defined. You can edit or delete
definitions, or create new ones that will be displayed when you select Paper
Size/Type with that printer selected.

Before WordPerfect can use any of the information that is displayed with the list
of paper size/type definitions, you need to select a paper size and type.

Each version of WordPerfect has a defaultform that is used ifyou do not select a paper
size and type. For U.S. versions, this is Standard 8.5" X II" paper. For non-U.S.
versions, the form varies.

To select a paper size and type,

1 Move the cursor to the place in your document where you want to change to
a different paper size and type. This should be the top of a page in the
document.

2 Press Format (Shift-F8), then select Page (2) to display the Format: Page
menu.

US select Page from the Layout menu.

3 Select Paper Size/Type (7), move the cursor to the paper type you want to
use (see Paper Type and Orientation below), then choose Select (1).

The paper definition currently in use is highlighted when you enter the Paper
Size/Type screen.

4 Press Exit (F7) to return to the normal editing screen.

Ifyou have not yet selected a printer, these steps will work somewhat differently (see

Paper Size/Type Screen below).

When you select a definition (as in the steps above), WordPerfect inserts a Paper
Size/Type code (see Codes below) into your document. When WordPerfect
encounters one of these codes while printing, it looks on the list of paper sizes
and types and uses the definition that matches the code exactly. If it cannot find
a definition to match the code, it uses the [ALL OTHERS] definition (see [ALL
OTHERSI below).

Important: The information concerning your forms is stored in the .PRS file for the
currently-selected printer. You can print theforms on different printers as long as each
printer has an identical form definition. Otherwise, the [ALL OTHERS] definition is
used. Ifyou delete or replace your .PRS file, you will lose the forms that you have
defined for that .PRS file.
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Adding a Definition

It is not necessary to define a paper type for every different form you print on.
WordPerfect comes with some preset definitions; in addition, the

[ALL OTHERS] paper type (see [ALL OTHERS] below) exists so that if you do
not have a paper definition to match the Paper Size/Type code in your document
(see Codes below), the [ALL OTHERS] definition is used instead. There are
some situations, however, where you may want to add a definition.

For example, if you have multiple bins or paper trays from which your printer
can retrieve paper, you can create a definition which directs your printer to the
proper location for a particular form.

Likewise, if you need to print a landscape document (text is parallel to the long
edge of the paper) and can only do so by rotating the form (i.e., inserting the
long edge of the form into the printer first), you may need to create a definition
specifying new dimensions for the form.

In short, if you are not happy with the [ALL OTHERS] definition, you need to
add a definition or edit the [ALL OTHERS] definition (see Edit [ALL OTHERS]
Paper Definition under [ALL OTHERS] below).

To add a definition, choose Add (2) instead of Select (1) in step 3 above, then
select a paper type (see Paper Type under Editing a Definition below). A screen
is displayed that lets you accept the defaults for that definition or edit them as
necessary (see Editing a Definition below). Press Exit (F7) when you finish
editing the definition, and you can see that the definition has been added to the
Format: Paper Size/Type screen.

If the paper definition you are copying or editing is the same as an existing definition
(i.e., valuesfor Paper Size, Paper Type, Font Type, and Labels match), WordPerfect will
display the error message “Paper type should be unique for this paper definition ”” when
you try to exit the Format: Edit Paper Definition menu (Shift-F8,2,7,5). You must edit
the definition to make it unique before it can be saved and added to the list of paper
definitions (see Editing a Definition below).

[ALL OTHERS]

The [ALL OTHERS] paper definition exists in case WordPerfect cannot find a
paper definition to match a Paper Size/Type code in your document (see Codes
below). It allows you to specify any paper size and type (according to your
printer’s capabilities) without actually creating a definition.

The [ALL OTHERS] definition increases your document portability (i.e., printing
a document from different computers and printers). Because WordPerfect uses
this definition if it cannot find a paper definition to match the code, you can
print ycur document with any printer, whether or not the document has the same
paper definitions as your printer.

Select the [ALL OTHERS] paper definition by choosing Select (1) with the
[ALL OTHERS| definition highlighted on the Format: Paper Size/Type menu
(Shift-F8,2,7). WordPerfect displays the Format: All Others menu with the
followirg three options:



Add (Create) New Paper Definition

Selecting this option (1) from the Format: All Others menu is the same as
selecting Add (2) from the Format: Paper Size/Type menu (see Adding a
Definition above).

Insert Temporary Paper Size/T”pe Code

Selecting this option (2) from the Format: All Others menu allows you to
insert a temporary paper size/type code into your document. Select a paper
size (or select Other (0) and enter your own dimensions), then select a paper
type (or select Other (0) and enter a name). The Format: Page menu is
displayed. After you exit this menu and return to the normal editing screen,
a Paper Size/Type code is inserted into your document.

When the document is printed, WordPerfect tries to match this temporary
paper size and type with an existing paper definition; if no match is found,
the [ALL OTHERS] paper definition is used.

When WordPerfect uses the [ALL OTHERS] definition, it will sound a beep
during printing if the Prompt to Load option has been set to Yes (the default
setting for [ALL OTHERS]). When it beeps, you need to insert the correct
paper into your printer and select Go (4) from the Printer Control menu
(Shift-F7,4).

You may want to edit the Prompt to Load option and change it to No so you
don't have to select Go from the Printer Control menu for every document
you print (see Prompt to Load under Editing a Definition below). You may
also want to change Location to Continuous; otherwise, you will be prompted
to insert a sheet of paper into your printer for each page in your document
(see Location under Editing a Definition below).

Edit [ALL OTHERS] Paper Definition

Selecting this option (3) from the Format: All Others menu is the same as
selecting Edit (5) from the Format: Paper Size/Type menu with the

[ALL OTHERS] paper definition highlighted (see Editing a Definition
below).

The screen that appears is slightly different from the one displayed if you
edit any other paper definition. Several options are not available on the
[ALL OTHERS] screen, and one additional option (Maximum Width) has
been included.

The defaults for this menu are general enough to fit most paper sizes and
types that do not have a corresponding paper definition. However, you can
edit these options (see Editing a Definition below for details).

There is no option for editing the Font Type on the [ALL OTHERS]
definition. If your printer can rotate fonts (e.g., most laser printers), the only
way you can use landscape fonts for the [ALL OTHERS] definition is if
your paper width exceeds the maximum width and your paper height does
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not. In this case, WordPerfect assumes you want to print in landscape and
uses the landscape fonts.

Format: Paper Size/Type
Font Double
Paper type and Orieneatian Paper size Prompt Loc Type Sided Labels

Standard - Wide - 1 ka.™ So  Contin Loud fib
[ALL OTHERS] width < 8.5" Yes Manual No

1 Select; 2 Add; 3 Copy; 4 Delete; 5 Edit; N Name Search; 1

The [ALL OTHERS] paper definition has a maximum width associated with
it. If your printer cannot rotate fonts and the width of the paper size you
select from the Paper Size menu when editing the [ALL OTHERS] paper
definition exceeds this maximum width, the message “Requested Form is
Lnavailable” appears next to the Paper Size/Type option on the Format: Page
menu (Shift-F8,2). The width dimension displayed next to “Paper Size” is
then set to the maximum width measurement. The on-screen and printed text
wraps relative to the maximum width measurement specified by the

[ALL OTHERS] definition.

Yau might want to enter a bigger number for Maximum Width if you plan
on using paper that is wider than the measurement displayed.

You can enter a new maximum width using the Maximum Width option on
the Format: Edit Paper Definition menufor the [ALL OTHERS] definition;
however, you should not enter a width that exceeds your printer's capability.

If your printer can rotate fonts, the only time you may get the “Requested
Form is Unavailable” message is if both the width and the height exceed the
[ALL OTHERS] maximum width measurement.

For example, if [ALL OTHERS] is set to Width < 8.5" and you select a
paper size that is 1\" x 12" (for which there is no matching paper definition),
WordPerfect uses the location specified in the [ALL OTHERS] definition
and positions the right margin relative to 8.5".

Codes

When you select a paper size and type (as you did in the steps above), a

[Paper Sz/Typ:.sfzefype] code is inserted into your document at the cursor
position. When WordPerfect encounters this code during a print job, it uses the
requesied form from that point forward. Therefore, you should always place the



Paper Size/Type code before any other codes at the top of a document (or page)
and use only one Paper Size/Type code per page.

You must place the Paper Size/Type code before any other codes at the top of the page.
Ifyou place the code anywhere other than the top of the page, it does not take effect until
the following page. You cannot place the code in a table or column.

If you edit a definition after a Paper Size/Type code has been inserted into the
document, WordPerfect automatically updates the Paper Size/Type code to reflect
the new definition when you exit the Format: Paper Size/Type menu.

Copying a Definition

You can make a copy of an existing paper size/type definition simply by
highlighting the definition you want to copy, then selecting Copy (3).
WordPerfect takes you into the Format: Edit Paper Definition menu where you
must edit the definition to make it unique before it can be saved and added to
the list of paper definitions. If the paper definition you are copying or editing is
the same as an existing definition (i.e., values for Paper Size, Paper Type, Font
Type, and Labels match), WordPerfect will display the error message “Paper
type should be unique for this paper definition” when you try to exit the Format:
Edit Paper Definition menu (Shift-F8,2,7,5).

You can press Exit (F7) to save the definition, or you can press Cancel (FI) to
exit this menu without saving the definition.

Deleting a Definition

You can delete a paper size/type definition by highlighting that definition,
selecting Delete (4) or pressing Delete (Del), then typing y to confirm that you
want to delete the definition.

Editing a Definition

If you want to change a setting for any of the paper definitions displayed on the
Format: Paper Size/Type screen, move the cursor to the definition you want to
edit, then select Edit (5). The screen displayed lets you edit all of the
information found on the Format: Paper Size/Type screen.

Binding Edge
Select this option (7) to add the binding offset (see Binding in Reference) to
the Top (1) or the Left (2) of the page. (The default for this setting is Left.)

Double Sided Printing

Select this option (6) (if your printer is capable of duplex printing), then type
y to tell WordPerfect to print on both sides of the paper. Type n to return to
the default of no double-sided printing.

If you have selected Top or Left for the binding edge (see Binding Edge
above), your printer will try to rotate the paper around the edge you specify.
For example, if you want to bind a document at the top (e.g., a calendar) and
print on both sides of the page, select Top for the binding edge. The printer
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will print top to bottom, turn the paper over (like turning the page of a
calendar), then print top to bottom again.

Font Type

Select this option (3) to print using Portrait (1) or Landscape (2) fonts.
Landscape fonts print text perpendicular to the inserted edge of the paper;
portrait fonts print parallel to the inserted edge. (See Printing, Landscape in
Reference for an explanation of printing landscape versus printing portrait.)

This feature must be used with the Paper Size feature (see Paper Size below)
for you to print in landscape (see Printing, Landscape in Reference).

If your printer cannot rotate its fonts (e.g., dot matrix and daisy wheel
printers), you should only specify Portrait for this option. (See Printing,
Landscape for details on landscape printing with a printer that cannot rotate
fonts.)

Labels
Select this option (8), then type y to define labels corresponding to this paper
definition (see Labels in Reference).

When you define labels to go with a paper definition, the Paper Size/Type
code (see Codes above) includes the dimensions of the labels.

Location

This option (5) displays a menu that tells WordPerfect how the paper is fed
to the printer. Select Continuous (1) if your printer is dot matrix or daisy
wheel and the paper is tractor-fed with perforated holes on each side.
Continuous forms on laser printers are single sheets of paper that are fed
with a paper cassette or a single bin sheet feeder.

Sometimes it may be difficult to determine if the paper in a laser printer is
continuous or comes from a sheet feeder with more than one bin. Generally,
if a laser printer has only one place to get paper, the paper should be defined
as continuous.

If your printer has more than one paper bin from which it can get paper,
select Bin Number (2), then enter the number of the bin where the paper is
located. The Helps and Hints screen for your sheet feeder may contain
information about your sheet feeder bins (see Sheet Feeder in Reference).

Select Manual (3) if your paper is handfed into the printer one sheet at a time.

Paper Size

This option (1) displays the Paper Size menu which lists several common
paper sizes. You can select one that is displayed or select Other (0) and
enter your own dimensions.

Paper Size refers to the dimensions of the paper on which you will print.
The dimensions are determined by the way the document is to be read. In
other words, the first measurement (width) represents the edge of the paper
parallel to text.



¢S PAPER WIDTH
O PAPER HEIGHT

For example, on a 9.5" x 4" envelope, text is parallel to the long edge of the
paper, so the paper width is 9.5". The paper height is 4". For an example
of creating an envelope definition, see Lesson 28: Envelopes and Labels in
the WordPerfect Workbook.

WtniRxfect

If your printer cannot rotate its fonts (see Printing, Landscape in Reference)
and you want to print a page landscape (long edge of the form parallel to
text), the only possible way you can do so is to insert the long edge of the
paper into the printer first. Make sure that the long edge of the paper (the
insertion edge) is represented as the width measurement in the paper size.
More information on landscape printing can be found in Printing, Landscape
in Reference.

You cannot select Other, then enter a height or width that is smaller than
your top or side margin settings (e.g., .75" x 2" labels when the margins are
1"). WordPerfect will not let you create a definition smaller than your
margins. You must first change your margins, then enter the desired height
and width.

Paper Type

Paper Type is simply what you want to call the paper you are defining.
When you select this option (2), the Format: Paper Type menu is displayed.
This menu lets you select from several different predefined types of paper
(e.g., Cardstock, Letterhead). If you want to use a form other than those
listed, select Other (9), then enter any name you want (e.g., Phil’s Second
Sheet Paper) to name your own paper type.

Prompt to Load

Select this option (4), then type y to have WordPerfect prompt you when it
is ready to print on this paper type. Your computer will beep and a message
telling you to insert the paper will appear on the Printer Control screen
(Shift-F7,4). Insert the paper, then type g to continue printing.

Ifyou are printing directly to a network printer (without using a capture command),
this option has no effect.

Text Adjustment

If you find that text on the printed page is not located where you expect it
should be (according to your margins), you may need to select this option (9)
to make adjustments to the text.
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Note that your top margin setting should not he smaller than your text adjustment. If
it is, text at the top of the page may be overprinted.

If, for example, you set your top and left margins at the default of 1" and
text does not start printing 1" from the top and left edges of the paper, try
adjusting the text using this option.

This option moves text on the page. If you want to move text up, select Up
(1 , then enter the distance. If you want to move text down, select Down
(2) , then enter the distance. Always enter a positive number for the distance
you want the text moved. If you select Up or Down, the amount you enter

is displayed next to “Top.” If you select Left (3) or Right (4), the amount
you enter is displayed next to “Side.” You can enter a text adjustment up or
down and left or right.

Il you want to return to the default of 0", select the same option you selected
to adjust the text (e.g., select Up (1) if the Text Adjustment option says “Up”
next to it), then enter 0.

View Document (Shift-F7.6) does not reflect text adjustment settings.

Macros for Envelopes and Labels
Two macros are included with WordPerfect that may help you in creating
envelopes and labels.

A macro for producing envelopes is included on the Macros keyboard layout.
See Macros in Appendix H: Keyboards for more information.

A macro for producing labels, LABELS.WPM, is included in the WordPerfect
keyboard hies group. See Labels Macro under Labels in Reference for more
information.

Paper Size/Type Screen

When you select Paper Size/Type (7) from the Format: Page menu, the screen
displayed lists information about all the paper definitions for the currently
selected printer. You can edit this information using the screen that is displayed
when you select Edit (5) (see Editing a Definition above).

You can add, delete, or select the definitions displayed on this screen. (You
cannot delete the [ALL OTHERS] definition.)

If you have not yet selected a printer, selecting Paper Size/Type from the
Format: Page menu will take you straight into the Format: Paper Size menu.
Select a paper size (see Paper Size above), then select a paper type from the
Formet: Paper Type menu (see Paper Type above). “Requested Form is
Unavailable” will appear next to Paper Size/Type on the Format: Page menu;
howe\er, a Paper Size/Type code is inserted into your document.



Paper Type and Orientation

The far left column of the Format: Paper Size/Type screen displays the Paper
Type and Orientation of those definitions set up for the currently selected printer.
This column displays the type of paper you selected (or that is already defined);
if the width of the paper is greater than the height, the word “Wide” appears
next to the type.

See Also: Printing—General Information; Printing, Landscape

Paragraph Numbering

A versatile tool, paragraph numbers can be used in the WordPerfect Outline
feature to create an outline. Used outside of the Outline feature, paragraph
numbers can be inserted anywhere in a document to simply number individual
paragraphs.

The paragraph numbers are numbered by WordPerfect and are automatically
updated to reflect any editing changes.

Paragraph numbers are differentiated by levels, then by numbers, letters,
keyboard characters, WordPerfect characters, or styles within a level. You can
have up to eight levels of paragraph numbering within a document, and this
differentiation lets you organize text in a hierarchical manner.

The screen below shows some examples of paragraph number levels.

A FIRST LEVEL NUMBER
LUl SECOND LEVEL NUMBER Econonics in Education
A THRD LEVEL NUMBER porspective

A. Why Economics Education?
B. Basic Principles

Case Study
A. PS 4
1. Grades 1-3
> 2m  Grades 4-6
Summit Community Collage
Carter State University
111. Moving Toward Discipline-Based Economics

IV. Conclusion_

C:\WPS1IN\TEST Doc 1 Pg 1 Ln 1" Pos 1"

Although you can use numbers, letters, keyboard characters, WordPerfect characters, or
styles to "number" paragraph numbers, we use the word “numbers” in the rest of this
section to describe all of the possibilities.
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If you are using paragraph numbers to create an outline, we suggest you read
Outline, Create in Reference. Although you can create and edit an outline
without using the Outline feature, it is easier to do so with the Outline feature.

To insert paragraph numbers in your document,

1 Move the cursor to where you want to insert the paragraph number.
2 Press Date/Outline (Shift-F5), then select Paragraph Number (5).
ra Select Paragraph Numberfrom the Tools menu

3 Enter a level number to “fix” the number at a certain level (see Levels
below).

or

Press Enter to let WordPerfect automatically determine the level for the
paragraph number (see Levels below).

You can use this method to insert paragraph numbers in an outline if you wish.

Appearance

The appearance of paragraph numbers is determined by the Paragraph Number
Definition feature (Shift-F5,6). When a Paragraph Number Definition code is
located in a document, all subsequent paragraph numbers conform to that
definition. 1f no Paragraph Number Definition code is located in a document,
paragraph numbers conform to the default (initial) settings for the Paragraph
Number Definition feature.

The Paragraph Number Definition feature lets you determine the starting number
for paragraph numbers as well as the appearance of the numbers themselves.
Several common paragraph numbering formats are included with WordPerfect,
and you can define formats of your own.

For more information on the Paragraph Number Definition feature, see Outline,
Define in Reference.

Changing Levels

To change the level of an automatic paragraph number to the next level, move
the cursor to the immediate left of an existing paragraph number, then press Tab
or tindent (F4). To change the level of an automatic paragraph number to the
previous level, move the cursor to the immediate left of an existing number, then
press ~Margin Release (Shift-Tab).

If the paragraph numbers are in an outline, you must place the cursor to the
immediate right of the paragraph number for Tab to change the paragraph
number to the next level and ¢Margin Release to change the paragraph number
to the previous level.

You can change the level of a fixed paragraph number in an outline by
performing the same operation described in the paragraph above. Only the level



number (not the position of the number) will change. You cannot change the
level of a fixed paragraph number outside of an outline or an outline style
inserted as a paragraph number.

Editing Paragraph Numbers

If you add or delete paragraph numbers from a document, WordPerfect
automatically updates the rest of the paragraph numbers for you to keep
numbering sequential. To delete a paragraph number, move the cursor to the
number, then press Delete (Del).

Levels

When you insert a paragraph number, you must determine its level, and you are
given two ways of doing so. Using the first way, you insert a level number.
Using the second way, you let WordPerfect determine the level number.

If you decide to insert a level number, the paragraph number is a Fixed
Paragraph Number [Par Num-.number] (where number is the level number). This
means that the paragraph number does not change its level number based on its
tab stop position. For example, if you want the number to be a third level
number even though it may be located at the left margin, enter 3 in step 3 above.

If afixed paragraph number is in an outline, you can change its level number without
changing its position on the page. If afixed paragraph number is not in an outline, you
cannot change its level number (see Changing Levels above).

If you decide to let WordPerfect enter a level number for you, the number is an
Automatic Paragraph Number [Par NurmAuto]. This means that the paragraph
number’s level depends on several factors, but that the level can always be
changed with Tab and "Margin Release (see Changing Levels above).

The “severalfactors” depend on the settings for the Paragraph Number Definition
options and the location of any Paragraph Number Definition codes in your document. If
you are interested in the Paragraph Number Definition options, read Outline, Define in
Reference. As you do so, remember that the Paragraph Number Definition code affects
all subsequent paragraph numbers.

Numbering

You can determine (or have WordPerfect determine) the level for a paragraph
number. The actual number for the paragraph number depends on the last
paragraph number or Paragraph Number Definition code prior to the one you are
entering (depending on which is closest to the paragraph number you are
entering).

Keep in mind that paragraph numbers are numbered sequentially in a document.
You can restart paragraph numbering from time to time in a document, or you
can start numbering at a number other than one, but even then, numbers will be
numbered sequentially from that point on in a document until you change
numbering again.
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When WordPerfect encounters an Outline On code, it searchesfor the closest Paragraph
Number Definition code preceding the Outline On code and uses those settings. This
includes starting the outline with the specified Starting Paragraph Number.

For nformation on restarting or changing paragraph numbering in a document,
see Starting Paragraph Number under Outline, Define in Reference.

Outline and Paragraph Numbers

When you use the Outline feature to create an outline, you are simply inserting
automatic paragraph numbers between outline codes. Why two features?
Versatility.

If you are using Outline, you can insert paragraph numbers by simply pressing
Enter if you wish. You can move entire “families” of paragraph numbers and
acconpanying text to different locations in an outline, and you can keep
paragraph numbering intact as you move an entire outline from one document to
another.

For more information on Outline, see Outline, Create in Reference.

If you are using Paragraph Numbering, you can insert single paragraph numbers
anywhere in a document without having to turn Outline on or off. And, you can
“fix” a paragraph number at a specific level.

If you want to insert fixed paragraph numbers in an outline, you can do so with
the Paragraph Numbering feature.

See Also: Outline, Create; Outline, Define; Outline, Style

Print, Document on Disk
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PRINT, DOCUMENT ON DISK

You may want to print a document that has already been saved on disk without
retrieving the document to the screen. The Print feature lets you print part or all
of a document from disk, and also print the document summary.

1 Press Print (Shift-F7) to display the Print menu.
3 Select Printfrom the File menu.

2 Select Document on Disk (3), then enter the filename of the document you
want to print.

3 Press Enter to print the entire document.
or
Enter the pages you want printed (see Selected Pages below).



Notes

If the printer does not respond at this point, select Control Printer (4) to check for any
messages or instructions (see Printer Control in Reference). If you see a message telling
you the document is notformatted for the current printer, see Printer Format below.

4 Press Exit (F7) to return to the normal editing screen.

Document Summary

You can print just the document summary for a document on disk by entering s
when you are asked to enter the pages in step 3 above (pressing Enter to print
all the pages will not print the document summary). If you want to print the
document summary along with selected pages of a document, type s in step 3
above, type a comma (,), then enter the selected pages. You must type s before
entering the selected pages. For example, enter s,I-3 to print the document
summary and pages 1through 3. If you want to print the entire document,
including the document summary, enter s-. See Selected Pages below for details
on printing selected pages of a document.

Even/Odd Pages

You can print the even or odd pages in a document by entering e for even or o
for odd when WordPerfect asks you which pages you want to print. The e or o
must be the first thing listed or must follow the s for document summary (see
Selected Pages below).

You can also print the even or odd pages in a range ofpages (e.g., €,2-20). Similarly,
you can print the even or odd logical pages (i.e., labels) by entering le or lo.

Fast Save

A document saved with the Fast Save feature (the default method for saving in
WordPerfect) can take longer to print than one saved when Fast Save is turned
off (see Fast Save in Reference). You need to be particularly aware of this when
you print several documents from disk at the same time.

List Files
You can print any WordPerfect file listed on the List Files screen (F5,Enter,4)
without retrieving it first (see List Files in Reference).

Printer Format

When printing a document from List Files or from disk that is fast saved, that
needs to be generated, or that is formatted for a different printer, WordPerfect
attempts to reformat the document. To reformat a document, WordPerfect must
associate a printer definition (.PRS file) with the document.

WordPerfect uses a .PRS file if a printer selection exists in the setup file
(WP(WP).SET) for that .PRS file. If the .PRS file exists, but its printer
definition is not found in the setup file, WordPerfect reformats the document
using the currently-selected printer.
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Selected Pages
You can indicate individual pages or groups of pages to be printed by following
these guidelines:

N Page N

S,N,M Document Summary and pages N and M

N M Pages N and M

N - Page N through the end of the document

N-M Pages N through M

-M The beginning of the document through page M
S- Document Summary and entiredocument

For example, if you enter 4,7 or 4 7 as the selected pages, pages 4 and 7 are
printed. If you enter 4,7,10-15 as the pages, then pages 4, 7, and 10 through 15
are printed.

If you have renumbered your pages with the New Page Number option on the
Format: Page menu (Shift-F8,2,6,1), WordPerfect uses the new numbers when it
prints selected pages.

Section Numbers

For some larger documents, you may have used New Page Number several
times to divide the document into sections. For example, you may have
numbered a document in the following way:

Preface i—vii

Chapter 1 1-12

Chapter 2 1-20

Chapter 3 1-10

Index i-iii

Notice in the above example that the preface and index have been formatted
for lowercase Roman numerals, while the chapters are formatted for Arabic
numerals.

When entering the numbers of individual pages to be printed, you can
indicate a section by typing the section number, a colon, then the pages you
want printed in that section (e.g., 2:4-7 will print pages 4 through 7 of
chapter 2). Sections for the two styles of page numbering (Roman and
Arabic) are counted separately by WordPerfect. So 1:12 indicates chapter 1,
page 12, while l.vi indicates preface, page vi.
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The following table lists pages that can be entered for the example given
above:

Preface, page i
| Chapter 1, page 1
Il or L11 Chapter 1, page 11

13 Chapter 2, page 13 (chapter 1 has only 12 pages)

2:i Index, page i

-12 Preface and chapter 1

1- Chapter 1, page 1 through the end of the document

2,2:2 Chapter 1, page 2 and chapter 2, page 2

1:1-2:3 The first page of chapter 1 (whether it is numbered as page

1 or not) through chapter 2, page 3
3:1-3:999 All of chapter 3
i—vii,i—Hi All of the preface and index
1 i Preface, pages i through ii

Notice that if no section number is entered, the first page of the document
matching the entered page number (Roman or Arabic) is printed.

When printing selected pages, you must enter the page numbers in numerical
order (e.g., 1 must com